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Introduction

Welcome to HTML in 10 Simple Steps or Less. Our mission in writing this book is to provide a quick
and accessible way for you to learn Hypertext Markup Language — the lingua franca of the World
Wide Web. We hope this book provides a resource that beginning and intermediate HTML coders can
use to improve their Web development skills. It is also our hope that it fills multiple roles as both a teach-
ing tool and a reference once you expand your skills.

What This Book Is

Each part in this book pertains to a different aspect of HT'ML and Web production, and we devote each
task within the parts to building a specific piece of Web page content. We’ve laid out these tasks in 10
steps or less so they’re easy to internalize and become part of your personal skill set.

Who We Are and What We Know

Robert Fuller has an extensive background in Web development and design. He served as senior devel-
oper for Travelocity’s Site59.com and takes his experience into the classroom — both live and online —
every day. He believes that in order for new Web developers truly to flourish, they must gain a solid
understanding of the Web’s underlying language, HTML.

He has authored, coauthored, and contributed to several books about HTML, Web design, graphic soft-
ware applications, and general computing. His online courses are currently available in college curricula
throughout the United States, Europe, and Australia.

Laurie Ulrich has used, written about, and helped others use computers since the early 1980s. She ran
two large training centers for computer resellers in Philadelphia and New York, and she served as an I'T
manager specializing in the proprietary software needs of midsize distributors. In 1992 she founded
Limehat & Company, Inc., a firm providing Web hosting, design, and Webmaster services to growing
businesses and nonprofit organizations. She has taught more than 10,000 students to make more effective
and creative use of their computers and software.

Laurie has also authored, coauthored, and contributed to more than 25 nationally published books on
desktop applications, graphics and illustration, and Web design.

How to Use This Book

We think of this book as a multipurpose tool — perhaps the Swiss Army knife of HTML coding. Not
only can you employ it as a guide to creating individual pieces of Web page content, but you can also use
this book as a valuable teaching tool. By working through the book’s tasks in sequence, you will learn the
basics of Web page development — from constructing tags (the core components of Hypertext Markup
Language) to publishing complete sites to a Web server.
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In addition to the material found in this book, the publisher maintains a companion Web site where
you’ll find information that doesn’t lend itself to a task-oriented approach. We point you to the Web site
(www.wiley.com/compbooks/10simplestepsorless) at various points throughout the book to give
you detailed information about particular concepts, help you learn about other Web-based resources, and
provide samples of some of the content you create.

What You Need to Get Started

As long as you have a computer, the list of requirements is quite short. To create Web page content you
need only two things: a program for writing code (a text editor) and another program for viewing the fin-
ished product (a Web browser).

Text Editors

In nearly every case, a computer’s operating system (OS) comes with a text editor. For example,
Microsoft Windows provides its users with the program called Notepad. It is a very simple, bare-bones
application that allows you to write simple text files — which is all that an HTML document is. Mac OS
9 (and earlier versions) contains a native text editor, called SimpleText. Apple refers to it as “the utility-
knife of software.” This simple application is designed for simple tasks. Mac OS X provides a new pro-
gram, called TextEdit, that replaces SimpleText. Both of these applications are more than sufficient for
writing HTML documents. Having written a vast quantity of HT'ML over the years, however, we’re sure
you’ll ultimately want to work with a text editor that offers more functionality than these limited-range
word processors do. Like anything else, you want the right tool for the job.

More robust programs offer advantages that make learning HT'ML easy. Just as a full-featured word
processor makes it easy to write letters, term papers, and books — compared with using Notepad or
SimpleText — an HTML code editor makes it easy to generate code properly and build robust Web
pages. For example, most HI'ML editors feature syntax-checking and code-coloring. Because they
understand the code you write, these programs assign colors to different functional parts of the code so
that you can easily spot errors (mostly caused by typos) and fix them.

Each major operating system — Windows, Macintosh, and UNIX/Linux — offers a number of HT' ML
editors that cost anywhere from nothing to over $100. (But as we said earlier, you get what you pay for.)
We review here some of the more popular editors available on each platform. Later on in the book, we
discuss these products and others in greater detail.

TextPad from Helios Software Solutions (Windows)

"TextPad is shareware, which means you can download it for free and generally use it indefinitely. However,
if you intend to use the program for an extended period, and derive much productive use from it, you
should register and pay for the program — if at least to get technical support and notifications of
upgrades or improvements (bug fixes). TextPad currently runs about US $26.

The creators of TextPad feel there shouldn’t be a steep learning curve when picking up a new application.
Your familiarity with other Windows programs should be sufficient experience. TextPad therefore pro-
vides the kinds of tools you expect from other applications, including keyboard shortcuts, spell-checking
(in 10 languages), the ability to open and edit multiple files simultaneously, drag and drop, undo and
redo, and the ability to create macros. TextPad also provides many code-specific tools, such as syntax-
checking, code-coloring, and libraries for storing reusable code snippets.
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BBEdit from Bare Bones Software (Macintosh)

BBEdit, whose marketing slogan is “It Doesn’t Suck,” emphasizes its HTML editing capabilities,
although it certainly isn’t limited to HTML. BBEdit functions similarly to TextPad and includes color
syntax-checking, spell-checking, and multiple undo and redo, just to name the basics. The only drawback
to BBEdit is its US $179 price tag. However, Bare Bones Software makes a free version called BBEdit
Lite. Although they don’t target it as keenly at the HTML coder, it is still a powerful, all-purpose text
editor.

Web Browsers

We suspect you already have a favorite Web browser, but if you’re serious about developing Web sites,
one browser isn’t enough. At the very least you should install the most current releases of both Netscape
and Microsoft Internet Explorer. As of this writing, here are the most current versions of these browsers
(version numbers may vary by the time you check these sites):

* Netscape 7.1 for Mac OS and Windows: http://channels.netscape.com/
ns/browsers/

 Internet Explorer 6 Service Pack 1 for Windows, Internet Explorer 5.1.7 for Mac OS 8.1
to 9.x, and Internet Explorer 5.2.3 for Mac OS X: www.microsoft.com/downloads/
search.aspx

Professional Web development environments test their Web sites with more browsers than these. They
test with computers running different operating systems using different monitor configurations and both
current and older versions of the most commonly — and sometimes not so commonly — used browsers.
They do this so that their site looks as good as possible for as many visitors as possible.

Don’t feel you need to strap yourself financially in the name of good Web design. Neither of us maintains
the ultimate testing suite at home (the office is a different story, but those costs are a business expense).
Although hardware costs money, browsers are typically free, so you should be able to round out your
browser-testing suite without spending a dime.

In addition to the current releases of Netscape and Internet Explorer, test your sites with a few older
versions of the big-name browsers. For example, get copies of Netscape 6.x and 4.x. There’ still value

in having old versions of browser software. Netscape made significant changes to their support for
Cascading Style Sheets and JavaScript when they released version 6.x, and it’s valuable to know the differ-
ences. You may be asked to develop a Web site that’s compatible with Netscape Navigator 4.7 — we’ve
had stranger requests.

Unfortunately, running multiple versions of browsers requires significant planning. For instance, you
can’t run two versions of Netscape at the same time, and you can’t even install two versions of Internet
Explorer on the same Windows machine (the later version overrides the earlier one). That’s one reason
why professional Web developers test their sites on more than one machine.

Stick with the Internet Explorer version you already have, or upgrade to the latest version and leave it at
that. Don’t downgrade your home machine; your operating system may be adversely affected. Macintosh
users seem to be able to install more than one version of Internet Explorer without incident but
Microsoft doesn’t recommend doing this.
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"The world of browsers extends beyond that of Netscape and Internet Explorer. Opera 7 (www . opera.
com) is a favorite among those who are fed up with Microsoft and Netscape. You can find current ver-
sions of many alternate browsers on CNET (www.browsers . com). It is also important to realize that
there are Web surfers who do not see the Web but who listen to it instead. They use text-to-speech
browsers, of which WeMedia Talking Browser (www.wemedia. com) is perhaps the best known.

If you ever need to test your work on any flavor of practically any browser ever made, you’ll find a
comprehensive archive of browsers at Evolt.org (http://browsers.evolt.org). It contains not only
previous versions of Netscape Navigator or Internet Explorer but also some of the earliest browsers ever
made — including the world’s first Web browser, Nexus, created by the inventor of HTML, Tim
Berners-Lee.

Are you ready to start coding? Let’s go.
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- Part 1
How to Write a Tag

Prior to computer-assisted publishing, you wrote notes to the manuscript’s
typesetter directly in the document — hence the phrase 7o 72ark up. In an
electronic text document, like a Web page, you can’t scribble in the margins;
you need another mechanism. That mechanism is the zzg. Hypertext Markup
Language is based on tags that mark up text-based documents. They instruct
Web browsers how to display content. What we’ll look at in this task is the basic
syntax (grammatical rules) for writing HTML tags.

1. To indicate where a given element begins, place the appropriate tag
before it. This consists of a certain abbreviation sandwiched by the
less-than (<) and greater-than (>) symbols. For example, to mark up a
paragraph, precede the text with the opening-paragraph tag (<p>), as
shown in Listing 1-1.

<p>She stretched herself up on tiptoe, and peeped over the
edge of the mushroom, and her eyes immediately met those of
a large blue caterpillar, that was sitting on the top, with
its arms folded, quietly smoking a long hookah, and taking
not the smallest notice of her or of anything else.

Listing 1-1: Placement of the opening-paragraph tag

2. 'To indicate where an element ends, place the corresponding closing
tag at the end. This looks the same as the opening tag, except for the
addition of the forward slash, as shown in Listing 1-2.

<p>She stretched herself up on tiptoe, and peeped over the
edge of the mushroom, and her eyes immediately met those of
a large blue caterpillar , that was sitting on the top, with
its arms folded, quietly smoking a long hookah, and taking
not the smallest notice of her or of anything else.</p>

Listing 1-2: Placement of the closing-paragraph tag
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3. When you define a tag’s artributes, which are its individual properties, Task 1
enter them inside the opening tag and separate them by spaces. The
closing tag doesn’t get any attributes. For instance, the attribute for
aligning a paragraph is written, simply enough, as align. Add it to the
opening tag as shown in Listing 1-3.

<p align>She stretched herself up on tiptoe, and peeped

over the edge of the mushroom, and her eyes immediately

met those of a large blue caterpillar , that was sitting
on the top, with its arms folded, quietly smoking a long
hookah, and taking not the smallest notice of her or of

anything else.</p>

Listing 1-3: The opening paragraph tag and its align attribute.

4. To set the attribute equal to an appropriate value, define that value by
using an equal sign and quotation marks, as shown in Listing 1-4.

<p align="right”>She stretched herself up on tiptoe,

and peeped over the edge of the mushroom, and her eyes
immediately met those of a large blue caterpillar , that
was sitting on the top, with its arms folded, quietly
smoking a long hookah, and taking not the smallest notice
of her or of anything else.</p>

Listing 1-4: A properly defined attribute that right-aligns the paragraph text

Figure 1-1 shows how this paragraph appears in the browser.

She stresched hersell up on bptoe, and peeped over the edge of the mushroom, and her eyes
smnedately meet those of a lage blue catwpdlar, that was siteg on the top, with &1 ams
folded, quetly smokag a long hookak, and takang not the rmallest motice of her o of mythag
else.

—

Figure 1-1: The sample paragraph rendered by Internet Explorer
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Structuring an HTML Document

he simple document template that you are about to build can be used again

and again as the starting point for every page you create. All HTML docu-
ments share this identical underlying structure — a kind of backbone onto which
you build your unique page content. As you learned in the previous task, most
HTML tags come in pairs which define the content within them. HTML refers
to these as container tags. An HIML document’s basic structure is really just a
series of large containers, inside of which you define the two main sections of
your page: the document head and the document body.

1. Open your text editor and begin a new blank document.

2. Iype the tag <html> at the top of the document. This tag begins the
document’s primary container. It defines the type of document you’re
creating: an HTML document.

3. This opening <html> tag requires a closing tag, so hit Enter (or
Return) twice to move down a few lines and then enter the closing
tag, </html>. Your document should appear like this:

<html>
</html>

4. Place your cursor on the line between the opening and closing tags.
Type the tag <head>, which defines the head section of the document.

5. Hit Enter (Return) twice and then type </head>. Your document
should now resemble Listing 2-1.

<html>
<head>

</head>
</html>

Listing 2-1: The head section of your HTML document
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6. To create the document title, which appears in the title bar of the
browser window, enter <title> and </title> between the head
tags of your document, as shown in Listing 2-2. For example,
entering <title>HTML in 10 Simple Steps or Less</titles
produces what you see in Figure 2-1.

<html>
<head>

<title>HTML in 10 Simple Steps or Less</title>

</head>
</html>

Listing 2-2: Defining the document title

Figure 2-1: The document title displayed on the title bar of the browser

7. The last element to add to your document template is the body sec-
tion. Between the closing </head> and the closing </html> tags,
enter opening and closing body tags, as shown in Listing 2-3.

<html>
<head>

<title> HTML in 10 Simple Steps or Less </title>
</head>

<body>

</body>
</html>

Listing 2-3: An HTML document with head and body sections defined.

8. Save your document. You can give it a name like blank.html and
then use it each time you want to start a new document by opening
it, making changes, and resaving the file with a different name.
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Task 3 Defining Meta Tag Keywords

document’s head section often contains descriptive information about the

document, referred to as metadata. Using the <meta> tag and its various
attributes, you can define such document properties as the author, the expiration
date, document key words, and descriptions. When search engines that support
metadata read your document, they can use this information to index it in order
to return your page when someone does a search on subjects matching the key-
words you have defined.

1. In the head section of your document, below the document title,
enter the <meta> tag, as shown in Listing 3-1.

<html>

<head>
<title>HTML in 10 Simple Steps or Less</title>
<metas>

</head>

Listing 3-1: Inserting the <meta> tag

2. Add the name attribute to the <meta> tag and set it equal to
“keywords”, as shown in Listing 3-2.

<html>

<head>
<title>HTML in 10 Simple Steps or Less</title>
<meta name="keywords” >

</head>
<body>

</body>
</html>

Listing 3-2: The name attribute set equal to “keywords”
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3.

4.

Insert a space and add the content attribute, as shown in Listing 3-3.

<html>

<head>
<title>HTML in 10 Simple Steps or Less</title>
<meta name="keywords” contents>

</head>
<body>

</body>
</html>

Listing 3-3: Adding the content attribute

Set the content attribute equal to a comma-separated list of key-
words pertinent to your page’s subject matter, as shown in Listing 3-4.

<html>
<head>

<title>HTML in 10 Simple Steps or Less</title>

<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less”>

</head>
<body>

</body>
</html>

Listing 3-4: Defining keywords for the <meta> tag

Because the <meta> tag is an empty tag, you want to make sure
that the code is both XHTML-compliant and still recognizable to
browsers that don’t yet support XHTML. To do that, conclude the
tag with a forward slash (/), placing a space between the last entry in
the tag and the forward slash:

<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />
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Defining Meta Tag Descriptions

Search engines use the <meta> tag’s description of the document for indexing
and ranking purposes. Some search engines also display the description
entries underneath the links on results pages. Because this text is meant for both
human and search engine readability, be sure to write it in a way that entices
people to click to your site.

1. In the head section of your document, below the document title,
insert another <metas tag.

2. Add the name attribute to your <meta> tag and set it equal to
“description”, as shown in Listing 4-1.

<html>
<head>
<title>HTML in 10 Simple Steps or Less</title>
<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />
<meta name="description”s>
</head>

<body>

</body>
</html>

Listing 4-1: Specifying that this <meta> tag contains a document description

3. Press the Spacebar and add the content attribute, which accepts
your description, as shown in Listing 4-2.

<html>
<head>
<title>HTML in 10 Simple Steps or Less</title>
<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />
<meta name="description” content>
</head>

<body>

</body>
</html>

Listing 4-2: Adding the content attribute
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4. Set the content attribute equal to a short piece of descriptive text, Task A
as shown in Listing 4-3.

<html>
<head>

<title>HTML in 10 Simple Steps or Less</title>

<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />

<meta name="description” content="HTML in 10 simple steps
or less. An introductory guide for the beginning coder.” >
</head>

<body>

</body>
</html>

Listing 4-3: Completing the property/value pair of a <meta> tag description

5. To make the <meta> tag both XHTML-compliant and still recog-
nizable to browsers that don’t yet support XHTML, insert a space
and forward slash at the end of the tag, as shown:

<meta name="description” content="HTML in 10 simple steps
or less. An introductory guide for the beginning coder”

/>




Task

5

- Part 1

Defining the Author of a
Document Using Meta Tags

f you want to put your John Hancock on your document, <metas tags allow you

to do this quite simply. To date, none of the search engines that take advantage
of metadata specifically target author information, but supplying it does clearly
mark who the content author is and who is responsible for updating the page.

1. Enter a <meta> tag into the head section of your document, setting
the name attribute equal to author, as shown in Listing 5-1.

<html>
<head>
<title>HTML in 10 Simple Steps or Less</title>
<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />
<meta name="description” content="HTML in 10 simple steps
or less. An introductory guide for the beginning coder” />
<meta name="author”>
</head>

<body>

</body>
</html>

Listing 5-1: Set the name attribute equal to”author”.

2. Follow the name attribute and author value with the content
attribute:

<meta name="author” contents>
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3. Set the content attribute equal to the name of the author, as seen in Task
Listing 5-2.

<html>
<head>
<title>HTML in 10 Simple Steps or Less</title>
<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />
<meta name="description” content="HTML in 10 simple steps
or less. An introductory guide for the beginning coder” />
<meta name="author” content="Robert Fuller and Laurie
Ulrich”>
</head>

<body>

</body>
</html>

Listing 5-2: The content attribute set to the author's name

4. To make the <meta> tag both XHTMUL-compliant and still recog-
nizable to browsers that don’t yet support XHTML, insert a space
and forward slash at the end of the tag, as shown:

<meta name="author” content="Robert Fuller and Laurie
Ulrich” />
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Task 6 Defining Meta Tag Expiration Dates

he default behavior of most browsers is to cache (a fancy word for save) the

pages it visits so that if you request the page again, it can pull it quickly from
your computer’s hard drive instead of pulling it off the Internet, which might take
more time. Although most browsers allow users to control this behavior, as a
developer you can specify the date on which the current content of your page
expires. From that point on, browsers visiting the site will have to connect to
your server to get the latest version. You can also instruct browsers not to cache
your Web pages at all.

1. Inserta <metas tag in the head section, setting the name attribute
equal to expires, as shown in Listing 6-1.

<html>
<head>
<title>HTML in 10 Simple Steps or Less</title>
<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />
<meta name="description” content="HTML in 10 simple steps
or less. An introductory guide for the beginning coder” />
<meta name="author” content="Robert Fuller and Laurie
Ulrich” />
<meta name="expires”>
</head>

<body>

</body>
</html>

Listing 6-1: Setting the name attribute equal to expires

2. Insert the content attribute as shown:

<meta name="expires” contents>

3. Set the content attribute equal to the expiration date, in Greenwich
Mean Time (GMT), as shown in Listing 6-2.

4. To prevent browsers from caching your documents at all, enter a
<metas> tag with the name attribute set equal to pragma and the
content attribute set equal to no-cache, as shown in Listing 6-3.
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<html>
<head>

<title>HTML in 10 Simple Steps or Less</title>

<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />

<meta name="description” content="HTML in 10 simple steps
or less. An introductory guide for the beginning coder” />

<meta name="author” content="Robert Fuller and Laurie
Ulrich” />

<meta name="expires” content="Mon, 17 February 2003
02:00:00 GMT”>
</head>

<body>

</body>
</html>

Listing 6-2: Expressing the expiration date in GMT

<html>
<head>

<title>HTML in 10 Simple Steps or Less</title>

<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />

<meta name="description” content="HTML in 10 simple steps
or less. An introductory guide for the beginning coder” />

<meta name="author” content="Robert Fuller and Laurie
Ulrich” />

<meta name="expires” content="Mon, 17 February 2003
02:00:00 GMT”>

<meta name="pragma” content="no-cache”>
</head>

<body>

</body>
</html>

Listing 6-3: Preventing a browser from caching your page with a special <meta> tag

5. 'To make these <meta> tags both XHTML-compliant and still rec-
ognizable to browsers that don’t yet support XHTML, insert a space
and forward slash at the end of each tag:

<meta name="expires” content="Mon, 17 February 2003
02:00:00 GMT” />
<meta name="pragma” content="no-cache” />
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Refreshing Page Content
Using Meta Tags

It’s possible to modify a browser’s behavior using <metas tags. In this task,
you’re going to generate code that has the same effect as hitting the browser’s
refresh button. You’ll also see how this same code can force the browser to load
another document.

1. In the head section of your document, below the document title,
enter a new <metas tag.

2. Add the http-equiv attribute and set it equal to refresh, as
shown in Listing 7-1.

<html>
<head>

<title>HTML in 10 Simple Steps or Less</title>

<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />

<meta name="description” content="HTML in 10 simple steps
or less. An introductory guide for the beginning coder” />

<meta name="author” content="Robert Fuller and Laurie
Ulrich” />

<meta name="expires” content="Mon, 17 February 2003
02:00:00 GMT” />

<meta http-equiv="refresh”>
</head>

<body>

</body>
</html>

Listing 7-1: Inserting the http-equiv attribute

3. Follow the http-equiv attribute and refresh value with the
content attribute and set it equal to the number of seconds you
want the page to remain static before refreshing, as shown in Listing
7-2. In this example, the page will refresh every five seconds.

<html>
<head>

<title>HTML in 10 Simple Steps or Less</title>

<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />

<meta name="description” content="HTML in 10 simple steps
or less. An introductory guide for the beginning coder” />

(continued)
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<meta name="author” content="Robert Fuller and Laurie
Ulrich” />

<meta name="expires” content="Mon, 17 February 2003
02:00:00 GMT” />

<meta http-equiv="refresh” content="5">
</head>

<body>

</body>
</html>

Listing 7-2: Setting the number of seconds to wait before a forced refresh

To force the browser to load another document after the refresh time
elapses, follow the refresh rate value with a semicolon and enter
url=pathname, where pathname equals the file path to a document
on your Web server or a complete URL to a document on another
site, as shown in Listing 7-3.

<html>
<head>

<title>HTML in 10 Simple Steps or Less</title>

<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />

<meta name="description” content="HTML in 10 simple steps
or less. An introductory guide for the beginning coder” />

<meta name="author” content="Robert Fuller and Laurie
Ulrich” />

<meta name="expires” content="Mon, 17 February 2003
02:00:00 GMT” />

<meta http-equiv="refresh” content="5;
url=http://www.w3c.org” >
</head>

<body>

</body>
</html>

Listing 7-3: Supplying the URL of another document you want the browser to load after
the forced refresh

To make your code both XHTML-compliant and still recognizable
to browsers that don’t yet support XHTML, insert a space and for-
ward slash at the end of the <meta> tag:

<meta http-equiv="refresh” content="5;
url=http://www.w3c.org” />
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Task 8 Defining Meta Tag Robot Values

robot is a type of program that search engines use to browse Web site docu-

ments and update their databases. Robots that make use of <metas tag infor-
mation read the metadata and index it for the search engine. You can control how
much or how little of your site a robot reads using the following attributes and
values for the <meta> tag.

1. Enter a <meta> tag in the head section of your document, below the
document title.

2. Define the name attribute and set it equal to robots, as shown in
Listing 8-1.

<html>
<head>
<title>HTML in 10 Simple Steps or Less</title>
<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />
<meta name="description” content="HTML in 10 simple steps
or less. An introductory guide for the beginning coder” />
<meta name="author” content="Robert Fuller and Laurie
Ulrich” />
<meta name="expires” content="Mon, 17 February 2003
02:00:00 GMT” />
<meta http-equiv="refresh” content="5;
url=http://www.w3c.org” />
<meta name="robots”>
</head>

<body>

</body>
</html>

Listing 8-1: Setting the name attribute equal to robots
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3. "To instruct robots to read your entire page and follow all the links within

it, follow the name attribute and robots value with the content
attribute and set it equal to all, follow, as shown in Listing 8-2.

<head>

<title>HTML in 10 Simple Steps or Less</title>

<meta name="keywords” content="HTML, Hypertext Markup
Language, 10 Simple Steps or Less” />

<meta name="description” content="HTML in 10 simple steps
or less. An introductory guide for the beginning coder” />

<meta name="author” content="Robert Fuller and Laurie
Ulrich” />

<meta name="expires” content="Mon, 17 February 2003
02:00:00 GMT” />

<meta http-equiv="refresh” content="5;
url=http://www.w3c.org” />

<meta name="robots”>
<meta name="robots” content="all, follow”>
</head>

Listing 8-2: Code allowing robots to read the entire page and follow all links
"To instruct robots to read your page, but refrain from following the
links within it, set the content attribute equal to all, nofollow:
<meta name="robots” content="all, nofollow”>

"To prevent robots from reading your page at all, set the content
attribute equal to none:

<meta name="robots” content="none”>

Insert a space and forward slash at the end of the <meta> tag to

make sure your code is both XHTML-compliant and still recogniz-
able to browsers that don’t yet support XHTML:

<meta name="robots” content="none” />




- Part 1
Task 9 Controlling the Document Background

ou can specify a document’s background color or background image using

two different attributes of the <body> tag. Background colors simply fill the
entire document. Background images are tiled by the browser, meaning they are
repeated left to right, top to bottom, filling up the visible space of the browser
window.

1. To define a background color for a document, add the bgcolor
attribute to the <body> tag, as shown here:

<body bgcolor

2. Set the bgcolor attribute equal to a hexadecimal color value or pre-
defined color name. Listing 9-1 shows a document with a black back-
ground color defined in hexadecimal notation. Figure 9-1 shows the
result in a browser.

<html>
<head>

<title>Background Color</titlex>
</head>

<body bgcolor="#000000" text="white”>
<hl>Here we have a black background with white text...</hl>

</body>
</html>

Listing 9-1: Setting the bgcolor attribute (and text color)

3. To specify a background image, add the background attribute to the
<body> tag, as shown here:

<body background

4. Set the background attribute equal to the pathname of the image
file on your Web server. Listing 9-2 provides a code sample of a doc-
ument that makes use of a tiling background texture graphic. Figure
9-2 displays the result in a browser.
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<html> Task 9

<head>

<titles>Background Images</titles>
</head>

<body background="images/bg stone.jpg”>
<hl>Isn’t this a nice stone background?</hl>
</body>

</html>

Listing 9-2: The background attribute

W Bachgiound Color  Microsolt Internet Explarer

Eile Edit View Favorites Took Help

Here we have a black background with white text...

| Done ) My Compustes
Figure 9-1: White text on a black background

A Untitted Nocument - Microwoft Internet E nplorer

Eile Edit View Favorites Took Help

Isn't this a nice stone background?

cross-refevences

= To see a hexadecimal color
chart and learn more about
hexadecimal notation, see
our Web site at www.wiley
.com/compbooks/
10simplestepsorless.

= Each listing here shows an
example of a heading tag.
To learn more, see Task 11.

| Done ") My Comgustes

Figure 9-2: White text over a stone background
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Working with Source Code
in the Browser

1l major Web browsers allow you to view the source code of documents you

view — an extremely useful feature. For example, imagine you’re surfing the
Internet and you come across a page you’re really impressed with. To see how it
was built, just view the source HT'ML code. Granted, if this book is your first
foray into HTML you may not understand what you’re looking at, but you will
in time. Each browser has slightly different commands and it supplies slightly dif-
ferent options. Here’s how you can view source code using Netscape Navigator
and Microsoft Internet Explorer.

1. While viewing a page in Netscape Navigator, go to the View menu
and select Page Source. This opens the Source window, as shown in
Figure 10-1. From here you can examine the source code, copying
and pasting the code into a text editor if you wish.

<txml wersiom="1,0% saceding="UTF
< 'DOCTYPE bim}! PUELYC “-//RAC//DTD XWTML t.8 Stract//EN®
TakbprS v, el or TR/ ERER] L /OTD shital l-dbei ok ded™>
<himl rmine="hrrp://vew. vl org/ 1995/ whitml® Lang="an=02"
saml 1 Lang="en- U257
chesd profile="htcp://wvy. vl org/2000/08/ vic=gynd/#"s
amtla RLIP-eqUIV="Content-Type™ COMERL="Lext/Mml; cCharsat=ucs-8= [»
ameta name="gonerator®
cenlent="HTHL Tidy for Mac OS5, sae www.wd.org™ />
ameta mame="koyvords”
content="U3C, World Vide Geb, Web, ¥U, Comsortiums, cosputer, access, accessibilicy, sesancic,
Mela REme="AeSCE IRt EOR”
conlent="WiC is over 400 orpanizations lesading che Sorld Uids Usb to ica full potential. Founde
“titlerParia Vigs Web Consortiwmc/lilles
<link rel="schema.Bl"” heef="htep://pucl.ocg/dc™ f»
e la REme="D0, DubIEctT MMl lang=Ten" lang=Tan”
content="W3C, World Vide Ueb, Web, UVWU, Comportium, computer, access, accessibilicy, semsantic,
e la REme="0C, TG LET mlilang=Tan" lang=Ten”
content="tor Id Vide Ueb Comsortium™ fx
omela Rames="DC,Description, Abstract™ sml:lang="en” Lang="sn"
content="U)C ip over 400 orpanizations lesding the World Vide Ueb to its full potantial. Founde
amrla name="0C.Date.Created” contenl="1598-10-05" f»
ameta name="0C. L - RFC1764" en=02" f>
amela Rame="DC.Creatoc™ Contenl="UlC Cossusications Teas" f>
ameta name="DC, Fublishes "
conlent=*W3C - Borld Wide Web Consortiws - hetp://www.ud.acg® f>

A l!

Figure 10-1: The Source window in Netscape Navigator

2. 'To save the source code from the Source window, select File &> Save
Page As and enter a filename.

3. In Microsoft Internet Explorer, select View => Source. This opens the
source code of the document in Notepad, as shown in Figure 10-2.

4. To save the source code, choose File & Save As from the Internet
Explorer window. This opens the Save Web Page dialog box shown
in Figure 10-3.

5. In the Save Web Page dialog box, set the Save As Type pop-up menu
to Web Page Complete, as shown in Figure 10-4.
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6. Choose a location on your hard drive to save the file and click Save. Task 0
A copy of the HTML document and a folder containing all the asso-
ciated images and media are saved to the location you chose.

[(7xnl wersion="1.0" encoding="UTF-8"7)

[{YDOCTYPE html PUBLIC “-//V3AC//DTD XHIML 1.0 SErict//EN"
“http: /e wd or g/ TR/AAERLY/DTO/xhtal 1=strict dtd >

[Khtml xnlns=" pif e wd org/ 199 lang="en-us"

benl 21 ang="en-U5">

fhead profile="http://vm. vl orqg/? 800/ 88/ vic-synd/ 8>

[ineta http-equiv="Content-Type" content="text/html; charset=utf-8" />

[(Meta name="generator”
content="HIML Tidy For Mac 05, see weu.ud.org™ />

Hneta name="keywords™
GNEEAT="WAC, Vorld Wide Ueb, Veb, VWA, Consortium, conputer, access, accessibility, semantic,
El_ﬂoﬂﬂ, Uz, WU, XML, standard, language, lnmt:z link, £S5, ROF, XSL, Berners-Lee,
v Lee, style suﬂt. cascading, schena, XHTHL ile, SUG, PMG, PICS, Htl, SMIL, umu.
» Anaya, free, open source, softuvare”

lCneta n--"nmr ption™
tutnm is over ABB organizatiens leading the Uorld Vide Web to its Full potential.
ounded by Tin Berners-Lee, the Web's inventor. The WIC Web site hosts specifications,
idelines, software and toals. Public participation 15 welcome. VIC supports universal access,
he senantic Web, trust, interoperability, eveluvability, decentralization, and cesler
multinedia.” />
[<titlexorid Vide Veb Consortiumd/titler
[C1ink rel="schema.0c” “I-"III'JI’H‘] Sorgrde” /3

lang="en"

[meta name="DC.Subject” xnl:l
content-“U3C, Vorld Wide Ueb, Ueb, \WA), Consertium, conputer, access, accessibility, senantic,
Berners-Lee,

w. 3, WIML, XML, Standard, language, technology. Mimk, CSS, ROF, XS,
, Lee, style sheet, cascading, schena, XHTML, mabile, SUG, PHG, PICS, DOM, SMIL, Mathie,

markup, Anaya, Jigsae, free, “mo.u!tuﬂv“h

neta name="DC.Title” xnl:lang="en" lang="en"

content="Warld Wide Web Consort iy

[{neta name="DC.Description.dbstract™ wal:lang="en" lang="en"

content="V3C is over 408 organizations leading the Uorld Wide Veb to its full potential.
runln by Tim Berners-Lee, the Web's inventer. The W3C Web site hosts specificavions, .

Figure 10-2: Source code in Notepad

Figure 10-4: Choosing Web Page Complete in the Save As Type menu
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Working with Text
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Task 26:
Task 27:
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Working with Headings

Working with Paragraphs

Applying Fonts

Setting the Font Size

Setting the Font Color

Applying Physical Styles

Applying Logical Styles

Inserting Character Entities

Using the Preformatted Text Element
Using the Blockquote Element
Setting Document Margins

Creating an Ordered List

Modifying Ordered List Styles
Modifying an Ordered List’s Starting Character
Creating an Unordered List
Modifying Bullet Styles

Nesting Lists

Creating Definition Lists
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Working with Headings

he following series of tags create document headings akin to those in newspa-

pers and magazines, or the task headings you see in this book. There are six
levels of headings, ranging from a heading 1 (the largest) to a heading 6 (the
smallest).

1. To format a word or phrase as a heading, place an opening heading
tag in front of it, as shown in Listing 11-1.

<hl>This is
<h2>This is

a Heading
a
<h3>This is a Heading
a
a
a

Heading

<h4>This is
<h5>This is
<h6>This is

Heading
Heading
Heading

o Ul ok W N

Listing 11-1: A series of opening heading tags

2. Place a corresponding closing heading tag after the word or phrase,
as shown in Listing 11-2. Figure 11-1 shows how these six headings
appear in the browser.

<hl1>This is
<h2>This is
<h3>This is
<h4>This is
<h5>This is
<h6>This is

Heading 1</hl>
Heading 2</h2>
Heading 3</h3>
Heading 4</h4>
Heading 5</h5>
Heading 6</hé6>

Q9 0 O 9 9

Listing 11-2: A series of corresponding closing heading tags

3. The heading tag’s only allowable attribute is align. Its possible val-
ues are left, right, and center. To align a heading, insert the
alignment attribute within the heading tag, as shown here:

<hl align>

4. Setyour align attribute equal to the desired alignment. Here we
use the center alignment. The result appears in Figure 11-2.

<hl align="center”>Heading 1 - Centered</hl>
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This is a Heading 1

This is a Heading 2
This is a Heading 3

This is 2 Heading 4

ek s 8 Hending §

Thas 15 a paragraph of otherwase usnodiied text

Figure 11-1: Six levels of HTML headings

Heading 1 - Centered

Figure 11-2: A center-aligned heading
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Working with Paragraphs

TML only recognizes single spaces between characters. Other than a single
tap on the Spacebar, HT'ML has little regard for how you physically type
your paragraphs. What HTML does recognize is tags to format paragraphs. This

task shows you how to format basic paragraph text.

1. To indicate the beginning of a paragraph, enter an opening <p> tag
in the <body> section of your code, as shown in Listing 12-1.

<body>

<p>

</body>
</html>

Listing 12-1: Starting a paragraph in the body of the document

2. To mark the end of a paragraph, place the closing </p> tag at the
end of your paragraph, as shown in Listing 12-2.

<html>
<head>
<title>Defining and Aligning Paragraphs</titles>
</head>

<body>

<p>HTML only recognizes single spaces between characters.
Other than a single tap on the space bar, HTML has little
regard for how you type things. What it does have regard
for is tags.</p>

</body>
</html>

Listing 12-2: Inserting text between the opening and closing paragraph tags
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3. To align a paragraph, add the align attribute to the paragraph tag:

e 42

<p align>

4. Set the align attribute equal to 1eft, right, center, or
justified, as shown in Listing 12-3. The effect, when previewed
in a browser, appears in Figure 12-1.

<p align="right”>HTML only recognizes single spaces between
characters. Other than a single tap on the space bar, HTML
has little regard for how you type things. What it does

have regard for is tags.</p>

Listing 12-3: Defining the align attribute

HTML only recogmres smgle spaces betwesn characters. Other than & magle tap om the
space bar, HTMIL has ktle regard for how you type thags. What 2 does have regasd foris

e — T

Figure 12-1: A right-aligned paragraph
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Applying Fonts

he <font > tag determines which font is applied to your text. By itself, this

tag has no effect on text. You specify the fonts as a value of the face
attribute. The most important thing you need to understand about specifying
fonts in HTML is that you don’t really determine the font that visitors see — the
browsers do. The best you can achieve is specifying the font you want them to
use. If people don’t have the proper fonts installed on their computers, the
browsers will use whatever font is installed as the default. Because you’re at the
mercy of visitors’ font collections, you can define a list of fonts, giving them a
choice of three or four similar fonts. If they don’t have your first choice, perhaps
they have your second choice or, failing that, your third.

1. To specify the font for a range of text, type an opening <font > tag
and add a face attribute to it as shown in Listing 13-1.

<body>

<p> <font face=" >

</body>
</html>

Listing 13-1: Beginning the <font> tag

2. Set the face attribute equal to your first font choice, as shown here:

<p> <font face="Arial >

3. Iype a comma and follow your first font choice with your second,
third, and fourth (if necessary):

<p> <font face="Arial, Helvetica, sans-serif”>
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4. Directly following the <font > tag, enter the text you want it to 3
affect: Task

<p> <font face="Arial, Helvetica, sans-serif”>By itself,
this tag has no effect on the text you apply it to. You
actually specify your chosen fonts as a value of the face
attribute. The most important thing to understand about
specifying fonts in HTML is that you don’t really
determine the font the visitor sees - their computer does.

5. At the end of this range of text, place a closing </font> tag:

<p> <font face="Arial, Helvetica, sans-serif”>By itself,
this tag has no effect on the text you apply it to. You
actually specify your chosen fonts as a value of the face
attribute. The most important thing to understand about
specifying fonts in HTML is that you don’t really
determine the font the visitor sees - their computer
does.</font> </p>

The effect of this is to display the text in this paragraph in Arial, as
shown in Figure 13-1.

By itself, thes 130 has no affact on e ted you apply i 10 You actually spacify your
chasen fonts as & valua of the face atirnbute. The MOST IMPOMaNt iNng 1o
understand about specifying fonts in HTML is that you don't really determine the
fort the wisitor sees - their computer does

—

Figure 13-1: A paragraph set in Arial
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Task A- Setting the Font Size

To specify the font size, use the size attribute of the <font > tag. The size
attribute accepts a numeric value from one of two scales: the absolute or rela-
tive scale.

1. To define the font size for a preexisting <font > tag, simply add a size
attribute set equal to your chosen value. Figure 14-1 shows what the
following code looks like in your browser.

<p> <font face="Arial, Helvetica, sans-serif” size="2">All
text affected by this font tag is now set to size
2.</font> </p>

<p> <font face="Arial, Helvetica, sans-serif”>All text
affected by this font tag is defaulting to the browser’s
base font size, because no size attribute is
defined.</font> </p>

Al s wacted by Shis fant 160 i aewr gat ts sire 2

Aot affacted by this lont 1ag is delmling 10 the browsars basa font sime, bacairss no size ambuts (s
defined

Figure 14-1: A font size of 2, in contrast to undefined font size

2. You can control the font size by simply adding a <font > tag with just
the size attribute defined. The following code changes the font size
of the word here to 5. Figure 14-2 shows what it looks like in your
browser.

<p> <font face="Arial, Helvetica, sans-serif” size="2">All
text affected by this font tag is now set to size 2.
Except this word <font size="5">here</font>, around which
I've nested a second font tag with a different size
setting.</font> </p>

<p> <font face="Arial, Helvetica, sans-serif”>All text
affected by this font tag is defaulting to the browser’s
base font size, because no size attribute is
defined.</font> </p>

3. To define the base font size for your entire document, enter the
<basefont> tag just below the opening <body> tag and set its size
attribute to a value from 1 to 7:

<basefont size="2">

A8 st acte by i o g i o ot 10 iz 2 Bzt i wand FHETE, arivenc which Fow sesnd  sicond far tag with &
et wze g

At affected by s fontiag i detauting ko e brovwser's base font 5ize, because no 5ize atnitats is

Figure 14-2: The word here augmented by a second font size value
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4. With the <basefont> tag and size attribute defined, use the Task A
relative scale to increase or decrease individual regions of text.
Figure 14-3 shows what this code looks like in your browser.

<basefont size="2">

<p>All text in this document will default to size 2.
<font size="+3">T</font>he first letter in this sentence

has now been punched up to a size 5 using a +3 size value.
</p>

Figure 14-3: The T increased to a font size of 5 using a relative +3 value

5. To make a region of text one size larger than the surrounding text,
wrap it inside the <big> and </big> tags. You can make this addi-
tive by using multiple <big> tags. To make the text smaller, use
<smalls>and </small> tags. Figure 14-4 shows what the code
looks like in your browser.

<p> We’ve made this word three times
<big><big><bigs>bigger</big></big></big> by nesting it
inside three sets of big tags.</p>

<p> <font size="5">We’ve made this word three times
<small><small><smallssmaller</small></small></small> by
nesting it inside three sets of small tags.</font></p>

= bigger v 5o of bg 3

We've made this word three times mas. by nesting it inside three sets of small
tags.

Figure 14-4: Multiple <big> and <small> tags with their cumulative effects
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Setting the Font Color

In the <font > tag, the face attribute sets the typeface and the size attribute
sets the text size. It shouldn’t come as a big surprise then that the color
attribute sets the text color. In HT'ML, colors can be defined using hexadecimal
notation (a six-character code for expressing the combined red, green, and blue
values of affected pixels) or a number of predefined English equivalents. There
are different methods for defining font color, with or without using the <font>
tag’s color attribute.

1. To define the font color for a preexisting <font > tag, simply insert
the color attribute and set it equal to your chosen color value, as
shown in Listing 15-1.

<body>

<p> <font face="Arial, Helvetica, sans-serif” size="2"
color="#0000FF”>This text has been turned blue using
hexadecimal notation, which uses six characters preceded by
a pound sign (#). </font> </p>

</body>
</html>

Listing 15-1: Use of hexadecimal value #0000FF to turn a paragraph blue

2. You can also control the font color by simply adding a <font > tag
with only a color attribute defined, as shown in Listing 15-2.

<html>
<head>
<title>Setting Font Color</titles>
</head>

<body>

<p> <font face="Arial, Helvetica, sans-serif” size="2"
color="#0000FF”>All text affected by this font tag is blue.
Except this word <font color="#00FF00”>here</font>, around
which I’'ve nested a second font tag turning the word
green.</font> </p>

</body>
</html>

Listing 15-2: Use of hexadecimal value #00FFOO to turn a word green
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3. To use predefined color names instead of hexadecimal values, set the
color attribute to equal the word color of your choice, as shown in
Listing 15-3.

<html>
<head>
<title>Setting Font Color</titles>
</head>

<body>

<p> <font face="Arial, Helvetica, sans-serif” size="2"
color="Purple”>This text is making use of the word “Purple”
- one of the 16 recognized colors in the HTML
standard.</font></p>

<p> <font face="Arial, Helvetica, sans-serif” size="2"
color="DarkOliveGreen”>This text is making use of the word
“DarkOliveGreen” (no spaces) - one of the many colors
browsers like Internet Explorer and Netscape Navigator
recognize. So much for standards compliance, huh?</font></p>

</body>
</html>

Listing 15-3: Use of the color names Purple and DarkOliveGreen

4. To define the default text color for your entire document, instead of
relying on the <font > tag, use the text attribute of the <body> tag,
as shown in Listing 15-4.

<html>
<head>
<title>Setting Font Color</titles>
</head>

<body text="#8B0000">
<p> All text in this document defaults to dark red. If you
prefer words over hexadecimal notation, the value would

coincidentally be “DarkRed”.</p>

</body>
</html>

Listing 15-4: Body text set to hexadecimal color #8B0000, which means dark red
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Applying Physical Styles

Your typical word processor has buttons for bolding, italicizing, and underlin-
ing text — and probably some other stylistic options hiding in a menu some-
where. In HTML, these are called physical styles because the tags used to create
them imply specific rendering by the browser.

1. To create bold text, wrap the chosen word or phrase with <b> and
</b> tags:

<b>Bold</b>

2. To italicize text, place the text between <i> and </1i> tags:

<i>Italic</i>

3. To underline text, place the text between <u> and </u> tags:

<u>Underline</u>

4. To strike through text, use the <s> and </s> tags:

<s>Strikethrough </s>

5. To produce a monospace (code-like) formatting, place the text
between <tt> and </tt> tags (stands for “teletype”):

<tt>Teletype</tt>

6. Although not technically considered physical styles in HTML, the
ability to superscript and subscript text also exists. To use these styles,
insert text between the following tag pairs: <sup></sup> for super-
script and <sub></sub> for subscript:

<p>Superscript: a<sup>2</sup> X b<sup>2</sup> =
c<sup>2</sup></p>
<p>Subscript: H<sub>2</sub>0</p>

Listing 16-1 shows all these formatting codes and Figure 16-1 shows
what the results should look like in a browser.
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<html>
<head>
<title>Physical Styles</title>
</head>
<body>
<p><b>Bold</b> <br>
<i>Italic</i> <br>

<u>Underline</u> <br>

<s>Strikethrough</s> <br>

<tt>Teletype</tt>

</p>

<p>Superscript: a<sup>2</sup> x b<sup>2</sup> = c<sup>2</
sup></p>

<p>Subscript: H<sub>2</sub>0</p>

</body>

</html>

Listing 16-1: Physical styles set in HTML

Figure 16-1: Physical styles rendered in the browser

7. You can combine these tags to double their effect. For example, if
you want to make text both bold and italic, simply surround your
chosen text with the bold and italic opening and closing tags. Figure
16-2 shows the resulting effect in your browser.

<p><b><i>Bold and italicized</i></b></p>
<p><i><b>The order of tags makes no difference</b></i></p>

Bald nnd isaliciged S
The order of tags makes no difference

Figure 16-2: Nested physical styles
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Applying Logical Styles

he physical styles you learned about in Task 16 apply a specific appearance

to text. Logical style tags format text according to the text’s meaning without
implying a specific appearance. This sounds like two different things, but because
the HTML standard leaves the rendering of logical styles up to the browser, logi-
cal styles, to date, produce the same effect on text as physical styles.

1. To place emphasis on a chosen word, place the text between <em>
and </em> tags:

<em>Emphasis</em> looks <is>italic</i>
2. To place stronger emphasis on a chosen word, use the <strong> and
</strong> tags:
<strong>Strong</strong> looks <b>bold</b>
3. To define a section of text as a code sample, use the <code> and
</code> tags:
<code>Code</code> looks like <tt>teletype</tt>
4. 'To define a sample of literal characters, use the <samp> and
</samp> tags:
<samp>Sample</samp> looks like <tt>teletype</tt> too.
5. To define text as it should be typed by a user, for example in an

instructional manual, use the <kbd> and </kbd> tags (short for
“keyboard”):

<kbd>Keyboard</kbd> also looks like <tt>teletype</tt>.

6. 'To define text as a variable name, for example in a programming lan-
guage, use the <var> and </var> tags:

<varsVariable</var> looks <isitalic</i>.

7. 'To format text as a term definition, use the <dfn> and </dfn> tags:
<dfn>Definition</dfn> also looks <isitalic</i>.

8. To define a citation, as out of a book, use the <cites and </cite>
tags:
<cite>Cite</cite> is another logical style that looks

<i>italic</i>.

Figure 17-1 shows the results of the code listed in Listing 17-1.
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<html>
<head>

<title>Logical Styles</title>
</head>
<body>

<p>

<em>Emphasis</em> looks <isitalic</i>. <brs>
<strong>Strong</strong> looks <b>bold</b>. <br>
<code>Code</code> looks like <tt>teletype</tt>. <br>
<samp>Sample</samp> looks like <tts>teletype</tt> too. <br>
<kbd>Keyboard</kbd> also looks like <tt>teletype</tt>. <br>
<var>Variable</var> looks <is>italic</i>. <br>
<dfn>Definition</dfn> also looks <isitalic</i>. <br>
<cite>Cite</cite> is another logical style that looks
<is>italic</i>.

</p>

</body>
<html>

Listing 17-1: Logical styles set in HTML

Emphasis Jooks italic.
Strong looks beld
code looks bike teletype.

ganple looks ke teletyps too.
Feyboard also looks like veletype.
Vanable looks italic.
Defimttion also looks italic.

Cite is another logecal style that looks rralic

Figure 17-1: Logical styles rendered in the browser
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Inserting Character Entities

here are about 100 keys on your keyboard, but with all those choices, how do

you type something obscure like the copyright symbol (©)? In a word proces-
sor, you insert a symbol from some menu or dialog box. In HTML, these sym-
bols are referred to as character entities or special characters. Instead of tags,
character entities are rendered numerically, beginning with an ampersand (&)
and pound sign (#) and ending with a semicolon. This task shows you how to
render a number of the more common character entities.

1.

10.

Type &#169; to display the copyright symbol:

<p> Copyright &#169; 2003 </p>

Type &#174; to produce the registered symbol:

<p>W3C &#174;</p>

Type &#153; to produce the trademark symbol:

<p>Alpha-Gizmo&#l53;</p>

Enter &#188; to produce the fraction one-quarter:

<p>&#188; teaspoon salt</p>

Enter &#189; to produce the fraction one-half:

<p>&#189; teaspoon sugar</p>

Enter &#190; to produce the fraction three-quarters:

<p>&#190; cup of honey</p>

Enter &#162; to produce the cent symbol:

<p>10&#162;</p>

Enter &#163; to produce the British Pound symbol:

<p>&#163;125,000</p>

Enter &#165; to produce the Japanese Yen symbol:

<p>&#165;500,000</p>

Enter &#8364 ; to produce the European Union’s Euro symbol:

<p>&#8364;700</p>

Listing 18-1 provides examples of these symbols and Figure 18-1 dis-
plays the results in a browser.
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<html>

<head>

<title>Character Entities</title>

</head>

<body>

<p>This book is copyrighted &#169;2003</p>

<p>My Favorite cola is Pepsi&#174;</p>

<p>My company name: Alpha-Gizmo&#153;</p>

<p>&#188; teaspoon salt in my soup.</p>

<p>&#189; teaspoon sugar in my tea.</p>

<p>&#190; cup of honey is way too much!</p>

<p>I remember when a pay phone cost 10&#162;</p>
<p>A $500,000 house only costs &#163;300,084.44 </p>
<p>Which is an astronomical &#165;59,037,844.65 </p>
<p>But a moderate &#8364;436,305.17 </p></body>
</html>

Listing 18-1: Character entities in HTML

Thes book 1 copynghted ©2003
My Favonie cola iz Pepn®
My company name: Alpha-Gizmo™™

% teasp-con salt m my soup.

¥4 teasp-oon rugar m my tea

% cup of honey i way too much!

I remember when & pay phose cost 104

A $300,000 house coly costy £300,084.44
Whach is an asronomical $39,037,844 65

But & moderate €436,305 17

Figure 18-1: Character entities rendered in the browser
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Using the Preformatted Text Element

here is a way to make a browser display text almost exactly as you type it in

your HTML document. The <pre> tag tells the browser that text is prefor-
matted, which means it should leave all white space as entered. In other words, if
you hit the Spacebar seven times, the browser will respect those seven spaces.
"Typically, browsers display any text written between <pre> tags with a mono-
spaced font.

1. Begin the region of your document to preformat with an opening
<pre> tag.
2. Enter the text you want preformatted into the document.

3. Close the preformatted region with a closing </pre> tag, as in the
following code. Figure 19-1 shows how it looks in your browser.

<pre>
| Mon | Tues | Wed | Thurs | Fri
| | | | |
Calculus | X | | X |
English | | X | | X |
Latin | X | | X | |
</pre>

Calculus

Figure 19-1: Code inside the <pre> tag rendered in the browser

4. If you choose, you can include <font > tags to control the size and
color, as shown in the following code. Figure 19-2 shows how the
modified code appears in the browser (except for the color, of course).

<pre><font size="4" color="red”>

| Mon | Tues | Wed | Thurs | Fri
| | | | |
Calculus | X | | X |
English | | X | | X |
Latin | X | | X | |

</font>
</pre>
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Calculus

Figure 19-2: Nesting <font> tags within preformatted text to enlarge the point size

5. To include logical or physical style tags inside <pre> tags, first enter
your text and test it in a browser to check your alignments. Then go
back to the code and insert the tags around your text choices, as
shown in the following code. Figure 19-3 shows how it looks in the
browser.

<pre><font size="4" color="red”>

|  <b>Mon</b> | <b>Tues</b> | <b>Wed</b> |
<b>Thurs</b> | <b>Fri</b>

| | | | |
<b>Calculus</b> | X | | X |
<b>English</b> | | X | | X |
<b>Latin</b> | X | | X |
</font></pre>

Calculus

Figure 19-3: Physical styles (bolding) applied to preformatted text
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Task 0 Using the Blockquote Element

he <blockquote> tag designates quoted text, specifically long quotations of
paragraph length or more. Browsers typically render text wrapped in
<blockquotes> tags as an indented paragraph.

1. To designate a block of quoted text, place an opening <blockquote>
tag at the beginning of the text to be quoted.

2. To conclude the block of quoted text, place a closing </blockquote>
tag at the end of the text to be quoted. A completed example is
shown in Listing 20-1. Figure 20-1 shows the results in the browser.

<html>

<head>

<title>The Blockquote Element</titles>
</head>

<body text="#000000"” bgcolor="#FFFFFF” >

<hl>Edgar Allan Poe</hl>
<p>The following is a quote from www.poets.org:</p>

<blockquotes><p>Edgar Allan Poe was born in Boston,
Massachusetts, on January 19, 1809. Poe’s father and mother,
both professional actors, died before the poet was three and
John and Frances Allan raised him as a foster child in
Richmond, Virginia. John Allan, a prosperous tobacco
exporter, sent Poe to the best boarding schools and later to
the University of Virginia, where Poe excelled academically.
After less than one year of school, however, he was forced
to leave the University when Allan refused to pay his
gambling debts.</p></blockquotes>

</body>
</html>

Listing 20-1: Code example of a block of quoted text

Edgar Allan Poe

The followmng 15 a quole Bom warw poets o

Edgar Allan Poe was bom m Boston, Massachuseits, on Jansary 19, 1809, Poe’s father and mother, both
profesnonal actors, ded before the poet was three and Jobn and Frances Allan rassed bam as a foster ddd =
Richmond, Vgmas Joha Allan, a prosperous tobaceo exporter, sent Poe to the best boarding schools and liter
to the Unmvernty of Virgmua, where Poe excelled academscally. Aller less than oae year of school, howewer, he
wai forced 1o leave the Unsverssy when Allan refimed to pay hes gamblng debis

Figure 20-1: A block-quoted paragraph rendered in the browser
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3. You can increase the amount of indentation using multiple Task 0
<blockguotes tags, as shown in Listing 20-2. Figure 20-2 shows
the results in the browser.

<html>

<head>

<title>the Blockquote Element</titles
</head>

<body text="#000000"” bgcolor="#FFFFFF” >

<hl>Edgar Allan Poe</hl>
<p>The following is a quote from www.poets.org:</p>

<blockquote><blockquote><p>Edgar Allan Poe was born in
Boston, Massachusetts, on January 19, 1809. Poe’s father and
mother, both professional actors, died before the poet was
three and John and Frances Allan raised him as a foster
child in Richmond, Virginia. John Allan, a prosperous
tobacco exporter, sent Poe to the best boarding schools and
later to the University of Virginia, where Poe excelled
academically. After less than one year of school, however,
he was forced to leave the University when Allan refused to
pay his gambling debts.</p></blockquote></blockquotes>

</body>
</html>

Listing 20-2: Using multiple <blockquote> tags to increase the indentation of a quoted
paragraph

Edgar Allan Poe

The follewmng is a quots Bom waww posts. org

Edgar Allan Poe was born m Bos-ton, Massachusens, on January 19, 1809 Poe's father and
mother, both profesnoaal actors, deed before the poet was theee and Joha snd Frances Alla rassed
bem as a foster chld m Richmond, Virgema. Jobn Allan, a prosperous tobacco exporter, sent Poe to
the best boardag schools and Later to the Universsy of Vgmsa, where Pos exceled academucaly
Alter less than one year of school, however, he was foreed 1o leave the Unsvernty when Al

sefuted to pay s gamblag debay !I

Figure 20-2: Multiple <blockquote> tags that have a cumulative effect
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Setting Document Margins

You can control the document margin with four nonstandard attributes of the
<body> tag. Two of the attributes were introduced by Microsoft Internet
Explorer; the other two by Netscape Navigator. When defined together, you’re
guaranteed margin control, not only in these two major browsers but also in their
competitors.

1. In your text editor, open an existing document whose margins you
want to modify or just begin a new document.

2. To define the margins of your document, first enter Internet
Explorer’s two margin attributes leftmargin and topmargin in
your <body> tag:

<html>
<head>

<title>Non-standard Margin Attributes</title>
</head>

<body leftmargin= topmargin= >

</body>
</html

3. Follow these two attributes with Netscape Navigator’s two attributes,
marginwidth and marginheight:

<body leftmargin= topmargin= marginwidth= marginheight=>

4. Set each attribute equal to a numeric value (representing pixels), as
shown in Listing 21-1. The value you specify for leftmargin and
marginwidth set the width of both your left and right margins.
Your topmargin and marginheight values set the width of both
the top and bottom margins. Figure 21-1 shows the result of this
code in your browser.
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<html>
<head>

<title>Non-standard Margin Attributes</title>
</head>

<body leftmargin="100"” topmargin="50” marginwidth="100"
marginheight="50">

<p>The values we’ve set for the four margin attributes
result in left and right margins that are 100 pixels wide,
and top and bottom margins that are 50 pixels high.</p>

</body>
</html>

Listing 21-1: A document with 50-pixel margins set for top and bottom, and 100-pixel
margins set for the left and right sides.

The vahses we've get for
the four margm attnbules
result m left and nght
margms that are 100 pixels
wide, ad top and bottom
margins that are 50 pixels
Iuzly

Figure 21-1: Specified margin settings rendered in the browser
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Creating an Ordered List

f you use a word processor to make a numbered list of items, all you have to do
is click a button and start typing. Creating them in HTML is almost as easy:
Use the <ol (ordered list) and <11i> (fist item) tags. Both are container tags with
opening and closing forms. As the name implies, you use ordered lists to render

information of a procedural nature — for example, the items in this task.

1. In the body of your HTML document, enter an opening <ol tag to
mark where the list begins.

2. Proceed to the next line, indent and enter an opening <1i> tag to
mark the start of the first list item.

3. Follow the opening <11i> tag with the text for your list item.
4. Finish the list item with a closing </11i> tag.

5. Continue this process, entering as many list items as required to
complete your ordered list. There is no limit to the number of items
a list can have.

6. To conclude your ordered list, enter a closing </ol> tag after the last
list item.

7. To format the text of your list, place an opening <font > tag above
the list and a closing </font > tag after the list. This way the entire
list — numbers and all — receives your formatting.

An example of an ordered list is shown in Listing 22-1. The page this
code produces appears in Figure 22-1.
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<html>

<head>

<title>Ordered Lists</title>
</head>

<body>

<hl>Honest Shampoo Instructions</hl>

<font face="Verdana, Arial, Helvetica, sans-serif” size="2">
<ol>
<li>Apply to wet hair</lis>
<li>Massage gently into hair and scalp</li>
<li>Rinse thoroughly</li>
<li>Repeat steps 1 - 3 to ensure you burn through
a bottle of this stuff a week.</li>
</ol>
</font>
</body>
</html>

Listing 22-1: An ordered list

Honest Shampoo Instructions

L Apply to wet har

2 Maseage gently nto haer and sealp

3 Emse thoroughly

4 Repeat sieps 1 - 3 to enure you bum through a bottle of ther stull a wesk

Figure 22-1: An ordered list rendered in the browser
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Modifying Ordered List Styles

By default, an ordered list renders items with Arabic numerals: 1, 2, 3, and so
on. You can modify the style of list items by defining the type attribute of the
<ol> tag. The type attribute for the <ol> tag accepts five possible values.

1. To create an uppercase alphabetical list, set the type attribute equal
to “A”:

<ol type="A">

2. To create a lowercase alphabetical list, set the type attribute equal
to “a”:
<ol type="a">

3. To create an uppercase Roman numeral list, set the type attribute
equal to “1”:
<ol type="1I">

4. To create a lowercase Roman numeral list, set the type attribute
equal to “i”:

<ol type="1i">

5. To create an Arabic numeral list, set the type attribute equal to “1":
<ol type="1">
6. To see how each of these styles appears in a browser, enter the code

shown in Listing 23-1 into your text editor and test it in a browser.
Your results should look similar to Figure 23-1.

A Fustdothm
B Then do that
C  Andden, do everythmg else

T not goang 1o do thus
Or that

& Or anythang olse

Vent
Vi
Vi

T e

m She Conquered

1. Thes sz the same as not defmng a type at ol
2 Youmught usc thes type @ a nested bt
3 Memed hats are covered a few tasks ahead

o w—

Figure 23-1: List styles rendered in the browser
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<html>
<head>

<title>Effects of the Type Attribute</title>
</head>

<body>

<ol type="A">

<li>First do this</li>

<li>Then do that</lis

<li>And then, do everything else</li>
</ol>

<ol type="a">
<li>I'm not going to do this</lis>
<1li>Or that</li>
<1i>Or anything else</li>

</ol>

<ol type="1">
<li>Veni</li>
<lis>vidi</1li>
<lis>Vici</1li>
</ol>

<ol type="i">

<li>I came</lis>

<1i>I saw</1li>

<li>She Conquered</li>
</ol>

<ol type="1">
<li>This is the same as not defining a type at all</lis>
<li>You might use this type in a nested list</lis>
<li>Nested lists are covered a few tasks ahead</li>
</ol>

</body>
</html>

Listing 23-1: Different ordered list styles
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Modifying an Ordered List’s
Starting Character

TML tries to be logical. Consequently, the attribute you define to specify
the starting number or character in an ordered list is named start. This
attribute allows you to maintain an unbroken ordering sequence even if you have
to separate lists with paragraph text. You specify the value of an individual list

item using the value attribute.

1. Enter an ordered list as discussed in Tasks 22 and 23.
2. Follow the list with paragraph text.

3. Create a second ordered list, defining the start attribute and setting
it equal to the number you want the second list to begin with. Listing
24-1 shows a complete document sample, and Figure 24-1 shows the
sample code displayed in the browser. In this example, the start
attribute equals 4, which forces the second list to begin with 4.

<html>

<head>

<title>Ordered Lists</title>

</head>

<body>

<p>To shampoo, follow these steps:</p>

<ol>
<li>Apply to wet hair</lis
<li>Massage gently into hair and scalp</li>
<li>Rinse thoroughly</li>

</ol>

<p>Then, to condition proceed by:</p>

<ol start="4">

<li>Wringing excess water from hair</lis

<li>Apply conditioner and massage gently into hair from
roots to ends</lis>

<li>Rinse thoroughly with warm water</lis>
</ol>

</body>
</html>

Listing 24-1: Specifying an ordered list’s starting number
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Te shampoo, follow there rieps

L Apply 1o wet har
2 Maseage geotly mto haer and scalp
3 Rmse thoroughly

Then, to condion proceed by
4 Wnngng excess water Som hasr

5 Apply condhossr and massage gently mio haer from roots 1o ends
6 Rmye thoroughly with warm waler

Figure 24-1: A continuous ordered list, separated by text, rendered in the browser

4. You can achieve the same effect using the value attribute of the first
<1i> tag, as shown here. Subsequent <11 tags follow in order.

<ol>
<1li value="4">Wringing excess water from hair</li>
<li>Apply conditioner and massage gently into hair from
roots to ends</lis>
<li>Rinse thoroughly with warm water</lis>
</ol>
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Creating an Unordered List

hat word processing calls a bulleted list, HTML refers to as an unordered
list. You create these using the <uls> tag and the same <11 > tag that
ordered lists use.

1. In the body of your HIML document, enter a <ul> tag.

2. Begin your list items by proceeding to the next line, indenting, and
entering an <1i> tag.

3. Follow the opening <11i> tag with the text for your list item and end
it with a closing </11> tag.

4. Continue this process, entering list items to complete your
unordered list.

5. End the unordered list with a closing </ul> tag. An example of an
unordered list appears in Listing 25-1. The page this code produces
appears in Figure 25-1.
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<html>
<head>
<title>Unordered Lists</title>
</head>
<body>
<hl>Points to Remember</hl>

<ul>
<lis>Don’t run with scissors</lis
<lisDon’t play with your food</1lis>
<lis>Don’t forget to wash your hands</1li>
</ul>

</body>
</html>

Listing 25-1: An unordered list

Points to Remember

+ Dot nun with scusors
» Don't play with your focd
= Don't forget bo wash your hasds

Figure 25-1: An unordered list rendered in the browser
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Modifying Bullet Styles

Just like the <ol> tag, the <ul> tag accepts the type attribute. In this case, the
type attribute governs the style of the bullet that precedes each list item. The
possible values for the type attribute are disc, square, and circle.

1.
2.

Create an unordered list as described in Task 25.
To create square bullets, set the type attribute equal to square:

<ul type="square”>

"To create circular bullets, set the type attribute equal to circle:

<ul type="circle”>

To create disc bullets, set the type attribute equal to disc:

<ul type="disc”>

"To see how each of these styles appears in a browser, enter the code
shown in Listing 26-1 into your text editor and test it in a browser.
Your results should look similar to Figure 26-1.

= -

Points to Remember

» Ordered kets have alpha-rumenc styles
s Unordered kets have bullet styfes
= Each kst controls these styles wath the ¢ ype astnbute

© Oydered bsts have alipha-nunenc styles
© Unordered bats have bullet siyles
© Each kst controls these styles with the cype amnibute

= Ogdered ksts hawe aipha-tumenc styles
= Thnordered kets have bullet styles
o Each bst coumrols these siyles wth the type amnbute

« Unordered ksts defauk 06 a dse style
= Ordered bsts defanlt 4o Arabec mamerals
» We stll have a therd kand of kst to leam

1

Figure 26-1: Different bullet styles rendered in the browser
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<html>
<head>
<title>Unordered Lists</title>
</head>
<body>
<hl>Points to Remember</hl>

<ul type="square”>
<li>Ordered lists have alpha-numeric styles</li>
<lis>Unordered lists have bullet styles</li>
<li>Each list controls these styles with the
<tt>type</tt> attribute</1li>
</uls>

<ul type="circle”>
<li>Ordered lists have alpha-numeric styles</li>
<li>Unordered lists have bullet styles</li>
<li>Each list controls these styles with the
<tt>type</tt> attribute</lis>
</ul>

<ul type="disc”>
<li>Ordered lists have alpha-numeric styles</li>
<li>Unordered lists have bullet styles</li>
<li>Each list controls these styles with the
<tt>type</tt> attribute</li>
</uls>

<ul>
<li>Unordered lists default to a disc style</li>
<lis>Ordered lists default to Arabic numerals</lis>
<li>We still have a third kind of list to learn</li>
</uls>

</body>
</html>

Listing 26-1: Code showing different bulleted list styles
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Nesting Lists

esting simply means to place elements inside other elements. When you nest

lists, you insert a new ordered or unordered list between list items in an
existing list. The existing list is called the parent list and the second, nested list is
called the child list. You can, in turn, nest a third list within the second, a fourth
within the third, and so on. By nesting lists in this fashion, each list becomes a
sublist of the parent list item above it. This technique is ideal for creating formal
outlines.

1. In the body of an HTML document, begin the parent list by enter-
ing an <ol> or <ul> tag.

2. Define an appropriate type attribute.

3. Move to the next line, indent, and insert list items for your primary
topics using <1i>and </11i> tags.

4. End the parent list with a closing </o1> or </ul> tag.

5. Beneath a list item, nest a child list whose items represent subcate-
gories of the parent list item above it. Set an appropriate type
attribute for this list’s <o1> or <ul> tag also.

6. Nest subsequent lists for each new subcategory level you require. A
full code example appears in Listing 27-1. Figure 27-1 shows how the
document appears in the browser.

= Type defaults to disc
© Fast most defauks 1o cocle
o Therd nest defisults 1o square
= and contmues as square wnal you set & type atnbute

Figure 27-1 Nested lists rendered in the browser
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<html>
<head>
<title>Nested Lists</title>
</head>
<body>

<ol type="I">
<li>Main Idea</1li>
<ol type="A">
<li>Subordinate Idea</li>
<ol type="1">
<li>Supporting Detail</li>
<ol type="a">

<li>Example</1i>
<li>Example</1i>
</ol>
<li>Supporting Detail</li>
</ol>
</ol>
</ol>
<ul>

<li>Type defaults to disc</li>

<ul>
<li>First nest defaults to circle</li>
<uls>
<1i>Third nest defaults to square...</li>
<uls>
<lisand continues as square until you
set a
<tt>type</tt> attribute</1li>
</uls>
</ul>
</uls>
</ul>
</body>
</html>

Listing 27-1: Example of nested lists
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Creating Definition Lists

Deﬁnition lists are slightly different than the previous list types you’ve encoun-
tered. The list items in a definition list consist of two parts: a term and a
description. Browsers render definition lists by placing the term on one line and
indenting the definition underneath it, creating what’s called a hanging indent.
You use three pairs of tags to create a definition list: <d1> and </d1> tags define
where the list begins and ends, <dt> and </dt > tags define the term, and <dd>
and </dd> tags define the term’s definition.

1. In the body of your HTML document, enter a <d1> tag to begin
your list.

2. Begin your term by proceeding to the next line, indenting, and enter-
ing a <dt> tag. Follow this opening <dt> tag with the first term you
intend to define and finish it with a closing </dt> tag.

3. Begin the term’s definition by proceeding to the next line, indenting
to be directly under the term, and then entering a <dd> tag.

4. Follow this tag with the text that defines the term and close this with
a </dd> tag.

5. Continue this process, entering as many terms and definitions as you
require, as shown in Listing 28-1.

<dl>
<dt>The Ordered List</dt>

<dd>Created using the OL element. This list should
contain information where order should be emphasized.</dd>

<dt>The Unordered List</dt>

<dd>Created using the UL element.

Listing 28-1: Example of a definition list

6. End the definition list with a closing </d1> tag. An example of a
completed definition list is shown in Listing 28-2. The page this code
produces appears in Figure 28-1.
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<html>
<head>
<titles>Definition Lists</title>
</head>
<body>
<hls>Lists in HTML</hl>

<dl>
<dt>The Ordered List</dt>
<dd>Created using the OL element. This list should
contain information where order should be
emphasized.</dd>
<dt>The Unordered List</dt>
<dd>Created using the UL element. This list should be
used to express a series of significant points
</dd>
<dt>The Definition List</dt>
<dd>Create using the DL element. This list should be
used to define a list of terms.</dd>
</dl>

</body>
</html>

Listing 28-2: A definition list

Lists in HTML

The Crdered Lin

Creased wsang the OL element Thes kst should contam mfommaion where order should be emphasired
The Unordered Lust

Created wng the UL slement. Thes kst should be used io express a senes of ngeslicant pomts
The Defingtion Lint

Crease using the DL elemens Thes ket should be mted 1o define a kst of termns

Figure 28-1: A definition list indenting the definitions beneath each term, thereby
creating a hanging indent







Part 3:

Working with Images

Task 29:
Task 30:
Task 31:
Task 32:
Task 33:
Task 34:

Inserting Images

Controlling Image Alignment and Spacing

Resizing Images Using Photoshop Elements
Optimizing GIF Images Using Photoshop Elements
Optimizing JPEG Images Using Photoshop Elements
Optimizing PNG Images Using Photoshop Elements




- Part 3

Inserting Images

hen you place the <img> tag in your document’s code, the browser embeds

the image file you reference in the document. Referencing a specific image
file in the <img> tag requires an attribute; the <img> tag — just like the <font>
tag you saw in Part 2 — doesn’t really do anything by itself.

1. To embed an image, place an <img> tag within the body of your doc-
ument, as shown here:
<img>

2. To specify the image you want displayed, add a src attribute, setting
it equal to the pathname of the image on the server, as shown here:
<img src="images/daisy calvin.jpg”>

3. To specify the image’s dimensions, include width and height
attributes and set them equal to the pixel dimensions of the image:
<img src="daisy calvin.jpg” width=”200" height="100">

4. To specify alternative text to be used in place of the image for users
with nonvisual browsers, include an alt attribute:
<img src="daisy calvin.jpg” width="200” height="100"
alt="Our cats, Daisy and Calvin.”>

5. To place a border around an image, include a border attribute, set-
ting it equal to the border’s thickness in pixels:
<img src="daisy calvin.jpg” width="200" height="100"
alt="Our cats, Daisy and Calvin.” border="5">

6. 'To render your <img> tag XH'TML-compliant, include a space after
your last attribute and enter a forward slash, as shown here:
<img src="daisy calvin.jpg” width=”200” height="100"

alt="Our cats, Daisy and Calvin.” border="5" />

Listing 29-1 shows how each attribute is used. Figure 29-1 displays
the code in a browser.
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<html>
<head>
<title>Inserting Images</title>
</head>
<body>

<img src="daisy calvin.jpg” width=”200" height="100"
alt="0Our cats, Daisy and Calvin.” border="5" />

<p>

<font face="Arial, Helvetica, sans-serif” size="2">
<b>Daisy and Calvin - the gruesome twosome.</b>
</font>

</p>

</body>

</html>

Listing 29-1: An image with text below it

Dabwy and Calvin - the giusseme hwosome.

Figure 29-1: An image with text below it, rendered in the browser
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Controlling Image
Alignment and Spacing

mage alignment is controlled with the align attribute. The values top,

middle, and bottom relate to the image’s position relative to the surrounding
text. The values 1eft and right cause the image to float to the left or right
margin, wrapping text down the image’s opposite side. White space surrounding
an image is controlled with the hspace and vspace attributes.

1. To align an image element, add an align attribute to the <img> tag
as shown here:

<img align="" src="images/daisy calvin-2.jpg” width="50"
height="50" alt="Our cats, Daisy and Calvin.” />

2. To vertically align the top of the image with the top, middle, or
bottom of the preceding line of text, set the align attribute equal to
top, middle, or bottom. Figure 30-1 shows the results created by
each value.

<imgy align="top’ sre= fdaimny_cal 2.3pg" widih-"50"
Reight="30" alt="0ur cats, Daisy and Calvin.® />

<img align="middie” src='images/daisy calvin-2.3pg" width="30"

height="50' alt-'Our cats, Daisy and Calvin.® />

u(- align="bottom" wre="images/daisy _calvin-2.jpg" width='350"
height="5%0" alt="Dur cats, Daisy and Calvin.” />

o w—

Figure 30-1: The effects of the align attribute set to top, middle, and bottom,
respectively

3. To float an image element to the left or right margin, set the align
attribute equal to either 1eft or right. Figure 30-2 illustrates both
alignments.
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<img aligns"left” sres'images/daisy _calvin-2.3pg" widths'50"
height="30" alt="Our cats, Daisy and Calvin." />

<img align="right' sro="images/daisy_calvin-2.3py’ width="30"
hoight="50" alt="0ur cats, Daisy and Calwin.* f>

Figure 30-2: Two paragraphs with images floated to the left and right

4. To center an image, wrap the <img> tag inside opening and closing
<div> tags and add an align attribute to it instead, setting it equal
to “center”. Figure 30-3 shows the results of centering an image.

<img Bre=' images/daiey_calvin-2.3p0" VEALh="50" height="350" alt="0ur
cats, Daisy and Calwin.” />
<faiv>

<div align="center*>

Figure 30-3: A centered image

5. To increase the amount of white space around an image, add the
hspace and vspace attributes and set them equal to a pixel value, as
shown in Figure 30-4.

<imq align=-left' sre='images/daisy_calvin-2.4py*
width="50" height="50" alt="fur cats, Daisy and Calwvin.”
n hapace="25" wapace="25" [>

L —— "

Figure 30-4: An image with 25 pixels of horizontal and vertical space added with the
hspace and vspace attributes
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Resizing Images Using
Photoshop Elements

mage editing is not exactly specific to HI'ML, but it is important to understand
whenever you work with images.

Changing an image’s pixel dimensions in an image editor is called resampling.

As you might guess, decreasing the image’s dimensions — also called
downsampling — deletes data from your image. Increasing the dimensions
(resampling up) adds new pixels through a process called interpolation — which
looks at existing pixels in the image and determines what the best color values of
the added pixels should be. In general, resampling up results in a loss of detail.

1. To resample an image using Photoshop Elements, first open the file
you want to resample by choosing File &> Open from the menu.

2. Choose Image = Resize = Image Size from the menu. This opens
the Image Size dialog box (see Figure 31-1).

Figure 31-1: The Image Size dialog box in Adobe Photoshop Elements

3. At the bottom of the dialog box, select the Resample Image option
and choose an interpolation method from the pop-up menu (see
Figure 31-2).

Figure 31-2: The Resample Image interpolation pop-up menu
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4. Click the Constrain Proportions option if it isn’t already checked. Task 3' ‘

Doing so maintains the image’s proportions by automatically updat-
ing the width or height when you alter one of the dimensions.

5. Enter Width and Height values in the Pixel Dimensions fields. If you
want to use percentages of the current dimensions instead, click the
pop-up menus to the right of the Width and Height fields to switch
from Pixels to Percent (see Figure 31-3).

Figure 31-3: Choose a unit of measure: pixels or percentage

6. The image’s resulting file size appears at the top of the Image Size
dialog box, with the old file size in parentheses. Click OK to process
your resampling choices and close the dialog box.
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Optimizing GIF Images
Using Photoshop Elements

ptimizing images results in a tradeoff between achieving the highest quality

image with the smallest possible file size. In this task, you’ll learn how to
optimize images and save them in the Graphic Interchange Format (GIF). This
file format is designed to create relatively detailed image files while retaining a
small file size, so you can transfer images quickly across the Web.

1. To optimize and save an image as a GIF file, open your selected
image by choosing File = Open from the Photoshop Elements
menu. This displays the Open dialog box. From here, locate your
image and click the Open button.

2. Choose Save for Web from the File menu. This opens the Save for
Web dialog box (shown in Figure 32-1). The interface displays the
original image in one pane and the optimized image in the other.
Make your optimization adjustments using the tools in the Settings
area on the right side of the dialog box.

543 2 1 6789

Figure 32-1: The Save for Web dialog box’s Settings tools for GIFs include: 1. Optimization
preset menu, 2. File Format menu, 3. Color Reduction Algorithm menu, 4. Dithering
Algorithm menu, 5. Transparency check box, 6. Interlaced check box, 7. Colors menu,
8. Dither percentage, and 9. Matte Color
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3. If you want to use one of the optimization presets in Photoshop Task 32
Elements, make a selection from the presets menu. The choices on
this menu modify all the tools in the Settings area; they have names
like GIF 128 Dithered.

4. To choose custom settings, simply use the rest of the tools in the
Settings area:

a. Choose GIF from the file format menu.

b. Select a color reduction algorithm, a mathematical formula for
deciding where and how to remove colors from an image without
making it look terrible. Choose from among Perceptual,
Selective, Adaptive, Web, or Custom. For most purposes,
Selective is the best choice.

¢. To specify manually the maximum number of colors in the image,
select a number from the Colors pop-up menu. You can enter the
value manually or click the arrows to increase or decrease the
value one number at a time.

d. Use the Dithering Algorithm pop-up menu if you choose to set a
dithering algorithm. Choose No Dither, Diffusion, Pattern, or
Noise. Use the Dithering Percentage pop-up menu to specify the
amount of dithering.

5. Look at the lower-left corner of the optimized image to see what
your optimization settings have done to the file size and download
time (see Figure 32-2).

Figure 32-2: The optimized file size and download time
determined by the Settings area

6. To save your optimized image, click OK. In the Save Optimized As
dialog box, type a filename and click Save.
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Optimizing JPEG Images
Using Photoshop Elements

PEG stands for Joint Photographic Experts Group, which is responsible for

creating standards for “continuous tone image coding.” An image with contin-
uous tone has a virtually unlimited range of colors or shades of gray. Whereas
GIFs can only handle 256 colors or shades of gray, JPEG images (also called just
JPEGs) can display 16,777,215. JPEGs are best suited for color photographs and
photorealistic images.

1. Open your image in Photoshop Elements and choose File &> Save for
Web from the menu to open the Save for Web dialog box.

2. Choose a JPEG preset or choose JPEG from the File Format menu
(see Figure 33-1).

1 2 3

Figure 33-1: The Save for Web dialog box’s Settings tools for JPEGs include:
1. File format menu, 2. Quality Level menu, and 3. Quality slider
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3. Ifyou prefer a custom setting, you can set the Quality Level menu to
Low, High, Medium, or Maximum (see Figure 33-2). A Maximum
option equals a value of 80.

Figure 33-2: The Quality Level menu

4. If you want to manually set the value, use the Quality slider (see
Figure 33-3). A value of 0 gives you the lowest possble image quality
with the smallest possible file size. A value of 100 gives you the high-
est quality image but the largest possible file size.

Figure 33-3: The Quality slider

5. To save your optimized image, click OK.

6. In the Save Optimized As dialog box, type a filename and click Save.
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Optimizing PNG Images
Using Photoshop Elements

he Portable Network Graphics (PNG) format was created as a free and more

robust alternative to GIF after Unisys, the patent owner of the GIF compres-
sion method (called Lempel-Ziv-Welch or LZW), sought royalties from software
developers whose programs used it. PNG uses a lossless compression algorithm,
just like GIF, and supports images with 8- and 24-bit color depths. At an 8-bit
color depth, PNG and GIF are equal in image quality, although PNG generally
results in infinitesimally larger file sizes. One reason not to use PNG in place of
GIF is if a large proportion of your audience uses browsers prior to version 4.0 of
Internet Explorer and Netscape Navigator, which don’t support it.

1. Open your image in Photoshop Elements and choose File => Save for
Web from the menu to open the Save for Web dialog box.

2. 'To optimize an image as PNG-8, choose PNG-8 from the File

Format menu.

3. The PNG-8 Settings options are identical to those for GIE, as you
can see from Figure 34-1. "To select a color reduction algorithm,
choose Perceptual, Selective, Adaptive, Web, or Custom from the
Color Reduction Algorithm menu.

Figure 34-1: The PNG-8 optimization settings
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4. To set a dithering algorithm, choose No Dither, Diffusion, Pattern,
or Noise from the Dithering Algorithm menu. Use the Dithering
Percentage menu to specify the amount of dithering you want.

5. Use the Colors menu to set the number of colors in your image.

6. If you save an image as PNG-24, the Settings tools display only the
File Format menu (see Figure 34-2). Simply select PNG-24.

Figure 34-2: The PNG-24 settings

7. 'To save your optimized image, click OK.

8. In the Save Optimized As dialog box, type a filename and click Save.







Part 4:

Audio and Video

Task 35:
Task 36:
Task 37:
Task 38:

Embedding Audio Files
Adding Background Sounds
Embedding Video
Embedding Java Applets




- Part 4
Embedding Audio Files

Browsers can’t play audio files without help from other applications. Enter the
plug-in, a piece of software that runs within the browser to expand its func-
tionality. Plug-ins are a Netscape creation, but when you have the Netscape
browser installed, Microsoft Internet Explorer makes use of them as well. As

of this writing, the Apple QuickTime plug-in comes installed with Netscape
Navigator 7.02, so both Netscape and Internet Explorer, if installed, make use
of it when playing embedded sound files.

1. In the body of your document, enter an <embed> tag.

2. Define a src attribute and set it equal to the location of the sound
file on the Web server. For example:

<embed src="backbeat.mid”>

3. Define width and height attributes to display a control panel in the
browser window. For example:
<embed src="backbeat.mid” width="100” height="15">

"This creates a control panel 100 pixels wide by 15 pixels high, as
shown in Figure 35-1.

4. - . -

Figure 35-1: A QuickTime audio control panel

4. 'To prevent the sound file from playing the very moment the page
loads, define an autostart attribute and set it equal to false:

<embed src="backbeat.mid” width="100” height="15"
autostart="false” >

5. To float the control panel amongst text, similarly to an image, define
an align attribute:

* left floats the control panel to the left margin and wraps text
around it to the right.

* right floats the control panel to the right margin and wraps text
around it to the left.

Listing 35-1 shows two embedded sound files, one aligned left and
one aligned right. Figure 35-2 shows how a browser treats the con-
trol panels.
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<html>
<head>

<title>Embedding Audio Files</title>
</head>

<body>

<p><embed src="backbeat.mid “height="35” width="150"
controller="true” align="left”>To float the control panel
amongst text, similarly to an image, define an align
attribute. Setting the align attribute equal to left floats
the control panel to the left margin and wraps text around
it to the right. Setting the align attribute to right floats
the control panel to the right margin, and text begins on
the left margin, wrapping down the left side of the control
panel. </p>

<p><embed src="backbeat.mid “height="35” width="150"
controller="true” align="right”>To float the control panel
amongst text, similarly to an image, define an align
attribute. Setting the align attribute equal to left floats
the control panel to the left margin and wraps text around
it to the right. Setting the align attribute to right floats
the control panel to the right margin, and text begins on
the left margin, wrapping down the left side of the control
panel.</p>

</body>
</html>

Listing 35-1: Using the align attribute of the <embed> tag

R To float the control panel amongst text,

amilaly to & image, defme an align aitnbwte. Setting the
align astnbute equal to left Aoats the control pasel to the left margm and wraps text
arounditto the right Semng the align annbute to nght floats the control panel to the
nght mangen, sad text beging oa the left margm, wrapping down the left nde of the
comtrol panel

To float the comtrol paned amongst text, aimalarly to an image, S
defline an align attnbute. Settng the align amnbute cqual to lcft

Aoats the control panel %o the left margin sad wraps texs arousd it bo the right. Sentiag
the alsgn amnbute to nght floats the control panel to the right margin, and text begias
on the left margin, wrapping down the left nds of the control panel

I

Figure 35-2: The control panel treated like an image by most browsers
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Adding Background Sounds

here are two ways to define sounds meant to play in the background while

visitors browse your site. One is a variation on Task 35 and another makes use
of Microsoft’s proprietary <bgsounds tag, which only works for Internet
Explorer.

1. In the body of your document, enter an <embed> tag.

2. Define a src attribute and set it equal to the pathname of the sound
file on the Web server.

3. Define width and height attributes, setting them equal to 1. This
constrains the control panel to a single pixel that can be hidden any-
where on the page.

4. Set the autostart attribute equal to true so that the sound begins
once the page has successfully loaded.

5. Define a 1oop attribute, setting it equal to the number of times you
want the sound file to play. To make the sound play continuously
while the page is viewed, set the attribute equal to -1. Listing 36-1
shows a completed <embed> tag.

<html>
<head>

<title>Background Sounds</title>
</head>

<body>
<embed src=" bandmarch.mid” width="1" height="1"
autostart="true” loop="-1">

</body>
</html>

Listing 36-1: The <embed> tag formatted for use as a background sound.
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6. To use Microsoft’s proprietary <bgsounds tag, place the tag inside
the <head> section of your document because it references some-
thing not specifically displayed in the browser window.

7. Define a src attribute and set it equal to the pathname of the sound
file on the Web server.

8. Define a loop attribute and set it equal to the number of times you
want the sound file to play. To have the sound play continuously
while the page is viewed, set the attribute equal to -1. Listing 36-2
shows a completed <bgsound> tag.

<html>
<head>

<title>Background Sounds</title>
<bgsound src="bandmarch.mid” loop="-1">
</head>

<body>

</body>
</html>

Listing 36-2: Using the <bgsound> tag to play a background sound

e 36
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Embedding Video

You can use the <embed> tag to embed video files in a document. Just as with
sound files, the physical appearance of control panels varies depending on the
plug-in required to display the video file, user’s browser, and operating system.

1. In the body of your document, enter an <embed> tag where you want
the video file to be displayed.

2. Define a src attribute to specify the location of the source file on the
Web server.

3. Define width and height attributes to specify the displayed video’s
dimensions.

4. Define an autoplay attribute and set it equal to true to make the
video play as soon as the page loads. Set it equal to false to have the
user click a play button to start the video clip.

5. Define a controller attribute, setting it equal to true to display a
control panel. A setting of £alse hides the control panel. Listing
37-1 shows a completed <embed> tag. Figure 37-1 displays the
results in a browser.

<html>
<head>
<title>Embedding Video</title>
</head>
<body>

<embed src="laurie.mov” width="177" height="144"
autoplay="false” controller="true”>

<br>

<embed src="laurie.wmv” width="177" height="144"
autoplay="false” controller="true”>

</body>
</html>

Listing 37-1: Using the <embed> tag
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Figure 37-1: A QuickTime clip (top) versus a Windows Media Viewer clip (bottom)

6. Define a 1oop attribute as follows:
* true makes the clip play continuously.
® false makes the clip play only once.

® palindrome makes the clip play normally and then play back-
wards, looping continuously.
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Embedding Java Applets

he scope of this book is not broad enough to teach you how to write your

own Java applets. Java is a complex programming language that you can use
to develop entire applications. You can also use it to write small applets embed-
ded in Web documents. There are all kinds of different applets available free for
download on the Internet. They include graphics, games, and navigational ele-
ments, to name only a few. An example of a simple animated graphic is shown in
this task. The two tags used to embed applets are <applet> and <objects.
First you need to download an applet.

1. Use your favorite search engine to browse for free Java applets until
you come across one you're interested in downloading. They are typ-
ically packaged in “zipped” archives that you can open with applica-
tions like WinZip for Windows and StuffIt for Macintosh.

2. Enter an <applet> tag into the body of your document at the point
in the code where you want the applet to appear in the browser
window.

3. Define a code attribute and set it equal to the location of the Java
source file:

<applet code="Kubik.class”>

4. Define appropriate width and height attributes. Exact dimensions
may be specified with the applet instruction you download, or you
may specify your own:

<applet code="kubik.class” width="222" height="77">

5. Using <param> tags, specify parameters supplied by the program-
mer. Your ability to do this depends on the applet you are using.
"Typically, parameters and definitions appear in the sample you down-
load. Parameters are controlled with name and value attributes, as
shown here:

<applet code="kubik.class” width="222" height="77">
<param name="text” wvalue="HELLO!”>

<param name="foreground” value="green”s>

<param name="background” value="black”>

6. Conclude your parameters with a closing </applet> tag, as shown
here:

<applet code="kubik.class” width="222" height="77">
<param name="text” wvalue="HELLO!”>

<param name="foreground” value="green”s>

<param name="background” value="black”>

</applet>
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To use the <object> tag, insert the opening tag into the body of
your document at the point in the code where you want the applet to
appear in the browser window.

In place of the code attribute, enter a codetype attribute and set it
equal to application/java. Enter a classid attribute and set it
equal to java: and the source filename (no spaces); include your
dimensions, as shown here:

<object codetype="application/java”
classid="java:kubik.class” width="222" height="77">

Include any parameters just as you would with the <applet> tag and
finish with a closing </object> tag. Listing 38-1 shows a completed
<object> tag in a document. Figure 38-1 displays the results in a
Web browser.

<html>
<head>

<title>Java Applets</titles>
</head>

<body>

<object codetype="application/java”
classid="java:kubik.class” width="222" height="77">
<param name="text” value="HELLO!”>

<param name="foreground” value="green”>

<param name="background” value="black”>

</object>
</body>
</html>

Figure 38-1: Example of a Java applet on a Web page

e 38
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Defining Hyperlinks

Hyperlinks are essential for the Web. You create them with the anchor tag,
<a>, yet another tag that requires attributes. The attribute that transforms
the little <a> tag into the linking powerhouse that puts the “hyper” in hypertext
is href, which stand for hypertext reference. The closing anchor tag, as you can
probably guess, is written </a>. The opening and closing anchor tags transform
the text or images they surround into a region that, when clicked, loads whatever
document you specify into the browser window. The href attribute points to the
document you want to load when the link is clicked.

1. In the body of an HTML document, locate the text or image tag you
want to convert into a link.

2. Place an opening anchor tag in front of that text or image tag and
define an href attribute, setting it equal to the pathname of the file
you want to open when the link is clicked, as shown in Listing 39-1.

<a href="bingo.html”>text-link

<a href="http://www.dingo.com” >
<img src="dingo.gif” width="100” height="25" border="0"
alt="My dingo, Spiff.”>

Listing 39-1: Examples of opening anchor tags

3. Place a closing anchor tag at the end of the text or directly after the
image tag you're turning into a link, as shown in Listing 39-2.

<a href="bingo.html”>text-link</a>

<a href="http://www.dingo.com” >

<img src="dingo.gif” width="160" height="198" border="0"
alt="My dingo, Spiff.” />

</a>

Listing 39-2: Examples of complete anchor tags

4. To format a link so that the document it points to opens in a new
browser window, define a target attribute and set it equal to
“_blank”:

<a href="bingo.html” target="_ blank”>text link</a>
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5. To control the color of text links, define the three following attrib-
utes for the <body> tag, setting them equal to hexadecimal or prede-
fined color name values:

* 1link specifies the color of links that haven’t been visited.
* vlink specifies the color of links that have been visited.

* alink specifies the color of links that are currently active.

Listing 39-3 shows a sample document. Figure 39-1 displays the doc-

ument in a browser.

<html>

<head>
<title>Hyperlinks</title>

</head>

<body 1ink="#0000FF” vl1ink="#990099” alink="#FF0000”>

<a href="bingo.html”>text-link</a>

<br />

<br />

<a href="http://www.dingo.com” target="_blank”>

<img src="dingo.gif” width="160" height="198" border="1"
alt="My dingo, Spiff.” />

</a>

</body>
</html>

Listing 39-3: Text and image-based hyperlinks

[

Figure 39-1: Text and image hyperlinks rendered in the browser
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Defining Pathnames

hether you’re defining the href attribute of the anchor tag, the src

attribute of the image tag, or in any way referencing files within your Web
site, you’re working with pathnames. A pathname is simply a way to describe the
file structure of your site — how files and folders (also called directories) are laid
out on your computer, and ultimately the Web server. Figure 40-1 diagrams a
simple structure of files and directories, which the following steps refer to.

vellow AN Figure 40-1: The Yellow directory containing two files

(page_1.html and page_2.html) plus two additional
page_1.html subdirectories (Blue and Lavender), each of which
page_2.html contain two files

blue
page_3.html
page_4.html

1. To reference a document in the same directory as the current file, set
the href attribute equal to the document’s filename. For example, to
create a link in page_1.html that opens page_2.html, write the anchor
tag as follows:

<a href="page 2.html”> </a>

2. To reference a document inside a directory that’s next to the current
file, set the href attribute equal to the directory’s name, add a for-
ward slash, and follow it with the filename. For example, to create a
link in page_1.html that opens page_3.html, write the anchor tag as
follows:

<a href="blue/page 3.html”> text or image </a>
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3. To move up one directory in the file structure, referencing a docu-
ment outside the directory of the current file, precede the filename
with two periods and a forward slash. For example, to create a link in
page_3.html that opens page_1.html, write the anchor tag as follows:

<a href="../page_1.html”> text or image </a>

4. To reference a document inside a directory that is outside the current
file’s directory, precede the filename with two periods and a forward
slash, and follow it with the directory name and filename. For exam-
ple, to create a link in page_5.html that opens page_3.html, write the
anchor tag as follows:

<a href="../blue/page 3.html”> text or image </a>

5. Always use absolute pathnames to link to documents found on some-
one else’s Web server. The easiest way to gather that information is
to open the Web site in a browser, navigate to the exact page you
want to link to, copy the URL in your browser’s address bar (see
Figure 40-2), and paste it directly into the HTML file, as
shown here:

<a href="http://www.domainname.com/directoryname/
filename.html”> text or image </a>

Figure 40-2: Copying a URL in the browser's address bar
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Creating mailto Links

At some point, you've probably clicked a link to send an e-mail. Doing so
opens your e-mail application with a new, properly addressed message win-
dow waiting for you to start typing. Creating this type of link varies only slightly
from what we covered in Task 40.

1. In the body of an HTML document, locate the text or image tag you
want to make into a link.
2. Place an opening anchor tag in front of that text or image tag.

3. Define an href attribute and set it equal to the mailto: protocol,
including the e-mail address the message should go to, as shown
here:

<a href="mailto:robert@limehat.com”>
4. To predefine the contents of the e-mail’s “Subject” line, follow the

e-mail address with a question mark (?), enter the word subject,
and set it equal to the text you want displayed, as shown here:

<a href="mailto:robert@limehat.com?subject=Party! RSVP”>
5. 'To predefine the body text of the message, follow the subject value

with an ampersand (&), enter the word body, and set it equal to the
text you want displayed, as shown in Listing 41-1.

<html>
<head>
<title>Mailto: Links</titles>
</head>

<body>
<a href="mailto:robert@limehat.com?subject=Party!
RSVP&body=I'11 be there”>Coming to our party?</a>

</body>
</html>

Listing 41-1: E-mail link with subject and body predefined
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6. Place a closing anchor tag (</a>) at the end of the text or directly
after the image tag you’re turning into a link. When the link is
clicked, the user’s e-mail application will open with the address,
subject, and body text already filled in, as shown in Figure 41-1.

Figure 41-1: The new message window with address, subject line, and body already
filled in




- Part 5

Linking to Named Anchors

You can do more than just link to documents and images. If you name an
anchor tag at a specific place within a document (at the start of a section, for
instance) you can specify that exact location in a hyperlink. This named anchor
effectively becomes a subaddress within the document. You name an anchor tag
by assigning a value to the name attribute of the <a> tag.

1. Enter an anchor tag at a specific line within a document to which you
want to link.

2. Define a name attribute for the anchor tag, setting it equal to a
descriptive term. For example:

<a name="answer 2”><p>A: Push the green Power button on

the remote. If that fails, check the surge strip.</p></a>

3. To link to this named anchor from within the same document, create
an <a> tag and set its href attribute equal to the value of the named
anchor. Precede the name with a pound sign, as shown here:

<a href="#answer 2”> Q: How do I turn on the TV? </a>
4. You can achieve the same effect using the id attribute, which all tags

accept. For example, in this code sample an id attribute could be
applied to the <p> tag, as shown here:

<p id="answer 2”>A: Push the green Power button on the
remote. If that fails, check the surge strip.</p>

The hyperlink would still be defined:

<a href="#answer 2”> text or image </a>
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5. To link to the named anchor or id element from a document outside
the current document, simply append the value to the end of the reg-
ular pathname. For example, if the named anchor were in a docu-
ment named fag.html, the correct pathname value for a link in
another document to #answer_2 might be written as follows:

<a href="faqg.html#answer 2”> text or image </a>

Figure 42-1 shows an example of named anchor links helping users
navigate a long text document.

T L L (]

previous next contents glerments atiributes index

12 Links

Figure 42-1: The Contents links at www.w3.0rg/TR/REC-htmI40Q/struct/links.html
pointing to corresponding paragraphs further down the page (links.html#h-12.2 in
this case)
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Defining Tables

Atable is a structured element that consists of rows and columns of cells. You
can place any kind of content you like in these cells: text, images, and even
other tables. If you can define it in HTML, you can place it inside a table cell.
There are three sets of container tags required to build any table. The <table>
and </table> tags define where the table begins and ends, the <tr>and </tr>
tags define where each row begins and ends, and the <td> and </td> tags define
the individual cells within each row. There are no tags specifically defining
columns; they result when multiple rows of cells are stacked on top of each other.

1. Within the body section of your document, enter an opening
<table> tag.

2. Move to the next line by hitting the Enter (or Return) key, indent
your cursor and enter an opening <tr> tag to define the start of the
first row.

3. Hit Enter again to move to the next line, indent your cursor again,
and enter an opening <td> tag to indicate the start of a new cell.

4. Follow the opening <td> tag with the specific content you want
placed in this cell.

5. Complete the cell by entering a closing </td> tag.

6. Repeat Steps 3 through 5 for each cell you want to add to the row.
When your row is finished, move to the next line and enter a closing
</tr> tag vertically aligned beneath the opening <tr> tag to aid
readability.

<tablex>
<tr>

<td> 1 </td>

<td> 2 </td>

<td> 3 </td>
</tr>

7. Repeat Steps 2 through 6 to add subsequent rows to the table.

8. After completing the desired number of rows, move to the next line
and finish the table with a closing </tables> tag, vertically aligned
with the opening <table> tag. Listing 43-1 shows the code required
to produce a table with three rows and three columns. Figure 43-1
shows the results displayed in a browser.
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<html>

<head>
<title>Tables</title>
</head>

<body>

<table>
<tr>
<td> 1 </td>
<td> 2 </td>
<td> 3 </td>
</tr>
<tr>
<td> 4 </td>
<td> 5 </td>
<td> 6 </td>
</tr>
<tr>
<td> 7 </td>
<td> 8 </td>
<td> 9 </td>
</tr>
</table>

</body>
</html>

Listing 43-1: Code for a borderless table with three rows and three columns

123
456
789

Figure 43-1: The rather minimal table displayed in a browser




- Part 6
Working with Table Borders

In Task 43, you created a simple table that organizes content into rows and
columns. To make the individual cells more distinct, define borders for your
table. Table borders are influenced by the following four attributes: border,
cellpadding, cellspacing, and bordercolor.

1. To render a visible border around the table perimeter and interior
cells, add the border attribute to the <table> tag and set it equal to
a numeric value, such as:

<table border="2">

Figure 44-1 shows the simple table from Task 43 with this border
attribute defined.

Figure 44-1: A table with a border one pixel thick

2. To control the thickness of internal borders between cells, define a
cellspacing attribute and set it equal to a numeric value, such as:

<table border="2" cellspacing="10">

Figure 44-2 shows the result of adding this attribute value.

hep
Wbk
nkeb

Figure 44-2: The same table in Figure 44-1 with cellspacing increased to 10 pixels




Building Tables

3. To control the amount of empty space between the border of a cell
and the content inside it, define a cel1padding attribute. Set it
equal to a numeric value, such as:

<table border="2" cellspacing="10" cellpadding="10">

Figure 44-3 shows the results in a browser.

Figure 44-3: The same table in Figure 44-2 with cellpadding increased to 10 pixels

4. 'To specify a border color, define a bordercolor attribute. Set this
equal to a hexadecimal value or predefined color name, for example:
<table border="2" cellspacing="10" cellpadding="10"
bordercolor="#FF0000" >

Figure 44-4 shows the results rendered in the browser.

L[]
[4)C] ]
L[]

Figure 44-4: The same table in Figure 44-3 with a border color applied
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Spanning Cells

Asingle cell can span multiple columns or rows. The number of columns or
rows a cell spans is defined using the colspan and rowspan attributes. To
demonstrate how these attributes function, we’ll build a small table and apply the
attributes individually.

1. In the body section of your document, enter the table code shown in
Listing 45-1. Figure 45-1 shows the results in a browser.

<table border="1" cellspacing="0" cellpadding="10">
<tr>
<td> 1 </td> <td> 2 </td> <td> 3 </td>
</tr>
<tr>
<td> 4 </td> <td> 5 </td> <td> 6 </td>
</tr>
<tr>
<td> 7 </td> <td> 8 </td> <td> 9 </td>
</tr>
</table>

Listing 45-1: Simple table code

1123
4|56
7189

Figure 45-1: A simple nine-celled table, with three rows and three columns

2. To span a cell across a number of columns, add the colspan attribute
to the <td> tag and set it equal to the number of columns you want to
span. For example, to make the number 1 cell span across the other
cells in the same row, add a colspan attribute equal to 3, as shown
here:

<td colspan="3"> 1 </td>
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3. Remove the code representing the two cells being spanned. In this
example, delete <td> 2 </td> and <td> 3 </td> from the first row,
save the document, and preview it in a browser. Figure 45-2 shows
the result.

Figure 45-2: Cell 1 spanned across three columns

4. To span a cell across a number of rows, add the rowspan attribute to
the <td> tag and set it equal to the number of rows you want to
span. For example, to make the number 3 cell span the other cells in
the same column, add a rowspan attribute equal to 3, as shown here:

<td rowspan="3"> 3 </td>

5. Remove the code representing the two cells being spanned. In this
example, delete <td> 6 </td> in the second row and <td> 9 </td>
in the third row, and then save your document and preview it in a
browser. Figure 45-3 shows the result.

1|2
41513
718

Figure 45-3: Cell 3 spanned across three rows
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Aligning Table Elements

Just like many other elements we’ve examined, the align attribute can be used
to influence a table’s position as well as the content of individual table cells.
When you apply the align attribute to the <tables tag, it affects the table the
same way as it does an image: It positions the table relative to the other text
inside the document. When you apply the align attribute to the <td> tag, it
aligns the cell’s content. Because cells also possess height — whether specifically
defined by the height attribute or forced by the cell’s content — you can vert-
cally align content within cells using the valign attribute.

1. To specify a table’s alignment, define an align attribute of the
<table> tag and set it equal to left, right, or center. Figure
46-1 shows the possible results.

{ g |<tamle align='legi">
Aligrang a table to the left foats the table te the left mangms and wraps tex down 21 nght nde.
3

<table align="'right" > 1E2
Akgamg a table to the nght Boats the table to the nght margmn and wraps text down #s et nde
3

[z

<table align="center®:>
Abgueng & tabla to the center, centers the table and mowes text onto the next kne

—

Figure 46-1: Three tables aligned around text: left, right, and center (from top to
bottom)
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2. To align the content within a cell horizontally, define an align
attribute for the <td> tag and set it equal to left, right, or
center. Figure 46-2 shows the result of each value.

td align="Lleft*> | <td align="center®> <td align="right®>

Figure 46-2: Cells aligned to the left, center, and right

3. To align the content within a cell vertically, define a valign
attribute for the <td> tag and set it equal to top, middle, bottom,
or baseline. Figure 46-3 shows the result of each value.

<id valign="top' > nevds 19 be emough height
& coll for the effects of the
wanbste 1o be movcable
nevds 19 be enough hewght
“Ld valign="middle" > & coll for the efiects of the
witnbwe 1o be moscable
nevds to be mmough hesght
@ coll for the efects of the
“id valign=‘bottom' » atinbete 1o by moscabie

Figure 46-3: Cells vertically aligned to the top, middle, and bottom, and at the baseline

4. 'To set the horizontal or vertical alignment for an entire row, define
the align or valign attributes of the <tr> tag.
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Defining Dimensions for Table Elements

L eft to its own devices, the dimensions of the overall table or individual cell is
governed by the content placed within it. Like some other elements you’ve
seen, the dimensional attributes width and height can also be applied to the
<table>, <tr>, and <td> or <th> tags with more or less similar results.

1. To specify the width of a table, add the width attribute to the open-
ing <table> tag and set it equal to a pixel value or a percentage. For
example:

<table width="200">

or:

<table width="80%">

Figure 47-1 shows examples of different table widths.

1

| S —
<tahle width="100">

[ | i
[ | |

“table widthe’ 506>

[
I | J

table width="1006">

Figure 47-1: Various table widths and their effects
2. To specify the width of an individual cell, add the width attribute to

the <td> tag and set it equal to a pixel value or a percentage. Figure
47-2 shows examples of cell widths.
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<table width='725°>
te width=* 150> <td widbh=' 225 > Lrd widths" 3507 |
:

| | | ]

<Lable widlh="100%" >
Td WiAEN="20%"> <L widthe' D04’ R e |

Figure 47-2: Different cell and table widths

3. To define the height of a cell, add a height attribute to the <td> tag
and set it equal to a pixel value or percentage. Figure 47-3 shows the
effect of different height values.

wtd height="50" >

witd height=*75">

“td height="100">

—

Figure 47-3: The effect of various height values

4. 'To set the width or height of an entire row, add width and height
attributes to the <tr> tag, setting them equal to pixel values or
percentages.
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Working with Table
Background Properties

11 four tag pairs used in creating tables support the attributes bgcolor and
background. The bgcolor attribute specifies the background color and
background specifies a background image.

1. To define a background color for the entire table, add the bgcolor
attribute to the opening <table> tag, setting it equal to a hexadeci-
mal value or a predefined color name. For example:

<table bgcolor="#003399">

2. To define the background color for an individual row, apply the
bgcolor attribute to the <tr> tag and, for a single cell, apply it to
the <td> or <th> tag. For example:

<tr bgcolor="#003399">
<td bgcolor="#003399">
<th bgcolor="#003399">

Figure 48-1 shows the effect of applying the bgcolor attribute to
the <table>, <tr>, and <td> tags simultaneously.

Figure 48-1: Red table, white row, blue cell
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3. To define a background image for a table, add the background Task 8
attribute to the <table> tag and set it equal to the pathname of the

image you want to use. For example:

<table background="images/bg.gif” >

Figure 48-2 shows a background image applied to a table.

’i

Figure 48-2: Background images tile from left to right and top to bottom across the
element they're applied to.

4. To define a background image for an individual row, apply the
background attribute to the <tr> tag and, for a single cell, apply it
to the <td> or <th> tag. For example:

<tr background="images/bg.gif”>
<td background="images/bg.gif” >
<th background="images/bg.gif” >
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o 49

Nesting Tables

esting tables inside other tables allows you to divide a document into discrete
regions. In this way, you gain greater control over page layout.

1. To nest a new table within an existing table cell, place your cursor
inside the cell and press Enter once or twice to create space for the
code you're about to enter, as shown in Figure 49-1.

<title-nesting Tables-/title-
</head-

<body>
<table width="600" border="0" cellspacing="0" cellpadding="5§"-
<tx>
<td width-"150"-

< /tds
<td

<h3>Introduction to Web Site Desigm</h3>
<prinstructor Staff</p-

<p-With the growth of the Internet, a web site can be used for almost
anything Learn HTML, the language of the web, and how to build a
complote wob site Learn how to use the web te educate yourself and
stay current on the latest technologies and standards. </p>

<prFriday, 7-Feb, 8 30 AM to 5:00 PM</p>

Figure 49-1: An existing table cell ready for nesting

2. Within the cell, enter a comment that describes the content being
placed in the nested table. Figure 49-2 shows an example.

“title-nesting Tables</Ctitle:
</hoad-
<body>
<table wi 600" 0" callspacing="0" cellpadding="5""

<tr>
“td width="150"-

<l== Begin Mavigation Table ==

<fed>

<t

<h3>Intreduct lon to Web Site Design</hi-
<prinstructor: Staff</p-

o h the g h of the Int t., a wob site can bo used for almost
anything Lears HTHL, the language of the web, and how to build a
complete web site. Learn how to use the web to educate yourself and
stay current om the latest technologies and standards </p-
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3. Move to the next line and enter the code defining your nested table,
as shown in Figure 49-3.

<head-
<title-nesting Tables</title-
</head -

<body>
<table width="600" border="0" cellspacing="0" cellpadding="§"-
<tzr>
<td width=-"150"-

«l== Begin Wavigation Table ==

<table width="125% border=*0" cellspacing="0" cellpadding="3%:

<tr>
<td><a href="registration html*-<font face="Arial, Helwetica,
sans-serif™ size="2" Register</font></fa></td>

<ftr>

<tr>
<tdr<a href="course desc html™ <font face="Arial, Helvetica,
sans-serif” size="2":Courses</font></a></rd>

<ftr>

<te>
<tdr<a href=“contact html*:|

Figure 49-3: Code for a nested table

4. After the closing tag of the nested table, move to the next line and
insert another comment tag demarking the end of the nested table, as
shown in Figure 49-4.

<td-<a href="contact html"-<font face="Arial, Helvetica, sans-

serif” size="2"-Contact
Us</font></a </td>

<ftr>

“tr>
<td-<font face="Arial, Helvetica, sans-serif” size="2".<a
href="index html* -lome/font-</a-/td-

<ftr-

</table-

<!== End Mavigation Table -=3|

<ftds

<td-

<h3>Introduct ion to Web Site Design</h3>
<prinstructor  Staff</p-

<p-With the growth of the Internet, a web site can be used for almost
anything Learn HTML, the language of the web, and how to build a
complete web site. Learn how te use the web to educate yourself and
stay current on the latest technologies and standards. </p>

Figure 49-4: A comment indicating the end of a nested table (“End Navigation Table”)
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Organizing Table Data

In Task 49, you learned how to use comment tags to make nested table code eas-
ier to read. HTML also has some tags for organizing individual parts of a table:
<thead>, <tbody>, <tfoot>, <captions, and <summary>. These tags are
generally used when the table you’re creating is meant to display tabular data.

1. To indicate a region of a table containing heading data, place opening
and closing <thead> tags around the code, as shown in Listing 50-1.

<theads>
<tr>
<th align="center” >MON</th>
<th align="center”>MEAN TEMP</th>
<th align="center” >HIGH</th>
<th align="center” >DATE</th>
<th align="center”>LOW</th>
<th align="center”>DATA</th>
<th align="center” >RAIN</th>
<th align="center”>AVE.WIND SPEED</th>
</tr>
</theads>

Listing 50-1: A table row marked as a header

2. To indicate the table code that makes up the footer, wrap it in open-
ing and closing <t foot > tags, as shown in Listing 50-2.

<tfoot>
<tr>
<td colspan="8">
*calculations based on 5 of 7 report zones
</td>
</tr>
</tfoot>

Listing 50-2: A table footer

3. To indicate the body of the table content, place opening and
closing <tbody> tags around the remaining table rows, as shown
in Listing 50-3.

<tbody>
<tr>
<td align="center”>1</td>
<td align="center”>23.8</td>
<td align="center”>43.2</td>
<td align="center”>30/1/03</td>

(continued)
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<td
<td
<td
<td
</tr>

</tbody>

align="center”>13.7</td>
align="center”>1/25/03</td>
align="center”>17.00</td>
align="center”>7</td>

Listing 50-3: The body section of a table

"To describe the data within a table, include <captions tags directly
following the opening <table> tag, as shown here:

<table width="100%" border="0" cellspacing="0"

cellpadding="3">

<caption><b>First Quarter Measurements</b></captions>

Figure 50-1 shows how captions appear in the browser.

I|III!CWMNMMkﬂ-hn¢nui IIIIIIIIII

1
2
3

Fust Quarter Measurements

MEAN TEMP HIGH DATE LOW DATE
233 432 V03 137 1A

2s 315 13203 152 5203
203 310 157303 93 iz

"caleulamscns based on 5 of 7 repost zones

Figure 50-1: A table caption appearing below a table

'ITW
71.00
4800

AVE WIND SPEED

o w—

To include a summary of the table data for text-to-speech browsers
and Braille-based devices, define a summary attribute for the
<table> tag, as shown here:

<table width="100%" border="0" cellspacing="0"
cellpadding="3" summary="First quarter weather
measurements, 5 of 7 zones reporting.”>
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Working with Forms
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Defining Form Elements

t seems that forms exist everywhere on the Web. They allow people to sign up

for newsletters, purchase goods, and send e-mail. Any HI'ML document that
contains a form has a section inside it containing opening and closing <form>
tags. Within this section lies the regular content and its markup, as well as
specific form-related elements called formz controls (check boxes, radio buttons,
menus, and so on).

Users fill in “the form” by entering information into text fields, making selections
from menus, and clicking check boxes and radio buttons. Clicking the “submit”
button sends the data they dutifully entered to a Web server, which sends the col-
lected form data to a processing script. The most important thing to understand
about Web forms is that they consist of two parts: the HTML-based interface that
visitors use to enter information (that is, the Web page) and a program on the
Web server that processes that collected information behind the scenes.

Web forms typically make use of something called the Common Gateway
Interface (CGI), a standard system for using external programs to communicate
with Web servers. Programs (called scripts) can be written in any number of pro-
gramming languages. The most common is Perl. The form page on the Web site
packages the information that users enter and sends it to the Web server where
the script resides. The script then processes the information and either has the
Web server send a response back to the visitor or holds and maintains the data
for some future purpose.

There is no single script that everyone uses to create forms. The Web page form
and the script on the server are unique little programs on each Web site. This
means that if you want to create your own forms, you need to learn how to

) . . .
program — but that’s a topic for another book. In this task, you simply learn
how to define the opening and closing <form> tags, which instruct browsers
where to submit the data and how the data should be sent.

1. Within the body section of the document, enter an opening <forms> tag.

2. Add an action attribute and set it equal to the URL of the process-
ing script, as shown in Listing 51-1.

<html>

<head>
<title>Forms</title>

</head>

<body>

<form action="/cgi-bin/guest.pl”>

</body>
</html>

Listing 51-1: The opening <form> tag and action attribute
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3. Follow the action attribute with the method attribute, setting it
equal to post or get, as shown in Listing 51-2.

<html>

<head>
<title>Forms</title>

</head>

<body>

<form action="/cgi-bin/guest.pl” method="post”>

</body>
</html>

Listing 51-2: A <form> tag with action and method attributes defined

4. To mark the end of the form, insert a closing </form> tag. Listing
51-3 shows a completed form container.

<html>

<head>
<title>Forms</title>

</head>

<body>

<form action="/cgi-bin/guest.pl” method="post”>

<!-- The elements that create the physical form the user
sees are placed between these opening and closing form tags.
-->

</form>

</body>
</html>

Listing 51-3: A completed form container
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Formatting Text Fields

fyou’ve ever filled out a Web-based form, you’ve noticed that more often than

not the information you’re providing is textual — names, addresses, passwords,
and comments — as well as numeric values like ZIP codes and phone and credit
card numbers. Form controls that accept this data are generically referred to as
text boxes. This task shows you how to examine the first of these three types: the
basic text field. These form controls are most commonly used for single-line
responses, like a name and address, and for short numeric values.

1.
2.

Enter an <input> tag.

Define a type attribute and set it equal to text, as shown here:
<input type="text”>

Define a name attribute and set it equal to the appropriate value
specified by the processing script. For example:

<input type="text” name="first name”>

To specify how wide the text field should be, define a size attribute,

setting it equal to a numeric value representing the width of the text
field in characters. For example:

<input type="text” name="first name” size="20"
"To specify a maximum number of characters the user can enter into

the text field, define a maxlength attribute and set it equal to a
numeric value, as shown here:

<input type="text” name="first name” size="20"
maxlength="20">
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6. If you want an initial value displayed in the text field when the docu- Task 52

ment loads, define a value attribute and set it equal to the text you
want the field to contain. For example:

<input type="text” name="first name” size="20"
maxlength="20" value="First Name Here”>

7. To make the <input > tag compatible with XHTML and keep it rec-
ognizable to non-XHTML browsers, conclude the tag by inserting a
space after the last attribute value and adding a forward slash and
closing bracket, as shown here:

<input type="text” name="first name” size="20"
maxlength="20" value="First Name Here” />

Figure 52-1 shows some typical text fields in a browser.

Name |

Email |
Organization [

Figure 52-1: Typical text fields rendered in the browser
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Formatting Password Fields

Password fields, logically enough, accept passwords. They respond to the same
size, maxlength, and value attributes as the text field but require the
type attribute to equal password so that any text entered into the password
field appears onscreen as asterisks (Windows) or bullet points (Macintosh). Other
than obscuring password text visually, a password field offers no sophisticated
security. It doesn’t encrypt or scramble the information in any way.

1. Enter an <input> tag.

2. Define a type attribute and set it equal to password. For example:
<input type="password” >

3. Define a name attribute and set it equal to the appropriate value
specified by the processing script, as shown here:
<input type="password” name="password” >

4. To specify the width of the password field, define a size attribute,

setting it equal to a numeric value representing the width of the pass-
word field in characters:

<input type="password” name="password” size="12">

5. To specify a maximum number of characters the user can enter into
the password field, define a maxlength attribute and set it equal to a
numeric value:

<input type="password” name="password” size="12"
maxlength="12">

6. To make the <input > tag compatible with XH'TML and keep it rec-
ognizable to non-XHTML browsers, conclude the tag by inserting a
space after the last attribute value and adding a forward slash and
closing bracket. Listing 53-1 shows an example of a simple login
screen. Figure 53-1 displays the resulting document in a browser.
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<html>
<head>
<title>Password Fields</title>
</head>
<body>

<form action="/cgi-bin/login.pl” method="post”>

User Name:<br>

<input type="text” name="user_ name” size="20" maxlength="20"
/>

<br>

Password:<br>

<input type="password” name="password” size="20"

maxlength="20" />

<br>

<br>

<!-- Submit and Reset Buttons -->

<input type="submit” value="Login” name="submit”>
<input type="reset” value="Clear” name="reset”>
</form>

</body>
</html>

Listing 53-1: Code behind a simple login screen

Figure 53-1: Simple login screen rendered in the browser
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Formatting Text Areas

Atext area is a large, scrollable, multiline text window. It is most commonly
used for collecting extended written comments. Unlike text and password
fields, the text area is not created with the <input > tag. Instead, it has its own
set of opening and closing <textareas tags.

1. Somewhere within the confines of your <form> tags, enter an open-
ing <textareas tag.

2. Define a name attribute and set it equal to the appropriate value
specified by the processing script. For example:

<textarea name="comments” >

3. 'To specify the width of the text area, add a cols attribute and set it
equal to a numeric value representing the width of the text area in
characters:

<textarea name="comments” cols="50">

4. To specify the height of the text area, add a rows attribute and set it
equal to a numeric value representing the height of the text area in
characters:

<textarea name="comments” cols="50"” rows="10">

5. To control how text wraps within the text area, add a wrap attribute
and set it equal to of £, virtual, or physical:

<textarea name="comments” cols="50" rows="10"
wrap="virtual”>

6. To complete the text area, add a closing </textareas tag:

<textarea name="comments” cols="50" rows="10"
wrap="virtual” >
</textarea>

7. If you want an initial value displayed in the text area when the
document loads, place the text between the opening and closing
<textareas tags, for example:

<textarea name="comments” cols="50" rows="10"
wrap="virtual” >

Place Your Comments Here...

</textareas>

Listing 54-1 shows a completed text area within the context of a
small form. Figure 54-1 renders the code in a browser.
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<html>
<head>

<title>Text Areas</title>
</head>

<body>
<form action="/cgi-bin/comments.pl” method="post”>

User Name:<br>

<input type="text” name="user name” width”30”
maxlength="20">

<br>

<br>

Enter Your Comments Here:<br>

<textarea name="comments” cols=40 rows=7 wrap></textarea>

<br>

<br>

<!-- Submit & Reset Buttons -->

<input type="submit” value=”Send Me” />

<input type="reset” value="Clear Me” />
</form>

</body>
</html>

Listing 54-1: A text field followed by a text area

User Name:

Enter Your C Here

Figure 54-1: A text field rendered in a browser
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Formatting Check Boxes

he check box form control acts as a switch that the user can toggle on or off

(check or uncheck). You create a check box by setting the <input> tag’s type
attribute equal to checkbox. Check boxes require a value attribute, which
supplies the value that gets passed to the script if the check box is clicked. By
defining the name and value attributes, you’re supplying both halves of the
name/value pair; the user decides whether it’s sent to the server by how they
respond to it — by checking it or not.

1. Enter an <input> tag.

2. Define a type attribute and set it equal to checkbox:
<input type="checkbox”>

3. Define a name attribute and set it equal to the appropriate value
specified by the processing script:
<input type="checkbox” name="fav flavor”s

4. Define a value attribute and set it equal to the value that will be
passed to the processing script if the user clicks the check box:
<input type="checkbox” name="fav flavor”
value="chocolate” >

5. If you want a check box to be preselected when the browser loads the
page, include the checked attribute:
<input type="checkbox” name="fav flavor” value="chocolate”
checked>

6. "To make the checked attribute compatible with XHTML, render it
like a traditional attribute and set it equal to checked:
<input type="checkbox” name="fav_ flavor” value="chocolate”

checked="checked” >

7. To make the <input > tag compatible with XHTML and still keep it
recognizable to non-XHTML browsers, conclude the tag by insert-
ing a space after the last attribute value and adding a forward slash
and closing bracket:

<input type="checkbox” name="fav_ flavor” value="chocolate”
checked="checked” />
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Listing 55-1 provides a simple check box example. Figure 55-1 ren-
ders the document in a browser.

<html>

<head>
<title>Checkboxes</title>
</head>

<body>
<form action="/cgi-bin/ice cream.pl” method="post”>
<p>What are your preferred ice cream flavors? </p>

<input name="flavors” type="checkbox” value="chocolate”
checked> Chocolate<br>

<input name="flavors” type="checkbox” value="strawberry”s>
Strawberry<br>

<input name="flavors” type="checkbox” value="vanilla”>
Vanilla

</form>
</body>
</html>

Listing 55-1: Code that generates three check boxes

What are you preferred ice cream flavors?

F Chocolate
T Swawbenry
[ Vanlia

Figure 55-1: Three check boxes to select our preferred ice cream flavor: chocolate,
strawberry, or vanilla
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Formatting Radio Buttons

hereas check boxes supply users with multiple-choice options in a form,

radio buttons supply either/or choices. You create radio buttons by setting
the <input> tag’s type attribute equal to radio. Radio buttons require the
same attributes as check boxes (type, name, and value) but when multiple radio
buttons share identical name attribute values, users can select only one at a time.
If the user has already selected one, clicking another deselects it.

1. Enter an <input> tag.

2. Define a type attribute and set it equal to radio:
<input type="radio”>

3. Define a name attribute and set it equal to the appropriate value
specified by the processing script:
<input type="radio” name="hand”>

4. Define a value attribute and set it equal to the value that will be
passed to the processing script if the user selects the radio button:
<input type="radio” name="hand” value="right”>

5. If you want a radio button to be preselected when the browser loads
the page, include the checked attribute:
<input type="radio” name="hand” value="right” checked>

6. To make the checked attribute compatible with XHTML, render it
like a traditional attribute and set it equal to checked:
<input type="radio” name="hand” value="right”

checked="checked” >

7. To make the <input > tag compatible with XHTML and keep it rec-
ognizable to non-XHTML browsers, conclude the tag by inserting a
space after the last attribute value and adding a forward slash and
closing bracket:

<input type="radio” name="hand” value="right”
checked="checked” />
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Listing 56-1 provides a simple three-button example. Figure 56-1
shows the resulting page in a browser.

<html>
<head>
<title>Radio Buttons</title>
</head>

<body>

<form action="/cgi-bin/dexterity.pl” method="post”>

<p>Which is your dominant hand?</p>

<input type="radio” name="hand” value="right” checked>
Right <brs>

<input type="radio” name="hand” value="left”>
Left <br>

<input type="radio” name="hand” value="both”>
Ambidextrous

</form>
</body>
</html>

Listing 56-1: A series of radio buttons

Whach is your dommant hand?

@ Rt
C Leit
© Ambidextrous

Figure 56-1: Make a selection using radio buttons to specify your dominant hand
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Formatting Selection Menus

election menus allow users to select one of several items in a pop-up list. You

define a selection menu with the <select> tag. Each menu option is laid
out in much the same way as you would create a list, using opening and closing
<option> tags to define each menu choice.

1. Insert an opening <select> tag.

2. Define a name attribute and set it equal to the appropriate value
specified by the processing script:

<select name="weaponry” >

3. To define a menu option, move to the next line, indent, and enter the
item between opening and closing <option> tags:

<select name="weaponry” >
<option>Vorpal Sword</options>
<option>Pointed Stick</options>
<option>Bare hands</option>

4. To specify an initial value for an option, define a value attribute for
the <option> tag and set it equal to the value to be sent to the pro-
cessing script. If this attribute is not defined, the initial value is set to
the content you placed between the <options tags:

<select name="weaponry” >
<option value="good” >Vorpal Sword</options>
<option value="bad”>Pointed Stick</options>
<option value="pointless”>Bare hands</option>

5. To specify one option as preselected, define a selected attribute for
the <option> tag and set it equal to selected:

<select name="weaponry” >
<option value="good” selected="selected”>Vorpal
Sword</options>
<option value="bad”>Pointed Stick</options>
<option value="pointless”>Bare hands</option>
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6. Once you've defined all your menu options, complete the selection
menu with a closing </select> tag. Listing 57-1 provides an exam-
ple of a simple selection menu. Figure 57-1 shows the resulting page
in a browser.

<html>
<head>
<title>Select Menus</title>
</heads>

<body>

<form action="/cgi-bin/good sense.pl” method="post”>

What would you use to stop a Jabberwocky?

<br>

<select name="weaponry” >
<option>Pick a weapon</options>
<option>-----------cmmmmmom - </option>
<option value="good”>Vorpal Sword</options>
<option value="bad”>Pointed Stick</option>
<option value="pointless”>Bare hands</options>

</select>

</form>
</body>
</html>

Listing 57-1: A simple selection menu

Figure 57-1: The selection menu listing your choice of weapon to stop a Jabberwocky
headed your way
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Formatting Selection Lists

hen you format a selection menu as a list, the form control becomes a box

from which a visitor can make one or more selections. Depending on how
you format the list, the box can sprout a scroll bar that allows users to move
through the list options. To turn a selection menu into a menu list, simply add
the size attribute to the <select> tag. This attribute accepts a numeric value
that signifies the number of list options to display. If there are more options in
the list than the number of lines defined, the list sprouts a scroll bar so the user
can read them all.

1. Insert an opening <select> tag.

2. Define a name attribute and set it equal to the appropriate value
specified by the processing script:

<select name="pets”>
3. To format the menu as a multiline list, add a size attribute to the

opening <select> tag and set it equal to a numeric value signifying
the number of list options you want to make visible:

<select name="pets” size="4">

4. To permit users to make multiple selections from the list, add a
multiple attribute and set it equal to multiple:
<select name="pets” size="4" multiple="multiple”>

5. To define your list options, move to the next line, indent, and enter
the items between the opening and closing <options> tags:
<select name="pets” size="4" multiple="multiple”>

<options>Dogs</options>

6. To specify an initial value for an option, define a value attribute for
the <options tag and set it equal to the value to be sent to the pro-
cessing script. If this attribute is not defined, the initial value is set to
the content you placed between the <options tags:

<select name="pets” size="4" multiple="multiple”>
<option value="k9”>Dogs</option>
7. 'To specify one option as preselected, define a selected attribute for
the <option> tag and set it equal to selected:

<select name="pets” size="4" multiple="multiple”>
<option value="k9” selected="selected”>Dogs</option>
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8. Once you've defined all your list options, complete the selection list Task 58

with a closing </select> tag. Listing 58-1 provides an example of a
simple selection list. Figure 58-1 displays the resulting page in a
browser.

<html>
<head>
<title>Selection Lists</title>
</head>
<body>

<form action="/cgi-bin/pet count.pl” method="post”>
<p>What kinds of pets do you have?</p>

<select name="pets” size="4" multiple="multiple”>
<option value="canine”>Dogs</option>
<option value="feline”>Cats</option>
<option value="avian”>Birds</optionx>
<option value="equine” >Horses</options>
</select>

<p>To make multiple selections, hold down your Ctrl key
(Win) or your Command key (Mac)</p>

</form>
</body>
</html>

Listing 58-1: A simple multiple-choice selection list

What kinds of pets do you have?

Barcs

To malee multiple selections, hold dewn your Cirl key (Win) o your Command key (Mac)

| € A9 ] :
Figure 58-1: A simple multiple-choice selection list rendered in the browser
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Formatting File Fields

ile fields allow your site’s visitors to upload files from their hard drive to the

Web server. The file field appears as a text field with a Browse button to the
right. The file field form control uses the <input > tag. Here the type attribute
is set equal to file.

1. Insertan <inputs> tag.

2. Add a type attribute and set it equal to file:
<input type="file”>

3. Define a name attribute, setting it equal to the appropriate value
specified by the processing script.
<input type="file” name="upload”>

4. 'To specify how many characters wide the file field should be, define a

size attribute and set it equal to a numeric value representing the
width of the text field in characters:

<input type="file” name="upload” size="20">

5. To specify a maximum number of characters the user can enter into
the field, define a maxlength attribute and set it equal to a numeric
value:

<input type="file” name="upload” size="20" maxlength="50">

6. To limit the type of files a visitor can upload, define an accept
attribute and set it equal to the MIME type of the files you want to
allow:

<input type="file” name="upload” size="20" maxlength="50"
accept="image/gif”>

7. 'To make the <input > tag compatible with XHTML and keep it rec-
ognizable to non-XHTML browsers, conclude the tag by inserting a
space after the last attribute value and adding a forward slash and
closing bracket:

<input type="file” name="upload” size="20" maxlength="50"
accept="image/gif” />




Working with Forms -

Listing 59-1 provides a simple file field example. Figure 59-1 displays
the result in a browser.

<html>
<head>
<title>File Fields</title>
</head>
<body>

<form action="/cgi-bin/image files.pl” method="post”>
<p>Upload Your GIF Images Here:</p>

<input type="file” name="upload” size="20"
accept="image/gif” />

</form>
</body>
</html>

Listing 59-1: A simple file field

Upload Your GIF Images Here

Figure 59-1: Clicking the Browse button opens a dialog box from which to select a
file for uploading
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Formatting Submit and Reset Buttons

ite visitors click buttons either to send the completed form to the server (the

Submit button) or to clear the form if they’ve made a mistake (the Reset but-
ton). You don’t get many choices to style basic form buttons, other than what text
you put on them. They’re typically rendered with beveled edges, in neutral gray
with black text on the face.

1. To create a Submit button, insert an <input> tag.

2. Add a type attribute and set it equal to submit:
<input type="submit”>

3. To specify the text on the button face, add a value attribute and set
it equal to the text you want:
<input type="submit” value="Submit”>

4. To create a Reset button, insert an <input > tag and add a type

attribute set equal to reset. Use the value attribute to specify the
text on the button face:

<input type="reset” value="Reset”>

5. If the processing script demands it, define a name attribute, setting it
equal to the appropriate value:

<input type="submit” value="Submit” name="submit”>
<input type="reset” value="Reset” name="reset”>

6. To make the <input> tag compatible with XHTML and keep it rec-
ognizable to non-XHTML browsers, conclude the tag by inserting a
space after the last attribute value and adding a forward slash and
closing bracket:

<input type="submit” value="Submit” name="submit” />

<input type="reset” value="Reset” name="reset” />

Listing 60-1 shows a simple form with Submit and Reset buttons in
place. Figure 60-1 renders the resulting page in a browser.
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<html>
<head>
<title>Submit & Reset Buttons</title>
</head>
<body>

<form action="/cgi-bin/message.pl” method="post”>
E-mail Address:<br>
<input type="text” name="email” size="20" />

<br>
<br>

Message:<br>
<textarea cols="50" rows="10" wrap="virtual” name="message”>

</textarea>

<br>
<br>

<input type="submit” value="Send Me” />
<input type="reset” value="Clear Me” />
</form>

</body>
</html>

Listing 60-1: A simple form with Submit and Reset buttons

E-madl Address

Figure 60-1: A simple form with Submit and Reset buttons rendered by the browser
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Task 61 Using Graphic Images for
Submit Buttons

f the browser’s neutral-gray, rectangular Submit button isn’t to your liking, you
can substitute it for a graphic using a form control called an image field.

1. Insert an <inputs> tag.

2. Add a type attribute and set it equal to image:
<input type="image”>

3. To specify the image to be used, add a src attribute and set it equal
to the image’s pathname. For example:
<input type="image” src="images/button.gif”s>

4. Specify the image’s dimensions with width and height attributes,
setting them equal to numeric pixel values:
<input type="image” src="images/button.gif” width="25"
height="25">

5. To specify an image border, define a border attribute:
<input type="image” src="images/button.gif” width="25"
height="25" border="1">

6. If the processing script requires it, define a name attribute:
<input type="image” src="images/button.gif” width="25"
height="25" border="1" name="submit_ image”>

7. Define the alt attribute and set it equal to your chosen alternate text
for the image:
<input type="image” src="images/button.gif” width="25"

height="25" name="submit_ image” alt="Submit”>

8. 'To make the <input> tag compatible with XHTML and keep it rec-
ognizable to non-XHTML browsers, conclude the tag by inserting a
space after the last attribute value and adding a forward slash and
closing bracket:

<input type="image” src="images/button.gif” width="25"
height="25" name="submit image” alt="Submit” />
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Listing 61-1 shows an example of an image field in use. Figure 61-1 Task
displays the finished work in a browser.

<html>
<head>
<title>Graphic Submit Buttons</titles>
</head>
<body>

<form action="/cgi-bin/message.pl” method="post”>

E-mail Address:<br>
<input type="text” name="email” size="20" />

<br>
<br>

Message:<br>
<textarea cols="50" rows="10" wrap="virtual” name="message”>
</textareas

<br>

<input type="image” src="images/button.gif” width="25"
height="25" name="submit_ image” alt="Submit” />

</form>
</body>
</html>

Listing 61-1: An image field substituting for the generic Submit button code

suban

Figure 61-1: The graphical submit button rendered in the browser
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Using Hidden Fields

ach of the form controls you’ve seen so far sends data to a script in response to

an action taken by the visitor, who types something into a field, clicks a check
box or radio button, selects something from a menu or list, and so forth. HTML
provides a mechanism by which you can include values in your form to be sent to
the script that visitors never see. These values are defined using hidden fields.

1.
2.

Insert an <input> tag.

Define a type attribute and set it equal to hidden:

<input type="hidden”>

Define a name attribute and set it equal to the appropriate value
specified by the processing script:

<input type="hidden” name="customer site”>

Define a value attribute and set it equal to whatever information
you want the field to pass to the script when the form is submitted:
<input type="hidden” name="customer site” value="Alpha-

Gizmo” >

"To make the <input> tag compatible with XHTML and keep it rec-
ognizable to non-XHTML browsers, conclude the tag by inserting a
space after the last attribute value and adding a forward slash and
closing bracket:

<input type="hidden” name="customer site” value="Alpha-
Gizmo” />

Listing 62-1 shows an example of a hidden field that sends data to a
script. Figure 62-1 shows how that data could be used by a script to
generate a special message to the visitor.

Saloct the Hewleners pou wueh 1o recewe.
I Ovad Fppene Weekly

P Do-lt-Yoursel Koot Camalm 10 Strpa or Lesa
7 Chade 4o Home Dentwiry

ey

3

Another Loyal Alpha-Gizmo
Customer!

Thask el
Wl ik pas pour Do Yaurmel Boot Canal in 10 Sieps or Lews Nrwaleiter oght seyl

Figure 62-1: The script returns a second page that makes use of the information
supplied by the hidden field
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<html>
<head>
<title>Hidden Fields</title>
</head>
<body>

<form action="http:// www.some-domain.com/cgi-bin/dental.pl”
method="post” >

<input type="hidden” name="web site” value="Alpha-Gizmo” />

Select the Newsletters you wish to receive:<brs>
<br>

<input type="”checkbox” name="newsletter”
value="oral hygiene” /> Oral Hygiene Weekly<brs>

<input type="checkbox” name="newsletter” value="root canal”
/> Do-It-Yourself Root Canal in 10 Simple Steps or Less<br>

<input type="”checkbox” name="newsletter”
value="home dentistry” /> Guide to Home Dentistry

<br>
<br>

<input type="submit” name="Submit” value="Submit” />
<input type="reset” name="reset” value="Reset” />

</form>
</body>
</html>

Listing 62-1: A hidden field that tells the script which Web site this form is from
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Specifying the Focus Order of
Form Controls

n a page with several form controls, pressing Tab moves the cursor from the

first form control to the last. By default, the page’s focus is the first form con-
trol on the page. You can control not only the Tab order but also the specific keys
that bring the focus to a particular form control. Both of these methods allow
users to bypass the mouse when they enter information on the form, and they are
typically included for visitors with speaking browsers.

1. Define a tabindex attribute for each form control you want to
affect.

2. Set each tabindex attribute equal to a numeric value, in the order
you want them to be focused on when people press the Tab key. For
example, tabindex="1" is first, tabindex="2" is second, and so
on, as shown in Listing 63-1.

3. To make a specific key bring a form control into focus, define an
accesskey attribute for the form control and set it equal to the key
letter or number. For example:

<input type="text” name="organization” size="20"

accesskey="0" />

4. Include explicit notes about your access key assignments within your
site (see Figure 63-1).

This webpage uses the  Windows ssers. hold dews the Alt
Iotters l.rll'ﬂ.h.:l'lulid.ulm

the Contral key. Then prezen

Figure 63-1: Instructional text that helps people navigate the form without the mouse
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<html>
<head>
<title>Focus Order</title>
</head>

<body bgcolor="#FFFFFF” text="#000000">
<form action="/cgi-bin/newsletters.pl” method="post”>

User Name: <br>
<input type="text” name="user” size="20" tabindex="7" />
<br>

E-mail Address:<br>
<input type="text” name="email” size="20" tabindex="6" />

<br>

Join the Mailing list?<br>

<input type="radio” name="mailing” value="yes” checked
tabindex="5" />

Yes<br>

<input type="radio” name="mailing” value="no” tabindex="4"
/>

No<br>

Select a Newsletter:<br>

<select name="select” tabindex="3">
<option>Chiropractic Accidents</options>
<option>Medical Love Stories</options
<option>Dental Torture made Easy</optionx>

</select>

<br>

<br>

<input type="submit” name="Submit” value="Submit”

tabindex="2" />

<input type="reset” name="Submit2” value="Reset”

tabindex="1" />

</form>
</body>
</html>

Listing 63-1: Defining tabindex attributes in reverse order
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Using Field Sets

Field sets allow you to group a series of related form controls visually and
structurally. Doing so gives users (of visual browsers) a greater understanding
of the form by wrapping related controls inside a gray or black border with an
accompanying caption (rendered with the <legend> tag). Text-to-speech and
Braille browsers use the captions to inform users about the section of the form
they’re in.

1. Insert the opening <fieldset> tag above the first form control in
the group.

2. Insert opening and closing <legend> tags immediately following the
the opening fieldset tag. For example:

<fieldset>
<legend></legend>

3. Place the text you want displayed as the f£ieldset’s caption between
the <legend> tags:
<fieldset>
<legend>Personal Information</legends
4. At the end of the group of form controls, insert a closing
</fieldset> tag.

Listing 64-1 shows a completed form using a field set. Figure 64-1
shows how Netscape renders the field set.
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<html>
<head>
<title>Field Sets</title>
</head>

<body>
<form action="/cgi-bin/data.pl” method="post”>
<fieldsets>
<tablex>

<trs>

<td>Last Name:</td>

<td><input name="personal lastname” type="text”
tabindex="1" /></td>

</tr>

<tr>

<td>First Name:</td>

<td><input name="personal firstname” type="text”
tabindex="2" /></td>

</tr>

<tr>

<td>Address:</td>

<td><input name="personal address” type="text”
tabindex="3" /></td>

</tr>
</table>
</fieldset>
</form>
</body>
</html>

Listing 64-1: A sample form using a field set

Figure 64-1: How Netscape renders the form that uses a field set
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Defining Frameset Documents

frameset document is a set of instructions for dividing the browser window

into separate panes. Each pane is called a frumze. The frameset document
defines the orientation of each frame, their physical properties, and the filenames of
the other HTML documents displayed within them. In this task, we lay out a base
frameset document. Subsequent tasks demonstrate how to flesh the document out.

1. Inyour text editor, open a new document and define the opening and
closing <html> tags, including a simple head section, as shown in
Listing 65-1.

<html>

<head>
<title>Frames</title>

</head>

</html>

Listing 65-1: Basic tags of any Web page, without <body> tags

2. Below the closing </head> tag, insert an opening <frameset > tag,
as shown in Listing 65-2.

<html>

<head>
<title>Frames</title>

</head>

<frameset>

</html>

Listing 65-2: An opening <frameset> tag

3. Move to the next line, indent, and add a <frame> tag for each frame
you want to define, as shown in Listing 65-3.

<html>

<head>
<title>Frames</title>

</head>

<frameset>
<frame>
<frame>

</html>

Listing 65-3: Adding empty frame tags
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4. To specify which document should be displayed in a frame, define a Task 65

src attribute for the <frame> tags and set them equal to the chosen
document’s pathname, as shown in Listing 65-4.

<html>

<head>
<title>Frames</title>

</head>

<frameset>
<frame src="nav.html”>
<frame src="opening main.htm”>

</html>

Listing 65-4: Defining src attributes for each <frameset> tag

5. To make the <frame> tag compatible with XHTML and keep it rec-
ognizable to non-XHTML browsers, conclude the tag by inserting a
space after the last attribute value and adding a forward slash and
closing bracket, as shown here:

<frame src="nav.html” />
6. To close the frameset, move to the next line, return to the left mar-

gin, and insert a closing </frameset> tag. This initial document
appears in Listing 65-5.

<html>

<head>
<title>Frames</title>

</head>

<frameset>

<frame src="nav.html” />

<frame src="opening main.htm” />
</frameset

</html>

Listing 65-5: Building a basic frameset document
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Specifying Frame Dimensions

frame’s dimensions and their orientation are defined by two attributes: rows

and cols. Their values don’t correspond to the number of rows or columns
you want to create. Instead, these attributes accept multiple column width and
row height values, separated by commas. The syntax works like this:

cols="width of the first column, width of the second
column, etc.”

rows="height of the first row, height of the second row,
etc.”

1. To create a frameset of columns, add the cols attribute to the
<frameset> tag:
<frameset cols>

2. Set the cols attribute equal to the widths of each column you want
to create. Separate each value with commas. For example:
<frameset cols="150, *”>

3. To create a frameset of rows, add the rows attribute to the
<frameset> tag:
<frameset rows>

4. Set the rows attribute equal to the height of each row you want to
create. Separate each value with commas, as shown here:
<frameset rows="75, *, 30">

5. For each row or column defined by the rows or cols attribute,
include a <frame /> tag within the frameset.
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Listing 66-1 shows the completed code for a two-column frameset.
Figure 66-1 shows that frameset displayed in a browser.

<html>

<heads>
<title>Frames</title>

</head>

<frameset cols="150, *”>
<frame src="left.html” />
<frame src="right.html” />

</frameset>

Listing 66-1: Code for a two-column frameset

2 Frames - Microsofl Internat E xplorer
Ele [dit View Faveiites Jooh Help
¢ g i 4 a2 W F I o I

Sop  Mebeih  Wome | Seach Faovober Meds  Mesoy  Mal P

This is | This is right.html
left.html

2] Done 7 vy Computes

Figure 66-1: A two-column frameset rendered in the browser

Task 66

tips

= To ensure that a frame

stays at a specific pixel
dimension, you need to mix
absolute pixel values with
relative values. For exam-
ple, the code shown in
Step 2 creates a first fixed
column that is 150 pixels
wide and leaves the rest of
the browser window over to
the second frame, which
expands and contracts as
the browser window
resizes.

Although not typically
done, you can define both
the cols and rows attrib-
utes simultaneously. For
example, <frameset
rows="1%, 6 1* 1*"
cols="1%,1%,1%">
would create a three-row,
three-column frameset of
equally sized frames.

cross-reference
= As you define a row or col-

umn, instead of using a
<frame /> tag, nesta
whole other frameset
(see Task 69).
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Task 67 Specifying Border Properties

H owever you define a frame’s border properties has a large impact on the look
and feel of your layout. You can leave borders to their default settings — free
to be repositioned by the visitor — or you can lock them in place to enforce a
specific boundary. You can also modify their color, set their thickness, make them
flat, or hide them completely.

notes
0 Femne s fe cEhEs 1. To disable borders, define a frameborder attribute for the
by default. A yes value <frameset> tag and set it equal to no:
simply hard-codes the
default browser behavior. <frameset cols="150, *” frameborder="no”>

When enabled, frame bor-
ders appear as gray, bevel-
edged bars, approximately
5 pixels thick. A no value

Figure 67-1 shows the result.

flattens the borders. D5 rames  Microsoh Intarmet £ aplorer

Internet Explorer displays File Edit View Fawoiites Tooh Help

borders roughly 2 pixels - -0 2 ) A F 3
thick (see Figure 67-1), Sop  Pebwh Home | Seach Favder Mede Wiy
provided no value has been ) L X

defined forthesboréier This is | This is right.html
attribute (see Step 2).

Netscape flattens the bor- IEft'html

ders also but leaves them

5 pixels thick.

= Apply this attribute to the
<frameset > tag to govern
the border’s appearance for
all borders in the layout.
Apply it to the <frame>
tag to affect specific
frames. Be aware that
frames sharing a common
border can’t have conflict-
ing frameborder values.

2] Done 7 vy Computes

* Aborder value of O ren-
ders borders invisible in
Netscape (see Figure 67-2).
Internet Explorer also 2. 'To modify the thickness of frame borders, add a border attribute to

requires the frameborder the <frameset > tag and set it equal to a numeric value representing
Sl e sel Eael e the border’s width in pixels:

Figure 67-1: Disabling the frame border in Internet Explorer

<frameset cols="150, *” frameborder="no” border="0">

Figure 67-2 shows the result.
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& Frames - Momcape .
" File Edit View Go Bookmarks Took Window Help Task 6]

.ﬁ. T “‘a“ __!;: = [ £ Hlez/ C/WINDOWS Destiop index. hm! = @
T om, Mall Y Home T Radie i Memcape “LSearch ) Shop . }Bockmarks o Fres AOL & Unlimite... & Instant
]l of Frames I »

This is This is right.html
left.html

e wle A

2 (3 Decument: Done 0.17 secs et s

Figure 67-2: Hiding borders in Netscape

3. To prevent users from resizing the border of a specific frame by drag-
ging on it, add a noresize attribute to the <frame> tag represent-
ing the frame you want to lock. For example:

<frame src="left.html” noresize />

4. 'To make the noresize attribute compatible with XHTML, set it
equal to noresize, as shown here:

<frame src="left.html” noresize="noresize” />

5. To specify border colors, add a bordercolor to either the <frame>
tag (to modify a specific frame) or the <frameset> tag (to govern all
borders in the layout). Set the attribute equal to either a hexadecimal
value or predefined color name. For example:

<frame bordercolor="#000000">

<frameset bordercolor="black”>
cross-reference

= Some of the early browsers
didn’t support frames, which
required Web designers to
include noframes content
(see Task 71).
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Controlling Frame Margins and
Scroll Bars

he content inside a frame impacts scroll bar behavior. Scroll bars appear

whenever there’s more content than can fit within the defined dimensions of
the frame. This means that scroll bars often pop up when a browser window is
resized or if the visitor’s monitor resolution is set sufficiently low. The margin
settings you specify can add to or subtract from the volume of content in a frame.

1. Open the frameset document you want to edit.

2. To specify the width of a frame’s left and right margins, add a mar-
ginwidth attribute to its <frame> tag and set it equal to a numeric
value that represents the margin’s pixel width.

3. To specify the height of a frame’s top and bottom margins, add a
marginheight attribute to its <frame> tag and set it equal to a
numeric value that represents the margin’s pixel width. Listing 68-1
shows margin width and height defined for one frame. Figure 68-1
shows the result in Internet Explorer.

<html>
<head>
<title>Frame Margins</title>
</head>

<frameset cols="150, *” framborder="no” border="0">
<frame src="left.html” />
<frame src="right.html” marginwidth="50"
marginheight="25" />
</frameset>

</html>

Listing 68-1: Margin attributes set for one frame
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2 Frames - Microsofl Internat E xplorer
Ele [dit View Faveiites Jooh Help
) 2

Siop  Mebeh  Home | Seach

This is This is right.html with a margin
width of 50 pixels, and a margin
height of 25 pixels.

left.html

2] Done ) My Compustes
Figure 68-1: Margin effects displayed in Internet Explorer

4. To control the scroll behavior of a frame, add a scrolling attribute
to the <frame> tag:

<frame src="left.html” scrolling>

5. Set the attribute equal to one of the following three values:

* vyes displays scroll bars regardless of the amount of content in
the frame

* no disables scroll bars entirely

* auto displays scroll bars if the frame content is sufficient to
require them (this is the default browser behavior)

cross-reference

= Coding frames can take
some time to get used to.
Many WYSIWYG editors
make the process a bit
easier. If you're curious
about those editors, see
Part 15 (Working with
Dreamweaver) and Part 16
(Working with FrontPage).



- Part 8

Nesting Framesets

Tables allow you to span columns and rows, but the colspan and rowspan
attributes aren’t available for the <frameset> tag. To achieve similar results,
you’d instead nest a frameset in place of a <frame> tag.

1. Create that initial frameset, defining either columns or rows with the
cols or rows attribute, as shown in Listing 69-1.

<frameset rows="75, *">
<frame src="top.html” />

</frameset>

Listing 69-1: Beginning a basic frameset

2. In place of one of the frame tags, insert an opening <frameset > tag,
as shown in Listing 69-2.

<frameset rows="75, *">
<frame src="top.html” /> <!-- First row: 75 pixels -->

<!-- Second row: to be filled by nested frameset -->
<frameset cols="150, *">

</frameset>

Listing 69-2: The parent frameset’s second row occupied by the nested frameset

3. Enter the <frame> tags for the nested frameset, as shown in

Listing 69-3.
<frameset rows="75, *">
<frame src="top.html” /> <!-- First row: 75 pixels -->
<!-- Second row: to be filled by a nested frameset -->

<frameset cols="150, *">
<frame src="left.html” />

<frame src="right.html” />

</frameset>

Listing 69-3: Nesting frames inside the frameset
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4. Close the nested frameset with a closing </frameset> tag. Listing Task 9
69-4 shows the completed code, and Figure 69-1 shows the results in

a browser.

<html>
<heads>
<title>Nesting Frames</title>
</head>
<frameset rows="75, *">
<frame src="top.html” /> <!-- First row: 75 pixels -->

<!-- Second row: filled by the nested frameset -->

<frameset cols="150, *”>
<frame src="left.html” />
<frame src="right.html” />
</frameset>

</frameset>
</html>

Listing 69-4: Completed code for nested frames

2 Frames - Microsofl Internat E xplorer

Eite Edit View Fawvorites Took Help

g a9 4 2 &
Sop  Pepwih  Home | Sesch Fovoes

This is top.html

This is | This is right.html
left.html

cross-reference
- = Most frame-based layouts
) ) 0y Compen place the main navigation

Figure 69-1: Nested frames in Internet Explorer links in one frame and the
documents they point to in

another (see Task 70).
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Task 0 Targeting Frames

Hyperlinks displayed in one frame can be written in such a way that the docu-
ments they point to are opened within other frames in the frameset. By giv-
ing your frames names (via the name attribute), you can reference those frames

using the <a> tag’s target attribute, setting it equal to the name of a particular
frame.

1. In the frameset document, add name attributes to each <frame> tag
and set them equal to a descriptive term. For example, left frame
or right frame, as shown in Listing 70-1.

<html>
<head>
<title>Targeting Frames</title>
</head>
<frameset rows="75, *">
<frame src="top.html” name="top frame” />

<frameset cols="150, *">
<frame src="left.html” name="left frame” />
<frame src="right.html” name="right frame” />
</frameset>

</frameset>
</html>

Listing 70-1: Describing each <frame> tag with name attributes

2. In the document containing the hyperlinks you want to target, add
the target attribute to each <a> tag and set it equal to the frame
name you want the linked documents to be displayed in. For exam-
ple, target="right_frame”, as shown in Listing 70-2.

<html>
<head>
<titlesLeft Frame</title>
</head>

<body bgcolor="red” text="white”>

<!-- This is left.html -->

<a href="home.html” target="right frame”>Home</a> <br>

<a href="about.html” target="right frame”>About Us</a><br>

<a href="contact.html” target="right frame”>Contact Us</a>

</body>
</html>

Listing 70-2: Targeting each <a> tag with a target attribute
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3. To make all links in a document open in a specific frame without Task 0
using the target attribute, add a <base> tag to the document’s
head section, as shown here:

<head>
<title>Targeting Frames</title>
<base />

</head>

4. Define a target attribute for the <base /> tag and set it equal to
the frame name you want the linked documents to be displayed in.
For example:

<head>
<title>Targeting Frames</titlex>
<base target="right_frame” />
</head>

5. "To make a link’s document open in a new browser window, set the
target attribute equal to » blank”:

<a href="contact.html” target="_blank”>Contact Us</a>
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Providing noframes Content

ames weren’t initially part of the HTML specification. They were intro-
duced in Netscape 2.0 and adopted shortly thereafter in Internet Explorer
3.0. Earlier browsers don’t support frames. To provide content for these older
browsers, noframes content has been the traditional method of making frames-
based sites backwards-compatible.

1. Open the frameset document in your text editor.

2. Below the closing </frameset > tag, enter an opening <noframes>
tag, as shown in Listing 71-1.

<html>
<head>
<title>No Frames</title>
</head>
<frameset rows="75, *">
<frame src="top.html” />

<frameset cols="150, *">
<frame src="left.html” />
<frame src="right.html” />
</frameset>
</frameset>

<noframess>

</html>

Listing 71-1: Start after the closing </frameset> tag
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3. Enter any type of text you’d place in the body section of a normal Task
HTML document, as shown in Listing 71-2.

<html>
<head>
<title>No Frames</title>
</head>
<frameset rows="75, *">
<frame src="top.html” />

<frameset colg="150, *">
<frame src="left.html” />
<frame src="right.html” />
</frameset>

</frameset>
<noframes>
<p>Your browser doesn’t support frames.<br>

Don’t panic. Simply go <a href="index-2.html”>here...</a>
</p>

</html>

Listing 71-2: Adding text to explain to people what to do if their browsers don’t
support frames

4. Close the noframes section with a closing </noframess> tag:

<noframes>

<p>Your browser doesn’t support frames.<br>

Don’t panic. Simply go <a href="index-2.html”>here...</a>
</p>

</noframes>
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Task 2 Working with Inline Frames

Inline frames are an invention of Microsoft. When rendered, they create a float-
ing, scrollable pane within the body of a regular HTML file. Microsoft must
have figured that since Netscape invented frames, they could do them one better.
The only problem is that, unlike frames which are supported by virtually all
browsers, no one but Internet Explorer supports inline frames. Still, developers
do occasionally make use of them. For example, when designing for an intranet (a
closed group of users, typically within an office, who have access to a private Web
server), where the browser being used is identical to all members, taking advan-
tage of a proprietary feature isn’t such a risk.

1. To insert an inline frame, insert an opening <iframe> tag within the
body section of a document.

2. Add a src attribute and set it equal to the pathname of the document
you want displayed within the frame:

<iframe src="content.html”>

3. Add a name attribute to allow the inline frame to be targeted and set
it equal to an appropriate value:
<iframe src="content.html” name="iframe 1”>

4. To specify the inline frame’s dimensions, include width and height
attributes and set them equal to pixel or percentage values:
<iframe src="content.html” name="iframe 1” width="400"

height="200">

5. 'To control the margins inside the inline frame, add marginwidth
and marginheight attributes as you would to a standard
<frame> tag:

<iframe src="content.html” name="iframe 1” width="400"
height="200" marginwidth="25" marginheight="25">

6. To float the inline frame to the left or right, similar to an image or
table, add an align attribute and set it equal to left or right:

<iframe src="content.html” name="iframe 1” width="400"
height="200"” marginwidth="25" marginheight="25"
align="1left”>

7. Follow the opening <iframe> tag with some form of instructional
content you want rendered by browsers that don’t support this tag.
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8. Inserta closing </iframe> tag to complete the inline frame. Listing
72-1 shows a simple inline frame document. Figure 72-1 shows the
effect in Internet Explorer.

<html>
<head>
<title>Inline Frames</title>
</head>

<body bgcolor="#333333" text="#FFFFFF">

<iframe src="http://www.highstrungproductions.com”
width="50%" height="50%" align="left”s>

<a href="http://www.highstrungproductions.com”> Go here!
</a>

</iframe>

<p>

<font face="Arial, Helvetica, sans-serif” size="2">
<b>This is one of my favorite web sites. It hasn’t been
updated in years...</b></font></p>

</body>
</html>

Listing 72-1: A simple inline frame document.

D inline Frames Miciosoh Internet | xplotes

File Edit View Favorites Took Help

This is ane of my lavarite web sites. It hasn bean
updated in year.
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| Done ) ko fore (M)

Figure 72-1: Showing a simple inline frame in Internet Explorer

cross-reference
= See Part 3 to learn about
aligning images. Part 6
covers aligning tables.
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Writing Style Rules

To quote its creators, “Cascading Style Sheets (CSS) is a simple mechanism for
adding style (e.g., fonts, colors, spacing) to Web documents.” The purpose is
to separate structure from style, leaving HT'ML to deal with the former while
CSS takes over the latter. With the birth of CSS, any HT'ML markup that deals
purely with how things should look is deprecated (no longer approved of). Instead,
CSS should be used. CSS’s syntax is slightly different from HTML. Angle brack-
ets, equal signs, and quotation marks disappear in favor of curly braces, colons,
and semicolons. Where HTML uses tags and attributes, CSS rules use selectors
(the element that the style defines), selectors have declarations (which contain
properties), and properties are assigned values (see Figure 73-1).

p { color: green }

Selector Declaration

Figure 73-1: Anatomy of a CSS style rule

Define a selector for the style rule.
Follow the selector with an opening curly brace.

Enter a property name, followed by a colon.

Ea o

Follow the colon with a space, supply a value for the property, and
conclude the property/value pair with a semicolon.

5. Move to a new line, and enter the second property/value pair.
Conclude each pair with a semicolon.

6. When the declaration contains all the properties you want to add,
end the declaration with a closing curly brace.
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Listing 73-1 shows a style rule for the <p> tag.

o) { font-family: Arial, Helvetica, sans-serif;
font-size: 12px;
color: #000000 }

Listing 73-1: A style rule with three defined properties

7. To assign a single declaration to a series of selectors, simply enter the
selectors as a comma-separated list, as shown here:

hl, h2, h3 { font-family: Arial, Helvetica, sans-serif }

8. To set selectors so that they only affect a tag when it appears under
specific circumstances, separate a number of selectors with a space.
For example:

hl b { color: red }

"This type of style definition (called a descendant style) tells the browser
only to apply this style to bold text used with level-1 headings.

9. To use CSS syntax within the flow of an HTML document, add a
style attribute to the tag you want to affect and set it equal to an
appropriate series of property/value pairs, each separated by semi-
colons, as shown in Listing 73-2.

<p style="font-family: Arial, Helvetica, sans-serif; font-
size: 12px; color: #000000">

Listing 73-2: CSS syntax applied inline to a paragraph tag
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Creating an Embedded Style Sheet

By embedding a style sheet we mean placing CSS code within the HTML
document itself. The code is written within a style element (defined by
opening and closing <style> tags) located in the head section of the document
(defined by opening and closing <head> tags). Embedded style sheets affect only
the specific HT'ML document in which the CSS code resides.

1. In the head section of an HTML document, enter an opening
<style> tag.

2. Define a type attribute for the <style> tag and set it equal to
text/css.

3. Insert one or two new lines and enter an opening comment tag, so
that your head section resembles Listing 74-1.

<head>
<title>Embedded Styles</title>

<style type="text/css”>

<!--

</head>

Listing 74-1: The opening <style> tag
4. Insert another line or two and begin entering selectors and declara-
tions, as described in Task 73.

5. To close the embedded style sheet, enter a closing comment tag,
followed by a closing </style> tag.
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Listing 74-2 shows a completed embedded style sheet.

<head>
<title>Embedded Style Sheets</title>

<style type="text/css”>

<!l--

o) { font-family: Verdana, Arial, Helvetica, sans-serif;
font-size: 1llpx;
color: #000000; }

hl { font-family: Verdana, Arial, Helvetica, sans-serif;
font-size: 22px;
color: #000000; }

h2 { font-family: Verdana, Arial, Helvetica, sans-serif;
font-size: 18px;
color: #000000; }

h3 { font-family: Verdana, Arial, Helvetica, sans-serif;
font-size: 1l4px;
color: #000000; }

-->
</style>
</head>

Listing 74-2: An embedded style sheet
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Creating an External Style Sheet

xternal style sheets are separate documents containing nothing but style rules.

You attach these style sheets to HT'ML documents using a link reference,
effectively allowing you to attach a single style sheet document to as many Web
pages as you like. This way you only need to change one style sheet document to
update the formatting of elements across every page to which the style sheet
document is attached.

1. Open a new blank document in your editor and enter the styles you
wish to define. Listing 75-1 provides an example.

body { color: #000000;
background: #FFFFFF;
margin-left: 100px;
margin-right: 100px;
margin-top: 100px }

hl { font-family: Arial, Helvetica, sans-serif;
font-size: 20px;
font-weight: bold }

p { font-family: Arial, Helvetica, sans-serif;
font-size: 12px;

text-align: Justify }

Listing 75-1: A sample style sheet

2. Save the file with a .css extension within the directory you’re using
for your local site files (see Figure 75-1).

Figure 75-1: Saving the style sheet

3. Open the HTML documents to which you want to attach the style
sheet. Within the head section of each document, insert a <1ink>
tag with a rel attribute set equal to stylesheet, and a type
attribute set equal to text/css.
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4. Add a final attribute to the <1ink> tag, href, and set it equal to the Task
appropriate pathname of the .css file you saved in Step 2. Listing
75-2 shows the complete code and Figure 75-2 shows the document
rendered in a browser.

<html>
<head>
<title>External Style Sheets</title>
<link rel="stylesheet” type="text/css”
href="10_ steps.css” />
</head>

<body>

<hl>Creating an External Style Sheet</hl>

<p>External style sheets are separate documents containing
nothing but style rules. These types of style sheets are
attached to HTML documents using a link reference,
effectively allowing you to attach a single style sheet
document to as many web pages as you like. Using this
approach you only need to make change to the individual
style sheet document to update the formatting of elements
across every page to which the style sheet document is
attached.</p>

</body>

</html>

Listing 75-1: A sample HTML document containing a link reference to an external style
sheet

Creating an External Style Sheet

Exeinal diyle Sheets &fe SepArals SOcusHANtS centhising noMng et Sivie ruiles. Thede hpes of
siyle shosls are slieched 10 HTML documents using & Bnk refesends, oSisciively allowiag you is
aRach o singie sivle shewt document to os meany web pages 88 you e, Usisg Bhis spprosch you
Oy need 1 BNAE Changt 16 Me INEMSUM SN0 SROE! OOCEMENt 10 UPOSIE The BMEASRg Of
olormpnds SCI04E Gviry Dage B0 mihich Tuk Sivle ahae! decement it aladhid

T |

Figure 75-2: An HTML page whose formatting is defined solely in an external style
sheet
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Defining Style Classes

hen you create a style class, you specify your own unique selector name and
attach a style declaration to it. You can apply your classes to any tag by
using the class attribute.

1. Type a period followed by a unique class name in the selector posi-
tion of your style rule. For example:

.citation

2. Follow the class selector with a declaration by entering an opening
curly brace, defining your desired properties, and completing the
declaration with a closing curly brace:

.citation { font-family: “Times New Roman”, Times, serif;
font-size: 12px;
font-style: italic }

3. Apply the class to your chosen HTML tag by adding a class attribute
and setting it equal to the class name (without the period):
<div class="citation”>

4. Limit classes to a particular tag by preceding the class selector with

the tag character. The following example makes sure the class can
only be implemented with the <p> tag:

p.citation { font-family: Times New Roman, Times, serif;
font-size: 12px;
font-style: italic }

5. Specify unique ID classes by preceding a class name selector with a
pound sign and applying them to a tag using the ID attribute:
#preamble { font-family: Arial, Helvetica, sans-serif;

font-size: 20px; }

<hl ID="preamble”>Preamble</hl>

Listing 76-1 shows an embedded style sheet that makes use of both a
standard and ID class. Figure 76-1 displays the results in a browser.
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<html>
<head>
<title>Style Classes</title>

<style type="text/css”>

<!l--

.citation { font-family: “Times New Roman”, Times, serif;
font-size: 12pt;
font-style: italic }

#preamble { font-family: Arial, Helvetica, sans-serif;
font-size: 20pt; }
-->

</style>

</head>

<body>

<hl ID="preamble”>Preamble</hl>

<p class="citation”>"We the People of the United States, in
Order to form a more perfect Union, establish Justice,
insure domestic Tranquility, provide for the common defense,
promote the general Welfare, and secure the Blessings of
Liberty to ourselves and our Posterity, do ordain and
establish this Constitution for the United States of
America.” </p>

</body>
</html>

Listing 76-1: Example of standard and ID classes

Preamble

'MuhﬁhpbqﬂhLhn@&ﬂuunaﬁrnubmanmvahlUumamﬂhﬂ&nunm-ndnunr
the

the general Welfare, and secure the Blessinge of Liberty
mawuhnmdawﬂumm»dnmhmmu«muﬁducmuwmmjwﬂcUNdﬂWuqmuﬂnm

Figure 76-1: A standard class (the citation) and an ID class (the heading) rendered in
the browser
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Defining the font-family Property

he font-family property in CSS functions identically as the face attribute

of the <font> tag in HMTL. Use this property to specify a prioritized list of
fonts with which the browser should attempt to render an element. Just as it does
with the face attribute, the browser renders text with the first font that matches
the one installed on the visitor’s computer.

1. Within the declaration of your style rule, include a font-family prop-
erty as shown here:

p { font-family: }

2. Follow the semicolon with the name of your first choice font. For
example:
p { font-family: “Times New Roman” }

3. Enter a comma and follow your first font choice with a second or
third, as shown here:
p { font-family: “Times New Roman”, Times }

4. Conclude the list with the generic font family name to which the
other fonts belong. For example:
p { font-family: “Times New Roman”, Times, serif }

Listing 77-1 shows an embedded style sheet sample. Figure 77-1
shows the resulting document in a browser.
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<html>
<head>

<title>The font-family Property</title>

<style type="text/css”>

<!l--

.code { font-family: Courier, monospace }

hl { font-family: Arial, Helvetica, sans-serif }
p (font-family: “Times New Roman”, Times, serif }

-->
</style>
</head>

<body>

<hls>Defining the <span class="code”>font-family</span>
Property</hl>

<p>The <span class="code”>font-family</span> property in CSS
is similar in function to the <span class="code”>face</spans>
attribute of the <span class="code”>&lt;font&gt;</span> tag
in HMTL. Use this property to specify a prioritized list of
fonts with which the browser should attempt to render the
element. Identically to the <span class="code”>face</span>
attribute, a browser renders text with the first font that
matches one installed on the visitor’s computer.</p>

</body>
</html>

Listing 77-1: The font-family property in practice

Defining the font-family Property

The font-family property m CSS u nmdar m function to the Farce aftnbute of the <Cont> tagm HMTL Tse the
property to specdy a pnomized kst of fonts with whach the browser should attemmpt to render the clement. Tdentically to the
face antnbute, & browser renders text with the first fort a8 matches cne mstalled oo the vntor's computer

Figure 77-1: Rendering the font-family property in the browser
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Task 8 Defining the font-size Property
with Keywords

s you might have guessed, the CSS font-size property fulfills the same
function as the size attribute of the <font> tag in HTML.

1. Within the declaration of your style rule, include a font-size
property.

2. Use the absolute-size keyword values xx-small, x-small, small,
medium, large, x-large, and xx-large to define values corre-
sponding to the HT'ML font size scale of 1 to 7, respectively. Listing
78-1 shows seven paragraph style classes using each value. Figure
78-1 shows how the browser renders the code.

<html>

<head>

<title>The font-size Property</titles>
<style type="text/css”>

<!--

p.one { font-size: xx-small }

p.two { font-size: x-small }

p.three { font-size: small }

p.four { font-size: medium }

p.five { font-size: large }

p.six { font-size: x-large }

p.seven { font-size: xx-large }

-=>

</style>

</head>

<body>

<p class="one”> font-size: xx-small = size="1" </p>
<p class="two”> font-size: x-small = size="2" </p>

<p class="three”> font-size: small = size="3" </p>
<p class="four”> font-size: medium = size="4" </p>
<p class="five”> font-size: large = size="5" </p>

<p class="six”> font-size: xx-large = size="6" </p>
<p class="seven”> font-size: xx-large = size="7" </p>
</body>

</html>

Listing 78-1: Absolute-size keyword values

3. Use the relative-size keyword values larger or smaller to increase
or decrease the size of text relative to the font size of the parent
element.
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i "
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font-size. mednun = suze="4"
font-size large = size="5"

font-size: xx-large = size="6"

font-size: xx-large = size="7"

Figure 78-1: Text rendered with absolute-size keyword values

Listing 78-2 shows the <div> tag (the parent element in this case) set
to large and two <p> tag style classes which increase and decrease the
font size relative to that value.

<html>

<head>

<title>The font-size Property</titles>

<style type="text/css”>

<!l--

div { font-size: large }

p.increase { font-size: larger }

p.decrease { font-size: smaller }

-=>

</style>

</head>

<body>

<div>

<p class="increase”> This line is larger </p>
<p> This line is large </p>

<p class="decrease”> This line is smaller </p>
</div>

</body>

</html>

Listing 78-2: Relative-size keyword values
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Defining the font-size Property
with Lengths

he CSS specification provides an extensive range of absolute and relative

length values not found in HT'ML. The inclusion of specific units of measure
provides greater control over how content is displayed across different output
devices (monitors, printers, and so on).

1. Adda font-size property to the declaration of your style rule.

2. Set the property equal to an absolute-size length value. Listing 79-1
shows a few possible values. Figure 79-1 displays the results in a
browser.

<html>

<head>

<title>The font-size Property</titles>
<style type="text/css”>

<! --

p.point { font-size: 12pt }

p.pica { font-size: 1pc }
p.cent { font-size: .4cm }
p.mill { font-size: 4mm }
p.inch { font-size: .15in }
-=>

</style>

</head>

<body>

<p class="point”>12 points</p>

<p class="pica”>1 picas</p>

<p class="cent”>.4 centimeters</p>
<p class="mill”>4 millimeters</p>
<p class="inch”>.15 inches</p>
</body>

</html>

Listing 79-1: Absolute-length values assigned to the font-size property
3. Use relative-size length values to indicate a length relative to some
other property. For example:
* em: The relative height of the font’s uppercase letters
* ex: The relative height of the font’s lowercase letters
*  px: The relative pixel resolution of the user’s monitor

®  %: A percentage of the font’s default size value
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Figure 79-1: Text rendered with absolute-length values assigned to the font-size property

Listing 79-2 shows possible relative values. Figure 79-2 displays the
results.

<html>

<head>

<title>Font Size</title>

<style type="text/css”>

<!--

p.em {font-size: lem}

p.ex {font-size: 2ex}

p.px {font-size: 16px}

p.percent {font-size: 100%}

-=>

</style>

</head>

<body>

<p class="em”>1 default uppercase letter high</p>
<p class="ex”>2 default lowercase letters high</p>
<p class="px”>16 pixels high</p>

<p class="percent”>100 percent of the default font size </p>
</body>

</html>

Listing 79-2: Relative-length values assigned to the font-size property

1 default uppercase letter hagh

2 defanll lowrercase letters hagh

16 pxels high
100 percent of the default font nze

i 7 &

Figure 79-2: Text rendered with relative-length values assigned to the font-size property
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Working with Font Styling

Font styling refers to the font-style, font-variant, and font-weight
properties. The font-style and font-weight properties correspond
loosely to HT'MLs physical styles <i> and <b>, only in CSS you can control the
degree of boldness you prefer. The font-variant property introduces a style
possibility lacking from HTML — small caps.

1. To specify whether a selector uses a normal, italic, or oblique
font, define a font-style property, as shown here:

.citation { font-style: italic }

2. To specify whether a font uses small-caps, define a font-variant
property set equal to small-caps. In a small-caps font, lowercase
letters are replaced with uppercase letters of slightly smaller size and
proportions.

3. To define a font-variant style that overrides a previous small-caps
setting, use a value of normal.

4. To regulate the boldness of text, include a font -weight property in
the declaration. For example:

{ font-weight: bold }
The font -weight property accepts relative keyword values of
lighter, normal, bold, or bolder.

5. To define the font-weight property using an absolute value, use the
following scale, in increments of 100: 100 (the lightest) to 900 (the
boldest). Normal font weight is 400; normal bold is 700.

Listing 80-1 shows each property in use within a style sheet. Figure
80-1 displays the results in a browser.
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<l--

hi {

<html>
<head>
<title>Font Styling</titles>

<style type="text/css”>

font-family: Arial;
font-style: italic;
font-variant: small-caps;
font-weight: bold }

font-family: Courier;
font-size: smaller;
font-style: normal;
font-variant: normal;
font-weight: normal }

p { font-family: Arial;
font-style: normal;
font-variant: small-caps;
font-weight: 500 }

-=>

</style>
</head>
<body>

<hl>Working with the <ems>font-style</em>,

styling.</p>
</body>
</html>

<em>font-

variant</em>, and <ems>font-weight</em> Properties</hl>

<p>These properties allow the designer to control font

Listing 80-1: Examples of the font-style, font-variant, and font-weight properties

WORKING WITH THE font-style, font-variant, AND font-
weight PROPERTIES

THESE PROPERTIES ALLOW THE DESIGNER TO CONTROL FONT STYLING

Figure 80-1: Text rendered with the font-style, font-variant, and font-weight properties
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Using the Font Property Shorthand

n CSS, you can define each of the various font properties’ values discussed in

Tasks 77-80 all under one inclusive property name, called font. CSS requires
that the properties be entered in the order provided here, each separated by a
space.

1. Within the declaration of your style rule, enter the font property, as
shown here:

h1l { font:

2. Define your desired font-style value (normal, obligue, or
italic):
hl { font: normal

3. Adda font-weight value using either keywords (1ighter,

normal, bold, and bolder) or values from the 100-900 scale
(400 = normal, 700 = bold):

hl { font: normal bold
4. Provide any desired font-variant value (normal or
small-caps):

h1l { font: normal bold small-caps

5. Include the font-size property value you want:
h1l { font: normal bold small-caps 24pt
6. To combine a 1ine-height value with your font-size value,

insert a forward slash (/) immediately after the font-size value and
then add a 1ine-height value:

h1l { font: normal bold small-caps 24pt/48pt

7. Conclude the list with your desired font-£family property, using
commas and quotation marks as required:
hl { font: normal bold small-caps 24pt/48pt Arial,

Helvetica, sans-serif }

Listing 81-1 provides examples of the font property shorthand
technique. Figure 81-1 displays the results in a browser.
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<html>
<head>

<title>Font Property Shorthand</title>
<style type="text/css”>

<l--
hl { font: normal bold small-caps 24pt/48pt Arial,
Helvetica, sans-serif }

p { font: 16pt/24pt Arial, Helvetica, sans-serif }

em { font: bold italic }

-—=>

</style>

</head>

<body>

<hl>Font Property Shorthand</hl>

<p>The CSS specification <ems>requires</em> that the
properties be defined in the order laid out in this task.
Even though some browsers don’t care which order you define
them in, others do, so it’s best to stick by the rules.</p>
</body>

</html>

Listing 81-1: Different implementations of the font property shorthand

FoNT PROPERTY SHORTHAND

The CSS specification requires that the properties be defined in the order laid
out in this task. Even though some browsers don't care which order you define
them in, others do. so it's best to stick by the rules.

Figure 81-1: Text rendered with different implementations of the font property
shorthand
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Working with Foreground and
Background Colors

SCreens aren’t black-and-white; your text needn’t be either. The CSS color
and background-color properties allow you to specify the foreground
color of an element’s text content and the color of an element’s background.

1. To specify a color for an element’s text, include a color property in
the style declaration. For example:

p { color:
2. To specity the color of an element’s background, include a
background-color property in the style declaration. For example:

body { background-color:

3. To define the value of these properties, use either:
e Hexadecimal notation: { color: #FF0000 }
¢ Predefined color name: { color: red }

4. CSS also allows the use of RGB triples, using either range or percent-
age values:

¢ RGB range: { color: rgb(255, 0, 0) }
* RGB percentage: { color: rgb(100%, 0%, 0% }

Listing 82-1 provides an example of these two properties in use.
Figure 82-1 gives you an idea of how each element implements them.




Cascading Style Sheets

<html>
<head>

<title>Color and Background Color</titles
<style type="text/css”>
<!--
p.inverted { color: #FFFFFF;
background-color: #000000 }

td.shaded { color: #000000;
background-color: #666666 }
-->
</style>
</head>
<body>
<table cellpadding="5” cellspacing="0" border="1">
<tr>
<td class="shaded” >
The cell’s background is completely filled...
</td>

</tr>

<tr>
<td>
<p class="inverted”>
while the background color of the paragraph text
only covers the text itself</p>
</td>

</tr>

</table>

</body>
</html>

Listing 82-1: Style classes using color and background-color properties

Figure 82-1: Different uses of style classes using color and background-color
properties
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Task 83 Controlling Character and Word Spacing

he space between letters, words, and lines can be increased or decreased using
the letter-spacing, word-spacing, and white-space properties.

Part 9

letter-spacing

p { letter-spaci

1. To specify the distance between characters in text, include a

property in the style declaration. For example:

ng:

Specify a length value for the property using any of the allowed units
of measure. For example:

letter-spacing:
letter-spacing:
letter-spacing:
letter-spacing:
letter-spacing:
letter-spacing:
letter-spacing:
letter-spacing:

2ex }
lem }
16px }
ipc }
12pt }
4.2mm }
.42cm |}
.165in }

"To specify the distance between words in text, include a
word-spacing property in the style declaration. For example:

p { word-spacing

Supply a length value using any of the units of measure that CSS

supports. For exam

{ word-spacing:
{ word-spacing:
{ word-spacing:
{ word-spacing:
{ word-spacing:
{ word-spacing:
{ word-spacing:
{ word-spacing:

Listing 83-1 shows

ple:

lex }
.Sem }
8px }
.5pc }
6pt }
2.1lmm }
.2lcm }
.0831in }

examples of different spacings. Figure 83-1

displays the document in a browser.
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<html>
<head>

<title>Spacing</title>

<style type="text/css”>

<!--

hl { letter-spacing: -.25ex;
word-spacing: -lex }

p { letter-spacing: .5ex;
word-spacing: lex;
font-size: 1lépt }
-—=>
</style>
</head>
<body>
<hl> Letter & Word Spacing </hls>
<p>The heading looks to be just overlapping, while this
paragraph is quite liberally spaced</p>
</body>
</html>

Listing 83-1: Spacing letters, words, and lines

1 etteVordpacing

The heading looks to be just overlapping, while this
paragraph 1s quite liberally spaced

Figure 83-1: Rendering different letter, word, and line spacing in a browser
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Controlling Line Spacing and
Vertical Alignment

ou can manipulate the distance between lines (referred to as leading) using

the 1ine-height property. The other CSS property that impacts line height
calculations is vertical-align, which combines the effects of HTMDs align
attribute as applied to the <img> tag with the physical style tags that affect line
height: <sup> and <sub>.

1. To control the amount of space between lines of text within a given
element, include the 1ine-height property in your declaration, as
shown here:

p { line-height:

2. Supply a value using any of the following methods:

¢ Keyword value: 1ine-height accepts the keyword value
normal, which tells the browser to use a “reasonable” value
based on the font size of the element.

* Length value: a numeric value in any of the units of measure
that CSS supports (ex, em, px, pc, pt, mm, cm, in).

*  Number value: a multiple of the element’s font size. For
example:

p { line-height: 1.5;
font-size: 12pt }
specifies a computed value of 1.5 X 12, equaling a line height of
18pt.
* Percentage: a percentage of the element’s font size. For example:

p { line-height: 125%;
font-size: 12pt }

specifies a computed value 25 percent larger than the current font
size, or 15pt (12 +4 =3, 3 + 12 = 15pt, for folks like us who are
mathematically challenged).

3. To control the vertical alignment of an element, include the
vertical-align property in your declaration. For example:

p { vertical-align:

4. Supply a value using any of the following methods:

* Keyword value: the vertical-align property accepts the key-
word values baseline, middle, text-top, and text-bottom
(like the align attribute of the <img> tag). It also accepts the




Cascading Style Sheets -

values sub and super, creating the same effect as the subscript Task SA

(<sub>) and superscript (<sup>) tags.

* Percentage: raise or lower the element by a percentage of the
line-height value.

* Length value: raise or lower the element by a specified value in
any of the units of measure that CSS supports (ex, em, px, pc,
pt, mm, cm, in).

Listing 84-1 provides some examples of line height and vertical
alignment. Figure 84-1 displays the results in the browser.

<html>
<head>
<title>Line Height & Vertical Alignment</title>
<style type="text/css”>
<!--
.math { vertical-align: sub }
p { font: 1l4pt Verdana;
line-height: 1.5 }
-=>
</style>
</head>
<body>
<p>This paragraph’s line height is 1.5 times bigger than its
font size.<br />
With the math class’s vertical alignment set to subscript,
it allows me to accurately render H<span
class="math”>2</span>0</p>
</body>
</html>

Listing 84-1: Examples of the line-height and vertical-align properties

This paragraph's line height is 1.5 times bigger than its font size.
With the math class's vertical alignment set to subscript, it allows me to
accurately render l-lzo

Figure 84-1: Text rendered using the line-height and vertical-align properties
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Defining the text-decoration Property

he text-decoration property allows you to add some additional flourishes
to text content. You can place a line over, under, or through text; make text
blink, or remove any predefined flourishes as well.

1. To apply a decorative style to text, include a text-decoration
property in your declaration, as shown here:
em { text-decoration:

2. Use any of the following keyword values to control the position of a
decorative line:
¢ Underline text with underline
® Place a line above text with overline
*  Strike a line through text with 1ine-through

3. To make the text blink, add a value of blink.

4. To remove any existing text decoration from an element, add the
value none.

Listing 85-1 provides examples of the text-decoration property.
Figure 85-1 displays the document in a browser.

The class we're using here adds an underfine to the emphasis tag.
The class we're using here adds a line overtext affected by the emphasis tag.

The class we're using here striikes a dme-torowph text affected by the emphasis tag.

The style applied to the anchor tag here removes the browser's default underline
decoration.

Figure 85-1: Text rendered with the text-decoration property
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<html>

<head>

<title>Text Decoration</titles>

<style type="text/css”>

<!--

body { font: l4pt Arial }

em.u { text-decoration: underline }

em.o { text-decoration: overline }

em.lt { text-decoration: line-through }

a { text-decoration: none }

-=>

</style>

</head>

<body>

<p>The class we’re using here adds an <em
class="u”>underline</em> to the emphasis tag.</p>

<p>The class we’re using here adds a <em class="0">line
over</em> text affected by the emphasis tag.</p>

<p>The class we’re using here strikes a <em class="1t”>line
through</em> text affected by the emphasis tag.</p>

<p>The style applied to the <a href="css.html”>anchor
tag</a> here removes the browser’s default underline
decoration.</p>

</body>
</html>

Listing 85-1: Examples of the text-decoration property
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Defining the text-transform Property

SS allows you to define styles that affect the capitalization of text. Not only
can you force all text to appear in UPPERCASE or lowercase, but you can
make the First Letter Of Each Word Capitalized As Well.

1. To control text case, include a text -transform property in the
declaration. For example:
p { text-transform:

2. Use any of the following keyword values to control the case of text
affected by the style:
* Render all text in uppercase letters with uppercase
* Render all text in lowercase letters with lowercase

* Render the first letter of each word in uppercase with
capitalize

3. To remove any previous transformations for an element, use the
value none.

Listing 86-1 provides examples of the text -transform property.
Figure 86-1 displays the document in a browser.

THIS CLASS RENDERS ALL THE TEXT IN THE PARAGRAPH IN UPPERCASE.

this class renders all the text in the paragraph in lowercase.

This Class Capitalizes The First Letter Of Each Word In The Paragraph...except these last
ones.

Figure 86-1: Text rendered using examples of the text-transform property
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<html>
<head>

<title>Text Transformation</title>
<style type="text/css”>

<!--

body { font: 1l4pt Arial }

p.up { text-transform: uppercase }
p.low { text-transform: lowercase }
p.cap { text-transform: capitalize }
em { text-transform: none }

-—>

</style>

</heads>

<body>
<p class="up”>This class renders all the text in the
paragraph in uppercase.</p>

<p class="1low”>This class renders all the text in the
paragraph in lowercase.</p>

<p class="cap”>This class capitalizes the first letter of
each word in the paragraph...<em>except these last
ones.</em></p>

</body>
</html>

Listing 86-1: Examples of the text-transform property
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Controlling Text Alignment
and Indentation

n HTML you control the alignment of text elements with the align attribute.

In CSS you use the text-align property instead. One thing that HTML
can’t do for you is indent the first line of a paragraph. CSS has no such restriction
and allows you to do that with the text-indent property.

1. To control the alignment of a text element, include a text-align
property within your declaration, as shown here:

p { text-align:
2. Use the following keyword values 1eft, right, center, or
justify to instruct the browser how to align the text.

3. To specify the indentation of the first line of text in a block, include a
text-indent property in your declaration.

4. Supply a length value (ex, em, px, pc, pt, mm, cm, in) to create an
indentation of fixed length or a percentage value, which creates an
indent relative to the element’s overall width.

Listing 87-1 shows examples of the text-align and text-indent
properties. Figure 87-1 displays the document in a browser.

toxt-alige: left
Thes class aligas ol taxt 10 the lefl Thes is also the defaull browser abgnasiad should you st make any admssmants. This class
shgas of text 10 the kel This is alse the defaull beewser sbgnmeent shosld you not make any sdpesiesests. Thes class abges ol
toxt 10 the lef. Ths s alos the defsull beowser ahgnamoad shoeld you mot enaka sy sdpstenoals
text=align: right
Thes class aligns a8 ext 10 Bha nght. This class abigns o fext 10 tha nght. This class aligns 3 besd 10 Bha nght. This class aligns
ol taxt te the right. Thes class aligns o text (e the nght. Thes claws aligns ol taxt 1o the nght. Thes class sligns ol taxt te the
mght This class abigns ol text 10 the sghi This class aligns o lesl 10 1he sght
toxi-align: ceater
This claws sbgne all text to the center. This class sliges ofl text to the conter. This class abgns ol text to the comter. This class
gt o toxt 8o the contor. Ths class sliges o Tox! 10 the center. This class aligne o teat 10 the conler. Thes clags aliges ol
tent 80 the comten. This class aligas all text 19 the center. This clss aligns all bexd 10 the cemter
toxt-align: justily: text-indent: Jax
Thes claws pusties texi, and also mdents the frst bne 3ex. Thes class jwisdes tert, and aleo mdents the Gt fne Jea. Ths

clas justios toxt, and also mdents the Gt bne Sax This class jetten toxt, and aise mdosts the st Bne 3o This class
Justifes text, and alse mdents the first bne 3ex. This clavs jovsdes tent, snd also indents (he frst bne 3ex

—

Figure 87-1: Text examples rendered with the text-align and text-indent properties
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<html>

<head>

<title>Text Alignment & Indentation</titles
<style type="text/css”>

<!--

body { font: 88t Arial }

hl { font: bold 88t Courier, monospace; text-align: left }

p.left { text-align: left }

p.right { text-align: right }

p.center { text-align: center }

p.just { text-align: justify; text-indent: 3ex }
-=>

</style>

</head>

<body>

<hl>text-align: left</hl>

<p class="1left”>This class aligns all text to the left. This
is also the default browser alignment should you not make
any adjustments. This class aligns all text to the left.
This is also the default browser alignment should you not
make any adjustments. This class aligns all text to the
left. This is also the default browser alignment should you
not make any adjustments. </p>

<hl>text-align: right</hl>

<p class="right”>This class aligns all text to the right.
This class aligns all text to the right. This class aligns
all text to the right. This class aligns all text to the
right. This class aligns all text to the right. This class
aligns all text to the right. This class aligns all text to
the right. This class aligns all text to the right. This
class aligns all text to the right. </p>

<hl>text-align: center</hls>

<p class="center”>This class aligns all text to the center.
This class aligns all text to the center. This class aligns
all text to the center. This class aligns all text to the
center. This class aligns all text to the center. This class
aligns all text to the center. This class aligns all text to
the center. This class aligns all text to the center. This
class aligns all text to the center. </p>

<hl>text-align: justify; text-indent: 3ex</hls>

<p class="just”>This class justifies text, and also indents
the first line 3ex. This class justifies text, and also
indents the first line 3ex. This class justifies text, and
also indents the first line 3ex. This class justifies text,
and also indents the first line 3ex. This class justifies
text, and also indents the first line 3ex. This class
justifies text, and also indents the first line 3ex. </p>
</body>

</html>

Listing 87-1: Examples using the text-align and text-indent properties




- Part 9
Working with Background Images

In HTML background images are limited to the document body and the various
parts of the table element. In CSS you can make use of background images in
virtually all elements.

1. 'To specify a background image for an element, include a
background-image property in your declaration, as shown here:

body { background-image:

2. To specify the path to the image you want to use, define a URL value
with the appropriate pathname (in parentheses) identifying the loca-
tion of the image file on the server. For example:

body { background-image: url (images/bg.gif) }

3. To control how the background image tiles, add a background-
repeat property. For example:

body { background-image: url (images/bg.gif);
background-repeat:

4. Supply the background-repeat property with one of the following
four keyword values:

* repeat tiles the image horizontally and vertically (the default
browser behavior)

* no-repeat prevents the image from tiling at all, displaying only
a single instance of the image

* repeat-x tiles the image horizontally only
* repeat-y tiles the image vertically only

5. To fix the background image in place, so it appears stationary while
the browser window is scrolled, add a background-attachment
property and apply the value £ixed, as shown here:

body { background-image: url (images/bg.gif);
background-repeat: repeat-x;
background-attachment: fixed;

6. Include a background-position property to determine the
position of a background image. Use this in conjunction with the
background-image property and the background-repeat
property, indicating no-repeat. For example:

body { background-image: url (images/bg.gif) ;
background-repeat: no-repeat;
background-position:
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7. Define a value for the background-position property using the
following value types:

* Length values: ex, em, px, pc, pt, mm, cm, in
* Percentage values

e Keyword values: top | center | bottom and left | center |
right

Listing 88-1 shows a sample style rule for the <body> tag, and
Figure 88-1 shows the effect in the browser.

body { background-image: url (flower.gif);
background-repeat: no-repeat;
background-position: center center }

Listing 88-1: Three related properties governing a background image and its placement

Figure 88-1: Displaying a non-repeating background flower image in the center of the
browser window
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Defining CSS Padding Properties

In the HTML table model, you have the ability to increase the spacing between
a cell’s content and the cell walls using the cellpadding attribute. The CSS
box model (explained on the book’s Web site) is very similar to a table cell. It
provides a mechanism for increasing or decreasing the spacing around content
through the use of padding properties. Unlike HT'ML, where padding is simulta-
neously increased on all sides around the cell content, CSS allows you to specify
the padding values for all fours sides independently using length (ex, em, px, pc,
pt, mm, cm, in ) or percentage values. A value of zero collapses the padding area
completely. Negative values are not permitted.

1. To specify the amount of padding above the element, include a
padding-top property in your declaration.

2. To specify the amount of padding on the right side of the element,
include a padding-right property.

3. To specify the amount of padding below the element, include a
padding-bottom property.

4. 'To specify the amount of padding on the left side of the element,
include a padding-1left property.

5. To render padding properties in shorthand, simply include a padding
property in your declaration, followed by one to four values:

® One value: Applies the stated padding equally to all sides of the

element

* Two values: Sets the top and bottom padding to the first value
and the right and left padding to the second

* Three values: Sets the top padding to the first value, the left and

right padding to the second value, and the bottom padding to
the third

* Four values: Applies the stated padding to the top, right, bottom,
and left sides, respectively

Listing 89-1 shows an example of the padding properties while
Figure 89-1 displays each property in action.

<html>

<head>

<title>Padding</title>

<style type="text/css”>

<!--

p.top { padding-top: 100px;
font: bold 12pt Courier;
background-color: #CCCCCC }

(continued)
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p.right { padding-right: 100px;
font: bold 12pt Courier;
text-align: right;
background-color: #CCCCCC }

p.left { padding-left: 100px;
font: bold 12pt Courier;
background-color: #CCCCCC }

p.bottom { padding-bottom: 100px;
font: bold 12pt Courier;
background-color: #CCCCCC }

-=>

</style>

</head>

<body>

<p class="top”>padding-top: 100px</p>

<p class="right”>padding-right: 100px</p>
<p class="left”>padding-left: 100px</p>
<p class="bottom” >padding-bottom: 100px</p>

</body>
</html>

Listing 89-1: Examples of the four padding properties

Figure 89-1: Rendering the four padding properties in the browser
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Defining Border Style Properties

In HTML only images and tables have definable borders. The CSS box model

extends borders to the entire spectrum of page content. The first step to define
a border is to specify a border style. There are eight styles to choose from and, as
with all properties relating to the CSS box model, you can specify them for each
side individually, or all four sides at once.

1. To specify the style of the border above an element, include a
border-top-style property in your declaration.

2. To specify the style of the border on the right side of the element,
include a border-right-style property.

3. 'To specity the style of the border below the element, include a
border-bottom-style property.

4, To specify the style of the border on the left side of the element,
include a border-left-style property.

5. To render border style properties in shorthand, simply include a
border-style property in your declaration.

6. Define a value for your border style properties using any of the
following keyword values:

* none removes all borders; this value forces the border width to 0
(see Task 91)

* dotted renders the border in dots

* dashed renders the border as a dashed line

® solid renders the border as a solid line

® double renders the border as two solid lines

* groove renders the border as an engraved line

e ridge renders the border as an embossed border

* inset renders the entire box to look as though it were embedded
in the page

* outset renders the entire box to look as though it were
embossed (the opposite of inset)

Listing 90-1 demonstrating the use of border style properties.
Figure 90-1 shows the effects of each value.

<html>

<head>

<title>Border Styles</titles>
<style type="text/css”>

<!--

(continued)
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body { font: bold 16pt Courier }

p.none { border-style: none }
p.dotted { border-style: dotted }
p.dashed { border-style: dashed }
p.solid { border-style: solid }
p.double { border-style: double }
p.groove { border-style: groove }
p.ridge { border-style: ridge }
p.inset { border-style: inset }
p.outset { border-style: outset }
-=>

</style>

</head>

<body>

<p class="none”>none </p>

<p class="dotted” >dotted</p>
<p class="dashed” >dashed</p>
<p class="solid”>solid</p>
<p class="double”>double</p>
<p class="groove” >groove</p>
<p class="ridge”>ridge</p>
<p class="inset”>inset</p>
<p class="outset”>outset</p>
</body>

</html>

Listing 90-1: Examples of the shorthand border-style property

none

dotted

Figure 90-1: Border styles rendered in the browser
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Defining Border Width Properties

n Task 90 you saw how to specify a border using the border style propertes. In
this task you learn how to control the width (or more accurately, thickness) of an
element’s borders. These properties accept keyword values (thin, medium, thick)
as well as any positive length value (ex, em, px, pc, pt, mm, cm, in). A value of zero

collapses the border area completely. Negative values are not permitted.

1. To specify the width of an element’s top border, include a
border-top-width property in your declaration.

2. To specity the width of the right border, include a border-right-
width property.

3. To specify the width of the bottom border, include a border-
bottom-width property.

4. To specify the width of the top border, include a border-left-
width property.

5. To render border width properties in shorthand, simply include a
border-width property in your declaration, followed by one to
four values:

*  One value: Applies to all sides of the element

* Two values: Sets the top and bottom paddings to the first value
and the right and left paddings to the second

* Three values: Sets the top padding to the first value, the left and

right paddings to the second value, and the bottom padding to
the third

* Four values: Applies to the top, right, bottom, and left paddings,
respectively

Listing 91-1 shows the code demonstrating the values. Figure 91-1
displays the effects of each potential value in a browser.

<html>

<head>

<title>Border Width</title>
<style type="text/css”>
<!--

body { font: bold 1l6pt Courier }

p.thin { border-style: dotted;
border-width: thin }

p.medium { border-style: dashed;
border-width: medium }

(continued)
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p.thick { border-style: solid;
border-width: thick }

p-length { border-style: double;
border-width: 25px }
-—=>
</style>
</head>
<body>
<p class="thin”s>border-style: dotted; border-width: thin</p>

<p class="medium” >border-style: dashed; border-width:
medium</p>

<p class="thick”>border-style: solid; border-width:
thick</p>

<p class="length”>border-style: double; border-width:
25px</p>
</body>
</html>

Listing 91-1: Code demonstrating border-width properties

-y

P L L T |

hm-ltylo; solid; border-width: thick 1

Figure 91-1: Border widths rendered in the browser
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Defining Border Color Properties

esides specifying the style of a border, and its width, you can govern its color.

As with all border properties discussed in previous tasks, CSS allows you to
define the border color of each side of an element independently. Values are
expressed in hexadecimal, color name, or RGB triple (see Task 82). Use the
keyword transparent to render a border invisible.

1. To specify the color of an element’s top border, include a border-
top-color property in your declaration.

2. To specity the color of the right border, include a border-
right-color property.

3. 'To specify the color of the bottom border, include a border-
bottom-color property.

4. To specify the color of the left border, include a border-
left-color property.

5. To render border color properties in shorthand, simply include a
border-color property in your declaration, followed by one to
four values:

*  One value: Applies to all sides of the element

* Two values: Sets the top and bottom paddings to the first value
and the right and left paddings to the second

* Three values: Sets the top padding to the first value, the left and

right paddings to the second value, and the bottom padding to
the third

* Four values: Applies to the top, right, bottom, and left paddings,
respectively

Listing 92-1 shows sample code that uses these properties, while
Figure 92-1 displays the effects of border color properties in a
browser.

<html>

<head>

<title>Border Color</titles>

<style type="text/css”>

<!--

body { font: bold 1l6pt Courier;
color: #FFFFFF;
background-color: #000000 }

p.hex { border-color: #CCCCCC;
border-style: dotted;
border-width: 5px }

(continued)
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p.color name { border-color: SlateGray; Task 92

border-style: dashed;
border-width: 5px }

p.triple { border-color: rgb(50, 50, 50);
border-style: solid;
border-width: 5px }

p.mixed { border-top-color: #FFFFFF;
border-right-color: #333333;
border-bottom-color: SlateGray;
border-left-color: rgb(50, 50, 50);
border-style: double;
border-width: 10px }

-=>

</style>

</head>

<body>

<p class="hex”>border-color: #CCCCCC</p>

<p class="color name”sborder-color: SlateGray</p>

<p class="triple”sborder-color: rgb (50, 50, 50)</p>

<p class="mixed” >border-top-color: #FFFFFF; border-right-

color: #333333; border-bottom-color: SlateGray;

border-left-color: rgb(50, 50, 50);</p>

</body>

</html>

Listing 92-1: Code demonstrating border-color properties

A Border Color - Microsalt Inteimat Explorers

File Edit View Favorites Tools Help

border-color: SlateGray

border-color rgh(50., 50. 50)

border—top-color: W#FF : border-right-color: #333333:
border-bottom-color teGray. border-left-color rqgb
(50, 50, 50):

cross-reference

= To learn how to combine
all border properties in a
shorthand declaration, see
Task 93.

Figure 92-1: Border colors rendered in the browser
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Using the Border Property Shorthand

You can render CSS border properties in shorthand two different ways. You
can define the style, width, and color of a single side in one declaration, or
the style, width, and color for all sides with one declaration.

1. 'To specify the style, width, and color for the single side of an
element, include a border-top, border-right, border-bottom,
or border-1left property in your declaration.

2. Define the width, style, and then color (separated by spaces) as a
single value. For example:

div { border-top: thin dashed #FF0000 }
3. To specify the style, width, and color for all sides of an element’s
border, include a border property in your declaration.

4. Define the width, style, and then color (separated by spaces) as a
single value, as in Step 2.

Listing 93-1 shows the code required to render this shorthand
method displayed in Figure 93-1.
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<html>

<head>

<title>Border Shorthand</title>
<style type="text/css”>

<l--

body { font: bold 16pt Courier }

p.four-sides { border-top: thick dashed #FF0000;
border-right: medium dotted green;
border-bottom: thin solid rgb(0, 0, 255);
border-left: S5px double #000000 }

p.all-sides { border: thin dashed SlateGray }
-=>

</style>

</head>

<body>

<p class="four-sides”>

border-top: thick dashed #FF0000;<br />
border-right: medium dotted green;<br />
border-bottom: thin solid rgb(0, 0, 255);<br />
border-left: 5px double #000000 </p>

<p class="all-sides”>

border: thin dashed SlateGray
</p>

</body>

</html>

Listing 93-1: Shorthand border definitions in code

border-top: thick dashed #FF0000;
border-right: medium dotted green:
border-bottom: thin solid rgb(0. 0. 255):
border-left: Spx double #000000

sasssnnnsll

‘border: thin dashed SlateGray

Figure 93-1: Shorthand border properties rendered in the browser
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Task 94 Working with Margin Properties

argin properties allow you to expand and contract the outermost area in the

CSS box model, the margin area — just as you would the padding area. You
can define the top, right, bottom, and left margin independently using individual
properties. A shorthand margin property allows you to define all margins simul-
taneously. Each property accepts length (ex, em, px, pc, pt, mm, cm, in) and

notes percentage values. A value of zero collapses the padding area completely.
T e —— Negative values are permitted.
guish between the padding
and margin settings. The 1. To specify the width of the top margin, include a margin-top prop-

gray regions around each

erty in your declaration.
paragraph mark the area

affected by the padding 2. To specify the width of the right margin, include a margin-right

property. The black regions roper

indicate the area affected property.

G WEET RIS 3. To specify the width of the bottom margin, include a margin-

= Margin properties are sup- bottom property.

ported equally by Internet . . ..

Explorer and Netscape. 4. To specify the width of the left margin, include a margin-left
property.

5. To render margin properties in shorthand, simply include a margin
property in your declaration, followed by one to four values:

* One value: Applies to all sides of the element

* Two values: Sets the top and bottom paddings to the first value
and the right and left paddings to the second

e Three values: Sets the top padding to the first value, the left and
right paddings to the second value, and the bottom padding to

the third

* Four values: Applies to the top, right, bottom, and left paddings,
respectively.

0 - | .

rgin-top: SOpx;
lpadding-top: 25px;

margin-right:
padding-right:

margin-left: S50px;
padding-left: 25px;

rgin~-bottom: 50px;
lpadding-bottom: 25px;

Figure 94-1: Margin properties rendered in the browser
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Listing 94-1 shows the code illustrating these properties. Figure 94-1 Task 9 A

displays the effects of margin properties in a browser.

<html>

<head>

<title>Margins</title>

<style type="text/css”>

<!--

body { background-color: black;
font: bold 16pt Courier }

p.top { margin-top: 50px;
padding-top: 25px;
background-color: #CCCCCC }

p.right { margin-right: 50px;
padding-right: 25px;
text-align: right;
background-color: #CCCCCC }

p.left { margin-left: 50px;
padding-left: 25px;
background-color: #CCCCCC }

p.bottom { margin-bottom: 50px;
padding-bottom: 25px;
background-color: #CCCCCC }

-=>

</style>

</head>

<body>

<p class="top”> margin-top: 50px;<br />

padding-top: 25px;</p>

<p class="right”s>margin-right: 50px;<br />
padding-right: 25px;</p>

<p class="left”s>margin-left: 50px;<br />
padding-left: 25px;</p>

<p class="bottom”>margin-bottom: 50px;<br />
padding-bottom: 25px;</p>

</body>

</html>

Listing 94-1: Different margin properties
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Defining Element Dimensions

hile HTML has width and height attributes, CSS has width and height

properties. You can define values in length measurements (ex, em, px, pc,
pt, mm, cm, in) or percentages of the parent element. Negative values are not
permitted.

1. To specify the width of an element, include a width property in your
declaration.

2. To specify the height of an element, include a height property.

3. To specify the maximum width of an element, include a max-width
property.

4. 'To specify the minimum width of an element, include a min-width
property.

5. To specify the maximum height of an element, include a max-
height property.

6. To specify the minimum height of an element, include a min-
height property.

Listing 95-1 shows sample code with defined width and height
properties, while Figure 95-1 displays these elements in a browser.

Figure 95-1: Widths and heights rendered in the browser
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<html>

<head>

<title>Width and Height</titlex>

<style type="text/css”>

<!--

p.one { width: 300px;
height: 100px;
border: thin dashed black;
padding: 88x;
background-color: rgb (200, 200, 200);
margin-left: 50px;
font: bold 16pt Courier }

p.two { width: 100px;
height: 300px;
border-style: inset;
padding: 88x;
background-color: rgb (200, 200, 200) ;
margin-left: 50px;
font: bold 16pt Courier }

-=>

</style>

</head>

<body>

<p class="one”>width: 300px;<br />

height: 100px

</p>

<p class="two”>width: 100px;<br />
height: 300px</p>

</body>

</html>

Listing 95-1: Examples of using the width and height properties
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Working with the float Property

he £loat property functions much like the align attribute of a <table> or
<img> tag. Using the float property, you shift an element either to the left
or right side and flow content down the opposite side.
1. To float an element, include a £1oat property in your declaration.

2. Define one of the three following keyword values:

* left places the element on the left margin and wraps content to

the right

* right places the element on the right margin and wraps content

to the left
* none disables the £1loat property

3. Specify which side of an element may not be adjacent to a floating
element using the clear property.

4. Define one of the four following keyword values:

® left prevents content from wrapping down the right side of left-
floated elements

® right prevents content from wrapping down the left side of
right-floated elements

* Dboth prevents content from wrapping around any floated
elements

* none disables the clear property

Listing 96-1 shows sample code that uses these properties while
Figure 96-1 displays floated and cleared content.

<html>
<head>
<title>Float and Clear</title>
<style type="text/css”>
<!--
img.one { float: left;
width: auto;
height: auto }

p.one { width: 300px;
height: 100px;
border: thin dashed black;
padding: 88x;
background-color: rgb (200, 200, 200);
margin-left: 50px;
font: bold 16pt Courier }

(continued)
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p.-two { clear: left;
width: 300px;
height: 100px;
border: thin dashed black;
padding: 88x;
background-color: rgb (200, 200, 200);
margin-left: 50px;
font: bold 16pt Courier }

-->
</style>

</head>

<body>

<img class="one” src="flower.gif” />

<p class="one”>This paragraph wraps down the right-hand side
of the floated image.
</p>

<img class="one” src=" flower.gif” />

<p class="two”>Because this paragraph has a clear: left, it
doesn’t...</p>

</body>

</html>

Listing 96-1: Examples of the float and clear properties

Figure 96-1: Floated and cleared content rendered in the browser




- Part 9
Controlling List-ltem Bullet Styles

In HTML you control the bullet styles of unordered lists using the type
attribute of the <uls> tag. In CSS you use the 1ist-style-type property
instead. With CSS, you can even use images as bullets.

1. To specify the list item style for an unordered list, create a style rule for
the <ul> tag and include a 1ist-style-type property. For example:

ul { list-style-type:

2. Define any of the following keyword values:
* disc is a solid round disc (the default)
® circleisa hollow circle
* square is a solid square

3. To control the position of a bullet, include a 1ist-style-
position property.

4. Define either of the following keyword values:

* inside places the bullet inside the list item block (see
Figure 97-1)

* outside places the bullet outside the list item block

5. To specify an image as a bullet style for an unordered list, include a
list-style-image property in your declaration.

6. 'To specify the path to the image you want to use, define a URL value
with the appropriate pathname (in parentheses) identifying the
location of the image file on the server. For example:

ul { list-style-image: url (images/triangle.gif) }

Listing 97-1 shows the code using these properties. Figure 97-1
displays various list item bullet styles.

<html>

<head>

<title>List Item Bullet Styles</title>
<style type="text/css”>

<!l--
body { font: 16pt Arial }
ul.square { list-style-type: square }

ul.compact { list-style-position: inside }

(continued)
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ul.triangle { list-style-image: url(triangle.gif) }
-—>

</style>

</head>

<body>

<ul class="square”>
<1li>The bullet style <br>is square</li>
<1li>The bullet style <br>is square</lis>
</ul>

<ul class="compact”>
<1i>The bullet position <br> is “inside”</li>
<li>While the other lists <brsare defaulting to
outside</1li>
</ul>

<ul class="triangle”>
<1i>The bullet style <brsuses a triangular image</li>
<1li>The bullet style <brsuses a triangular image</li>
</uls>

</body>
</html>

Listing 97-1: Examples of the list-style-type, list-style-position, and list-style-image
properties

= The bullet style
is square

= The bullet style
is square

« The bullet position

is “inside”

« While the other lists
are defaulting to outside

+ The bullet style
uses a triangular image
+ The bullet style
uses a triangular image

Figure 97-1: Various bullet styles rendered in the browser
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Controlling List-ltem Number Styles

Just as you saw in Task 97, in HTML the style of numbering in an ordered list
is governed by the type attribute of the <o1> tag. In CSS you use the 1ist-

style-type property.

1. To specify the list item style for an ordered list, create a style rule for
the <ol> tag and include a 1ist-style-type property. For example:

ol { list-style-type:

2. Define any of the following keyword values:
® decimal uses Arabic numerals (1, 2, 3)
® lower-roman uses lowercase Roman numerals (i, i, iii)
® upper-roman uses uppercase Roman numerals (I, II, III)
® lower-alpha uses lowercase letters (a, b, ¢)
* upper-alpha uses uppercase letters (A, B, C)
* none disables list styles
3. To control the position of a bullet, use the 1ist-style-position
property.
4. Define either of the following keyword values:
* inside places the bullet inside the list item block

* outside places the bullet outside the list item block

Listing 98-1 shows sample code for different effects you can create
with ordered lists. Figure 98-1 displays the ordered lists in a browser.

<html>
<head>
<title>List Item Numbering Styles</title>
<style type="text/css”>
<!--
body { font: bold 12pt Arial }
ol.decimal { list-style-type: decimal }
ol.lower-roman { list-style-type: lower-roman;

list-style-position: inside }
ol.upper-roman { list-style-type: upper-roman }
ol.lower-alpha { list-style-type: lower-alpha }
ol.upper-alpha { list-style-type: upper-alpha }
ol.none { list-style-type: none }
-=>
</style>
</head>

(continued)
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<body>

<ol class="decimal”>
<li>decimal</li>
<li>decimal</li>
<li>decimal</li>

</ol>

<ol class="lower-roman” >
<lislower-roman;<br> inside</li>
<li>lower-roman;<br> inside</1li>
<li>lower-roman;<br> inside</1li>

</ol>

<ol class="upper-roman”>
<lisupper-roman</lis>
<li>upper-roman</li>
<li>upper-roman</li>

</ol>

<ol class="lower-alpha”>
<li>lower-alpha</li>
<lis>lower-alpha</li>
<li>lower-alpha</li>

</ol>

<ol class="upper-alpha”s>
<li>upper-alpha</li>
<li>upper-alpha</li>
<lisupper-alpha</li>

</ol>

</body>

</html>

Listing 98-1: Different styles of ordered lists

3.

i
H

i

c. lower-alpha
A upper-alpha

B. upper-aipha
C. upperalpha

Figure 98-1: Different ordered-list styles rendered in the browser
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Creating Layers with Absolute Positions

he <div> tag is a generic tag that contains no inherent formatting abilities.

Simply short for division, the <div> tag is meant to be used wherever you
intend to begin a block-level section of page content. Although not exclusively
meant for layering, by using inline CSS syntax, the <div> tag is ideal for creating
layers with an absolute position.

1. Within the body section of your document, insert an opening
<divs> tag.

2. To apply a name to the layer, add an id attribute and set it equal to
the name you want to give the layer.

3. 'To begin including inline style syntax, add a style attribute. The
value of this attribute will contain the various style declarations.

4. To specify an absolute position for the layer, define a position
property and supply a value of absolute. Follow this declaration
with a semicolon to continue adding to the style attribute value.

5. To specify the actual coordinates for the layer’s position, define left
and top properties and supply pixel values for them, as shown in
Listing 99-1.

<html>
<head>
<title>Layered Content</titles>
</head>

<body>

<div id="rain text” style="position: absolute; left: 150px;
top: 50px”>

</body>
</html>

Listing 99-1: Defining the left and top properties
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6. To define the layer’s dimensions, define width and height proper-
ties, as shown here:

<div id="rain text” style="position: absolute; left:
150px; top: 50px; width: 265px; height: 25px”>

7. 'To control a layer’s stacking order, define the z-index property and
supply it a numeric value.

8. Insert the content you want displayed within the layer and close the
layer with a closing </div> tag, as shown in Listing 99-2. Figure
99-1 displays these two layers in a browser.

<div id="rain text” style="position: absolute; left: 150px;
top: 50px; width: 400px; height: 200px; z-index: 2">
<hls><font color="red”>The Rain in Spain Stays Mainly in the
Plain.</font></hl>

</div>

<div id="shadow_text” style="position: absolute; left:
145px; top: 55px; width: 400px; height: 200px; z-index: 1”>
<hl1>The Rain in Spain Stays Mainly in the Plain.</hl>
</div>

Listing 99-2: Code for two completed layers of text

The Rain in Spain Stays
Mainly in the Plain.

Figure 99-1: Displaying the two layers of text in the browser
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Task 100 Creating Layers with Relative Positions

G enerally you use the <span> tag to apply an inline style to a small section of
page content, instead of defining a larger, block-level element — as you do
with the <div> tag. By setting the position property to relative, you place the
content that falls between the opening and closing <span> tags in a location
relative to its normal position within the flow of the document.

1. Within the body section of your document, insert an opening
<span> tag.

2. To apply a name to the layer, add an id attribute and set it equal to
the name you want to give the layer.

3. 'To begin including inline style syntax, add a style attribute. The
value for this attribute will contain the various style declarations.

4. To specify an absolute position for the layer, define a position
property and supply a value of relative. Follow this declaration
with a semicolon to continue adding to the style attribute value.

5. To specify the coordinates for the layer’s position, define 1eft and
top properties and supply pixel values for them.

6. To control a layer’s stacking order, define the z-index property and
supply it a numeric value.

7. Insert the content you want displayed within the layer and close the
layer with a </span> tag.

Listing 100-1 shows a code example and Figure 100-1 shows the
results in the browser.

<html>
<head>
<title>Layered Content</titles>
</head>

<body>

<hl> The Rain in Spain Stays

<span id="plain” style="position: relative; left: -167px;
top: 40px”>Mainly in the Plain.</spans

<hl>

</body>
</html>

Listing 100-1: Example of a relative span
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The Rain in Spain Stays
Mainly in the Plain.

Figure 100-1: A relative span displayed in the browser
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Task 101 Defining a Layer’s Clipping Area

D

1.

efining a clipping area masks off content within a layer, leaving a rectangular
area within the layer visible in the browser window. By defining a clipping
area, you don’t actually delete content, you simply hide it from view.

"To begin a clipping area, , add a clip property and supply a rect value.

clip: rect

Follow the rect value with parentheses, where you add the four coor-
dinate values (see Figure 101-1).

right — >
left ——>

top 0
bottom l 0

Figure 101-1: Diagram of clipping area values

Within the parentheses, enter the first value indicating how many
pixels down from the top should be masked off. Enter a space before
assigning the second value.

clip: rect (35 )
Enter a second value indicating where the right side of the layer’s

clipping area should begin. Enter a space before assigning the third

value.

clip: rect (35 48 )

Enter a third value indicating where the bottom side of the layer’s
clipping area should begin.

clip: rect (35 48 45 )

Enter a fourth value indicating how many pixels in from the left side
of the layer should be masked off.

clip: rect (35 48 45 18)
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Listing 101-1 shows a completely defined clipping area.

<html>
<head>
<title>Clipping Areas</title>
</head>

<body>

<div id="kitty” style="position:absolute; width:100px;
height:100px; z-index:1; left: 48px; top: 46px; clip:
rect (35 48 45 18)”><img src="catcube3.jpg” width="100"
height="100"></div>

</body>
</html>

Listing 101-1: A layer with a clipping area defined
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Task 102 Preparing Documents for Scripting

his may seem obvious, but HTML and JavaScript are two different animals.

One is a markup language, and the other is a form of programming language.
Consequently, when you add JavaScript to an HI'ML document, you need to
embed the code within <script> tags. This way, when the browser reads the
JavaScript code, it knows what it’s looking at. Otherwise, the browser will assume
that what you’ve written is regular document text that should be displayed in the
browser window. In this task, you set up a container to house JavaScript code.

1. Enter an opening <script> tag, as shown here:
<script

2. Define a language attribute for the <script> tag and set it equal to
JavaScript, as shown here:
<script language="JavaScript”>

3. Old browsers don’t recognize JavaScript code. To hide your code
from these browsers, place it between HTML comment tags by mov-

ing to the next line and entering an opening HTML comment tag, as
shown here:

<script language="JavaScript”>

<!l--

4. Enter a few blank lines and enter two forward slashes, followed by a
closing HTML comment tag (see Listing 102-1).

<script language="JavaScript”>

<!--

/==

Listing 102-1: Opening and closing comment tags within a JavaScript code section




Simple JavaScript

5. Move to the next line and enter a closing </script> tag.

Task 102

Listing 102-2 shows a finished container in the head section of an
HTML document, awaiting JavaScript code.

<html>
<head>
<title>Java Script</title>

<script language="JavaScript”>

<!--

//-->

</script>

</head>

<body>

</body>
</html>

Listing 102-2: A JavaScript container in the head section of an HTML document
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Task 103 Inserting Simple Time Stamps

JavaScript is an object-based language, meaning there are a number of predefined
components (objects) the programmer can access and manipulate. One of
these is the Date object. Essentially, when you reference the Date object, the
browser looks at the date and time setting of the computer. In this task, you’ll
learn how to invoke the Date object and make it appear on the screen.

1. In the head section of the HT'ML document, insert a script container
like that in Task 102, as shown here:

<script language="JavaScript”>

<!l--

//-=>

</script>

2. Place your cursor within the container and define a variable by
entering var, as shown here:

<script language="JavaScript”>
<!l--

var
//-->

</script>

3. Give the variable an appropriate name so it’s easier to understand.
For example, because this variable stores the visitor’s current date and
time settings, name the variable right_now, as shown here:

<script language="JavaScript”>
<!l--

var right now
//-=>

</script>

4. Set the variable equal to a new Date object, as shown here:

<script language="JavaScript”>
<!--

var right now = new Date()
//-->

</script>
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5. In the body section of your document, place a script container where
you want the time stamp to appear, and inside it enter a
document . write statement and reference the variable name inside
parentheses.

Listing 103-1 shows the sample code and Figure 103-1 shows the
resulting document displayed in a browser.

<html>
<head>
<title>A Simple Time Stamp</titles>
<script language="JavaScript”>
<!--

var right now = new Date ()
//-->
</scripts>
</head>
<body>
<script language="JavaScript”>
<!--

document .write (right_now)
//-->
</script>
</body>
</html>

Listing 103-1: Place the <script> tags and document.write() statement anywhere in
the body section where you want them to appear

Sun Mar 16 13:5327 EST 2003

&

Figure 103-1: A simple time stamp. The value of the Date() object typically appears
as Day, Month, Date, Hour (24-hour clock) : Minute : Seconds, Time Zone, Year
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Task 10A‘ Changing Content Based on Time

n Task 103 you learned how to make the date and time appear onscreen. With
the right JavaScript code, you can also show visitors a different page based on
the time of day they come to your site.

1. In the head section of a new document, enter opening and closing
<script> and comment tags:

<script language="JavaScript”>

<!l--

/] -=>

</script>

2. Within the scripting area, declare a variable to hold the Date ()
object. For example:

<script language="JavaScript”>
<!--

var time = new Date ()

/] -->

</script>

3. Move to a new line and begin your if statement, as shown here:

<script language="JavaScript”>
<!l--

var time = new Date()

if ()
/] -->
</script>

4. Within the parentheses you entered, insert the variable’s name and
the getHours method, as shown here:

<script language="JavaScript”>
<!l--

var time = new Date ()
if (time.getHours () )

/] -=>

</script>
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5. Set the method less than or equal to 12:

<script language="JavaScript”>

<!l--
var time = new Date ()
if (time.getHours() <= 12 )

/] -=>

</script>

6. Follow the argument with curly braces. Inside it instruct the browser
to send the visitor to a specific document (see Listing 104-1).

<script language="JavaScript”>
<!l--

var time = new Date()

if (time.getHours() <= 12 ) {
location = index-am.html
}

/] -=>

</scripts>

Listing 104-1: A completed if statement

7. After the closing curly brace, enter an else statement (see Listing
104-2), which tells the browser which document to display if the ini-
tial conditions aren’t met.

<script language="JavaScript”>
<!l--

var time = new Date ()

if (time.getHours() <= 12 ) {
location = index-am.html

}

else {
location = index-pm.html
}

/] o-->

</scripts>

Listing 104-2: The completed if and else statements
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Task 105 Writing to the Browser’s Status Bar

very browser has something called a status bar that typically runs along the

bottom of the window and displays what the browser is currently doing. For
example, when you run your mouse over a link, the link’s URL appears. When
you click a link, the status of the download’s progress appears. Using JavaScript,
you can control the contents of the status bar. In this task, you’ll learn how to
customize text in the status bar using event handlers.

1. To customize text in the status bar when a page loads, add the
onLoad event handler to the opening <body> tag, as shown here:

<body onLoad

2. Set the onLoad handler equal to window. status, as shown here:

<body onLoad="window.status

3. In turn, set window. status equal to the string of text you want to
display in the status bar when the page loads. Use single quotes
around this value and double quotes around the entire onLoad value,
as shown below. Figure 105-1 shows how the browser’s status bar
appears after the document loads.

<body onLoad="window.status=’'The Rain in Spain Falls
Mainly on the Plain’”>

Figure 105-1: The status bar displays this text until the next event triggers a new
handler.
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4. To customize text in the status bar when an image is moused over,
add the onMouseOver event handler to the <img> tag and set it
equal to a window. status statement, as shown here:

<img src="daisy.gif” width="100” height="100" alt="Daisy”
onMouseOver="window.status='This is Daisy!’”>

5. To change the status bar text when the mouse moves off the image,
add an onMouseOut event handler and define it as you require. For
example:

<img src="daisy.gif” width="100” height="100" alt="Daisy”
onMouseOver="window.status='This is Daisy!’”
onMouseOut="window.status='Meow!’ ">

Figure 105-2 shows the mouseover effect.

Figure 105-2. Changing the status bar with an onMouseOver event so that it reads
“This is Daisy!” when the picture is moused over
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Task 06 Hiding E-mail Addresses
from Spammers

ne of the ways spammers harvest e-mail addresses is by setting up programs

(called bots, short for robots) that crawl across Web sites searching for
mailto: links, which indicate the presence of e-mail addresses. You can circum-
vent this trick by breaking an e-mail address down into its component parts, set-
ting each part equal to a variable name, and then putting it all back together
again using a document . write statement.

1. In the body section of your document, place a script container where
you want the e-mail address to be written.

2. Between the comment tags of your container, enter a variable to hold
whatever name or word appears before the @ symbol in the e-mail
address. For example:

<script language="JavaScript”>

<!l--
var myName = “robert”

//-->

</script>
3. Define another variable to hold the domain name which appears after
the @ symbol in the e-mail address, as shown here:

<script language="JavaScript”>

<!l--

var myName = “robert”

var myDomain = “highstrungproductions.com”
//-->

</scripts>

4. Define a third variable which adds the two variables together with an
@ symbol. For example:

<script language="JavaScript”>

<!l--

var myName = “robert”

var myDomain = “highstrungproductions.com”
var myAddress = myName + “@” + myDomain
//-->

</script>
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5. Enter a document .write statement which concatenates the anchor
tag and last variable. Listing 106-1 shows the complete code and
Figure 106-1 shows the corresponding code displayed in a browser.

<script language="JavaScript”>

<!l--

var myName = “robert”

var myDomain = “highstrungproductions.com”

var myAddress = myName + “@” + myDomain

document .write (“<a href='mailto:” + myAddress + “‘>Write
Me</a>")

//-->

</scripts>

Listing 106-1: Breaking an e-mail address into variable values, which keeps
spammers from collecting a usable address

Figure 106-1: The mailto: link is written with the “Write Me” text specified in the

document.write statement, and when it's moused over, the completed link is referenced
in the status bar.
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Preloading Images

hen a browser reads an HT'ML document and comes across an <img> tag,

it begins downloading the image file from the Web server in order to dis-
play it in the flow of the document. The time it takes to do this varies on the size
of the image and the speed of the visitor’s Internet connection. In Task 29 you
learned that defining width and height attributes speeds the loading of the overall
document by letting the browser know just how much space each image
requires — so the rest of the document can load in the meantime. Using
JavaScript, you can inform the browser of all the images in your document and
have them loaded into memory before the browser begins loading the page. The
result is that the browser loads the entire page at once after it’s downloaded all
the image files.

1. In the head section of your document, enter a script container, as dis-
cussed in Task 102.

2. Define a variable within the comment tags of the script container and
give it a name that describes the image it’s going to store. For
instance:

<script language="JavaScript”>

<!l--
var orangeCat

//-->

</script>

3. Set the variable name equal to a new image object, as shown here:

<script language="JavaScript”>

<!l--
var orangeCat = new Image ()

//-->

</script>

4. Inside the parentheses, enter the dimensions for the image — width
followed by height, separated by a comma:

<script language="JavaScript”>

<!l--
var orangeCat = new Image (150, 50)

//-->

</scripts>
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5. On the next line, define the pathname of the source file for the image Task 107

object:
<script language="JavaScript”>

<!--

var orangeCat = new Image (150, 50)
orangeCat.src = “images/japser.jpg”

//-=>

</script>

6. Repeat Steps 2 through 5 for each image in your document, as shown
in Listing 107-1.

<script language="JavaScript”>

<!l--

var orangeCat = new Image (150, 50)
orangeCat.src = “images/japser.jpg”

var crazyCat = new image (150, 50)
crazyCat.src = “images/daisy.jpg”

var bwCat = new image (150, 50)
bwCat.src = “images/calvin.jpg”

var babyCat = new image (150, 50)
babyCat.src = “images/willow.jpg”

//-->

</script>

Listing 107-1: Multiple Image() objects defining image download details

7. In the body of your document, define your <img> tags as you nor-
mally would. When the browser calls up the images it will do so from
the copies in local memory it downloaded prior to loading the page.
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Task 108 Creating Simple Image Rollovers

An image rollover is the result of swapping one image for another in response
to a mouseover. Images should be preloaded so that when the mouse event

triggers the swap there isn’t a blank spot onscreen while the browser downloads
the image file.

1. In the head section of your document, enter a script container.

2. Define a variable within the comment tags of the script container and
give it a name that describes the first image displayed in the rollover.
For example:

<!l--
var homeButtonUp

//-->

3. Set the variable name equal to a new image object and, inside the
parentheses, enter the dimensions for the image, as shown here:

var homeButtonUp = new Image (100, 50)

4. On the next line, define the pathname of the source file for the image
object, as shown here:

var homeButtonUp = new Image (100, 50)
homeButtonUp.src = “images/home up.gif”

5. Repeat Steps 2 through 4 to define the image to be displayed when
the mouse rolls over the image. For example:

var homeButtonUp = new Image (100, 50)
homeButtonUp.src = “images/home up.gif”

var homeButtonOvr = new Image (100, 50)
homeButtonOvr.src = “images/home ovr.gif”

6. In the body of the document, create an image link using the first
image displayed in the rollover, and add a name attribute set equal to
a word describing the image:

<a href="index.html”><img src="images/home up.gif”
width="100"” height="50" alt="Home Page” border="0"
name="home” ></a>

7. Add onMouseOver and onMouseOut event handlers to the <a> tag:

<a href="index.html”
onMouseOver="document . home.src=homeButtonOvr.src”
onMouseOut="document . home . src=homeButtonUp.src” ><img
src="1images/home up.gif” width="100” height="50" alt="Home
Page” border="0" name="home”></a>
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8. Repeat Steps 6 through 7 for each rollover image for which you’ve Task 08
defined image objects. Listing 108-1 shows the complete code for the

document. Figure 108-1 shows the effect in action.

<html>
<head>
<title>JavaScript</titlex>
<script language="JavaScript”>
<!--
var homeButtonUp = new Image (100, 50)
homeButtonUp.src = “images/home up.gif”

var homeButtonOvr = new Image (100, 50)
homeButtonOvr.src = “images/home_ovr.gif”
//-->

</script>

</head>

<body>

<a href="index.html”
onMouseOver="document . home.src=homeButtonOvr.src”
onMouseOut="document . home . src=homeButtonUp.src”><img
src="1images/home up.gif” width="100” height="50" alt="Home
Page” border="0" name="home”></a>

</body>

</html>

Listing 108-1: Image rollover code

E
—

Figure 108-1: Image rollover effect rendered in the browser
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Task 109 Creating Simple Pop-up Windows

efore you read onward, you should understand why pop-up blocking soft-

ware is so popular. When used intrusively, pop-up windows aggravate your
visitors’ experience of your Web site. Use them, if at all, to enhance the viewing
experience, not to pummel viewers into submission. In this task you learn how to
open a small window with a mouse click.

1. Within the body of your document, insert an anchor tag:

<a>

2. Define an href attribute for the tag and set it equal to #:

<a href="#">

3. Follow the attribute with an onC1ick event handler, as shown here:

<a href="#" onClick>

4. Set the event handler equal to window.open (), as shown here:
<a href="#" onClick="window.open()"”>

5. Inside the parentheses, enter the name of the document inside single
quotes that you want displayed in the pop-up window. For example:
<a href="#" onClick="window.open(‘dingo.html’)”>

6. Enter a comma and follow the name of the document with the name
you want to assign the window object. For example:
<a href="#" onClick="window.open(‘dingo.html’,
‘myWindow’ )" >

7. Enter a comma and define the window properties you want to
include within single quotes, separated by commas. For example:

<a href="#" onClick="window.open(‘dingo.html’, ‘myWindow’,
‘width=300, height=200")">
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Your choices are as follows: Task 109

* width specifies the width of the window in pixels

® height specifies the height of the window in pixels

® location=yes includes the window’s address bar

® toolbar=yes includes the window’s standard toolbar buttons
* scrollbars=yes includes the window’s scrollbars

8. Follow the opening anchor tag with the image or text you want
affected and complete the link with a closing anchor tag.

Listing 109-1 shows such a link in a document. Figure 109-1 shows
the results in a browser.

<html>
<head>
<title>Pop-up Windows</title>
</head>
<body>

<a href="#" onClick="window.open(‘dingo.html’, ‘myWindow’,
‘width=300, height=200’)”>Dingo? What Dingo?</a>

</body>
</html>

Listing 109-1: Link code that opens a 300 x 200 window

Figure 109-1: The pop-up window that appears after clicking on the link
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Task 110 Adding a Free Google Search Bar

G

1.

oogle is the most widely used search engine on the Web. With just a little bit
of code pasted into your site’s documents, you can add a Google search bar

to your site free of charge.

Go to www.google.com. Beneath the main Google search field, click
the Business Solutions link.

On the following page, scroll to the bottom and locate the Free
Solutions category. Click the Free Search link.

At the “Google’s Free Web WebSearch and SiteSearch” heading,
click the Sign Me Up for Free Search link directly beneath the
heading. The next page to appear begins, “Step 1 of 4: Select a
Search Option.”

On the Step 1 of 4 page, check the Free WebSearch radio button and
then click the Continue button at the bottom of the page.

On the Step 2 of 4 page (see Figure 110-1), use the form to customize
how the results page will appear. Enter color options, supply Google
with the URL of your site’s logo, and preview the results. When
you’re satisfied with your modification, or choose to leave the default
settings as they are, click the Continue button to proceed.

URL flocation) of your loge:

o Wip iwww youe sgriiogo pf
Sz of your logo (m pixels). ml nqnl
Algnment of your loge |¢ll¢ i

Colors can be entered in either text or hexidecomal form, (e.g. black or M000000).
Google logo background color:  [Whas 5]

Background (BGCOLOR) color: | ]
Text (TEXT) color- k

Figure 110-1: The form fields that customize how your Google search results page will
appear
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6. On the Site 3 of 4 page, enter your first and last name, your e-mail
address, a chosen password, a company name if you have one, and the
URL of your Web site. Click the Continue button to move ahead.

Task

7. The Step 4 of 4 page (see Figure 110-2) displays the source code
required to place a Google Search bar onto your site. Select the code
with your cursor and copy and paste it into your chosen HTML
document.

Create a bnk to Google's Free Search sermce by copyng aad pasting the follownng html code mte your owm web

"l--ISQ-I.;cth‘e--’ B
| <censer>

<FORM mehod=CET acnon=hap ffwww googht comicustom>

‘<TABLE bgeclor=#FFFFFF >

wwcnb

ﬂHG SRCshsp Swww googhe comfogosLogo_40wht gf borderm ALTeGoogle aligrmmsdde> </A>

<hd>

[ etd>

| <INPUT TYPE=text namenq arem] | maslengthn? 55 yakipen™>

(<INPUT typessubme namessa VALUE="Google Search™

[ «INFUT typesbadden namescol VALUE="AH center, S hitp ffararw mango. com AWFID de5b3c3c 1ed02d3E">.

| <Ahd><fr></TABLE>
‘JFORH’

el Semhﬁb!e

Figure 110-2: The source code Google provides for you to copy and paste into a
document on your Web site
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Task 11 Adding a Free News Ticker

am.com offers a free news ticker you can easily place on your Web pages.
The ticker is a small Java applet that you add to pages by copying and pasting
a few lines of code.

1. Go to www.7am.com/ticker/ to read about the features of the 7 a.m.
ticker, shown in Figure 111-1.

the 7am ticker

o What is the 7Tam.com News Ticker?

R's o groat mews gerace om Tam com News Shat brngs the very latest m beadines to
YOUR wab pagis - 24hrs & day, 365 days 4 yaar

The 7am com News Tickes is & very small Jave spplet that can be added te yeur own
pages by inchuding just & senall ameust of axtra HTML code (see Add Tickar). And

Figure 111-1: The 7 a.m. ticker information page

2. When you’re ready to add the free ticker to your page, click the Add
the Free Ticker link (sixth link down the bulleted list when we wrote
this book) to take you to the installation instructions.

3. Read the instructions thoroughly. Copy and paste the applet code
from the first field into your Web page’s source code, shown in
Figure 111-2.

4. Add any of the available parameters you want to include, as described
in the All Users section.

5. Follow the instructions to add your own headlines and corresponding
URL:s to the ticker.
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the 7am ticker

' How 1o install the ticke: Appler on your Web page =& 890
Step 1. Inttall the bacic Ticker Code!

Select tha code in the box below, copy @ aad paste inde yeur hinsl in the place
whew you want the licker to sppear. I You see not sure abowt thes then plaase ge
Reths bothem of the 0Bt

applat Coden"sevenillensTicker .class” Q
"RLER 1/ /W, Tam. 0w JAVA" W1AthS450 Daight=15>

Kparas smee="channels® VALOE="+808Lbnevs ">

</applet>

For those websies that only requese an overvew of the world news beadines, the
sasice Comed koe of charge -and that's &

Figure 111-2: Getting the code for the 7 a.m. news ticker: the first field contains the
applet code; the rest of the page describes the available parameters for the applet

. Test your document in a browser and make any modifications to the
width and height attributes of the applet tag you see fit. Figure 111-3
shows the applet at work.

EEEEEEN 0 e eielcesbesviesasn B

Figure 111-3: The 7 a.m. news ticker in action
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Task 442 Adding a Web Poll

reepolls.com provides free, customizable, form-based polling for your site.

With an account you set up on the Freepolls.com Web site, you can adminis-

ter your poll from their site — changing poll questions and layout — and see
your changes executed on your site.

1. Go to www.freepolls.com and click the Sign Up button to start the
registration process. On the Step 1 page, choose a username and
enter it into the field provided. Click the Next button to advance and
choose your account type.

2. When your username is accepted, the next page displays all the dif-
ferent account types that Freepolls offers. Choose the 100% Free
account option at the bottom of the page by clicking its Sign Up
button. Doing so takes you to the Account Info page.

3. In the fields provided on the Account Info page (see Figure 112-1),
enter your vital statistics (name, e-mail address, preferred password,
etc.). Choose any Special Deal information you want to receive,
complete the Terms of Service section, and click Next.

Signup
Please M in your account information below. Your info will be kept plately
confidential, and will not ba shaned with cutside partios without your Sxpress Permssion

Your Site: http:/ /coptol freepolls.com

it Wi ‘_ prenpanpmy, ‘._
Passwond: I Verify Password: I
Mot Pyzswoed mart contem ot beart & we " o laatars pnd mobary fre peaster recusty

E=mad Adidress: I— Verfy E=mad: I'—

soty Thir armad sddress well by caed to pand pou miprmetwn sn uposter regasdmg your Franpolls com acovest
Proforred E-mad Format:  © 7ML Format T Test Format

Date of Birth: mmy/18yy r‘ n 4_‘

Figure 112-1: The Freepolls.com New Member Signup page

4. The next page of the Poll Wizard is another Deals page, which has
one option prechecked. If you don’t want this stuff, deselect it and
click Next to proceed.

5. Go to the middle of the next page where it says Create a New Poll
and click the Create New Poll button.

6. On this page (see Figure 112-2), enter your poll question and possi-
ble answers into the fields provided. Once you’re finished, click Next.
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This s the poll guestion.
For sxample; "Who will win the Workd SeresT

Poll Answors/Choices  Choce #1 [~ Chocess [T
checerz [ chokesr [
Chuice #3 [_ Chaice ## |_
Choce#d [~ Chocesws [
Choco#s [ Choceswo [

Aftor entering the poll question and answars, continue to the next step. Ment > |

Figure 112-2: Poll Wizard page where you formulate your poll question and answers

7. On the following page, enter your poll title, the URL of your page
where the poll will appear, and the name of your site. Select the cate-
gory that best fits your site. Click Next to proceed.

8. In the next two pages, choose a color scheme and then a layout. Click
the Get HT'MIL button to move to the last page in the Poll Wizard.

9. The last page provides different options for displaying your poll (see
Figure 112-3). Choose the option that best suits your needs and then
copy and paste the source code from the provided field into your
document.

You
a3 ghown:
® RECOMMENDED: With this verson of the poll sorgt, you only need to
’;":“ insert it on your page once.
P ® When you changs your pol from the Freepolis.com administration anea, the
e ad o page whire you placed the poll wil iy Show your
the Guertion changas (no need 10 update your sie).
® For sxample, you could have 2 weeldy poll that you change once per week.
E You would never have to update your site,
® You need to copy and pasie this script to a page on your séte (ana tima
[heepots]  oniy).
Lesirss o o Mlay
w '-- Bagin Poll Code
F=r S TTLE  avand A0 L4604  pomit bon
CLASS=1vaAnC10479415246094
% IP=Svanl104 794152960442 <4
M F=hsp://fcnepolls.com CLASS=ivanl_FP
= kg™ ==+ e g
Ad Cost:
$0.05 ™ Makn polls results pap Up i & Paw window.,

g

Figure 112-3: The JavaScript option shown first seems to be the most eye-catching; it
also has the most upfront advertising

10. Test your document in a browser.
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Task 13 Becoming an Amazon.com Associate

o become an Amazon.com associate, place a properly configured link to
Amazon.com on your Web site. When your site’s visitors click through to
Amazon.com from your site, you earn up to 15 percent in referral fees.

1. Go to www.amazon.com and scroll all the way down to the text links
that begin with Directory of All Stores, shown in Figure 113-1. Here
you see the Join Associates link. Click this one to begin.

Whera's My Stuff? Shipping & Returns Newd Help?

* Track your (ecent orders. * Soe our shiopig (ales B polcies. ¢ New customer? Cick here to leam

* View or change your orders in = Egturn an item (heve's our Eaturns  sbout searching, browsing. and

Youc Account. BodCy) Shoppeng Bt Amazin com.

» See our anamated demol * Forgot your password? Chck here,
+ Badesm or buy @ gift certificate

Our Internanional Sger Casads | Usgted Epgdos | Gemmey | Japsn | Erasce I
Help | Shoppme Cart | Youw Accous | SelBoms | 1-Chck Settmps
WIWIMIWI&MIM

Figure 113-1: The Amazon.com Join Associates link (Image © 2002 Amazon.com, Inc.
All Rights Reserved.)

2. Having read through the overview information, click the Read Our
Operating Agreement link at the bottom of the page and read that
information as well. Once you've read through the pertinent docu-
mentation, scroll to the top of the page and click the Join Now link.
A dialog box appears, informing you that you’re about to access a
secure server. Click Yes to continue and advance to the first part of
the registration process.

3. In the fields displayed on the next page (see Figure 113-2), enter your
e-mail address, check Create a New Password for Associates Central,
enter and confirm your password, and then click Submit.

4. On the following page, read the instructions thoroughly and com-
plete the form. Click the Submit button at the bottom of the page
when you’re done. Depending on the payment option you chose on
the previous page, the next page you see may request banking infor-
mation. The other options sends you gift certificates or checks.

5. You'll be shown your account summary. Choose the Edit button if
there are any errors, or Submit if the information is correct.
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Primary amail: Meste enter the emad address that we should use for ol
- garding g n ! Central, and more.
This wil be the sngle emad address assocsated with your account snd should be
wsed by you when writing o the Amazon.cos Associates Program for any reason.
This will make it addier for our Customer Service depanment to quickly addness your

Primary emall: |
& 1 am am exytmg Amazos com customer
My password is: I_-
OR
© Crease a new password for Associates Central

pesswors: |

Figure 113-2: Entering your e-mail address and creating a password (Image © 2002
Amazon.com, Inc. All Rights Reserved.)

6. The next page provides you with instructions for putting the Amazon.
com link and graphics in your page. Click the Build-It button below
the Amazon.com graphic of your choice. You'll be asked to log in to
Associates Central, at which point you are presented with the neces-
sary HT'ML code, already embedded with your Associates ID.

7. On the next page (see Figure 113-3), copy the source code from the
top field in the document. Copy the graphic to your computer for
uploading to your Web site. Depending on where you place the
graphics within your site, you may need to edit the <img> tag code
that Amazon.com supplies.

1. Copy the HTML.

<&

PREF = "RCTD: / / WUV, M EOK . COBY B34/ 0D 1008/ CRALTSCT TLAGT
pre=gnoreyliixdd. git border=0o</ >

® Copy everythmg Bom the boxmstep 1

» Paste 2 mdo the appropruate place = your HTML Your trackeg ID (mango-20]) = already
embedded n the HTML

» Drowsload the graphsc from Svep 2 mio e same drectony as your HTML I you seed 5o
Sowmload the graphes mic » dferent deectony be rure o change e maags source (DMG SRO)
path to match the new location (chek here for mstrucoas o how Bo copy and download graplacs)

Figure 113-3: Copying and pasting the code, and saving the graphic (Image © 2002
Amazon.com, Inc. All Rights Reserved.)
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Task 11A‘ Adding a Free Hit Counter

Free—Hit—Counters.com gives you a free hit counter, and they get an opportu-
nity to advertise their product on your site. Their hope is that you’ll drive
traffic to their site and those folks (or you) will sign up for the upgrades, which
does cost something.

1. Go to www.free-hit-counters.com and click their Sign Up link. In the
first page (see Figure 114-1), enter your name, e-mail address, site
URL, etc. in the fields provided. Click the Join button.

Welcome to

Free-Hit-Counters.com
Fraa Hit Countars’ bve webste traffic
statistics are avadable through any
Our hat "

Sent for web %, wab mark
and wab promoters, Frae hit counter
service i very easy to use, and we offer

et 9 serviced

to users who need a different profile than
_ | the free sccount provides.

Haw doos it work?

= New users recesve hit counter code upon
froe Nt counter's serwcs. Tracking

code must be installed within the el

code of sach web page to be tracked.

| Each tme a tracked web page is

| requested, tha Free-HC server 5 asked to

provide a graphic image to duplay.

Through this arangemant, frae hit

counters records site visitor statistics.

Users may logn anylime 1o viaw bve

trafic reports.

S00.u0 (0 4 (109 ACCOuN

Figure 114-1: The Free-Hit-Counters.com initial sign-up page

2. Select an image from the list of choices (see Figure 114-2) and click
the Choose button.

3. Select the code on the following page (see Figure 114-3) and copy
and paste it into the body of your document where you want it to
appear.
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FREEHIT-COUNTERSCOM

Figure 114-2: Image options available for your counter

4. Click the Finish button.

Figure 114-3: Copying the hit counter’s JavaScript code from the field provided

AIEERAVIFRTOT . USeL APERT LOLOYEETARE (12
img=escepe {~. /bwttona/bd. Jpg®) s
umant, cookie=' _support chesk=l':
‘heepts

18 { [ loaar San. heat . subste (0, 8] == heeps: ) | | | losasy,
ip='hrcpe” ;) data = 'fagt=' + ascepe(agt] #
"Eimg=' + img + 'Ce=' & mscape (document.raferrac)

i+ ' Gali=' & epcape(navigstor.appliems) + ‘élg=' =
Eacape (RAVIgALSE . SyStEnlanguags) + 'C08=" &
jescape (navigator. placformy + " salV=' &

jescaps (RAVIGALAE . APPVEES1ER) &

1£ (narvigetor. appVersion. subsrring(0,1)>'3") (daca
= data + "Ced=' + scresn.calsrDepth + '&p=' +

[
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Task 15 Adding Weather Data to Your Site

f you want to provide your site’s visitors with a local four-day forecast, or the
ability to search for that information, TimeTemperature.com has the solution
for you.

1. Go to www.timetemperature.com and click the link at the top of the

page that adds a free weather chart on your site. The first page shows
you the three options available to you: a free weather image, a free
custom weather page, and a weather search box.

. To insert an image containing a four-day forecast for your location,
enter your City, State, or ZIP code in the fields provided at the
bottom of Method 1. Click the Go button.

. On the following page, you see the current weather and four-day
forecast for that locale. To add this information to your Web page,
click the link in the middle of the page that reads, “Click here to add

this forecast to your web site!”

. The next page (see Figure 115-1) offers you the source code required
to place both images (current weather and four-day forecast) in your
Web site. Simply copy the HT'ML to your page where you want the
images to appear.

You can add the following tone forecast to your web page:

" . P ol
Bated: 334 PW EST NOW WK 17 2900

TOMIGHT Tugstny T MEDMESDAT
Chear Partly

Partly Partly

]
mm Ll [T 5. L
d g e, £ Lcon

Teo add uimply capy the followsmng himl te your page:
<abuefe"h P Hwwsr = “"“;' L
bt e Lo o e i g
g ety S s comcgp b &
ben i ar.stoisrarr &rmpeode= | HE place=Hunmgdonsvaey
Endrpaicountiy=uslbpr=ge=Sr=Smetne=00 duplay=" border="1" wdih="10"

Iutaghte " JI" 3 Ua>

Figure 115-1: The Method 1 source code page for adding weather information to your
Web site

. To order a free custom weather page, click the order link beside the
sample under Method 2. Enter your e-mail address, Web site URL,
city and state, and your name in the fields provided. You’ll be sent the
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URL of your custom weather page within two or three business days.
Then just link from your site to that page.

6. 'To insert a weather search box, go to Method 3 (see Figure 115-2)
and copy and paste the provided code into your document.

Tha therd sathod of FREE wwallvs contens for yeur wab es & 10 utilioe sue op code seach
o Yo cus parts the cods for this sewrch box ints the himd sectson of « tes box on you se wnd 8 wll
appea pust Bice the example below B you Mm_ﬂuucuhmm

¥ You cen also smmply ok ta
Chel hege Thes
[ BB Tty

With mast HTML ¥ mply creale 4 st Doz wnd paste the faBowing code wle e himd
wwction for e text Box Hews i the cede be copy snd paste o your web page.

<ES0D method="POST™

sction="hicp://vww. cimetemperature..com' ogl=bin/geccow/gatev. cgi®™>
<pr<mt Far Enter<BR> fquot:City,
Statedquot </ stoong>,or <strong>Iipcode</stoong>: <Bi>

41nput EYPET"hiddEn” name="thene™ VAlus="dsfault™:

<inpst ctype="hidden” name="user” valwe="defaulc”>

<IRpME EYPE="hiddEN" BARE="LOCECASL™ VAlues"IandN":

<input type=“text” neme="pands® Fize="15" value=""»

<1ApNE EYPESTBUBBIE" VAINE="GD" mane="Subsit”:(nbepr </pr4/tormd

Figure 115-2: The Method 3 source code page for adding weather information to your
Web site
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Downloading and Installing TextPad

extPad from Helios Software Solutions is, in our opinion, the best Windows-

based text editor on the market. It functions seamlessly in any modern
Windows OS (95, 98, ME, N'T; 2000, and XP), it loads quickly, and it’s designed
in accordance with the Microsoft Windows Guidelines for Accessible Software
Design. What that means is that it looks and behaves similarly to any Microsoft
product you’ve installed, so learning how to use it doesn’t require mastering a
new user interface from square one. If you’ve used any Microsoft Office applica-
tion, you can figure out TextPad’s basics in one sitting.

You download the full application on a trial basis. After evaluating the program, if
you want to keep using it, you can purchase and register it online. Before you can
start using TextPad, you need to download and install it. The download takes
only a few minutes, even when using a dial-up connection, and the installation is
completed in seconds.

1. Go to www.textpad.com.

2. Click the Download link at the top of the page (see Figure 116-1).

he Jouw dadisor
Foor B inaderics

extPad"

TEX(P ad home page

English | Jopanese | Polski

TextPad & s 3 powerful, TextPad 4.6.2 i the cument
genaval puspote editor for release. You are weicome to
plan text fies. Basy to use, download 2 copy for free
with al the features a power evaluation,

USET MeGUINeS. Downioad now .

More .

Figure 116-1: The navigation link to the download page on the TextPad site

3. Click the link titled TextPad Downloads from the bulleted list at the
top of the page or scroll down to the heading of that same name.

4. From the table (see Figure 116-2), select the language you want and
click the link for the download method you prefer. For readers in
North America we suggest either HT'TP (USA) option to download
the installation file.



TextPad

Figure 116-2: The table of download options

5. A dialog box will ask you if you want to save the file or open it.
Choose Save to begin the download and specify where on your hard
drive you want the file saved. Make sure you choose a location you
can find later on.

6. Once the file has downloaded itself, double-click the file’s icon to
begin the installation process.

7. Follow the prompts provided in the installation wizard until the
installation is complete (see Figure 116-3). Depending on when you
download your copy, your version number may differ from the one
shown here.

Welcome to the InstaliShield Wizard for
TextPad 4.6

The InstalsrisidR ) Wizard wil diow you 10 se0cfy, repar, of
ramove TextFad 4.6. To contnue, dick Next

Figure 116-3: The InstallShield Wizard for TextPad
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Task 17 Creating and Opening Files

hen you first open TextPad, you see a new blank file. You also see various
interface elements at your disposal to generate HTML files.

1. To create a new unnamed document, choose File = New or click the
New Document button (see Figure 117-1) on the tool bar. You will
see a blank screen awaiting your code.

Figure 117-1: TextPad’s New Document button

2. To create a new named document, choose File &> Open or click the
Open button (see Figure 117-2). This displays the Open File(s)
dialog box.

Figure 117-2: TextPad’s Open button

3. In the field that lists all your folders (see Figure 117-3), double-click
a folder where you want to create the file.

Figure 117-3: The Open File(s) dialog box
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4. 'Type the filename in the File Name field.

5. Use the Files of Type list to select the file type (HT'ML) and then
click OK (see Figure 117-4).

Flaa ")

Figure 117-4: The Files of Type list

6. Click Yes in the message box that appears, which tells you that the
file does not exist and asks whether you want to create it.

7. To open an existing file, choose File &> Open from the menu or click
the Open button to display the File Open dialog box.

8. Locate the file you want to open from within your file system and
click OK.
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Task 18 Moving Around in Text

Programmers don’t touch the mouse much. Why should they? When you
code, you type a lot so why should your hands ever leave the keyboard?
TextPad, like any good text editor, provides keystrokes that can move the cursor
quickly through your code so your fingers don’t have to waste precious seconds
moving to the mouse to perform basic functions. (Well, almost never.)

1. To move the cursor to the beginning of a file, press Ctrl+Home (see
Figure 118-1).

el
thead >
ttitle>Richard A. Levan
tneta http-equiv="Cont
tlink rel="stylesheet”
t“head>

Figure 118-1: Pressing Ctrl+Home jumps the cursor to the start of the document.

2. "To move the cursor to the end of the file, press Ctrl+End (see
Figure 118-2).

LS

i/table>
/H >
:/hl.urwl

Figure 118-2: Pressing Ctrl+End jumps the cursor to the end of the document.

3. To move the cursor forward one word (or tag, attribute, or value),
press Ctrl+W.

4. To move the cursor back one word, press Ctrl+B.
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10.

"To move the cursor back to the end of the previous word, press

Curl+D. Task 18

To move the cursor to the start of the next paragraph, press Alt+!.

To move the cursor to the start of the previous paragraph, press

Ale+T.
To scroll down one line, press Ctrl+l.
To scroll up one line, press Ctrl+T.

To move the cursor to a specific line number, press Ctrl+G to open
the Go To dialog box and enter the line number.
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Task 19 Selecting Code

reating code is a matter of typing it out. But after that you need to be able to
manipulate it. In order to edit the contents of your HTML file, you need to
learn how to select it. TextPad provides the following methods for selecting code.

1. Asyou're likely used to doing in your favorite word processor, select-
ing code with your mouse is as easy as holding the left button down
at the start of the code you want to select and dragging the pointer to
the end of the selection (see Figure 119-1).

="GET" action="hitp ~cwew mle ¥ =uuﬂ
Innl-'l " cull 0= k] Ill'll' right*s

u.i 1
itdidlont faces"dria watica. eams-oeril” nu- 2%

finput t "radic” names"sitesesrch” wvalues"
tfont colors"FFFFFEE"» Babcs/fomt)
{input Lypes‘radic”’ names’sitessarch’ walues"vew rlevan coa”

»
ciont color="sFFFFFF " » rlevan con < lomtocsdontd td
ATt 2

Figure 119-1: Dragging across a selection to highlight it

2. To select a single word, double-click it with the left mouse button
(see Figure 119-2).

sction="http ~~wwy mle S =uuﬂ
8" oul 1 k] |lln- right*s

“deunder line” rinbsp. (/td)
face="Arial Helwetica sans-oexril” nu- 2%
"radic” nases"sitesesrch’ values”
= "JFFFFEE "» Wabc fomt)
{input Im- radic” name="sitessarch’ walue="vew rlevan coa”

cfent eem- SFFFFFF "+ rlevan com < lomtocsdontooreds
T

Figure 119-2: Double-clicking a word to select it

3. To select a whole line, move the cursor to the left margin until it
changes to a right-pointing arrow, then double-click at the start of
the line.

4. 'To select a whole paragraph, triple-click in the left margin at the start
of any line in the paragraph.

5. To select the entire document, hold the Ctrl key and click anywhere
in the left margin of the document. Alternatively, press Ctrl+A or
select Edit = Select All from the menu (see Figure 119-3).
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""" Laggs mouse at the start of the
selection, hold down the
Shift key, and then click
the mouse at the end of
the selection.

= You can use the Shift key
in conjunction with any of
the keystrokes discussed

4 5 I-Ij inTask 118 to select a
ey = = S o e = word, paragraph, or line
at a time.

Figure 119-3: Selecting the entire document

6. To select code with the keyboard, hold the Shift key down while
using the arrow keys to move the cursor to the end of your selection.

7. "To cancel your selections, press the Esc key.

cross-reference

= Because HTML coding can
become repetitious, you'll
probably be doing a lot of
copying and pasting. That's
a function of the Clipboard,
covered in Task 120.
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rask 4 20 Using the Cliphoard

TextPad offers the same Clipboard functionality you’re accustomed to in other
applications (Ctrl+C = Copy, Ctrl+V = Paste, and Ctrl+X = Cut). TextPad also
provides a few unique Clipboard functions you’ll wish your word processor
possessed.

1. With no code selected, copying the line the cursor is currently on is a
simple matter of choosing Edit ©> Copy Other = Line. Cut the line
to the Clipboard using Edit => Cut Other = Line.

2. To copy the word the cursor is currently in, choose Edit => Copy
Other = Word. Cut the word to the Clipboard using Edit &> Cut
Other & Word (see Figure 120-1).

Figure 120-1: The Copy Other menu

3. To add more code to whatever you currently have in the Clipboard
buffer, select a range of code and choose Edit &> Cut Other = Cut
Word Append, or Cut Line Append, or Edit &> Copy Other = Copy
Line Append or Copy Word Append.

4. 'To copy a line of code from one document and paste it into a new
document, including the necessary tags to render an HTML
document, choose Edit = Copy Other &> As a HTML Page (see
Figure 120-2).
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Figure 120-2: Code copied into a new document with all necessary document tags

5. To paste text from a browser and have it maintain its HTML format-

ting, select the text in the browser window, move to TextPad and
choose Edit = Insert = Paste HT'ML (see Figure 120-3).

«?xml version="1 [ ---- 150=085%=1" 1) -
<« /DOCTYPE htal PUBLIC "-//W3C/ DTD XHTHL 1.0 Trassitional /EN° "http - wev wd org-TR/whtall-DTD
<html xmlna="http ~“www vl org 1995 =zhtml'y

»

restitlar

http-equivs “Content-Trpe" comtent="text-html. charsst=iso-801%-1"
»

chomt mize* 1 rkcopy. 2083. High Struny Prodections. Inc. s fonti]

-r’hudr
cs/htnly

Figure 120-3: Text copied from a browser and pasted with the appropriate HTML
formatting
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Task 21 Managing Files

extPad allows you to manage multiple files using the Manage Files dialog box.

From this little interface, you can duplicate, delete, and rename files, as well
as update their timestamps. All of these functions come in extremely handy when
you work within a large Web site.

1. To access the Manage Files dialog box (see Figure 121-1), click the
Manage Files button on the toolbar (it looks like a filing cabinet,
fourth button from the left) or choose File = Manage Files.

Figure 121-1: The Manage Files dialog box

2. Click the Browse button to locate the file you want to work with.
Then click OK to accept the file you select.

The following steps assume you’ve selected some file in the Manage
Files dialog box.

3. To copy the selected file somewhere else in your folder structure,
click the Copy button to display the Copy dialog box (see
Figure 121-2).

Figure 121-2: The Copy dialog box

4. From here, click the Browse button to choose where you want to
copy the file. Click OK to complete the copy.

5. To delete a file, click the Delete button to display the Delete dialog
box (Figure 121-3). Click the OK button to confirm the deletion.
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Figure 121-3: The Delete dialog box

6. To rename a file, click the Rename button to display the
Rename/Move dialog box (see Figure 121-4).

Figure 121-4: The Rename/Move dialog box

7. Enter a new filename in the To field to rename it in the same folder
as the original file, or click the Browse button to move the file to a
different folder.

8. 'To update the file’s timestamp, click the Touch button and then click
OK in the Touch dialog box to change the document’s last modified
date and time to the current system settings.
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Task 22 Using the Find and Replace Tools

ind-and-replace functionality is vital for Web site maintenance. You might

have multiple documents with multiple instances of identical link code and
now you have to change all the links to a specific page throughout the site.
Don’t panic — TextPad’s find and replace functionality is second to none.

1. To find code, choose Search = Find from the menu to open the Find
dialog box (see Figure 122-1).

Figure 122-1: The Find dialog box

2. In the Find What field, type in the search string, or choose a
previous string from the drop-down list.

3. Set the options you want to control the search.

4. Click the Find Next button to scroll to a found instance of your
search criteria. If the string is not within the document, TextPad
prompts you that the string was not found.

5. To replace code, choose Search = Replace from the menu to open
the Replace dialog box (see Figure 122-2).

Figure 122-2: The Replace dialog box
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6. Enter the string you want to locate in the Find What field and the Task 2 Z
code you want to replace it with in the Replace With field.

7. Click the Scope options to choose whether the search is done within
the currently active document, a selected range of text, or across all
currently open files.

8. Click Find Next to select the next instance of the string in the docu-
ment, and click Replace to change that instance. Clicking Replace
Next replaces the current selection and jumps to the next occurrence.
Clicking Replace All replaces all instances of the string within the
current scope.
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Task 23 Searching for Strings in Multiple Files

f you need to know all the occurrences of a particular string within a given set
of files, use the Find in Files command. This command generates a report that
details each occurrence of the string by filename and line number.

1. Choose Search = Find in Files from the menu bar to open the Find
in Files dialog box (see Figure 123-1).

Figure 123-1: The Find in Files dialog box

2. Enter the search string in the Find What field.

3. Enter the file extension for the files you want to search in the In Files
field, preceded by an asterisk. For example, *.html or *.htm.

4. Click the Browse button to open the Browse for Folder dialog box
(see Figure 123-2). From here, locate the folder you want to search.
The folder’s pathname is entered in the In folder field.

Figure 123-2: The Browse for Folder dialog box
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5. Click the Find button to begin the search and generate the report,
shown in Figure 123-3.
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Flgure 123-3: An example of a report usmg the All Matchlng Lines optlon in the Report
Details section

6. To open all the files returned in the report, right-click the report
window and choose Open All from the context menu.
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Task 12A‘ Finding Matching Brackets

COding languages, especially HTML, are loaded with brackets. There are
times when finding an opening bracket’s closing match can give you a
headache. TextPad, like any good coding tool, has the solution.

1. 'To find a matching bracket, place the cursor on the left side of the
bracket you want to match, as shown in Figure 124-1.

€ 3

ﬂilmt type="toxt” nanes"textfield?">»

~:Inun type="button® name='Buttoni® welue='Go"™»
cAngy

Figure 124-1: Placing the cursor to the left of the bracket

2. From the menu bar, choose Search &> Match Bracket, or press
Cturl+M. If there is a matching bracket, the cursor will jump to it and
select it (see Figure 124-2).

itd>

<input type="text" nemestextfisld2'l

téml type=‘button’ mane='Buttcnl’ walue=‘Go":
<ty

Figure 124-2: A selected bracket.
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3. To toggle back and forth between the two brackets, press Ctrl+M.

Task 12A‘

4. In along stretch of code, place the cursor within the line and choose
Search = Match Bracket to send the cursor to the next closing
bracket in the document.

5. To select all text between brackets, place the cursor on the left side of
the bracket you want to match, and press Ctrl+Shift+M. If TextPad
locates a matching bracket, all text in between will be selected (see
Figure 124-3).

gy
‘input type=_button” neme="buttonl”™ walues="Go®»
tdy

Figure 124-3: Text selected between brackets
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Task 25 Using the Spelling Checker

1.

N o o

extPad can check the spelling of your document against 11 language
dictionaries, including Legal English and Medical English dictionaries.

To check the spelling of a document, open the file and choose
"Tools = Spelling from the menu bar. If TextPad finds a misspelled
word, it launches the Spelling dialog box (see Figure 125-1). The
Spelling dialog box displays the misspelled word in the Not in
Dictionary field and its closest guess in the Change To field.

Figure 125-1: The Spelling dialog box

If the correct spelling is available in the scrolling list of options
beneath the Change to: field, select it and click the Change button.

If the correct spelling is not available, enter it manually into the
Change To field and click the Change button.

To change all occurrences of the misspelled word, click the Auto-
Correct button.

"To add the word to the dictionary, click the Add button.
"To undo the last changed word, click the Undo Last button.

"To change the current working dictionary, click the Options button
to open the Spelling Preferences dialog box (see Figure 125-2). Here
you can change the current working dictionary and modify the
spell-checking preferences.

To edit a dictionary, click the Edit button in the Spelling
Preferences dialog box to display the Edit Dictionary dialog box
(see Figure 125-3).



TextPad

Figure 125-2: The Spelling Preferences dialog box

9. To add a word to the dictionary, select the dictionary file from the
Files field at the bottom, type the word you want to add in the Words
field, and click the Add Word button.

10. To delete a word, select it from the scrolling list of words and click
Delete Word.

Figure 125-3: The Edit Dictionary dialog box
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Task 26 Working with the Document Selector

he Document Selector is a handy tool for selecting open documents quickly

and activating their windows in the applications. When you turn the
Document Selector on, you see a list box on the left side of the TextPad
window, showing you each currently open document in alphabetical order.

1. To display the Document Selector, choose View = Document
Selector from the menu bar, or press F11. All currently open docu-
ments are displayed (see Figure 126-1). To activate a document,
simply click its filename.
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Flgure 126-1: Files displayed in the Document Selector (Ieft side of the screen)

2. To increase the width of the Document Selector, move the cursor
over the right border until the cursor changes to a double-headed
arrow. Click and drag the border.

3. To select multiple files in the Document Selector (see Figure 126-2),
Ctrl-click individual filenames. Click on a filename and Shift-click on
another to select all filenames in between. You can also highlight
multiple filenames by clicking the mouse and dragging it over the
names you want to select.
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Figure 126-2: Multiple files selected in the Document Selector

4. To move the selector among the filenames, click within the
Document Selector and then use the arrow keys to move up and
down the list of files. Press Home to jump to the first file in the list
and End to jump to the last.

5. To see the full pathnames of files (see Figure 126-3), right-click
in Document Selector and choose Show Full Paths from the

context menu.

Figure 126-3: Full pathnames displayed in the Document Selector

6. To close a selected file, click in the Document Selector and press the
Delete key, or right-click in the Document Selector and choose
Close Document(s) from the context menu.
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Creating Workspaces

hen you’re developing a Web site, you typically create a directory (folder)

somewhere on your hard drive that contains all your Web site’s files. This
folder mimics the root folder of your Web server. In TextPad, you can save any
series of files you're currently working on as a “workspace.” You could have 5, 10,
or 20 documents open that represent an entire Web site, save them all in a
TextPad workspace, and then later open all these related files simultaneously
using a single menu command. This saves you the hassle of continually using the
File menu to open files. You'll see all open documents either in the Document
Selector or in the Document Tabs.

1. To create a workspace, open all the files you want the workspace to
contain.

2. Choose File = Workspace => Save As from the menu. This opens
the Save As dialog box (see Figure 127-1), with the workspace name
initialized to the current folder.

Figure 127-1: The Save As dialog box with the workspace filename set to that of the
current working folder

3. If necessary, browse to where you want to save the workspace file or
change the filename, then click Save to save the file and close the
dialog box.

4. 'To add or remove files from the workspace, simply open or close files
while in the workspace and choose File => Workspace = Save (or
Save As).
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5. To open a saved workspace, choose File = Workspace = Open. This

displays a File Open dialog box, from which you can locate the .tws Task 27

file and click the Open button. The Workspace submenu also displays
recently opened workspace files which you can open immediately
(see Figure 127-2).

Figure 127-2: A recently opened workspace listed on the Workspace submenu

6. To close a workspace, choose File &> Workspace &> Close. TextPad
asks if you want to save your changes and closes the workspace and
all its related documents.
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rask 4 28  Working with the Clip Library

TextPad’s clip library is an interface that gives you access to predefined snippets
of code. These snippets are organized into files, which TextPad calls “books.”
These books typically refer to a particular programming language, or pertain to a
specific aspect of a programming language. TextPad comes with a number of clip
library books installed, most notably one for inserting HTML tags and another
for HTML character entities.

1. To open the clip library, choose View = Clip Library from the menu
or press Ctrl+F3. The clip library appears on the left side of the
TextPad application window (see Figure 128-1).

Figure 128-1: The clip library

2. To select a different book, click the drop-down list at the top of the
clip library interface (see Figure 128-2).
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Figure 128-2: The clip library’s drop-down list

3. Use the scrolling list of clips below the drop-down list to locate the
one you want to insert (see Figure 128-3).

Figure 128-3: The scrolling list of clippings

Mousing over a clip in the scrolling list displays a tool tip containing
the code that will be inserted (see Figure 128-4).

Figure 128-4: A clipping’s tool tip

4. To insert a clip, double-click its name in the scrolling list, select the
clip, and press Enter. Alternatively, right-click the clip and choose
Insert from the context menu.
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Task 29 Editing Clip Libraries

ou can edit existing clips, as well as create whole new clip libraries, all with a
minimum of effort, using the clip library’s context menu.

1. To edit an individual clipping, right-click its name in the scrolling list
and choose Edit from the context menu. This opens the Clip Library
Entry dialog box (see Figure 129-1).

¢ Patsll wermome="1 0" encoding="luo- 88531
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Figure 129-1: The Clip Library Entry dialog box

2. In the fields provided, edit the part of the clip that appears before the
cursor location, as well as the code to be placed after the cursor loca-
tion. Clips that don’t insert wrapping content will only show code in
the upper field.

3. To rename a clip, choose Rename from the context menu to open the
Clip Library dialog box (see Figure 129-2). From here, simply enter
a new name for the clip.

Figure 129-2: The Clip Library dialog box
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4. 'To delete a clip, choose Delete from the context menu. TextPad
displays a prompt asking you to confirm the deletion.

5. To add a new clip to a book, right-click the scrolling list of clips and
choose Paste New Entry from the context menu. This displays the
Clip Library Entry dialog box again with the current contents of
your system’s Clipboard entered in the Text Before Cursor or
Selection field. If the Clipboard is empty, the field is blank awaiting
your input. From here, simply enter a name for your clip and content
in the appropriate fields.

6. To edit an entire book, right-click the book’s name in the drop-down
list and choose Edit Book. This opens the text file for the entire book
in the application window. You can manually edit the document now.
Simply edit the entries and choose Save from the File menu when
you’re done.

7. To create a new empty book, choose New Book from the context
menu. TextPad displays a Save As dialog box, prompting you for its
filename, followed by a prompt for the name to be displayed in the
drop-down list (see Figure 129-3). From, here you can right-click the
scrolling list and choose Paste New Entry to create new clips as
described in Step 5.

Figure 129-3: Prompts when creating a new book
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Task 130 Downloading Clip Libraries

ew clip libraries aren’t necessarily something you have to create yourself.

There are many available libraries for download at the TextPad Web site —
specifically, about HTML/XHTML tags, predefined color name values, CSS
properties, and JavaScript libraries.

1. Go to www.textpad.com.

2. Click the Add-ons link at the top of the page (see Figure 130-1).
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Figure 130-1: The Add-ons link

3. Click the Clip Libraries link on the subsequent page (see
Figure 130-2).

4. Read the descriptions of the clip libraries offered from the table and
then click the link on the left side to begin the download process.

5. Once the zipped file is downloaded, choose Configure = Preferences
from TextPad’s menu to open the Preferences dialog box. Choose
Folders to see what folder on your hard drive TextPad uses to access
the clip libraries (see Figure 130-3).
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Figure 130-2: The Clip Libraries link

6. Extract the new clip library file into the folder indicated in the
Preferences dialog box.

7. To activate the new clip libraries you’ve installed, restart TextPad and
go to the Clip Library drop-down list. The new book names appear
in the list in alphabetical order.

Figure 130-3: The Preferences dialog box with Folders selected
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Task 31 Configuring TextPad with
Web Browsers

extPad has a reconfigured button on its standard toolbar that looks like a little

globe. When you click it, it launches the current document in your system’s
default Web browser. Of course, when you create Web content, you want to test
your document in more than a single browser. Fortunately, you can configure
"TextPad to launch the current document in as many different browsers as you
have installed on your computer. The following series of steps add a command
to the Tools menu and configure a button on the Tools toolbar (which you can
always move later to the toolbar of your choice).

1. Choose Configure = Preferences to open the Preferences dialog box.
Click Tools on the left to view the Tools options (see Figure 131-1).

Figure 131-1: The Preferences dialog box with the Tools option selected

2. In the upper-right corner, click the Add button and choose Program
from the menu that appears. This opens the Select a File dialog box
(see Figure 131-2).

Figure 131-2: The Select a File dialog box
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3. From here, locate the executable program file for the browser you
want to add to the Tools menu and click the Open button to close
the dialog box. The program name now appears in the Preferences
dialog box.

4. Click Apply to confirm the operation. To change the order of
commands, click the up and down arrow buttons at the top of the
list. Click OK to close the Preferences dialog box.

5. To view the Tools toolbar, choose View = Toolbars = Tools from
the menu. Sixteen user-defined tool buttons appear as little hammer
icons on the toolbar. Each tool corresponds to the commands in the
order they are defined.

6. To copy buttons to other toolbars, choose View = Toolbars =
Customize. This displays the Customize dialog box (see
Figure 131-3).

Figure 131-3: The Customize dialog box

7. Click the Commands tab and select the Tools category to see all the
buttons on that toolbar. Drag the button icons to any toolbar visible
in TextPad.
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Task 132 Configuring an HTML Validator

extPad has been designed to integrate with the Al Internet Solutions CSE

HTML Validator. Validation software allows you to find and correct invalid
markup, such as improperly nested tags, missing quotation marks, and misspelled
tag and attribute names. This task covers how to download and install the
Validator and configure it for use with TextPad.

1. Go to www.htmlvalidator.com.

2. Click the Download link in the top navigation bar (see Figure 132-1).

(WU Ualitinter

CSE HTML Validator

( 7, 2003) CSE Camic:

Figure 132-1: The Download link on the CSE HTML Validator site

3. Click the appropriate link to download the version of your choice:
the Trial version, the Lite version, or the Registered version (requires
prior online purchase). The next screen you see depends on the
version you choose.

4. In the subsequent page, click the appropriate link to begin the down-
load. The Save As dialog box (see Figure 132-2) appears, allowing
you to choose where to save the installation file.
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Figure 132-2: The Save As dialog box

5. Once the installer executable is downloaded, double-click its icon to
begin the installation process, and follow the prompts in the installa-
tion wizard. Once installation is complete, TextPad adds a command
to run the Validator to the Tools menu.

6. 'To add commands to the Tools menu that allow access to the
Validator’s configuration dialog boxes, select Configure =
Preferences. Click the Tools category.

7. Click the Add button and select HTML Validator Commands
from the drop-down list (see Figure 132-3). Click OK.

Figure 132-3: The Add button drop-down list in the Preferences dialog box
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Task 33 Creating Keystroke Macros

he purpose of a macro is to let you record any frequently repeated editing

command (including the typing of text) and play it back whenever you need
it. This saves you time doing repetitive tasks. In TextPad, you can create up to
64 named macros.

1. To begin recording a macro, either choose Macro &> Record, click
the Record On/Off button on the toolbar (see Figure 133-1), or press
Crurl+Shift+R.

Figure 133-1: The Record On/Off button

2. With the recorder running, type out your code as you would nor-
mally, or make your menu command selections. When finished,
choose Macro = Stop Recording, click the Record On/Off button on
the toolbar, or press Ctrl+Shift+R again.

3. To save the macro, choose Macro = Save from the menu to open the
Save Macro dialog box (see Figure 133-2).

Figure 133-2: The Save Macro dialog box
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4. Provide a filename for the macro, being sure not to obliterate the Task 33
.tpm file extension. By default TextPad uses MACROwx.tpm, where

xx is a number.

5. Provide a name for the macro in the Display Name field. This name
appears in the Macro menu. You can also include the macro author’s
name and a description of what the macro does.

6. Select an option from the Default Play Mode list and click OK to
close the dialog box.

7. To play the macro, go to the Macros menu and select its name from
the list of choices.
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Task 13A‘ Creating a Tag-Wrapping Macro

In this task, you’ll learn how to define a macro that wraps selected text in the
tags of your choice. You can then create a series of these macros for nearly
every container tag combination HTML requires. What’s more, you can assign
keyboard shortcuts to the macros, turning TextPad into a dedicated HTML
authoring tool.

1. Open TextPad and begin a new blank document. Enter a single line
text into the document and select it.

2. Open the Replace dialog box (see Figure 134-1) by choosing
Search = Replace or pressing F8.

Figure 134-1: The Replace dialog box

3. In the Find What field, type a backward slash (\) and ampersand (&),
as shown in Figure 134-2.

Figure 134-2: Entering \& in the Find What field

4. In the Replace With field, enter a container tag set with an amper-
sand in the middle. For example, <p>&</p>.

5. Click the Regular Expression check box and then start the recorder
by clicking the Record On/Off button on the toolbar, or pressing
Curl+Shift+R.

6. With the macro now recording, go back to the Replace dialog box
and click the Find Next button, followed by the Replace button.
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7. Stop the recording by clicking the Record On/Off button or pressing Task 3A
Ctrl+Shift+R, and follow the prompts to save the macro, giving it an

appropriate name.

8. To assign a keyboard shortcut to the macro, select Configure =
Preferences. This opens the Preferences dialog box. In the
Preferences list on the left, choose Keyboard (see Figure 134-3).

Figure 134-3: The Preferences dialog box with the Keyboard option selected

9. Select Macros from the Categories field. This displays all the com-
mands currently in the Macros menu in the Commands field. From
here, select the name of the macro you just created.

10. Enter a key combination in the Press New Shortcut Key field — for
example, Alt+P — and click the Assign button to match the macro to
your shortcut key choice.
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Task 35 Working with Color Syntax Checking

TextPad recognizes the type of code you’re writing through the use of document
classes. TextPad comes with a number of predefined classes — most notably for
you, the HT'ML document class. These classes color-code different parts of
HTML. For example, tags, attributes, and values each have their own color in
TextPad. When you make a typographic or HT'ML syntax error, the color of all
code following the error changes to a single color so that the error stands out.
You can easily modify these colors to suit your own taste.

1. To modify the HTML document class colors, choose Configure =
Preferences to open the Preferences dialog box.

2. Click the plus sign beside Document Classes in the options list to
expand the list of currently installed classes.

3. Click HTML to examine the HTML class (see Figure 135-1).

Figure 135-1: The Preferences dialog box with the HTML class selected

4. Click the plus sign beside HT'ML to expand the class options.

5. Select the Colors option from beneath the HTML class (see
Figure 135-2).

Figure 135-2: The Colors option of the HTML document class
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6. Choose the item whose color you want to modify.

7. Change the text color and the color behind it by clicking the
Foreground and Background buttons to the right and selecting a
color option from the color picker that appears (see Figure 135-3).

Figure 135-3: The Foreground color picker

8. Click Apply to change the color and keep the dialog box open, or
click OK to change the color and close the dialog box.

9. To return the colors for a selected item to their original values, click
the Set Defaults button.
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rask 4 30 Downloading and Installing BBEdit

Any company that sells its software under the tag line “It doesn’t suck” is a
winner with us. BBEdit is the premiere HTML and text-editing application
for Macintosh OS. Downloading the fully functioning, 30-day trial version of
BBEdit 7.0 is fairly simple.

1. Go to www.barebones . com (see Figure 136-1) and click on the
Products link and select BBEdit.
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Figure 136-1: The Bare Bones Software home page

2. On the main BBEdit page, look for the vertical list of links on the
right side of the screen and click on Demo.

3. In the “Please Sign Up!” form, enter the information they request
and click the Register button (see Figure 136-2).

4. Click the Demo Package download link to begin downloading the
installation file and choose a location on your system to save it (see
Figure 136-3).

5. With the executable installation file downloaded, double-click the file
to unpack the installer. Double-click the installer to install BBEdit on
your system.
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rask 4 B 1 Configuring BBEit for Web
Site Development

Ithough you ultimately copy your files to a remote Web server when you

publish your Web site, you develop your site (and edit it after publication) on
your local computer. This task shows you how to develop your local file structure
and set up your site in BBEdit.

1. On your hard drive, create a folder that will contain all the files and
directories of your Web site.

2. Choose Edit = Preferences to open the BBEdit Preferences panel
(see Figure 137-1). Scroll down to HT'ML Web Sites in the left-hand
list.

i

Figure 137-1: The BBEdit Preferences panel with HTML Web Sites selected
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3. Click the Add button on the right to display the Web Site Settings

dialog box (see Figure 137-2). Task 31

Figure 137-2: The Web Site Settings dialog box

4. In the Site Name field, enter a descriptive name for your site. This is
the name that the site will appear later as in the HTML Web Sites
category of the BBEdit Preferences panel.

5. In the Web Server Name field, enter the URL of your Web server, if
you have one (bttp://www.domain_name.com/).

6. In the Site Path on Server field, enter any subfolders that lead to the
index.html home page. For example, if the path to the home page is
www.domain_name.com/alpha/beta/index.html, enter alpha/beta.

7. In the Default Page Name field, enter your Web server’s default root
filename.

8. Beside the Local Site Root field, click the Set button to select the
folder you created in Step 1.
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Task 138 Creating New HTML Documents

You can create an HTML document in any text editor just by entering markup
code and saving the file with an .htm, or .html extension. However, using
BBEdit allows you to insert the main structural tags of an HTML document
quickly and easily.

1. Click New Document on the HTML Tools Palette or choose File =
New = HTML Document from the main menu to open the New
HTML Document dialog box (see Figure 138-1). If you choose, you
can simply click OK here and insert the document tags. Otherwise,
continue to define other properties of the document.
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Figure 138-1: The New HTML Document dialog box
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2. To specity a DOCTYPE declaration, select an option from the pop- Task 38
up menu beside the Insert DOCTYPE check box.

3. Using the check boxes provided, deselect any standard container tags
you want to leave out.

4. Enter the title of the HTML document in the Title field.

5. To indicate what language the document is written in, make a selec-
tion from the Lang menu.

6. To define a <meta> tag, enter the necessary code into the Meta field.

7. To include a <1ink> tag, for example to reference an external style
sheet, enter the necessary code in the Link field.

8. 'To specify the Web site this file is part of, use the Web Site pop-up
menu to select one of the sites you've defined.

9. To specify a template you want this file based on, select it from the
Templates pop-up menu.

10. Click OK to close the dialog box and open the new document. A
new document opens on the desktop (see Figure 138-2). The code
contains information you entered in the New HTML Document
dialog box.
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Figure 138-2: A new HTML document
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Task 39 Using the Tag Maker Edit Tag Tools

BEdit provides two context-sensitive tools for inserting and modifying tags:

"Tag Maker and Edit Tag. “Context-sensitive” means that BBEdit looks at
where the cursor is currently positioned in the code and only provides tags,
attributes, or CSS options that make sense for that location.

1. Place your cursor within the flow of your document code.

2. To open the Tag Maker (see Figure 139-1), click the Tag Maker but-
ton on the HTML Tools palette, choose Markup = Tag Maker from

the main menu, or press Command+M.

[ wmserttag | Figure 139-1: The Insert Tag dialog box

3. Select the appropriate tag you want to insert from the list of tags.

4. 'To bring up an attribute dialog box appropriate to the selected tag
(see Figure 139-2), hold down the Option key and click the Insert
button.
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Figure 139-2: An attribute dialog box

appropriate to the selected tag — in this Task 39

case the <p> (paragraph) tag

5. Enter any attribute values you require and click the Apply button to
close the dialog box.

6. To display attributes for preexisting tags (see Figure 139-3), place the
cursor within the tag and invoke the Tag Maker using any of the
methods described in Step 1.

Figure 139-3: An attribute dialog box for a preexisting <body> tag

7. To modify the most common attributes of a tag, click Edit Tag on the
HTML Tools palette. Enter the appropriate values and click Apply.
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Task 1A-0 Formatting Text

f there’s a tag, the HTML Tools Palette has a button to insert and format it. To

mark up text, simply click a button and, where applicable, modify the tag’s
attributes in the resulting dialog box. Occasionally you have to wander up to the
BBEdit menu bar to find a command, but not often.

1. To insert a paragraph, click the Paragraph button on the HT'ML
Tools Palette or choose Paragraph from the Block Elements sub-
menu. This opens the Paragraph dialog box (see Figure 140-1). Here
you can modify the tag’s align, ID, class, and style attributes.

Figure 140-1: Modifying the <p> tag with the Paragraph dialog box

2. To insert headings, click the Heading button and select one of the six
heading tags from the submenu that appears.

3. Toinsert <font> tags, click the Font button to open the Font
dialog box (see Figure 140-2). Specify values for the face, size,
and color attributes by clicking the appropriate check boxes and
entering values in the fields provided.

Figure 140-2: Modifying the <font> tag with the Font dialog box

4. 'To insert physical style tags, click the Font Style Elements button
and select the style of your choice from the submenu.
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5. To insert logical styles, click the Phrase Elements button and select Task AO

the appropriate style from the submenu.

6. To insert preformatted text (with the <pre> </pre> tags), click the
Block Elements button and choose Preformatted from the submenu.

7. "To modify the default body text and text link colors, click the Body
Properties button to open the Body Properties dialog box (see Figure
140-3). Place check marks next to the attributes you want to specify
and use the color tools to select a color.
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Figure 140-3: Modifying default body text and text link colors in the Body Properties
dialog box

8. 'To format selected text as a hyperlink, click the Anchor button to
open the Anchor dialog box (see Figure 140-4). Enter values for the
appropriate attributes in the fields provided.

Figure 140-4: Hyperlinking text with the Anchor dialog box
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Task A-l Creating Lists

TML requires a series of structured tag pairings to render lists in the
browser. BBEdit makes manipulating list code a pretty simple proposition.

1. To convert existing text to a list, select the text comprising the list
items and click the List button on the HTML Tools Palette to open
the Lists submenu (see Figure 141-1).

Figure 141-1: The HTML Tools Palette List submenu

Select List from the submenu to open the Lists dialog box (see
Figure 141-2).

=

Figure 141-2: Selecting list options in the Lists dialog box

2. Select the list type, attribute settings, and markup options using the
radio buttons, check boxes, and pop-up menus in the dialog box.

3. Click Apply to close the dialog box and wrap the selected text in the
appropriate markup.
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4. To build a list from scratch, choose the list type from the List button Task A ‘

submenu to insert the appropriate opening and closing tags (<ul>
</uls, <ol> </ol>, or <dl> </dl>), along with an empty pair of
list items tags (<1i> </1i>, or <dt> </dt> and <dd> </dd>). (See
Figure 141-3.)
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Figure 141-3: List tags inserted using the HTML Tools Palette

5. Enter the text required for your list items.

6. To modify the attributes of any tag in the list, place the cursor within
the tag and click the Tag Maker button to view a list of possible
attributes in the Insert Attribute dialog box (see Figure 141-4).

Figure 141-4: Modifying attributes in the
Insert Attribute dialog box
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Task A-z Inserting Images

BEdit makes it easy to insert images and enter values for the <img> tag’s
associated attributes.

1. Click the Image button on the HTML Tools Palette to open the
Image dialog box (see Figure 142-1).
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Figure 142-1: Inserting images using the Image dialog box

2. In the Src field, enter the pathname of the image file or click the File
button to browse for one on your hard drive. Alternatively, use the
Recent URLs pop-up menu to select among image files you’ve
recently inserted.

3. In the Alt field, enter the alternate text you want to specify for the
image.

4. To specify the dimensions of the image, click the Size check
box and enter width and height values in the W and H fields,
respectively.

5. To specify hspace and vspace attributes, click the Space check box
and enter values in the H and V fields, respectively.

6. To align the image, click the Align check box and choose an option
from the pop-up menu to the right.
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7. Click Apply to close the Image dialog box and insert the appropriate
code into your document (see Figure 142-2) that makes the image
appear on your Web page.
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Figure 142-2: Code inserted using the Images dialog box

8. 'To center-align an image, insert a <div> tag with an align attribute
setto “center” by selecting the <img> tag, clicking the Div button,
and modifying the align attribute in the Division dialog box (see
Figure 142-3).

ﬁ Figure 142-3: Setting values for the

<div> tag using the Division dialog box

9. To see how the image appears in a browser, click the Preview button
at the bottom of the HTML “Tools Palette and choose one of the
installed browsers on your system to open the HTML document (see
Figure 142-4).

Figure 142-4: Options for previewing your page in a
browser
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A-3 Creating Tables

BEdit provides you with a number of features to generate HTML tables. You

can modify every attribute of the table-related tag (<table>, <tr>, <td>,
and <th>). Of course, you can also access these attributes using the Tag Maker
and Edit Tag tools.

Part 13

. To insert a table, click the Table button on the HTML Tools Palette,

and select table from the submenu. This opens the Table dialog box
(see Figure 143-1).

Figure 143-1: Setting table values in the Table dialog box

. To specify a value for the table border, click the Border check box

and enter a pixel value in the field provided.

. To define the table’s width, click the Width check box and enter

either a pixel or percentage value in the provided field.

. To specify values for cell padding and cell spacing, select the appro-

priate check boxes and supply pixel values in the associated fields.

. To specify the table’s alignment, click the Align check box and use

the pop-up menu to the right to set the alignment to left, right, or
center.

. To define a background color for the table, click the BGColor check

box, click the color picker, and choose a color value from the palette.
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7. Click Apply to close the dialog box and insert the opening and clos-
ing <table> tags with your attributes already defined.

8. To insert a new row — which HTML defines with the <tr> tag —
click Tables and choose Row from the submenu to open the TR
dialog box (see Figure 143-2). Specify the <tr> tag’s align and
valign attribute values, as well as a background color.

ﬁ Figure 143-2: Setting attribute values
ﬂ“ _ ;: for the <tr> tag in the TR dialog box
e T a—
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9. To insert a new cell — which HTML defines with the <td> or <th>
tag — click Tables and choose TD or TH to open the corresponding
dialog box (see Figure 143-3). Specify the dimensions of the cell, the
number of rows or columns the cell spans, its horizontal and vertical
alignment, and its background color.

Figure 143-3: Setting table cells in the TD dialog box
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Task 1A-A‘ Building Forms

BEdit makes inserting and formatting form controls easy using the Forms
submenu of the HT'ML Tools palette.

1. To generate the opening <forms tag, click the Forms button
and choose Form from the submenu to open the Form dialog box
(see Figure 144-1).
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Figure 144-1: Defining a form control in the Form dialog box

L

Click the relevant radio button for the Method attribute (Post or Get).

In the Action field, enter the URL of the processing CGI script that
runs the form control.

w

4. Click the Apply button to close the Form dialog box and insert the
generated code into the current document.

5. To insert any of the form controls created with the <input> tag,
click the Forms button and choose Input from the submenu to
display the Input dialog box (see Figure 144-2).

6. Select the type of form control in the Type pop-up menu. Supply the
value for the name and the value attributes, if applicable, in the
fields provided.

7. 'To create a selection menu, choose Select from the Forms button
submenu to display the Select dialog box (see Figure 144-3). Supply
the name attribute value, activate multiple selections, and modify the
size attribute in the fields provided. Click Apply to insert the code.

8. To insert selection menu <options tags, place the cursor between
the opening and closing <select> tags and choose Option from the
Forms submenu. This opens the Option dialog box, where you
define the 1label and/or value attributes in the fields provided.
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Figure 144-3: Defining a selection list in the Select dialog box
9. To insert a text area, click Text Area on the Forms submenu to open

the Text Area dialog box (see Figure 144-4). Specify the values of the
rows and cols attributes in the fields provided and click Apply.

Figure 144-4: Defining a text area using the Text Area dialog box
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Task 1A-5 Working with Frames

In a frames-based layout, one document (the frameset document) defines the
properties of the various frames on the page, each of which are separate docu-
ments. From the Frames submenu on the HTML Tools Palette you can invoke a
number of dialog boxes that allow you to insert and modify the various tags that
make up the frameset document.

1. To insert the <frameset> tags, click the Frames button on the
HTML Tools Palette and choose Frame Set from the submenu to
open the Frameset dialog box (see Figure 145-1).

Figure 145-1: The Frameset dialog box

2. Select either Rows or Cols, and enter your dimension values in the
field provided. Click Apply to close the dialog box and insert the
code.

3. To insert <frame> tags, click the Frames button and choose Frame
from the submenu to open the Frame dialog box (see Figure 145-2).

4. Click the File button to locate the document you want to display in
this frame, or enter the pathname manually.
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10.

To define the name attribute of the frame, enter a value in the
Name field.

"To modify the scrolling attribute of the frame, select the Scrolling
check box and set the associated pop-up menu to Yes, No, or Auto.

"To prevent the user from resizing a frame, click the No Resize

check box.

To modify the frameborder attribute, select a value of None, 0, or
1. None removes the frameborder attribute from the tag, while 0
and 1 set the attribute equal to those respective pixel values.

To specify frame margins, enter values in the fields provided.

To insert <noframes> tags, place your cursor outside the
<frameset> tags and choose No Frames from the submenu.
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Task 1A-6 Defining CSS Font Properties

1.

Ladi g

he HTML Tools Palette provides a means of editing Cascading Style Sheet
code, whether the code is inline, embedded, or in an external style sheet doc-
ument. To modify CSS <font> tag properties, follow these steps.

Place the cursor in the current document at the point you want to
insert the style definition. Click the CSS button and choose Font
from the submenu to open the Font dialog box (see Figure 146-1).

Enter a selector of your choice in the Selector field.

To specify a color property, click the color picker and select a color
from the color palette.

"To define a font-size property, click the pop-up menu beside the
Size field to select a unit of measure and then enter a value in

the field.

"To define a line-height property, click the pop-up menu beside the
Line Height field to select a unit of measure and enter a value in

the field.

"To define a font - family property, enter a value in the Font
Family field.
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7. To define a font -style property, choose Italic, Oblique, or Normal
from the Style pop-up menu. The Default value leaves the property
undefined.

8. To define a font-weight property, choose a value from the Weight
pop-up menu. The Default value leaves the property undefined.

9. To define a font-variant property, choose Small-Caps or Normal
from the Variant pop-up menu. The Default value leaves the prop-
erty undefined.

10. When you’ve completed you choices, click the Apply button to insert
the style declaration (see Figure 146-2).
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Figure 146-2: A completed style definition in the document window
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Task A-7 Defining CSS Text Properties

BEdit’s CSS editing tools allow you to adjust text properties in CSS, which

affect the physical characteristics of the text itself — spacing of characters,
words, and lines as well as alignment and indentation. Defining these properties
in BBEdit is simply a matter of accessing the appropriate dialog box and entering
your chosen values.

1. Place the cursor in the current document at the point you want to
insert the style definition. Click the CSS button and choose Text
from the submenu to open the Text dialog box (see Figure 147-1).

Figure 147-1: The Text dialog box

2. Enter a selector of your choice in the Selector field.

3. To define a text-indent property, click the pop-up menu beside
the Text Indent field to select a unit of measure, and then enter a

value in the field.
4. To define a text-align property, choose a value from the
Alignment pop-up menu.

5. To define a vertical-align property, choose a value from the cor-
responding pop-up menu, or select a percentage from the menu and
enter a numeric value in the field.
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10.

To define a text-transform property, choose a value from the

transformation pop-up menu.

To define word-spacing and letter-spacing properties, select a

unit of measure from their respective pop-up menus and enter a

value in their fields.

To define a white-space property, choose a value from the White

Space pop-up menu.

To define a text-decoration property, select each of the check
boxes you want to include from those listed at the bottom of the

dialog box.

Click Apply to close the dialog box and insert the definition in the
current document (see Figure 147-2).
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Figure 147-2: Text properties added to a style definition
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Task A-S Defining CSS Background Properties

n HTML you can assign a background color or image to several areas of the

document, including various parts of a table (cells, rows, or the entire table)
and layered content. In CSS, by comparison, you can determine the background
of any element in the document including individual words, paragraphs,
headings — anything. If there’s a tag for it, you can modify its background.

1. Place the cursor in the current document at the point you want
to insert the style definition. Click the CSS button and choose
Background from the submenu to open the Background dialog box
(see Figure 148-1).

Figure 148-1: The Background dialog box

2. Enter a selector of your choice in the Selector field.

3. To define a background-image property, click the File button to
browse your hard drive for an image file you want to use.

4. To define a background-color property, click the dialog box’s
color picker and choose a color from the palette.
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5. To control how a background image tiles, define a background-
repeat property by selecting a value from the Repeat pop-up menu.

rask 4 48

6. 'To specify the location of a background image, define a background-
position property by entering Left and Top coordinates in the
fields provided and specifying the unit of measure with the corre-
sponding pop-up menus.

7. To specify whether the background image is fixed or scrolls with the
browser window, define a background-attachment property using
the Attach pop-up menu.

8. To insert the new definitions, click the Apply button. The code is
written to the document (see Figure 148-2).
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Figure 148-2: Background definitions in the document window
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rask A A9 Defining CSS Padding and
Margin Properties

BEdit makes it easy to define padding and margin properties in CSS. You do
it all in the same dialog box.

1. To define padding properties, place the cursor in the current docu-
ment at the point you want to insert the style definition. Click the
CSS button on the HTML Tools Palette and choose Padding from
the submenu to open the Padding dialog box (see Figure 149-1).

Figure 149-1: The Padding dialog box

2. Enter the selector you're defining the property for in the Selector field.
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3. To supply an identical value for each of the four possible sides, type a Task Ag

value in the first field and choose a unit of measure from the accom-
panying pop-up menu.

4. To define a value for any combination of sides, enter individual

values in each of the subsequent fields — top, right, bottom, or
left — as indicated by the field’s icon on the left.

5. To define margin properties, place the cursor in the current docu-
ment at the point you want to insert the style definition. Click the
CSS button on the HTML Tools Palette and choose Padding from
the submenu to open the Padding dialog box (see Figure 149-2).

Figure 149-2: The Margins dialog box

6. As described just previously for the Padding dialog box, enter the selec-
tor in the Selector field and type margin values in the fields provided.
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Task 150 Defining CSS Border Properties

Before CSS came into style, so to speak, the only HTML elements that could
possess borders were tables and images. Now any element can possess a bor-
der. You can determine the width of an element’s border, the border color, and

the border style using BBEdit’s CSS border tools. The properties defined for the
selector are border-width, border-color, and border-style, respectively.

1. Place the cursor in the current document at the point you want to
insert the style definition.

2. Click the CSS button on the HTML Tools Palette and choose Border
from the submenu to open the Border dialog box (see Figure 150-1).

3. Enter the selector you're defining the property for in the Selector
field.
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4. Use the fields on the left side of the dialog box to enter border-width
values, specifying units of measure with the pop-up menus directly to
their right.

5. To specify border-color values, click the color pickers and make
selections from the color palette. To select one of the 16 predefined
color names, use the pop-up menus to the right of the color pickers.

6. To specify border-style values, make selections from the pop-up
menus on the extreme right side of the dialog box.

7. To insert the values and close the dialog box, click the Apply button.
The generated code is entered into the document (see Figure 150-2).
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Figure 150-2: Border property style definitions applied to a page
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Task 51 Defining CSS Box Properties

he box model of Cascading Style Sheets surrounds every element by a kind of

rectangular “bull’s-eye,” with four zones radiating out from a central area that
holds the element itself — text, image, table, or whatever. This central area is
known as the content area. The next zone out from this is the padding area (gov-
erned by padding properties covered in Task 149), followed by the border area
(Task 150), and then the margin area (Task 149 again). Instead of bundling the
box properties into a single dialog box, BBEdit breaks them up for easier access
but leaves the last five box properties (width, height, float, clear, and
display) to themselves.

1. Place the cursor in the current document at the point you want to
insert the style definition. Click the CSS button on the HTML
Tools Palette and choose Box from the submenu to open the Box
dialog box (see Figure 151-1).
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Figure 151-1: The Box dialog box

2. Enter the selector you're defining the property for in the Selector field.

3. To specify a width property, enter a value in the Width field and
choose a unit of measure from the pop-up menu.
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4. 'To specify a height property, enter a value in the Height field and
choose a unit of measure from its pop-up menu.

5. To specify a float value, make a selection from the corresponding
pop-up menu.

6. To specify a clear value, make a selection from the relevant pop-up
menu.

7. To specify a display value, make a selection from the pop-up menu.

8. 'To close the dialog box, click the Apply button. The generated code
is inserted into the document (see Figure 151-2).
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Figure 151-2: Box property definitions.
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rask A B2 Validating HTML

BEdit has a feature that debugs your HTML syntax and link references. This

prevents you from creating code with errors or broken links that will affect
the look of your page when you publish it to the Web. You can validate HTML
on an individual document or on an entire folder or site.

1. To validate the current document’s code, click the Check Syntax but-
ton on the HTML Tools Palette. If BBEdit finds any errors, the
HTML Syntax Errors panel (see Figure 152-1) appears.
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Figure 152-1: When BBEdit encounters errors, it displays the HTML Syntax Errors panel
in the code window.
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2. Click the warning or error in the upper portion of the dialog box to
see the corresponding line of code displayed in the lower portion.
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3. To make corrections to the code, double-click the error or warning Task 5 Z
to jump to the document containing the document. The line is high-

lighted in the document window.

4. 'To check the syntax of all documents in a given folder, click the
Check button on the HTML Tools Palette and choose Folder Syntax
from the submenu to display the Check Folder Syntax dialog box
(see Figure 152-2).

Figure 152-2: The Check Folder Syntax dialog box

5. By default the dialog box defaults to the folder containing the
currently active document. To select a different folder, click the
pop-up menu arrow to the right of the dialog box and choose
Other. This opens the Choose a Folder dialog box in which you
locate your folder.

6. Click the Check button in the Check Folder Syntax dialog box.
Errors appear in the HTML Syntax Errors dialog box. Click to see
the referenced code in the lower portion, and double-click to open
the specified document at the indicated line to edit it.

7. To check an entire site’s syntax, choose Site Syntax from the Check
button’s submenu to display the Check Site Syntax dialog box. It too
defaults to the site of the currently active document. To switch sites,
use the same pop-up menu mentioned in Step 5. Click the Check
button in the Check Site Syntax dialog box to display errors in the
HTML Syntax Errors dialog box as we previously discussed.
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rask 4 5D Using BBEdit Utilities

BEdit contains a number of practical utilities that help you add or remove

markup tags quickly. Use Translate to mark up a plain-text document quickly
with basic paragraph tags. Conversely, use Remove Markup to strip markup tags
from an HTML document. You can also wrap content within comments and
change the case of text.

1. To convert plain text to HTML, select the text in the document
window, click the Utilities button on the HTML Tools Palette, and
choose Translate from the submenu to open the Translate dialog box
(see Figure 153-1).

ﬁ Figure 153-1: Converting plain text to HTML

using the Translate dialog box

2. Click the Text to HT'ML option, choose your conversion parameters,
and click the Translate button.

3. To strip all tags from a document, choose Remove Markup from the
Utilities submenu.

4. To wrap content in comment tags (see Figure 153-2), select a range
of content and choose Comment from the submenu.
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Figure 153-2: Comment tags inserted using the Utilities submenu

5. To remove all comment tags from a document, choose Remove
Comments from the submenu.

6. To convert all tags in a document to uppercase or lowercase, select
the corresponding command from the Utilities submenu.

7. To specify what case BBEdit defaults to, open the HT'ML Preferences
category of the BBEdit Preferences panel (see Figure 153-3) and click
either the Upper Case or Lower Case radio button. You can then use
the Normalize Tag Case command on the Utilities submenu to con-
vert all tags to that choice.
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Part 13

Task 15A‘ Using Find and Replace

Y

real

our marketing department is sure to change their minds seven times today
about some magic phrase they had you place in 200 locations on the com-

pany Web site before you finally crawled home to bed. Now you have to change
it one more time — quickly. That’s exactly where the Find and Replace tool is a

lifesaver.

1. Choose Search = Find from the BBEdit menu bar to open the Find
& Replace dialog box (see Figure 154-1).

Figure 154-1: The Find & Replace dialog box

In the Search For field, enter the string you want to search for.

In the Replace With field, enter the string you want the found text to
be replaced with.

Use the central check boxes to modify your search parameters as
necessary.

To display the search results in a search results window (see Figure
154-2), select the Batch Find check box.

"To return only the files that don’t have the search string present, click
the Exclude Matches check box.

Use the controls at the bottom part of the Find & Replace dialog box
to specify the set of files to search.
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10.
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Figure 154-2: The Search Results window

To do a multifile search, click the Multi-File Search check box and
make a selection from the pop-up menu beneath it to specify a cate-
gory: Folder, Open Documents, or Web Site. Choose the specific
folder or Web site from the second pop-up menu.

Click the Options button to display the Multi-File Search Options
dialog box (see Figure 154-3). Choose the folder parameters and file
types through which you want to search.
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Figure 154-3: The Multi-File Search Options dialog box

Click the appropriate button on the right side of the dialog box
(Find, Find All, Replace, or Replace All).
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Task 55 Working with File Groups

For those situations where you find yourself working with a large number of
related Web pages, consider using a file group. Creating a file group gener-
ates a small BBEdit file that references the files and directories comprising the
group. When you access the file group, BBEdit opens the corresponding files and
folders for easy editing.

1. To create a file group, choose File &> New = File Group from the
BBEdit menu bar to display a new file group window (see Figure 155-1).

Figure 155-1: A new file group window

2. 'To add files to the file group, click the Add Files button to display an
Open dialog box or drag a file into the file group window from the
Finder.

3. To add folders to a file group, click the Add Folder button. This
opens the Add Folder to Group dialog box:

4. Click Choose to locate a folder in the Open dialog box or drag it

from the Finder into the field on the left. Click Add to complete the
selection and close the dialog box.

5. 'To save the file group, choose File = Save from the menu bar and
save the file group to a chosen location.
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Figure 155-2: The Add Folder to

Group dialog box Task 55

6. To open a file group, choose File & Open from the menu bar.

7. To access files and folders in the File Group window, simply double-
click them or select them and click the Open button. Files are opened
in a document window, while folders are opened in disk browser
windows (see Figure 155-3).

Figure 155-3: Finding folders in a disk browser window

8. To remove a file or folder from a file group, drag it into the Trash or
select it and click the Remove button.
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Task 56 Setting Menu Keys

ach function in the HTML Tools Palette we’ve covered here in Part 13 is
mirrored as a command on the Markup menu. BBEdit makes it easy to define
keyboard shortcuts (“equivalents”) for them.

1. Choose Edit = Set Menu Keys from the BBEdit menu bar to open
the Set Menu Keys dialog box (see Figure 156-1).

Figure 156-1: The Set Menu Keys
dialog box
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2. To access the commands for the Markup menu, scroll down and click
the disclosure triangle next to Markup (see Figure 156-2).

3. To add a menu key, select a command and click the Set button. This
displays the Set Key dialog box (see Figure 156-3).
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Figure 156-3: Creating a keyboard
shortcut in the Set Key dialog box

4. 'Type a key combination and click OK. If the key combination is in
use already, a prompt tells you which keystroke it’s currently assigned
to and asks if you want to replace it (see Figure 156-4).

Figure 156-4: A keyboard shortcut
already in use

5. To reset an accepted keystroke, click the Reset button and try
another keystroke combination.
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Task 57 Modifying Color Syntax Checking

BEdit allows you to modify the colors it uses to color the HTML code.

Although there is no objective, functional benefit to changing these colors,
doing so gives you the freedom to impose your personal style (favorite colors,
etc.) on your editing environment.

1. To enable color syntax checking, open the BBEdit Preferences panel
by choosing Edit = Preferences from the menu bar or pressing
Command+; on the keyboard. Choose Editor Defaults to view these
options (see Figure 157-1). Make sure you click the Syntax Coloring
check box.

Imwﬁuﬁbmm.uhm-mm | L-ﬂ’—l L ae ]

Figure 157-1: Setting the code editor’s default preferences

2. To modify the colors used in syntax-checking, choose Text Colors
in the BBEdit Preferences panel (see Figure 157-2) to view these
options.
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Figure 157-2: Setting the syntax-checking colors

3. To modify the background color, select a new color from the
Background color picker.

4. To modify HTML tags, select a new color from the General color
picker.

5. 'To change the color of comment tags, select a new color from the
Comments color picker.

6. To change the color of <a> tags, select a new color from the Anchor
color picker.

7. To change the color of <img> tags, select a new color from the
Image color picker.

8. To assign unique colors to attributes, click the Color Attributes
Separately check box, Assign attribute colors with the Names color
picker and values with the Values color picker.

9. 'To save your changes, click the Save button in the upper right and
then close the BBEdit Preferences panel.
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Task 58 Modifying HTML Color Preferences

By default, BBEdit’s color picker uses a 216-color, Web-safe palette. These
216 colors are guaranteed not to shift or dither on any platform, running
any browser, when running in 8-bit color mode. There’s just one small problem
with that: Personal computers advanced beyond 8-bit color nearly a decade ago.
Consequently, using colors outside the Web-safe palette isn’t as risky as it was
in 1995. For this reason, you may want to change BBEdit’s color picker to gain
a little leeway.

1. Choose Edit = Preferences from the menu bar or press Command+;
to open the BBEdit Preferences panel. Select HTML Colors
(see Figure 158-1) to view those options.

= —

Figure 158-1: Making HTML color preferences

2. Under Color Picker, click Apple Color Picker. The next time you
invoke a color picker, the Apple color opens (see Figure 158-2).
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Figure 158-2: The Apple Color Picker

3. In the Apple Color Picker, scroll down the list of options on the left
side and select the HTML Picker (see Figure 158-3).
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Figure 158-3: The HTML Picker
4. Use the RGB sliders to specify levels of red, green, and blue.
Corresponding hexadecimal color values appear in the HTML field.

5. To restrain the sliders to a Web-safe palette, click the Snap to Web
Color check box.

6. Once you choose a color, click OK to close the dialog box and insert
the color value.
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Exploring the HomeSite Environment

At first glance, Macromedia HomeSite 5 looks like a simple text editor — a
place to type your HTML code, save your files, and create other types of
code that are added to your HTML document. Looks can be deceiving, however.
HomeSite is a very powerful program that offers a variety of automated features,
views, tools, and commands found throughout a fairly complex (yet easy to use)
interface. In this task, you take a tour of that interface, checking out each of the
main areas of the workspace and learning to navigate HomeSite efficiently. If
you’d like to give HomeSite a test-drive, go to the Macromedia Web site
(www.macromedia.com) and download an evaluation version. It will only

work for 30 days, after which you must purchase the application in order to
keep using it.

1. Display HomeSite’s screen tips. Hover your mouse over the buttons
on the main toolbars, on all the tabs on the right side (top) of the
window, and across the bottom of the left-most panel. Figure 159-1
shows the entire workspace.

Site View Resource Your HTML document
window  window tabs Editor toolbar QuickBar is typed here

1T OCI Tl LI
</mwts

by

Figure 159-1: The HomeSite workspace divided into sections

2. Click the Help button (the purple book with a “?” on it) among the
tabs at the bottom of the Resource panel. The Help tools appear (see
Figure 159-2).

3. Click the Projects tab on the Resource panel to see your project files
and folders.
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4. To see a tree-like display of your project files, click the Site View tab, Task 59

also found in the Resource panel. Figure 159-3 shows an index page
(Home Page) and two subpages (About Us and Contact Us).

Figure 159-2: Click the plus signs next to the various topic groups to find the help you
need.

ceatloBone Pagec/uitiey
< /handr

<bedy>

s hreds“absuras, braohbous Usc o
<h hrefe"comtact. kia™Centact Uni/as

Figure 159-3: Use the view in the upper left to get a sense of the relationship among
your pages and to establish links between them.

5. Experiment with the Quickbar. Click the Fonts tab (also called the
Fonts toolbar) to see your text formatting tools and then check out
the Tables tab (Tables toolbar).
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Task 160 Creating a New Project

In HomeSite, a project is the same as a site. It’s called a project because, typi-
cally, the development of a Web site — rather than just a few ad hoc pages — is
a project unto itself. If you think about a project as being a site, you’ll find it very
easy to understand HomeSite’s tools.

1. Choose Project &> New Project. The New Project dialog box opens
(see Figure 160-1).

Figure 160-1: Starting a new project

2. 'Type a name for your project in the Project Name field.

3. Type or browse to the location of the project folders. If you click the
yellow folder button at the right end of the Location of Project File
field, the Select Directory dialog box opens (see Figure 160-2).
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Figure 160-2: Selecting a directory for your
project and its files and subfolders
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4. Click a directory (or folder) where you want to store your project
files and click OK. The project files will appear in the Projects tab of
the Resource panel (see Figure 160-3).

Figure 160-3: The main project folder and two subfolders are ready to store the HTML
documents and other files you create and use with the project.
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Task 61 Organizing a Project with Folders

Once you've set up a project, you can add folders to the project folder, creating
a filing system for your HTML documents, images, and site content files
(documents, worksheets, and other files that your client may send you or that
you may accumulate yourself). Although the number of folders you can create is
unlimited, don’t add so many folders and subfolders that you create a filing
system that’s difficult to manage, navigate, and understand.

1. With the Projects tab displayed in the Resources panel, right-click
the main project folder. A submenu appears (see Figure 161-1).

Figure 161-1: Accessing folder-related tools by right-clicking your existing folders
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2. To create a new subfolder for your projects folder, choose Add Folder.

The Add a Project Folder dialog box opens (see Figure 161-2). Task 61

Figure 161-2: Defining a new folder in HomeSite

3. In the Add a Project Folder dialog box, click the Folder Name text
box and type a name for the folder. The name should be in lowercase
and contain no spaces or punctuation.

4. Click the Physical Folder option.

5. Asneeded, type or browse to (using the browse button) the Directory
Path that contains your folder.

6. Click the Auto Include Files Using Filter option and leave All Files
selected.

7. Click the Auto Include Subfolders option if it’s not already selected.
8. Click OK to create the folder.
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Task 62 Starting a New HomeSite Document

fter you create your project and build your folders to store HTML docu-

ments and related files, you can start your first HomeSite document. This
task shows you how to start a new page, work within the automatically-inserted
tags, and begin entering page content.

1. With your project displayed in the Project tab of the Resource panel,
choose File = New. The New Document dialog box opens (see
Figure 162-1).

Figure 162-1: Picking the kind of page you want to create

2. Double-click the Default Template icon. This creates a new HTML
document with the starting tags already inserted (see Figure 162-2).

cratlolnuicledo tanies
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Figure 162-2: The starting page with <html> and <body> tags already in place
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3. Once the page is onscreen, enter a title for the page between the
<title> </title> tags.

4. Click inside the <head> </head> tags to insert your <meta> tags,
where you include the keyword or description text.

5. Click between the <body> </body> tags to begin building your
page and inserting text and graphics. Use the Tags menu to choose
from some commonly used tags (see Figure 162-3).

Figure 162-3: Inserting heading tags so you can enter your first heading text and
format it
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Task 63 Creating and Using Web
Page Templates

hen you start a new document with the default template, your HTML
document already contains some basic tags. This is more helpful than
starting out with a blank document; otherwise you must insert all tags manually.
The benefit of using templates is that they do some of the work for you. The
same goes for templates that do a lot of the work for you. Instead of repeatedly
building pages that contain many of the same elements you want to appear
throughout your Web site, just save one file as a template and create the
others from it. Doing so will save you from having to reinvent the wheel
every time you create a page for your Web site.

1. Build a Web page that contains the components you could use to
start another page for the same Web site (see Figure 163-1).

Contact

You can reach us amy of the followmg ways

Figure 163-1: A template that includes a basic table with text and images you can
replace later
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2. To save a page that contains the necessary elements with which to Task 63
create subsequent Web pages, choose File => Save As Template.

3. In the Save as Template dialog box, type a name for your template
(see Figure 163-2).

Figure 163-2: Saving your template with a descriptive name

4. To use a template that you or someone else already created, choose
File = New and click the Custom tab in the New Document dialog
box (see Figure 163-3).

Figure 163-3: User-created templates in the Custom tab

5. Select the template and click OK to see it appear as a new, untitled
page.
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Task 16A‘ Inserting and Converting Files

H omeSite makes it easy to incorporate an existing HTML document into an
open file. You can also insert a text file or other type of document into a
Web page.

1. To insert an existing HT'ML document into the one you’re currently
working on, click where you want the inserted document’s code to
start.

2. Choose File = Insert File. In the Open dialog box, navigate to the
file you want to insert (see Figure 164-1).

Figure 164-1: Finding the HTML file you want to insert into your open document

3. Double-click the file you want to insert in your existing document.

4. To add content to your file by converting another file, such as a text
(-txt) file, to HTML first and then inserting it, click where the new
content should go.

5. Choose File & Convert File.

6. In the Open dialog box navigate to the file you want to convert, such
as a comma or tab-delimited text file. Click Open to insert the file
(see Figure 164-2).
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Figure 164-2: Converted text file inserted into an open HTML document

7. Once your text is inserted, edit the text as desired and apply format-
ting using <font > tags and related attributes (see Figure 164-3).

55 # Last Hame Frst Hame Departracnt obs Tetle

A77-46-3325 Balsamo Anthosy Operations Coordmator * §75,400.00 *
513-51-5459 Barbar Kansath Sales Rapresentstros * £55,700.00 *
146-55-8762 Bowlng Jem Sales Daector * $135,000.00 *
127-85-9654 Chambers Boremary Accouting Manager * £95,750 00
333254793 Durnin Themnar Accoumting Coordinator ™ $72,800.00 *
441-41-1152 Elmualels Mo Marketng Coordmator * §67.500.00 *
247-66-5873 Fraskenfield Samantha Sales Manager * £75,000.00 *
123-43-6759 Fuller Robart Salts Coordnasor * §52,500.00
369-30-6926 Genger Mary Naketmg Coordnator * $66,500 00~
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245-87-1234 Miller Qury Sales Representairve = $45,600.00 *
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621-67-1858 Thomas Cameron Sales Repreventaiee = $56,750.00 *
321-65-4987 Uinch Kad Oparations Dwector ™ $125,500 00"
545.56-7552 Weller Barbara Marketng Coordmator * $76,250.00 *

Figure 164-3: Formatted text, which should probably be in a table
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Task 65 Finding and Inserting
Tags and Attributes
Even if you know HTML like the back of your hand, you needn’t always type it

out. The Tags menu contains many tags and attributes that you can insert
with the click of a button.

1. In an open document, click where you want to insert a tag or
attribute. Figure 165-1 shows <font> tags in need of the bold
attribute and some text to display in bold.
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Figure 165-1: Elaborating a tag by inserting an attribute for it
2. Click the Tags menu to display the tags and attributes that you can
insert (see Figure 165-2).

3. Click the tag or attribute you want to insert from the menu. It
appears where your cursor was positioned (see Figure 165-3).

4. Asneeded, insert your text between the tags/attributes.

5. Continue inserting tags and attributes from the Tags menu, as
needed.
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Figure 165-3: The strong attribute appearing within the <font> tag
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Task 66 Cleaning Code with CodeSweeper

COdeSweeper does just what its name implies. It sweeps code, cleaning out
redundancies and getting rid of extraneous code inserted by various
development tools. You can choose which sort of code to sweep (you’ll be
sweeping HTML here) and then let the CodeSweeper do its thing.

1. Open a document that needs sweeping and make it visible in the Edit
tab of the main window. Choose Tools &> CodeSweeper.

2. From the submenu (see Figure 166-1), choose the language you want
CodeSweeper to sweep. Here choose HTML CodeSweeper
(Optimized for HTML Only).

HTHL FORLIC -/ W3C/DTD NI 401 Trssitlensls o>
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Figure 166-1: You can sweep HTML, JSP, Web-XML, and WDDX.

3. In the CodeSweeper dialog box (see Figure 166-2), click Run
CodeSweeper. Figures 166-3 and 166-4 show before and after views
of a code page that’s been “swept.”

Figure 166-2: Click Run CodeSweeper to continue the process.
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Figure 166-4: Same code after CodeSweeper

4. To clean up a document that you developed in Macromedia
Dreamweaver, select Tools &> CodeSweeper &> Macromedia HTML
Tidy Settings. The same CodeSweeper dialog box appears, with Run
or Configure buttons. If you choose to run the CodeSweeper, your
Dreamweaver-created code will be cleaned up.
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Task 167 Editing Cascading Style Sheets
with the Style Editor

he Style Editor utilizes a third-party program called TopStyle Lite. Through
this program, you can view and edit Cascading Style Sheets (CSS) and save
them for use in your HTML documents.

1. Click the Style Editor button, which you can find on the toolbar
shown in Figure 167-1. TopStyle Lite opens (see Figure 167-2). The
application window consists of a large panel where the CSS appears,
a Preview panel area below that, and a two-tabbed section on the
right for viewing the details of your style sheet.

Style Editor button

Figure 167-1: Next-to-last in the toolbar is the Style
Editor button
Start a new file
View style sheet here
Add new selectors
Word wrap Toggle style inspector

Toggle preview on and off Preview style sheet effects
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Figure 167-2: Opening a style sheet and viewing it in the TopStyle workspace
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2. Choose File = Open to select a style sheet to edit. The Open dialog Task 61
box (see Figure 167-3) lists only files with a .css extension, by default.

Figure 167-3: Choosing the CSS file you want to view

3. Edit the style sheet, as desired. Use the New Selector button or type
directly in the panel displaying the style sheet.

4. 'To save your changes to the style sheet, select File = Save. This
overwrites the existing version. To preserve the original version
and create a second version that reflects your latest changes, choose
File = Save As. This opens the Save As dialog box. Give the CSS
file a new name or choose a new location (like your Project folder)
in which to save it.
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Previewing in External Browsers

reviewing Web pages in an actual browser window (rather than just through

HomeSite’s Browse tab) is an essential step in the Web design process. As you
work in a text-based development environment like HomeSite, viewing pages,
images, formatting, and all visual elements is key to spotting mistakes, seeing the
need for layout changes, and recognizing opportunities perhaps to use more
color, different fonts, more or fewer graphics, and to test animated GIFs and
movie files on your page. By previewing your files in actual browsers, you help
ensure that what you designed is what your visitors actually see.

1. Choose Options = Configure External Browsers.

2. In the External Browsers dialog box, view the currently selected
browsers (see Figure 168-1).

Figure 168-1: Seeing which browsers you have installed, and which ones
you need to add

3. Assuming you want to add a browser, click the Add button and use
the Browser dialog box (see Figure 168-2) to select a new browser.

Figure 168-2: Selecting a browser to add to the list
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4. In the Name box, type the name by which you want to list the
browser when you click the View External Browser List button or
open the External Browsers dialog box. Click OK.

5. Back in the External Browsers dialog box, choose one of three
options affecting how external browsers are launched. Your best
choice is to leave the default (third option) selected.

6. If you want to rename or redirect the path to a browser application —
perhaps to open a more recent (or older) version than the one you set
up — select one of the listed browsers and click the Edit button. The
aforementioned Browser dialog box opens, showing the settings for
the selected browser, which you can edit right there.

7. Click OK to return to the External Browsers dialog box.

8. Repeat Steps 3 through 5 for any other browsers you wish to add to
your External Browsers list. In order to set them up, make sure they
are installed on your computer.

9. To preview your page in a selected browser, be sure the page is open
and in Edit view. Click the View List of External Browsers button
(see Figure 168-3). Choose a browser from the list. Your page will
appear in the appropriate browser window.

o Halped preserve mone than 250 histons baldngs

© Saved more than |2 prvate gardens and parks m our area

© Worked with enveonmentalists to same 1000+ acres of open space
o Emabkshed a trust for widils peeservation

O Bossary of Terms

Opin Space
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] Preservationssts
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Provate Gardens
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between prvate homes

Figure 168-3: Selecting a browser from the list
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69 Formatting Body Text

n Part 2 you learned how to format text in HTML. In this task, you learn how
to format text using the Fonts tab in HomeSite. You can enhance your code
with a single click of a button.

1. In an open document, select the body text you wish to format. If the

text is not there, type it in first or refer to Task 164, “Inserting and
Converting Files.” You can also copy and paste text from word-
processing documents as needed.

. Click the Fonts toolbar (see Figure 169-1).

Figure 169-1: Thirteen different formatting options appear on the Fonts tab.

. To apply a new font, click the Font button (the first button) and view
the Tag Editor - FONT dialog box (see Figure 169-2).

Figure 169-2: Choose your font and its attributes through the Tag Editor dialog box.

. On the FONT Tag tab, select a color for the font and choose a size
by selecting Relative+, Absolute, or Relative— values.

. Click the Browser-Specific tab to see whether there are any issues for
your particular installed browsers. In Figure 169-3, it appears that
Netscape needs a point-size equivalent for the font size chosen in the
FONT Tag tab. Enter a number to satisfy this requirement.
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Figure 169-3: Entering information that your installed browsers require

6. Use the HTML 4.0 tab (see Figure 169-4) to select individual fonts,
font combinations (using the Combo field), and Generic fonts.

Figure 169-4: Satisfying font specifications for HTML 4.0

7. Work with the remaining tabs like Language and Style Sheets/
Accessibility (for assigning a style sheet to the font) as needed. For
most simple text formatting, however, Steps 1 through 8 more than
suffice.

8. Click OK to return to the document and Fonts toolbar.

9. Click the buttons for any formatting you wish to apply. As you click
any of these buttons, the proper attributes appear in the code.
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Task 110 Creating Lists

here are four types of lists you can create in HomeSite and two ways to create
them. Creating a Quick List uses a dialog box to establish the type of list
you’re creating. You can also create lists from existing body text.

1. To create a list from scratch and format it at the same time, start by
clicking in the document where the list should begin.

2. Click the Lists toolbar (see Figure 170-1).

Figure 170-1: The Lists toolbar provides a quick set of list-creation tools.

3. Click the Quick List button (the first one on the bar). The List
dialog box opens (see Figure 170-2).

Figure 170-2: Typing and formatting your list in the List dialog box
4. In the Rows field, enter the number of rows in your list, or click the
up and down triangles to increment or decrement the default of 1.
5. Choose a List Style: Ordered or Unordered.

6. Choose a Type. The list of items shown depends on whether you
choose Ordered or Unordered in Step 5.

7. In the large text box in the middle of the dialog box, click to start
typing your list. Type each item in the list and press Enter after each
item to start a new line.

8. Click the Generate </LI> Tags check box to set this option.
9. Click OK to create the list. The results appear in Figure 170-3.
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Figure 170-3: The code for a list
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(and the list itself) is generated and inserted into the

10. To convert lines of text you've already typed into a list, select them
and click any of the remaining buttons on the Lists tab. A definition
list, created from existing text, appears in Figure 170-4.

Figure 170-4: Constructing a list of terms and definitions quickly
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Cnr Glossary of Terms:
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Task 11 Checking the Spelling

here aren’t too many things more embarrassing than publishing something on

the Web that contains a spelling error or typo. Publishing the mistake to a
potential audience in the thousands or millions is unthinkable. To avoid this pos-
sibility, always use whatever proofing tools you have at your disposal to check
your spelling. HomeSite’s tool checks for and fixes errors in a selected range of
text or across an entire Web page. If you’re not sure about certain esoteric or
industry-specific terms, flag the (potential) errors with the Mark Spelling Errors
command and correct them later after you’ve consulted a dictionary or online
reference.

1. To check the spelling of a selected range of text, start by selecting the
text to be checked — drag through it with your mouse and avoid
selecting any adjacent tags (see Figure 171-1).
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Figure 171-1: Restricting your spell check to a specific portion of text

2. Choose Tools = Spell Check. The Spell Check dialog box opens
(see Figure 171-2) with the first spelling error selected (highlighted
in the document and displayed in the dialog box).
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Bur Glossary ef Temms:<p></p>

Figure 171-2: Errors shown in context as well as in the Spell Check dialog box

3. Look in the Change To text box. If the word there is the correct
spelling, click the Change button next to it. If not, look at the list of
words in the Suggestions list, pick one, and then click Change.

4. If none of the suggested words is right, type your own correction in
the Change To box and click Change.

5. When all misspelled words have been displayed and either changed,
ignored, or added to the dictionary, a prompt appears, telling you the
statistics for the spell check session (see Figure 171-3). Click OK.

Figure 171-3: Spell check statistics — how much text was
checked and how many mistakes found and corrected —
appear at the end of a spell check session.

6. To check your entire page, click anywhere in the text (don’t select
anything specific) and choose Tools = Spell Check. Repeat Steps 3
through 5.

7. To check the spelling in your entire project, choose Tools => Spell
Check All. Each document will be opened and checked, one at a
time, until all documents have been checked and all errors resolved.
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Task 12 Adding a Horizontal Rule

horizontal rule is a line that extends across your Web page. Its width and
thickness are determined by attributes you apply, and its placement is deter-
mined by where you insert the tag, either directly or using a menu command.

1. Click wherever you want the rule to appear, relative to the existing
content on the page.

2. Select Tags = Horizontal Rule. The Tag Editor - HR dialog box
opens (see Figure 172-1).

Figure 172-1: The Tag Editor - HR dialog box establishes the appearance and
placement of horizontal rules

3. In the HR Tag tab, choose an Align setting. Center is the default,
although you can choose Left or Right, depending on your page’s
layout.

4. Set the Width of the line, meaning how far across the page the rule
runs. Enter a percentage, such as 5o for a rule that runs half the
width of the page.

Enter the size in pixels, indicating the thickness of the rule.

e @

Click the No Shading option if you don’t want a chiseled, shaded line
(which you get by default on lines in excess of 1 pixel).

7. Click OK to create the rule code (see Figure 172-2).




Working with HomeSite

AT UE OCJRRIEATLEGC /ML TNt
ooty
<hmtedul typesTeitcle™
CLDBELPHE Preserve BOCE This 250 NISTOCLC BuLloLegs
clizfeved more than LD privene gardens snd parks in sur ares
wen £ save LBOO+ actes of cpen

clirEsvablished u touse for wildlide preservation
<iely
LAY AL "SRt B GLAMMEY O Tooms: </ div-o-2 /0

<l
CHtsBpen Spaceip</pr
AODURTARCER], WV I0p0 1abd D0

ple wien o nistsry andoe
FLIALLE S S
<deabravate Gacdens:</deaoc/p

<4Or0ardms and park-1ike space sn privats estatas and sharsd comson
ALRAP DEUMAD PELVALE DAGES< /D00

il

<P pedn Bpef-"cantacthtal T Contact Wac e

cpodipaon boefs hasesry. henl“x0us Histerpd/ w00 e
bt

</badp

Figure 172-2: The <hr> tag inserted to create the line you want

Figure 172-3 shows the Browse preview of the page.

About Our Crganszation

o Halped preserve mone than 250 histons baldngs

© Saved more than |2 prvate gardens and parks m our area

o Worked with envaronmentalists to yawe 1000+ acres of open rpace
o Emabkshed a trust for widils peeservation

O Bossary of Terms

Opin Space

Unscached, undeveloped lnd
Preservationasts

People concerned with prevensing destruction of kmory sadion wikdilfe
Provate Gardens

Gardens and pak-tce space on prrvase estates and shared common areas

Figure 172-3: The horizontal rule as it appears on the page
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Task 13 Searching an HTML Document

issing something? Can’t find where someone’s name appears on a given

Web page, or where you used a particular image or applied a specific color?
HomeSite has tools for looking for any text — body text, a tag, an attribute, a
value — and displaying all occurrences it finds.

1. To look for text within an open document, choose Search &> Find or
click the Find button on the toolbar (see Figure 173-1).

Find Extended Find

Figure 173-1: The Magnifying glass works the searching tool.

2. In the Find dialog box (see Figure 173-2), enter the text, number, or
tag you’re looking for.

Figure 173-2: Search for a name, number, or piece of code.

3. Customize your search by clicking the Match Whole Words or
Match Case options.

4. Choose the Direction for your search, Up or Down, based on your
current cursor position.
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5. Click Find Next to find the first occurrence of the text you’re looking
for. As each instance is found, click outside the dialog box to edit or
delete the text directly and then click back inside the dialog box to
activate it, and click Find Next to go to the next occurrence.

rask 4 T D

6. To do a more elaborate find, click the Extended Find button on the
main toolbar, or choose Search & Extended Find.

7. In the resulting Extended Find dialog box (see Figure 173-3), type
the text you’re looking for in the Find What box and then use the
Find Where options to choose which documents, folders, or projects
to use in the search.

Figure 173-3: The Extended Find dialog box

8. Click the Find button. A list of the occurrences of the text you’re
searching for appears in the pane below the document window,
including a total number of matches found.
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Task 17 A‘ Replacing Web Page Content

sing Find and Extended Find (see Task 173) requires that you act on each

found item individually, clicking within the document and making changes to
the text that’s been found. While this is useful for a few isolated items, you need to
use Replace and Extended Replace to make more sweeping changes or to replace
every single occurrence of a specific piece of text or code with something else.

1. To replace text in the active document, click the Replace button on
the toolbar (see Figure 174-1) or choose Search = Replace.

Replace Extended Replace

Figure 174-1: Using the Replace button to perform a simple search and replace
operation

2. In the Replace dialog box (see Figure 174-2), type the text you're
looking for in the Find What text box and type the text you want to
replace it with in the Replace With text box.

Figure 174-2: Telling HomeSite what you're looking for and what to replace it with
once it's found

3. Choose the direction you want the process to take — Up, Down, or
only applying to a selection made beforehand.

4. Click the Replace button to replace each found item individually or
Replace All to do a global find and replace in one step.

5. To do a more extensive find and replace, searching within multiple
documents and folders, choose Search = Extended Replace. You can
also click the Extended Replace button on the toolbar.

6. In the Extended Replace dialog box type the appropriate text in the
Find What and Replace With text boxes (see Figure 174-3).

7. Use the Find Where options to control how many files to search:
Current Document, All Open Documents, In Folder, or In Project.
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Figure 174-3: The Extended Replace dialog box

8. Make selections from the five check boxes on the right side of the
dialog box to restrict what’s found.

9. Choose File Types for your extended replace session. For example,
you could eliminate .doc files and only search in .htm or .html files.

10. Click Replace. Any items found are listed in the pane beneath the
main window (see Figure 174-4). Double-click any items listed to
activate them within the text for further manual editing.

Figure 174-4: See all items found and replaced in a single scrollable list.
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Task 15 Inserting an Image

nserting an image is as easy as issuing the proper command and selecting an
image. All the requisite code is inserted for you.

1. Click within your existing code at the point where the image should
appear.

2. Choose Tags = Image. The Tag Editor - IMG dialog box opens
(see Figure 175-1).

Figure 175-1: Choosing an image and setting its attributes in the Tag Editor - IMG
dialog box

. In the IMG Tag tab, click the Source box and type the pathname of
the image you want to insert. To avoid mistakes, click the Folder but-
ton at the end of the field and browse for the image. (Doing so opens
the Open dialog box.)

. Enter any text (to appear when you hover the mouse over an image
or to accommodate browsers that don’t show graphics) in the Alt
Text field.

. Give your image a Name to make it easier to spot code references to
it. (This is not the same as the image filename.)

. Choose a Border thickness (enter a number of pixels) if you want a
frame around your image.

. Choose a Left, Right, Top, Middle, Bottom align setting.

. If you want to add any white space around the image, enter values in
the HSpace (space above and below the image) and VSpace (space to
the left and right of the image) fields.
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9. Click the Browser-Specific tab to check for any settings that you
can establish for particular browsers or versions of browsers
(see Figure 175-2).

Figure 175-2: Dealing with browser-specific issues for your image

10. Click OK to insert the image and generate the code behind the
scenes (see Figure 175-3).
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Figure 175-3: Code generated from choices made in the Tag Editor - IMG dialog box




- Part 14
Task 16 Using the Image Map Editor

An image map is a series of “hotspots” drawn on an image to turn areas of it
into links that you can use to open other pages or files on the site.

1. Open the document that contains the image you want to turn into an
image map.

2. In the document, click the New Image Map button (see Figure
176-1) or choose Tools = New Image Map.

Figure 176-1: The New Image Map button

3. In the Create Image Map dialog box (see Figure 176-2) observe the
list of images from the open document — one line per image. Click
the one you want to turn into an image map.

Figure 176-2: The Create Image Map dialog box

4. Click in the Map Name text box to give your map a name. This name
will appear with the HTML code for the image map and make it eas-
ier to spot the code references to the map. Click OK.

5. In the Image Map Editor window (see Figure 176-3) begin drawing
the map areas on your image.
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Cut, copy, Delete a  Select an existing map area
and paste  selected

map areas map area

Draws rectangular shapes

Draws circular
shapes

¢ s Draws freeform
Visit seeability. polygons
Make a donation on Gary'sbehalf [ | Adjust view
Visit Gary's running club site
See pictures of Cary and his family
Return to the home page
Shows name
of the map

Figure 176-3: All the tools you need to build your image map appear here.

6. Click a shape tool and use it to map out an area by clicking and drag-
ging across the image to create the shape.

7. Assoon as the shape in Step 6 is complete the Tag Editor - AREA
dialog box appears (see Figure 176-4). With the AREA Tag tab
selected, type a URL or pathname in the HREF text box to whatever
the map area should link to.

S ivamen Laillly 00g

T e —

Figure 176-4: The Tag Editor - AREA dialog box sets the <href> tag for the image map.

8. Click OK to finish this particular map area. Back in the Image Map
Editor, continue mapping areas of the image.

9. Create as many image maps as you’d like — using one, two, or all
three of the shape tools as needed. Repeat Steps 7, 8, and 9 for each
newly mapped area you create.
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Task 17 Inserting Tags Automatically

nstead of typing your tags manually, you can choose tags from a list instead,
which prevents you from making typos in code. The Tag Chooser helps you
select tags to insert in a document, as well as determine a tag’s attributes.

1. Click to position your cursor where the tag should appear in code.

2. Choose Tools = Insert Tag to open the Tag Chooser (see Figure
177-1).

Figure 177-1: Choose from different categories of tags in the Tag Chooser.

. In the Tag Chooser, note the plus signs next to the different groups
of tags in the left pane: HTML Tags, XHTML Tags, and so on.
Click the plus sign next to HT'ML Tags to see the subcategories (see
Figure 177-2).

. Select a subcategory, such as Page Composition, Formatting and
Layout, or Lists.

. View the tags for each selected subcategory in the right panel and
scroll through them until you find the one you want. Click once on
the tag and click Select.
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Figure 177-2: Viewing HTML tag categories in the Tag Chooser

6. Assuming the tag you choose has attributes that can be set, click the
Select button to open the Tag Editor - [TAG NAME] dialog box (see
Figure 177-3, which shows the MARQUEE tag, for example).

Figure 177-3: Viewing the associated attributes for the selected tag

7. In the Tag Editor dialog box, use the tag name’s tab to fill in the rele-
vant fields. These fields and options vary depending on which tag
you choose.

8. Click OK to insert the tag and its attributes, based on your settings.
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Task 7 8 Inserting Tables

Tables are an important structural device in Web sites. HomeSite provides a set
of easy-to-use and powerful tools for inserting and formatting tables.

1. Inyour active document, click to position your cursor where the
table should appear.

2. Click the Tables toolbar.

3. To draw a quick table (and insert all the requisite code), click the last
button on the Tables tab, called the Table Sizer (Quick Table). A grid
appears (see Figure 178-1).

L FUBLIC “-//C//DTD NN 4,01 Toans

Figure 178-1: Use the Table Sizer to insert a quick table (3 x 3 in this case).

4. Drag through the pop-up grid (it expands for tables larger than 4 x 5)
and release the mouse button when the blue cells in the grid and the
dimensions listed below the grid match the table you want to create.

5. "To have more control over the table you create, as well as its content and
attributes, use the Table Wizard (first button on the Tables tab). Click
the button to open the Table Wizard dialog box (see Figure 178-2).

Figure 178-2: Click in the Table Wizard to design your table.
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6. Click the Row and Column buttons (the cells in the sample table) Task 7 8

and then click the plus and minus buttons to increase or decrease the
number of rows or columns in your table.

7. When the grid in the Table Wizard equals the dimensions you
require, click Next.

8. In the Table Properties page of the Table Wizard (see Figure 178-3),
enter your desired specifications and click Next.

Figure 178-3: Establishing table properties in the Table Wizard

9. In the Cell Properties page (see Figure 178-4), click any individual
cells to assign Content, establish the cell’s Width, and set up the
Content Alignment.

ot
Fuihe

Figure 178-4: Setting up the attributes and content of individual cells

10. Click Finish to create the table.
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Task 19 Building Framesets

1.

ames have their fair share of detractors. Designers don’t like how they control
page layout. Site visitors don’t like how they affect searching and navigating within
framesets, not to mention bookmarking them. Still, they are a powerful tool for struc-
turing Web pages. HomeSite makes it relatively easy to set up a frameset in your site.

To start a new page with frames (called a frumeset), choose File =
New. In the New Document dialog box, double-click the Frames
Wizard icon.

In the Frame Design page of the Frames Wizard (see Figure 179-1),
click any one of the four starting frames and use the Col+, Col-, Row+,
and Row- buttons to add columns and rows (frames) to your frameset.

Select a frame

Hold Shift to select
more than one frame

Figure 179-1: Deciding how many frames you want in your frameset

Click Next to move to the next step in the Frames Wizard, the
Frame Attributes page (see Figure 179-2), which offers tools for set-
ting up content for each frame in the frameset, and for establishing
size and scrollability.

. "To set up individual frame attributes, click in each frame and enter a

name in the Name text box as well as a Web address in the Source
URL text box. Use the Margins and Frame Appearance sections to
establish the frame equivalent of cell padding (margins) and deter-
mine whether or not the frame will have a scrollbar and if visitors can
resize the frame themselves.

. When each frame is set up, click Finish.

. Using the Frames toolbar (see Figure 179-3) you can augment and

alter the frameset you just created. There are buttons to open tag-
and attribute-creating dialog boxes (Set, Fra, If, No); for inserting
framesets (Set), frames (Fra), and floating frames (If); and for turning
off frames with a set of <noframes> tags (No).
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Frame Attnbates

Task 179

tips

= Combine two frames by

a1 <exk | | o |

Figure 179-2: Clicking in a frame to set your frame attributes

H conmun | Fosts | Taties  Frvmne | pueme | some | s |

HERTE wn o @

Figure 179-3: Using the Frames toolbar to add to existing frames, build frames from
scratch, or access dialog boxes for customizing existing frames

Use the Browse tab to make sure you have the frameset you want, no
matter which method you used to build or customize it. Figure 179-4
shows a completed frameset with Web pages displayed in two frames
and a blank frame awaiting original content.
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Figure 179-4: Verifying your frameset layout and content on the Browse tab

holding down the Shift key
to select two frames and
then clicking the Col- or
Row- button to merge the
pair into one.

= |f your frame contains a

lot of text, set some sort of
margin (just a few pixels)
so that the text doesn’t run
right into the frame’s walls.
The default setting is 10
but you may want more or
less, depending on your
design goals and frame
content.

= The Next button remains

dim — there is no subse-

quent step, which can be
confusing — so just click

Finish when you've set up
your frames.

= Make sure each frame’s

Source URL setting is
correct by viewing the
frameset in a browser.

cross-reference

* Frames are easily created
in a graphical environment
such as the one provided
by Dreamweaver — check
out Part 15.
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Task 180 Creating Forms

orms allow you to obtain information from your site’s visitors. Through text

boxes, drop-down lists, check boxes, and radio buttons, you can elicit opin-
ions, vital statistics, thoughts, ideas, and even credit card numbers. HomeSite
gives you tools for building forms — from creating the form itself to populating
it with interactive tools your visitors need to answer the questions posed by the
form.

1. Click within your page code to place the cursor where the form
should appear.

2. Click the Forms toolbar (see Figure 180-1).

. Add Submit and Reset buttons Insert a text box
orm )
button Insert a hidden field

Add a text area

Use radio buttons

Checkbox feature

Create a menu Select object

Figure 180-1: Tools needed to build a form and fill it with form objects appear in the
Forms toolbar.

3. Click the Form button to open the Tag Editor - FORM dialog box
(see Figure 180-2).

Figure 180-2: The Tag Editor - FORM dialog box

4. Supply an Action for your form — the URL of the processing script.
If you don’t know this address, check with your Webmaster, or the
Web host from whom you purchase space for your Web page.

5. Choose your Method: POST or GET.

6. Give your form a Name and click OK to create the form. The
<form> </form> tags appear and your cursor is automatically
situated between them.
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7. Begin adding form objects, using the remaining Forms toolbar but- Task 180
tons. Each addition results in a Tag Editor dialog box with options
for the specific object. Figure 180-3 shows the Tag Editor - INPUT
dialog box for a text box.

Figure 180-3: Entering settings for a particular form object you're inserting into the form

8. Click OK to insert the form object with the settings you’ve established.

9. Repeat Steps 7 and 8 for each form object you want to include in
your form.

10. Click the Browse tab to see your finished form (see Figure 180-4).
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Figure 180-4: Viewing the form to make sure it has all the objects you want
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Task 81 Determining Document Weight

ocument weight refers to the size of a Web page, the number of dependent

files (images, multimedia files, style sheets), and the estimated time it takes
someone to download the document over a dial-up Internet connection.
HomeSite’s document weight tool shows you how big a Web page is and the esti-
mated time it takes people to download the page to their browser. Depending on
what you find out, perhaps you only need to reoptimize your Web graphics (to
make them smaller) or eliminate a sound or movie file that’s not essential to the
page but is slowing its load time. After making your changes, you can review the
document weight to see if you’re closer to the goal of creating an efficient, fast-
loading page.

1. Inan open document, select Tools = Document Weight.

2. In the Document Weight dialog box (see Figure 181-1), review the
list of dependent files (see the Dependency list), each containing a
file size (see the Size column).

Figure 181-1: Checking your list of dependent files and their sizes
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3. Check the Weight and Estimated Download Time statistics and see if Task 8 ‘
they’re within acceptable limits.

4. Asneeded, sort your list of dependent files by clicking the
Dependency button or Size button. Whichever button you click,
you’re sorting the list in that field’s order.

5. Double-click any file you want to find more information about.
In the Image Properties dialog box (see Figure 181-2), you can see
the name of the file, its format and size, and a preview of the image
itself.

Figure 181-2: Previewing and finding
out more information about a particular
dependent file in the Image Properties
dialog box

6. Click OK to exit the Image Properties dialog box and go back to the
Document Weight dialog box; click OK again.

7. Make any changes to your dependent files — reoptimizing graphics
to make them smaller, eliminating nonessential images — and then
reopen the Document Weight dialog box to see if your changes
appreciably reduced the page’s download estimates.
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Task 82 Validating and Verifying Your Code

here’s nothing more frustrating for site visitors (and consequently for Web

designers) than links that don’t work or some aspect of the page that appears
improperly due to a coding error or browser-functionality conflict. Errors reduce
a visitor’s faith in your site and creates more work for the designer. Instead of
putting errors on the Web, use HomeSite’s document validation tools to check
your code for conflicts and problems, and use the link verification tools to make
sure all your links work as intended.

1. To check whether your links work, click anywhere in the document
(on the Edit tab) and choose Tools = Verify Links. The Results pane
appears to display a list of links in the page. Figure 182-1 shows the
Results pane for a page with many links — some that work and some
that don’t.

Figure 182-1: A list of page links and the status of each one

2. Ifyou choose, sort the Results pane by clicking the Source, Link,
Full URL, and Status buttons at the top of the columns. Sort by
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Status to see all nonfunctioning links together or sort by Full URL to
see if the problem links are associated with a particular site that may
be down since you last checked it.

3. To fix individual links that aren’t working, double-click them to go to
the code where the link appears.

4. To complete checking the overall page quality, validate the code
throughout the page by choosing Tools => Validate Current Document.

5. In the Results pane, observe the list of problems found — if any —
and double-click them individually to see the problem in context (see
Figure 182-2).
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Figure 182-2: Checking the Line column for the status of individual problematic code
lines

6. Edit the problematic tags as needed, using Help if you need it, or
reinsert the tag using the Tag Chooser (Tools = Insert Tag).
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Customizing HomeSite

aking an application work the way you do is a big part of using it efficiently.

If you constantly have to reset options or work around things that the
application does, you're wasting time and effort, and probably getting frustrated
with the application as a whole. HomeSite’s customization settings allow you to
change the appearance of the workspace and tweak the way the program per-
forms various tasks. You may not need or want to make any changes but it’s nice
to know that you can.

1. To customize the way HomeSite’s workspace looks and works, choose
Options = Customize.

2. In the Customize dialog box (see Figure 183-1), choose from one of
the four tabs: Toolbars, Keyboard Shortcuts, Snippet Shortcuts, and
Script Shortcuts.

Shows buttons currently in place

Available buttons
for the toolbar

Figure 183-1: Customize just about any aspect of HomeSite’s workspace and
commands

3. On the Toolbars tab, select any toolbar from the Visible Toolbars list
and add commands to the bar by dragging buttons from the
Toolbuttons list (set to All by default) to the sample bar within the
dialog box.

4. Click the Add Separator button to insert vertical breaks between
(groups of) buttons as you add them to various toolbars. Figure 183-2

shows the Fonts toolbar with a new separator and a few new buttons
added.

5. On the Keyboard Shortcuts tab, view the list of shortcuts. If there are
any you want to change, use the text box in the lower left corner to
enter a new shortcut. Click Apply to make the change happen.

6. Click Close to apply your changes to the toolbars or shortcuts.
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Separates default toolbar buttons 3
from newly added ones Newly added options TaSk 8

Figure 183-2: Adding more heading styles to the Font toolbar

7. To change the way HomeSite’s commands and features work, choose
Tools = Settings.

8. In the Settings dialog box (see Figure 183-3), examine the various
categories on the left. For each one you click, the settings on the
right change to offer options relevant to the category you’ve selected.

Figure 183-3: From the general to the very specific, you can change just about anything
about the way HomeSite works.

9. Using the options for the selection made on the left panel, make
changes to HomeSite’s defaults, including its spelling options, which
include a checklist of spelling situations that you can make HomeSite
ignore (such as words in ALL. CAPITAL LETTERS).

10. Click the various categories on the left and make your changes, as
needed, on the right. When you’ve made all the changes you want,
click Apply to close the dialog box.
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Task 18A‘ Using Auto-Backup

acking up files is one thing most people forget to do. You think about it and

decide you’ll get around to it one day, but you never do so. When your
computer crashes or you write over a file you didn’t mean to, you’re out of luck
because you have no backup with which to replace the missing or corrupted file.
"To save you from your own tendency to forget to backup, HomeSite offers an
Auto-Backup feature that creates backup versions of your files and saves them
to a location you specify.

1. To make sure Auto-Backup is on and working efficiently for your
needs, choose Options &> Settings.

2. In the Editor category, click the Auto-Backup subcategory.
The Settings dialog box and the default Auto-Backup options
appear (see Figure 184-1).

Figure 184-1: Customizing Auto-Backup’s settings
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3. Make sure Enable Auto-Backup is checked.

Task 18A‘

4. Use the Backup Directory box to adjust the location of your backup
files. Click the Browse button to open the Browse for Folder dialog
box (see Figure 184-2).

Figure 184-2: Choosing a new location for your backup files

5. Select a folder from the dialog box and click OK.

6. Verify the other settings in the dialog box (the rest of these defaults
are generally best for most users) and click Apply to confirm your
changes, if any.
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Establishing Deployment Options

(14 Deployment” is HomeSite’s term for uploading a Web site to a Web server.

Before deploying your site (or project) to the Web, it’s a good idea to
make sure your deployment options are set up properly. This prevents last-minute
surprises when you deploy the site — such as an inability to log on to the remote
server because you have the wrong password or don’t have the right folder chosen
to store your Web site files. You can avoid these problems and more with a little
advance preparation.

1. Open the site (project) you want to deploy and choose Tools =
Settings.

2. In the Settings dialog box, click the Projects category and display the
Deployment subcategory (see Figure 185-1).

Figure 185-1: Customizing HomeSite’s deployment process

3. Although the default settings are generally acceptable for most situa-
tions, if you wish to change any of them, check or uncheck settings
as needed.

4. If you want to be able to upload all files, regardless of how long ago
you or your team worked on them, turn off the Upload Only
Newer option.
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5. In the Logging section, leave Disable Logging unchecked because
you don’t want to not keep logs of your deployments.

6. Use the Browse button at the end of the Log File field to choose a
new place to store your log files, as needed.

7. If you want to update the path to your project file so that your
deployment goes to the right folder to find your local files, choose
Project > Properties.

8. In the Edit Project Properties dialog box (see Figure 185-2), type a
path to your project files.

Figure 185-2: View the current path and type a new one if you know it.

9. If you don’t know the exact path, click the Browse button at the end
of the Deployment Path field to open the Select Directory dialog box
(see Figure 185-3).

(il

peesss DB
i

=)
o]
o
o
g
o
o
=

i

Shbits
HH
¥

5 ) W s Contare
i [ HPTSMET

Figure 185-3: Selecting a folder for your project files

10. Click a folder to select it and click OK to confirm the new location of
your project files.
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Deploying Files and Folders

ssuming your deployment settings are correct and you’re ready to put your

locally-stored project up on the Web, you’re ready to deploy. It’s a rather
militaristic-sounding term for the process of uploading files, but the serious tone
of the terminology is well-placed. The way you upload your files to the Web can
make or break your site’s successful appearance online — if dependent files are
missing or links to project pages fail because not all the pages are uploaded, you’ll
have confused visitors and may have created some extra work for yourself in fix-
ing the problems. To make deployment easier, and to help eliminate problems
before they occur, HomeSite provides the Deployment Wizard.

1. Choose Project = Deployment Wizard to open the wizard
(see Figure 186-1).

Figure 186-1: Starting the
Deployment Wizard

2. In the first page of the wizard, choose whether you’ll do a Direct
Deployment or a Scriptable Deployment. Direct is the default because it
assumes you're uploading local files to a Web server on a one-time basis.

3. Click Next. The Select Deployment Destination and Options page
appears (see Figure 186-2).

Figure 186-2: Choosing where
your project files will end up
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4. Choose the type of deployment (Local/Network or Remote/FTP). Task 86
In this case, choose FTP, because this is how I connect to my Web

server. Your choice would be based on your Web server’s location and
preferred deployment method.

5. Choose which files to upload and whether or not to create folders on
the remote location that match the local project files. You would
want to create folders and subfolders to match your local folders so
that paths to files in those folders would be supported on the Web
server, just as they worked locally.

6. Click Next. On the Ready for Deployment page (see Figure 186-3),
click Finish to begin deployment.

Figure 186-3: Clicking Finish to
deploy your site

After deployment finishes successfully, the Results window (see
Figure 186-4) opens and shows the success or failure of your attempt.
Each step in the process is listed, along with the status of that step.

7. If your deployment failed, repeat the Wizard or check your Project
Properties to see if your remote or local settings are incorrect.
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Figure 186-4: Checking the Results pane to see if deployment worked
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Task 87 Assigning Preview Browsers

Agood Web designer tests all pages in more than one browser — preferably
more than one version of each — before uploading pages to the Web. This
allows you to find out if any of your pages don’t appear or function properly for
visitors who use specific browser software or specific versions of that software. In
this task you determine which browsers to use to preview your Web pages.

1. With Dreamweaver MX open and running, choose File => Preview in
Browser. From the shortcut menu, choose Edit Browser List.

2. In the Preferences dialog box (see Figure 187-1), select the Preview
in Browser category and then choose which browsers you want to
use, clicking the plus sign to add them.

Figure 187-1: Choosing from the list of browsers you have on your computer, adding
one, some, or all of them to your preview list
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3. When you click the plus sign, the Add Browser dialog box appears
(see Figure 187-2). Here you enter a browser name, choose which
application to run, and designate the browser as your primary or
secondary default.

Figure 187-2: Setting options about the browser you add to the preview list

4. Click OK to accept the settings for this browser and return to the
Preferences dialog box.

5. Repeat Steps 1 through 4 for each browser/version you want to add
to your list.

6. Click OK to close the Preferences dialog box.
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Task 88 Defining Sites

he first step to build a Web site in Dreamweaver MX is to define it, to tell

Dreamweaver what your site is called, the site’s domain name, and where its
files (images and related content) are stored locally. These same folders are recre-
ated later on the Web server so that the Web site mirrors your local file structure
perfectly.

1. Choose Site = New Site to open the Site Definition dialog box (see
Figure 188-1). If your screen looks different, click the Basic tab to see
the Site Definition wizard.

Figure 188-1: Starting the site definition process by naming your new site

2. Enter a name for your site and click Next.

3. Choose what sort of server technology (ColdFusion, ASP, NET, JSP,
or PHP) you want to use. Choose Yes to use server technology or No
to skip that.

4. Click Next. The third step in the process appears, asking how you
edit your pages (locally or on the server).

5. Choose Edit Local Copies on My Machine. You must enter the path
to the folder where you will store this site’s pages.

6. Click Next and choose how you connect to your Web server.
Depending on your response, different options will appear in the
dialog box.
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7. Click Next and decide if you want to enable Check In and Check
Out.

8. Click Next and confirm your settings (see Figure 188-2).

Figure 188-2: Making sure your settings are correct

9. Click Done. Your site is set up and you can begin adding pages to it.

10. 'To begin building your site, save the blank, new document
as index.htm and see how that file appears in the site map
(see Figure 188-3).

Figure 188-3: Making your first page,
typically saved as index.htm, the official
home page
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Task 89 Using Site Maps

Asite map allows you to create and control links between pages and to open
particular pages for editing. It also gives you a bird’s-eye view of your site so
you can discern relationships between your pages and the site’s structure. One
caveat: You need to establish a site first, with some files saved in it, in order to use
a site map. The following steps assume you’ve created a site and saved at least
one file in it — preferably the home page, index.htm.

1. To open an existing site and view its site map, choose Site = Site
Map. If you have more than one site available, click the drop list that
lists all of your sites (a list of your available sites appears as shown in
Figure 189-1) and choose the one you want to see.

Figure 189-1: Choose which site you want to work with from the Edit Sites dialog box

2. With the site open and the site map displayed, double-click the site
folder to display the files within the site. A tree structure appears,
similar to the one seen in Windows Explorer, showing the connec-
tion between your site files.

3. To open a site file, double-click its icon in the site map. The file
opens in its own window, ready for you to edit the page.

4. To create a quick link between two pages in your site, expand the site
map window by clicking the Expand/Collapse button (the last button
on the toolbar). The site map window expands substantially, based on
the overall Dreamweaver window size and any other displayed work-
space items (see Figure 189-2).

5. Click the Site Map button (third button from the left) so that a “fam-
ily tree” version of your site map appears on the left side of the win-
dow (see Figure 189-3).

6. Click on the Point-to-File icon (next to the index.htm icon in the site
map) and drag it to a file in the site list. If you don’t see this icon,
click once on the file icon. Once the connection is made, the second
file appears in the site window and the link between the files is indi-
cated by a line connecting the two file icons (see Figure 189-4).

7. Continue making connections or close the site map by reclicking the
Expand/Collapse button.
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Expand/Collapse button

Figure 189-3: Site map of your index.htm file

Figure 189-4: Connecting two pages in a site map
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Task 190 Establishing Page Properties

Page properties, which apply to the active page in your site, should be consis-

tent throughout the site. This means you should apply the same properties to
each new page you create, or else establish them once and use them when build-

ing subsequent pages.

1. Open the page for which you want to establish properties. Choose
Modify = Page Properties.

2. Enter a title for your page in the Page Properties dialog box (see
Figure 190-1).

Figure 190-1: Customize virtually anything about the active page in the Page Properties
dialog box

3. Choose a background image for your page, if desired. Otherwise
choose a background color using the palette (see Figure 190-2).




Working with Dreamweaver

Figure 190-2: Setting the page background as a picture or solid color

4. Using the same palette buttons for each option, set the Text and
Links, Visited Links, and Active Links colors.

5. Change page margins as desired.

6. If you’re using a tracing image, set its pathname here.

7. Click OK to confirm your settings and see them applied to the page.
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Task 91 Setting Code View Options

rust us when we say there’s no substitute for knowing the code. Just because

Dreamweaver is a visual editor doesn’t mean you never have to look at
HTML again. In fact, Dreamweaver wants you to. That’s why it gives you so
much access to it. Half of the document window is devoted to Code view.

1. Open Dreamweaver and go to the document window.

2. On the document window’s toolbar, click the Code View button (see
Figure 191-1).

Figure 191-1: The Code View button

3. Choose View > Code View Options. A submenu appears with a
check mark beside any currently set option (see Figure 191-2).

4.08 Tramssviconal//EN">

Figure 191-2: The Code View Options submenu
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4. Select any of these options from the submenu: Task 91

*  Word Wrap: Wraps code so it can be read without any horizon-
tal scrolling.

* Line Numbers: Displays line numbers along the side of the
code.

¢ Highlight Invalid HTML: Highlights invalid HTML in bright
yellow. When an invalid tag is clicked, information about how to
fix it appears in the Property inspector (see Figure 191-3).

=

Figure 191-3: Suggested code corrections in the Property inspector

¢ Syntax Coloring: Toggles code coloring on and off.

* Auto Indent: Indents code automatically when you press the
Enter key while editing or adding code in Code view.

5. To disable a checked option, simply select it to remove the check
mark.
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Task 92 Working with Code Snippets

n Dreamweaver, a code snippet is just a saved bit of code (HTML, CSS,

JavaScript, or any other language). A handy panel allows you easily to create,
store, and retrieve these snippets. Dreamweaver also comes with some ready-
made snippets you can use as a starting point.

1. To insert a code snippet, place your cursor in the desired location
within your document.

2. Select Window = Snippets to open the Snippets panel (see
Figure 192-1) and double-click the snippet of your choice.

Figure 192-1: The Snippets panel
3. To create a new snippet, click the New Snippet button (the document

with the plus sign) located at the bottom right of the panel to open
the Snippet dialog box (see Figure 192-2).

Figure 192-2: The Snippet dialog box
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4. Enter a name and description for the snippet in the fields provided. Task 9 z
5. Choose your snippet type:

*  Wrap Selection: Enter the code you want to appear in front of
the selection in the Insert Before field and the code you want to
appear after the selection in the Insert After field

* Insert Block: Simply enter your code into the Insert Code field
6. Choose a preview type:
* Design: When you insert the snippet the Preview pane appears
in Design view
* Code: The Preview pane displays the snippet code
7. Click OK to close the Snippet dialog box.

8. 'To edit or delete a code snippet, select it in the panel and click the
Edit Snippet button to reopen the Snippet dialog box, or the Remove
button to delete it.

9. 'To create folders to manage your snippets, click the New Snippet
Folder icon at the bottom of the panel and drag your snippets into
the new folders or the preexisting folders.
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Task 193 Inserting and Formatting Text

Text appears on virtually every Web page. It expresses ideas, shares informa-
tion, sells products, and instructs. Dreamweaver makes it easy to insert text
into pages; link text to other pages, files, or sites; and format text so it’s legible
and color-coordinated with the rest of your page.

1. In the open page, click to position your cursor where the text should
begin.

2. 'Type your text. Word-wrapping forces long lines of text to flow to
the next lines (see Figure 193-1).
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Figure 193-1: Typing a page title or paragraph of information

3. After typing, select any text that you want to format.

4. Ifit’s not already displayed, select Window => Properties to view the
Properties inspector. The Font and Size selectors on it adjust the
appearance of your text (see Figure 193-2).

5. Click the Text Color button to open the color palette, which you can
use to select a color or enter a hexadecimal value for one (see Figure
193-3).

6. Apply bold or italic, as desired, by clicking the B and I buttons,
respectively.
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Resize text4 - List and target options Task 193

Choose a font/font group Choose text color

Create links Enter the color's hexadecimal number here

Format button Choose bold oritalic  Change alignment
J
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Figure 193-2: The Properties inspector allows you to format any aspect of text

7. Use the alignment buttons (Left, Center, Right, or Justify) to change
the horizontal alignment of your text.

8. Repeat Steps 1 through 8 for any other text that needs formatting on
the page.

Figure 193-3: Picking a color from the Web-safe palette
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Task 19A‘ Creating Lists

L‘iJsts come in three varieties: ordered lists (also called numbered lists),
nordered lists (bulleted lists), and definition lists.

1. Select your list — any series of lines of text or paragraphs.
2. To create a bulleted list, click the Unordered List button.

3. To create a numbered list, click the Ordered List button. Figure
194-1 shows an unordered list created from four lines of text.

« HTML in 10 Suaps of Lass
« Digztal Photography for Dusnmies]

Figure 194-1: An unordered list implies a series of equally-important items with no
implied priority between them.

4. Delete items in your list and observe the changes in the list itself. If
your list is numbered, the number sequence updates automatically.

5. Add items to your list and observe the changes to the number of bul-
leted items or the number sequence of list items.

6. To create a definition list, select the text and choose Text = List &
Definition List.

As shown in Figure 194-2, the items in the list alternate between
being terms and definitions.
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Figure 194-2: Building a list of terms and definitions
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Task 95 Proofing Page Text

Dreamweaver’s spell-check feature works very much like that in any word
processor. Words not found in the internal dictionary are listed as misspelled,
and you have the opportunity to choose an alternate spelling or edit the text
directly.

1. To spell-check just one part of your page, select the text and choose
Text = Check Spelling. If you want to check the entire page, just
choose the command without first selecting any text.

2. In the Check Spelling dialog box (see Figure 195-1), each misspelled
word appears, one by one.

Edit text here

Spelling suggestions list

Figure 195-1: Mistakes found within the selected text or on a page appear in the Word
Not Found in Dictionary text box.

3. Select an alternate spelling from the Suggestions list or type a correc-
tion in the Change To text box.

4. Click Change or Change All if you want to implement the change.
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5. Ignore a word you know is spelled correctly by clicking Ignore or
Ignore AlL

6. If you spell-check a selection, you’ll be prompted that the selection
has been checked (see Figure 195-2).

Figure 195-2: Checking just a portion of your text, or checking all of it if you wish

7. When the spell check is complete and the entire page has been
checked, the dialog box closes.
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Task 96 Using Find and Replace to
Edit Page Content

pdating a Web page or Web site for the new year (changing copyright refer-

ences), changing someone’s name, and bringing product or service references
up-to-date are all great uses of Find and Replace. It helps you get a tedious,
error-prone job done quickly.

1. To find text and replace it with other text, open any page you want to
change.

2. Choose Edit = Find and Replace. The Find and Replace dialog box
opens (see Figure 196-1).

Figure 196-1: The Find and Replace dialog box provides all the controls you need to
make global edits to your page or site.

3. In the Find In list box choose the scope of the Find and Replace ses-
sion: Current Document, Entire Current Local Site, Selected Files in
Site, or Folder.

4. In the Search For list box specify if you want to look for anything
other than text. Your choices include Source Code and Specific Tag.

5. Type the text you’re looking for in the text box to the right of the
Search For list box.

6. Type what you want the found content to be replaced with in the
Replace With text box.
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7. Click the options below to refine your Find and Replace session. Task 96

8. Click Replace All to do a global Find and Replace for the scope of
your site selected in the Find In list box.

9. Click OK to respond to the confirming dialog box (see Figure 196-2),
which indicates which areas of the site were checked and how many
replacements occurred.

Figure 196-2: Results of performing a requested Find and Replace
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Task 97 Importing Word HTML

icrosoft Word makes it easy to convert Word documents into HTML.

Unfortunately, Word adds extraneous code that bloats HTML files.
Dreamweaver makes it easy to work with Word-converted HTML files by taking
out the code that Word puts in, making a much cleaner HTML file in the
process.

1. In the page into which you wish to import a Word HTML docu-
ment, choose File = Import = Word HTML.

The Clean Up Word HTML dialog box opens (see Figure 197-1).

Figure 197-1: The dialog box that says it all: “Clean Up Word HTML”

2. On the Basic tab, view the list of cleanup tasks that will be performed
and uncheck any that you don’t want done.

3. On the Detailed tab (see Figure 197-2), view the specific Word ver-
sion information that Dreamweaver will use to clean up the code, and
check the CSS cleanup options as well. Uncheck any items you don’t
want done.
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Figure 197-2: Choosing the version of Word used to create the imported HTML
document

4. Click OK to perform the cleanup and import the Word HTML file
into Dreamweaver. A prompt appears (see Figure 197-3), telling you
what was done to the imported document.

Figure 197-3: A rundown of the unnecessary code Dreamweaver stripped out of the
Word HTML document
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Task 98 Importing Data Tables from
Other Applications

uppose you need to take a Microsoft Excel worksheet or a table from a

Microsoft Word document — or even a data table from Microsoft Access or
another database management system — and import it into a Web page. This
task requires importing the tabular data — located in a table, one piece of data
per cell — and inserting it so it’s legible and accessible within Dreamweaver. You
can easily make that tabular data appear in a Dreamweaver-created table using
the Import Tabular Data command.

1. Open the page you want to import tabular data into and choose File
= Import = Tabular Data.

"This opens the Import Tabular Data dialog box (see Figure 198-1).

Figure 198-1: Choosing the source of the tabular data and informing Dreamweaver
how you want to use and display it

2. Click the Browse button to select your tabular data file. This opens
the Open dialog box (see Figure 198-2).

Figure 198-2: Navigating to the data file you want to import into your Web page
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3. Select the file you want to import and click OK. This returns you to
the Import Tabular Data dialog box.

4. Choose the delimiter that separates the individual pieces of data
within your source document. Tab is the default.

5. Leave the Table Width setting in its default condition: Fit to Data.

6. Insertany cell padding or cell spacing you feel enhances the legibility
of your data.

7. If your top row is the column headings (field names from the data-
base), you may want to choose Bold from the Format Top Row
list box.

8. Click OK to import the tabular data and create a table in the Web
page (see Figure 198-3).

513519459 Barber  Keseth  Sales mpm-mmmooo
196550762 Bowhg__ Dem  Saes  [Deector  $135,00000
77.55-9654 Chambers  Rosemaey Aeemm 493,750.00 |
333.25.4793 Durm Thomas mm (Coordmator  $72,80000 |
441411192 Fhaleh  Miruen [ Marketng Coordamasor 1$67.500.00
m&smsrmu.nus.nm Sades nm.. 475,000 00
123-45-6789 Fuler  Robent  Sales  [Coordemasor  $52,50000
$9-30-0926 Gegn  Mary  Makaimg_ Coordmasor 16,0000
585-61-5725 Kassel  [Jeme [Accoming Coordmator 'ﬂs»now
312457521 Memmelstem Dind__ Accownting Direckor ﬂmsmm
245-27-124 Miler  [Gary  [Sales wusmm
|a||nm5p-uk Katin u.-tm; Manger  $67.50000
30145-9612 Ped [Boxe Manager  185,50000
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620.67-1858 Thomas  (Chmercn (Sales  Represestatve $36.73000

Figure 198-3: A database of employees becomes a table of names and numbers in
Dreamweaver
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Task 99 Inserting and Formatting Images

nserting an image into Dreamweaver is almost too easy. It’s also easy to change
the image’s dimensions and alignment, and apply a border to the image.

1. In Design view, click to position your cursor where the image should
be placed.

2. Choose Insert = Image. The Select Image Source dialog box opens.

3. Navigate to the image you want to use. A preview of it appears to the
right (see Figure 199-1).

Figure 199-1: Navigating to the folder containing the image you want to use — known
as the image source

4. Click OK to insert the selected image on the Web page. If you
choose an image that’s not already stored in the current site, a
prompt appears asking if you want to copy the file to the site folder.
Click Yes.

5. Once the image is in place, click to select it (see Figure 199-2). The
Properties inspector displays various image-related options (be sure
the inspector is in its expanded state).

6. Give your image a name for use within the HTML code by clicking
in the text box under the word “Image” and the image size. Type a
short name in the box.
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Type name for the image here

Change vertical and horizontal alignment

Dimensions

Observe image dimensions Type alternate text here

Figure 199-2: Image options in the Properties inspector

7. Use the Alignment tools (three buttons and an Align list box) to repo-
sition the image on the line or within the table cell that contains it.

8. Enter a number in the Border field, indicating the pixel width of any
border that surrounds the image.
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Task 200 Inserting Flash Text

1.

® N

hen you click on Flash text in a browser, it changes color, creating a subtle
level of interactivity. Flash text can function as an interactive link too. You

can create Flash text quickly and easily in Dreamweaver.

In Design view, click to position your cursor where the Flash text
should appear.

Choose Insert = Interactive Images = Flash Text.
"This opens the Insert Flash Text dialog box (see Figure 200-1).

Figure 200-1: All the tools you need to build interactive Flash text in the Insert Flash
Text dialog box

Choose a font and size for your Flash text. The first font in your
operating system’s Font folder determines the default font; size 30 is

the default size.

Apply bold (B), italic (I), or underline (U) styles to your text and set
any alignment changes (Left, Center, or Right) to the text. Left is the
default.

Click the Color button to choose a color for the text in the resulting
palette.

Click the Rollover Color button to choose the color that the text
turns when someone points to it with the mouse.

Type the Flash text in the Text field.
"Type or browse to the URL or file that this Flash text should link to.
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9. Establish your target setting for the linked page/file. Task 200
10. Click the OK button to create the Flash text and see it on the Web
page (see Figure 200-2).

My Family. .

Zachary %nch

e "

Figure 200-2: Flash text generated by Dreamweaver appears under the image.
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Task 201 Inserting Flash Buttons

Flash buttons are really cool graphic buttons or tabs that contain text (which
you provide) in any number of visually compelling styles. You can choose the
button style, color, and font, and determine where the button links to.

1. In Design view click to position your cursor where the Flash button
should appear.

2. Choose Insert = Interactive Images = Flash Button. The Insert
Flash Button dialog box appears (see Figure 201-1).

Figure 201-1: Creating a Flash button in the Insert Flash Button dialog box

3. Scroll through the Style list and click on individual style names to see
them in the Sample box.

&

When you find one that you like, leave it selected.

o

Click in the Button Text box and type the text that should appear on
the button face.

6. Choose a font for the text, and also a size by entering a number in
the Size text box.

7. In the Link text box, enter or browse to a URL or file that the Flash
Button should link to.
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8. Click OK to create the button and see it on the Web page (see Task 0 ‘
Figure 201-2).

® L YR EE |

:

Figure 201-2: Flash button with the text, font, and size you choose
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Task 202 Testing and Formatting a Flash Button

0

1.
2.

nce you create a Flash button, you can use the Properties inspector to test
and change its appearance and placement on the page. You can also name
your button so that the related HTML code is easy to spot within Code view.

Click on the Flash button to select it. Handles appear around it.

Observe the Properties inspector (see Figure 202-1) and be sure it’s
expanded to show all of its tools. Once you expand it and leave it that
way, it should remain in the expanded view.
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Figure 202-1: Flash button settings in the Properties inspector

Click in the text box under the words “Flash Button” on the left side
of the Properties inspector. Enter a name for the button. That

name will appear in the HTML code that refers to the button (see
Figure 202-2).

Enter new height and width settings for the button, as needed, using
the H and W boxes.

. Adjust the Quality of the button image. High is the default and your

best choice.

. Click the Play button to see how your button reacts when the mouse

pointer goes over it (see Figure 202-3).
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Figure 202-2: References to a Flash button in code after giving it a short, relevant

name in the Properties inspector

7. Adjust the alignment of the button. This changes its horizontal align-
ment on the line or within the table cell that contains it.
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Flgure 202-3: Changes occur in Flash buttons when the mouse pointer hovers them

Task 202

= For a browser's-eye view of
the Flash button, use the
Preview in Web Browser
shortcut (press F12 to
open your default browser)
and mouse over the button.

cross-veference

= You can preview your pages
in a browser window, test-
ing all of their features,
through any of the text
editors covered in this
book. For example,
HomeSite has a preview
command, discussed in
Part 14.
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Task 203 Assigning an External Image Editor

ou probably have a favorite application for creating and editing graphics.

Dreamweaver displays an Edit button in the Properties inspector (visible
whenever a graphic is selected), which you can set to open the graphics-editing
application of your choice. Clicking the Edit button launches the designated
application and opens the selected graphic to await your changes.

1. Choose Edit = Preferences to open the Preferences dialog box (see
Figure 203-1).

Figure 203-1: Customizing many areas in Dreamweaver

2. In the Category list, select File Types/Editors. The right side of the
dialog box changes (see Figure 203-2).

3. In the Extensions list, click once on the first Web-safe graphics file
format you see: GIF, JPG, or PNG.

4. Check the Editors list next to the Extensions list; the application (if
any) associated with that file type appears.

5. "To change programs, select the unwanted application and click the
minus-sign button on the Editors side of the dialog box. The current
application name disappears from the list.

6. Click the plus-sign button above the Editors list to open the Select
External Editor dialog box (see Figure 203-3).
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Figure 203-2: Choosing file types and selecting programs that edit them

7. Navigate to the application folder of the program you want to use for
editing graphics, and double-click the executable file. You’re returned
to the Preferences dialog box.

8. Repeat Steps 3 through 7 for each of the file types (GIF, JPG, PNG)
you want to assign to a specific editor.

Figure 203-3: Choosing the application you want to associate with a selected file type
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Task ZOA' Creating Image Maps

A

1.

n image map is a group of hotspots — geometric shapes drawn on top of an
image that you associate with specific URLs or files. This turns the area into
a hyperlink.

Click once on the image you want to turn into an image map.
Handles appear around it and the Properties inspector shows image-
related tools (see Figure 204-1) .
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Figure 204-1: Selecting an image in Dreamweaver

In the lower half of the Properties inspector, click on the map shape
that works for the area you want to turn into an image map (see
Figure 204-2).

Figure 204-2: The image map tools

As soon as you draw the map area, the Properties inspector changes
its features (see Figure 204-3). Click in the Link box and type the
URL or path to the file the image map area should link to.

Make a target choice for your link: _blank, _self, _parent, or _top.

Repeat Steps 2 through 4 for each area you want to include in the
image map.
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Figure 204-3: Setting the link details for a specific image map area

6. When your image map is complete, press F12 to preview your page
in a browser. View the links that have been placed in the image map
(see Figure 204-4).

Figure 204-4: Pointing to areas on an image map




- Part 15
Task 205 Creating Image Rollovers

Arollover consists of two images that occupy the same space on your Web
page. One image replaces the other when the mouse pointer hovers over it.
Rollovers are most useful for images because the image’s change in appearance
draws attention to the link. A rollover can also provide instructions (such as
“Click Here!”).

1. In Design view click to position the cursor where the image rollover
should appear.

2. Choose Insert = Interactive Images = Rollover Image to open the
Insert Rollover Image dialog box (see Figure 205-1).

Figure 205-1: The Insert Rollover Image dialog box gives you all the options you need
to set up your rollover.

3. Give the rollover a name in the Image Name text box. The name
helps you find the code pertaining to the rollover in Code view.

4. Type the name of the file you want to use for the original image, or
click the Browse button to find the file manually.

5. Choose the rollover image — the image that appears when someone’s
mouse rolls over the original image.

6. Type any desired alternate text, such as instructions for following the
link, a description of what happens when the link is clicked, or text
that serves as a caption for the image that appears.

7. In the When Clicked Go to URL text box, type or browse to the
URL that the interactive image should link to.
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8. Click OK to create the rollover. The image appears to have shading
over it when it first appears in Dreamweaver (see Figure 205-2). This
indicates that more than one image is occupying the space.

| BRéOsFEOROR

Figure 205-2: The original image appears and shading indicates that another image
associated with the same spot appears on the page.
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Task 206 Building Navigation Bars

navigation bar can be very convenient, and depending on your page design,

may be essential for providing a consistent list of links to pages within a site.
Visitors like “nav bars” because they appear the same on every page (if they’re
designed correctly) and designers like them because Dreamweaver makes them
easy to build.

1. Click to position the cursor where the navigation bar should appear.
You should be in Design view (or the Design portion of the Code &
Design view).

2. Choose Insert = Interactive Images = Navigation Bar to open the
Insert Navigation Bar dialog box (see Figure 206-1).

1
1
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Figure 206-1: Adding several images to a navigation bar, each pointing to a different
page in your site

3. Replace the “unnamed1” text in the Element Name text box with the
name you want to give the first image in the navigation bar.

4. Click the plus-sign button above the Nav Bar Elements box. This
moves the named element into the list of elements.

5. Click the Up Image text box and click the Browse button to select
the image you want to appear when there’s no mouse pointer hover-
ing over the first element of the navigation bar.

6. Click in the When Clicked Go to URL text box and type the URL of
(or browse to) the page that should appear when the first element in
the navigation bar is clicked.
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7. Choose the direction that the navigation bar should run:
Horizontally (the default) or Vertically. You can also leave the Use
"Tables option clicked at the bottom of the dialog box so that the bar
is placed in a table.

8. Repeat Steps 3 through 7 for each element in the navigation bar.
9. Click OK to create the bar (see Figure 206-2).

Who We Are

We've been m bunmess mnce
1992, promdng traseng, consultng,
technzcal documentation, and mmce

1997, web denign and hostng

Who We Are

Web Services

Publications

Instruction

Figure 206-2: A navigation bar blending in with the rest of the page and running
vertically, creating a graphical table of contents along the left side of the page

Task 206
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Creating Tables

Tables are one of the most powerful tools available to a Web designer. They
enable you to structure your pages with considerable precision — placing text
and graphics side by side, controlling the space taken up by text or graphics, and
creating navigation bars and product listings. Their uses are nearly unlimited.
Dreamweaver makes it easy to build them. (As you discover in Task 208,
Dreamweaver also makes it easy to change and customize them after

they’re built.)

1. In Design view click to position your cursor, placing it where the
table should start. This can be on a page, inside a frame, within a
layer, or inside an existing table.

2. Click the Insert Table button on the common toolbar to open the
Insert Table dialog box (see Figure 207-1).

Figure 207-1: Defining the table you want to create in Dreamweaver

Enter the number of rows you want in your table.
Enter the number of columns you want in your table.

Enter any cell padding or cell spacing you think your table needs.

e o e

Enter the width of the table — a percentage of the page width or an
exact pixel width. (The default is 75 percent of the page.)

7. If you want a border on your table, click in the Border cell and enter
the pixel width of that border.

8. Click OK to create the table. A new empty table appears (see
Figure 207-2).
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Figure 207-2: Table as a grid that can house any text or graphics you want to place
within its cells



- Part 15
Task 208 Modifying an Existing Table

You can easily resize tables, change the background color, and adjust cell
padding and spacing. You can also nest a table inside another one for further

structural control over the placement of text, graphics, and graphical use of col-
ored backgrounds and borders.

1. To access tools for changing the appearance and placement of your
table, point to any edge of the table. When your mouse turns into a
four-headed arrow (see Figure 208-1), click it.

Four-headed arrow

CE
:

4 HNEu00EE0880

Figure 208-1: The mouse pointer as a four-headed arrow to indicate that table editing
is possible

2. In the Properties inspector, change the number of cells in your table
by changing values in the Rows and Cols fields.

3. Alter the W (width) and H (height) fields to change the size of the
table itself.
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4. Use the array of six buttons (see Figure 208-2) to make changes to
the table’s size and relationship to the page — using the first two but-
tons, you can clear the row heights and column widths to size the
table to its contents, ignoring any previously-set dimensions.

Convert Table Width to Percent
Clear Row Heights
Clear Column Widths

Convert Table Width to Pixels

Convert Table Height to Pixels

Convert Table Height to Percent

Figure 208-2: Tidying your table’s dimensions to eliminate wasted space

5. Adjust the CellPad and CellSpace settings (entered in pixels).

6. Choose a new background color (Bg Color) for the table or apply a
background image (Bg Image) to the table.

7. Apply a border (set the pixel depth in the Border field) and choose a
color (Brdr Color).

8. Align your table relative to the page using the Align list box. Your
choices are Left, Center, or Right, or Default.
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Task 209 Creating Forms

orms allow visitors to interact with your Web page through form objects: text

boxes, drop lists, radio buttons, and check boxes. Using these form objects,
you can gather information for an online database. Creating a form requires first
inserting one and then populating it with form objects. You can use a table to
control form object placement as long as the table is within the form itself.

1. To insert a form on your page, click in Design view to place your cur-
sor where the form should appear. Select Insert = Form to open a

box with a red dashed border.
2. As desired, insert a table into the form box.

3. Begin populating the form with form objects. To insert a form object,
choose Insert = Form Objects.

4. Continue adding objects to your form. For each one, use the
Properties inspector to establish the object’s settings. Figure 209-1
shows the Properties inspector options for a List/Menu.

Choose number of values visible at one time
Allows visitors to make multiple selections

Choose default List Value List Values
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Figure 209-1: Customize individual form objects to help visitors make appropriate
selections in a form.

5. When you complete the form, click its border to select the entire
form. The Properties inspector changes to offer tools for establishing
how the form itself works (see Figure 209-2).

Figure 209-2: Add code to run the form with which visitors interact.
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6. In the Properties inspector, click the folder icon at the end of the
Action text box to establish a pathname for the form processing
script.

7. Choose POST or GET as the method for your form.

8. Establish the target method for your form: _blank, _self, _parent,
or _top.

9. Choose an Enctype setting.
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Task 210 Working with Frames

ames aren’t always popular with Web designers or the Web-surfing public
for a variety of reasons. However, frames do present a flexible structural envi-
ronment for building a Web page (a fiumeser when a group of frames are built
inside it) and they do give the designer some interesting tools for displaying
several Web pages within one visual field.

1. To create a frameset, choose File & New. In the New Document dia-
log box click Framesets in the Category list (see Figure 210-1).

Figure 210-1: The Framesets list providing several arrangement options

2. To see what each of the listed framesets looks like in terms of the
frames it creates, click on each one and observe the result in the
Preview area.

3. Click Create after you find a frameset that appears to provide the
arrangement you need for your page. A new page appears, with
frames in place (see Figure 210-2).

4. Use the Properties inspector to set your border preferences.
5. Populate your individual frames by clicking in the desired frame.

6. To set preferences for individual frames (to accommodate the con-
tent), press the Alt key and click inside the frame. The Properties
inspector changes (see Figure 210-3).

7. If your frame contains another Web page, enter the URL in the Src
box. You can click the folder icon to browse to the file as well.

8. Choose whether or not your frame has a scroll bar and whether or
not visitors can resize the frame. Continue setting up the remaining
frames (see Figure 210-4).




Working with Dreamweaver -

Frame border

Walls indicate individual frames “Untitled Frameset” in title bar
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Figure 210-2: Frameset settings in the Properties inspector

) Toggle scrollbar on or off
Create internal

margins Src box No Resize Turn borders on or off
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Figure 210-4: A frameset filled with original content (left) and links to other sites (right
and bottom) that the browser fills within the frame borders

Task 210
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Task 11 Working with Layers

Unlike frames and tables, layers float above a Web page; they’re not a fixed
part of the page. Unless you fill a layer with a background color or image,
you can see through them. You can put anything you want in a layer, however:
text, graphics, tables, and multimedia. Some older browsers (prior to version 4.0)
don’t display layers, so use them with care. Only put information in layers if you
know your visitors use current versions of Internet Explorer, Netscape, and other
browsers.

1. To start the process of creating a layer, click in Design view where
you want the upper-left corner of the layer to be.

2. Choose Insert = Layer. A layer appears on the page (see Figure 211-1).
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Figure 211-1: Inserting a layer in one step

3. With the layer selected, observe the Properties inspector (see Figure
211-2), which you can use to customize the layer’s appearance and
placement.
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Figure 211-2: Selecting a layer displays the Properties inspector and its layer-related
tools

If you don’t like your layer’ size and position, adjust them using the
L (Left), T (Top), W (width), and H (height) fields.

If you have more than one layer occupying any portion of the same
space on the page, adjust the z-index (the layer’s stacking order) for
the active layer.

Choose a Vis (visibility) setting: Default, Inherit, Visible, or Hidden.

Set any background (Bg) treatments (images or colors) for the layer.
Without any background color or image set, the layer is transparent.

Use the Tag field to choose the HI'ML tag that defines the active
layer (DIV is the default).

Choose how you want content that overflows the layer’s dimensions
to appear. Your choices in the Overflow field are Visible, Hidden,
Scroll, and Auto.

After establishing these settings for your layer, fill it with text,
graphics, tables, even other layers (called nested layers). Figure 211-3
shows a layer with text and graphics, and a scroll bar to let the visitor
read it all.

[The text and graphec are
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Figure 211-3: Layers give you design freedom, but with potential drawbacks in older
browsers
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Task 12 Creating Style Sheets

Cascading Style Sheets allow you to bundle several formats into one easily
applied tool. Viewed and created through the CSS Styles palette, you can
create them for sitewide or single-document use. Build them based on existing
content’s formatting or from scratch.

1. In the Design panel, click the CSS Styles tab. If the Design panel is
not visible, choose Window = CSS Styles to display the panel.

2. Click the New CSS Style button (the document icon with the plus
sign) at the bottom of the Design panel (see Figure 212-1).

— Attach Style Sheet
— New CSS Style
— Edit Style Sheet
— Delete Style Sheet

Figure 212-1: The CSS Styles tab in the Design panel

3. In the New CSS Style dialog box, use the Name box to name your
new style sheet.

4. Accept the default Make Custom Style setting in the Type area.

5. Determine the Define In location — typically, the same as the style
name (entered in the Name box), with the .css extension.

6. Click OK to open the Save Style Sheet File As dialog box (see
Figure 212-2).
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Figure 212-2: Saving your style sheet in your site folder
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7. Click Save to save the CSS file.

8. In the CSS Style Definition dialog box (see Figure 212-3), establish
the formatting that the style sheet applies.

942
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Figure 212-3: Defining your Cascading Style Sheet in one or more categories

9. When your style sheet formats are established, click the OK button
to close the CSS Style Definition dialog box.

10. To use your style sheet, select content in the Web page and then click
the CSS name in the CSS Styles tab on the Design panel. Figure
212-4 shows a CSS applied to text in a Web page.

Font color and size applied by CSS Design panel
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Figure 212-4: Formatting applied easily with a CSS in the Design panel
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Task 13 Using Behaviors

y generating JavaScript code in HTML documents, Dreamweaver behaviors

allow you to create ways for visitors to interact with your Web page. Typical
uses include something that happens when a mouse pointer hovers over or clicks
on a graphic, providing more options for interactive outcomes than a simple
rollover or Flash button does.

1. To access the Behaviors tab, activate the Design panel. If the panel is
not visible, choose Windows => Behaviors to display it. Select the
Behaviors tab (see Figure 213-1).

Figure 213-1: The Behaviors tab in the Design panel

2. In your Web page select the graphic or other component that you
want to associate with the behavior.

3. Click the plus-sign button in the Behaviors tab to display a list of
behaviors you can associate with the selected page element (see
Figure 213-2).

4. Depending on the behavior you choOse, you may have to select a
file — an image to swap, a sound to play, and so on.

5. Click OK to confirm that the sound, image, or other file is associated
with the event.

6. Back in the Behaviors tab, click the drop triangle on the behavior
you’ve added. It lists the events that can trigger the selected behavior
(see Figure 213-3).

7. To add to or reduce the list of events to match the browsers your visi-
tors are most likely to use, choose Show Events For from the events
list and make a selection from the submenu.

8. Repeat Steps 2 through 7 for any elements in your page you’d like to
make more interactive for visitors.
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Figure 213-2: Choosing the behavior you want to occur

Figure 213-3: Choosing a way for visitors to interact with the Web page
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Task 21A‘ Using the Preload Images Behavior

he Preload Images behavior loads images into the visitor’s browser cache.

Once the images are loaded, the browser loads the rest of the page and the
entire document appears at once. This provides a more uniform experience
for the visitor, so they don’t have to watch the site construct itself in front of
their eyes.

1. Attach the Preload Images behavior to the body section of your doc-
ument by selecting the <body> tag on the tag selector in the lower-
left corner of the document window (see Figure 214-1).

Figure 214-1: Selecting the <body> tag in the document window’s tag selector

2. Open the Behaviors panel by selecting Windows = Behaviors from
the menu bar.

3. Click the Behaviors panel’s plus button and choose Show Events
For = 4.0 and Later Browsers.

4. Click the Behaviors panel’s plus button a second time and choose
Actions = Preload Images. This opens the Preload Images dialog box
(see Figure 214-2).

Figure 214-2: The Preload Images dialog box
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5. Click Browse to locate an image file to preload or else enter Task 1A
an image’s pathname in the Image Source File field.

6. Click the plus button at the top of the dialog box to add the image
from the Image Source File field to the Preload Images list. This
clears the Image Source File field so you can select another image.

7. Repeat Steps 5 and 6 for each image you want to preload for this
document.

8. 'To remove an image from the Preload Images list, select the image in
the list and click the minus button.

9. When you've selected all the images you want to preload, click OK
to close the dialog box.
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Task 15 Using the Open Browser
Window Behavior

he Open Browser Window behavior opens a pop-up browser window that

goes to a URL you specify. You can specify all sorts of properties for this
window, such as dimensions, window name, resizability, and appearance of
menus, tools, and scroll bars, and so on.

1. Select the element to which you want to attach a pop-up window.

2. Open the Behaviors panel by choosing Windows = Behaviors from
the main menu bar.

3. Click the Behaviors panel’s plus button and choose Show Events For
> 4.0 and Later Browsers.

4. Click the plus button again and choose Open Browser Window from
the submenu. This opens the Open Browser Window dialog box
(see Figure 215-1).

Figure 215-1: The Open Browser Window dialog box

5. Click the Browse button to locate the file you want opened in the
new window.

6. Use the Window Width and Window Height fields to set the dimen-

sions for the new window.

7. Setany of the following options by marking the corresponding
check box:

* Navigation Toolbar: The row of standard browser buttons
(Back, Forward, Home, etc.)

e Location Toolbar: The window’s address field

* Status Bar: The window’s status bar, where messages like
remaining load times and link URLSs appear
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¢ Menu Bar: The standard menu bar (File, Edit, View, Go, etc). Task 15

* Scrollbars as Needed: Scroll bars, which appear if content
extends beyond the viewable area

* Resize Handles: Window that users can resize either by drag-
ging the lower right corner of the window or by clicking the
maximize button (Windows) or size box (Macintosh) in the upper
right corner

*  Window Name: Name of the new window object, which allows
you to target it with links or manipulate it with JavaScript

8. Click OK to close the Open Browser Window dialog box.

9. Choose the event handler you want to trigger the behavior.
Figure 215-2 shows a pop-up window triggered by a hyperlink.
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Figure 215-2: A simple pop-up window (right) triggered by clicking on a link (top left)
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Task 16 Using the Validate Form Behavior

he Validate Form behavior makes sure your visitors have entered the right

kind of data into specified text fields. If the visitor enters any bad data (data
of the wrong type for a field’s specifications), the JavaScript in this behavior pre-
vents the form from being submitted to the server.

1. Attach the Validate Form behavior to the <form> tag of your docu-
ment by selecting it with the tag selector in the lower left corner of
the document window (see Figure 216-1).
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Figure 216-1: Selecting the <form> tag in the document window

2. Open the Behaviors panel by choosing Window = Behaviors from
the menu bar.

3. Click the Behaviors panel’s plus button and choose Show Events
For => 4.0 and Later Browsers.

4. Click the Behaviors panel’s plus button again and choose Validate
Form from the submenu. This opens the Validate Form dialog box
(see Figure 216-2). Each text field in the form appears in the Named
Fields list box.
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Figure 216-2: The Validate Form dialog box, showing all fields in the form

5. Select a text field from the Named Fields list.
6. Click the Required check box if the field must be filled in by the

visitor.

7. Choose one of the following Accept options:

* Anything: For a required field accepting basic text content, like
names or street addresses

* E-mail Address: To check that the field contains the @ symbol
*  Number: To check that the field contains only numbers

*  Number From: To check that the field contains a number in a
specific range, which you enter in the fields to the right

8. Repeat Steps 5 through 7 for each field you validate.
9. Click OK to close the Validate Form dialog box.



- Part 15

Task 17 Using the Set Text for Status Bar
Behavior

very browser has a status bar. It typically runs along the bottom of the

browser window and displays what the browser is currently doing. For
example, when you run your mouse over a link, the URL the link points to
appears. When you click a link, the status of the download appears too —
typically the phrase, “Downloading http://...”. The Set Text of Status Bar
behavior writes a message to the status bar in response to some action taken by
the site visitor.

1. Select the element you want the to trigger the status bar message.

2. Open the Behaviors panel by choosing Windows = Behaviors from
the menu bar.

3. Click the Behaviors panel’s plus button and choose Show Events
For = 4.0 and Later Browsers (see Figure 217-1).

Figure 217-1: The Show Events For submenu

4. Click the plus button again and choose Set Text = Set Text of Status
Bar from the submenu. This opens the Set Text for Status Bar dialog
box (see Figure 217-2).

Figure 217-2: The Set Text for Status Bar dialog box
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5. "Type your message in the Message field.
6. Click OK to close the Set Text for Status Bar dialog box.
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7. Choose the event handler you want to trigger the behavior.
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Task 18 Working with Assets

he Assets panel provides a list of the weapons in your Web design arsenal —

images, colors, sounds, movies, URLs, templates — that you can use in Web
pages. Any of these items you add to pages are automatically added to your Assets
list. You can also add items from the Assets panel or Favorites folder to your Web
page quickly and easily — it’s just a matter of drag and drop.

1. Before you can use your Assets, you have to display them. Choose
Window => Assets, or click the Assets tab in the Files panel.

2. For a page that already has some images and other elements inserted,
the Assets panel will already have some items in it you can use. To
view them for each of the categories (see Figure 218-1), click the but-
tons on the right side of the tab.
Add to Favorites
Refresh list of Assets

Assets panel  Shows assets for entire site
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Figure 218-1: Assets stored in nine categories (right side)

3. To use an asset, click the category it belongs in and drag it from the
Assets panel onto the page (see Figure 218-2).

4. To move an asset to the Favorites folder, simply click on it and click
the Add to Favorites button in the lower right corner of the Assets
panel. Figure 218-3 shows the current Favorites folder for a particu-
lar site.
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Figure 218-2: Reusing an image from the Assets panel by dragging it onto the page

Create a folder Edit Favorites Remove from Favorites
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Figure 218-3: Your most-used images, colors, and other page elements in the Favorites
folder for easy access

5. To take an asset out of the Favorites folder, select it and then click
the Remove From Favorites button.
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Task 19 Setting Up a Remote Host

1.

Eal

hen it’s finally time to upload your site to a Web server, you need to pre-
pare for it first. After you tell Dreamweaver how you will connect to your

Web server, you establish login and security settings for the connection.

Choose Site = Edit Sites. The Site Definition dialog box (Basic tab)
appears (see Figure 219-1). If you already see the Advanced tab, go
to Step 2.

Figure 219-1: Setting up the site’s definition

Click the Advanced tab in the Site Definition dialog box and select
the Remote Info category. The Web server information appears on
the right (see Figure 219-2).

Choose your access method.

In the FTP Host box, type the physical location of your FTP server —
an IP address or something like ftp.domzain.com.

If there’s a particular directory within the FTP server you need to
connect to, enter it in the Host Directory box.
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10.

Figure 219-2: Establishing Web server settings

Type your login name — typically a user ID or username — and
enter your password.

Check any of the three additional options — Use Passive FTP, Use
Firewall, or Use SSH Encrypted Secure Login.

If you want your edited files to be automatically uploaded whenever
you save them, click the Automatically Upload Files to Server on
Save option.

If you work in a group and want to make sure two people can’t work
on the same file at the same time, click the Enable File Check In and
Check Out option.

Click OK to save your remote server settings.
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Task 220 Downloading and Uploading Files

Once you set up a remote folder, you’re ready to upload your files to the Web
server. You can also move files in the other direction, from the Web server to
your local drive — either to back up what’s on the server or to replace local files
with what’s stored remotely on the server. Uploading and downloading are
referred to, respectively, as put and gez.

1. Before using Get or Put, you must activate the Files panel and click
the Site tab. To display the Files panel, choose Window = Site.

2. To put your files on the remote server (or into a local or network
folder), click the right-most drop list (to the right of the Site drop
list) and choose Local View (if it’s not selected already). Then select
the folder/s or file/s you want to upload (see Figure 220-1)
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Figure 220-1: Selected files in a folder for uploading

3. Click the Put button (with the blue upward arrow), and then choose
Remote View from the right-hand drop-down list.

4. Click the Refresh button to see your remote server or local/network
file and the uploaded files there (see Figure 220-2).
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Figure 220-2: Viewing files on the remote server

5. To get, or download, files from a remote server or another local/
network folder, select the content you want to download.

6. Click the Get button (with the green downward arrow).

7. When your Get/Put session is complete, click the Disconnect from
Remote Host button.
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Task 9'QX Using Check In/Check Out

hen two or more people edit pages in a particular site, it makes sense to use

Dreamweaver’s Check In and Check Out feature. Much like taking books
out of a library, the Check In and Check Out system ensures that if one person
checks out a file, no one else can work on it at the same time (they can view it,
however). Check In and Check Out makes the process of multiple designers
uploading files to the Web server more orderly.

1. To use Check In and Check Out, first turn Check In and Check Out
on. Select Site = Edit Sites.

2. The Edit Sites dialog box opens (see Figure 221-1). Select the site
you want to edit.

Figure 221-1: Choosing the site to control with Check In and Check Out

3. Double-click the site you want to edit, or select it and click the Edit
button.

4. In the Site Definition dialog box, click the Advanced tab if it isn’t
already selected.

5. Click the Remote Info category (see Figure 221-2).

6. Next to Check In/Out, click both the Enable File Check In and
Check Out option and the Check Out Files When Opening option.

7. 'Type your name in the Check Out Name text box and also enter an
e-mail address in the Email Address text box. Click OK to close the
dialog box.
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Figure 221-2: Accessing advanced settings in the Site Definition dialog box

8. To use Check In and Check Out, go to the Site tab of the Files panel
and select the file(s) you wish to edit or upload (put) to the Web

SErver.

9. Click the Check Out Files button (the green downward arrow with
the check mark). Depending on your situation make your selection in
the Dependent Files dialog box.

10. When you finish editing the file, select it in the site list and click the
Check In button (the blue upward arrow with the padlock next to it).
Again, depending on your situation, make your selection in the
Dependent Files dialog box.
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Setting Up a Web Site

Microsoft FrontPage is a Web design tool that uses a WYSIWYG interface to
allow you to design your pages and sites graphically. You can also get a good
look at the code, too, and preview your work in a browser window to check your
progress as you design. FrontPage is famous for its themes, the preset styles that
control the buttons, background, and overall look of sites designed with the prod-
uct. This speeds and simplifies the design process, but also creates sites that are
immediately identified as “FrontPage sites,” which isn’t usually a good thing. You
can also design from scratch, avoiding the potential pitfalls of a site with graphics
that thousands of other FrontPage designers will have also used. When beginning
the design process in FrontPage, it’s best to set up a site, and to do so following a
set of prescribed steps. It’s also important to realize that a Web site is more than a
collection of pages. It’s a cohesive, logical structure that incorporates pages,
graphics, and links into a functioning system. The need to build a functioning
Web site locally is key to uploading the site to a remote server and having all the
pages and their components appear and function properly.

1. With FrontPage launched, choose File = New. This opens the New
task pane (see Figure 222-1).

|i . v« Figure 222-1: The New task pane gives you
options for starting a new page or site.
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2. Click the More Web Site Templates link in the middle of the task
pane to access the Web Site Templates dialog box.

3. Double-click the Empty Web Site icon to create a new site (see
Figure 222-2).
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Figure 222-2: View a list of existing sites (if any) and your new site’s starting folder
structure, which includes an images folder.

4. Click the Navigation button at the bottom of the window to access
tools for a hierarchical view of the pages in your site. Figure 222-3
shows the resulting view and tools.

New page button

Figure 222-3: Click the New Page button to add your first (and subsequent) page.
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Task 23 Creating and Rearranging
Blank Web Pages

fter creating a blank Web site, you’re ready to insert pages — starting with

the home page and creating a tiered, hierarchical structure of subpages that
branch off of it. Using the Navigation view of your new site, it’s easy to insert
pages and access additional site-building tools.

1. In Navigation view, click the New Page button. If this creates your
home page, click on the Home Page icon that appears (shown in
Figure 223-1).
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Figure 223-1: The Home Page is the first page you create and also the top-most page
of the site.

2. With the Home Page icon selected, indicating that the next page
should be a subpage to it, click the New Page button again. A
subpage icon appears (see Figure 223-2).

3. To create a third level of pages, click one of the existing subpage
icons and then click the New Page button. A third tier appears, along
with an icon for its first page.

4. To rearrange pages and tiers of pages, simply drag them with your
mouse. You may find yourself wanting to rearrange them for any
number of reasons — to establish the connections between pages that
FrontPage will later use to create navigation tools based on your page
hierarchy, or to help you view your site more logmally, grouping your
pages logically. Whatever your reason for rearranging your existing
pages, you can drag them within the same tier or between tiers (see
Figure 223-3).
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Figure 223-3: Dragging a page to change its location within the site hierarchy
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Task 22A‘ Naming and Saving Pages

1.

fter adding pages to a blank Web site and rearranging them to meet your

needs, you should name and save the pages. In so doing, you’re determining
the page names that appear on any page banners, in the page title bars when the
pages are viewed through a browser, and the page names that you’ll refer to as
you edit the site over time. Choose names that make it clear what the page does.
Don’t limit yourself to using all lowercase letters, underscores in lieu of spaces
(“about_us”) , or abbreviated names (“page3a”). Pick names that make it easy for
you to select the right file when it comes time to edit it later.

In Navigation view, click once on the page you want to name and
save. The selected page in Navigation view is highlighted, and its
name appears in a white box (see Figure 224-1).

Figure 224-1: The generic name applied when a page is created (such as “Top Page
17”) is easily replaced later

Right-click the page icon and choose Rename from the menu that
appears (see Figure 224-2). The name you give the page will appear
in the navigation view of the site, as well as on the page title bar
when viewed through a browser.

Once you select Rename, the existing (generic) name is highlighted,
which you can type over. The name you type here will also appear in
any page banner, so feel free to use spaces, proper capitalization, and
so forth (see Figure 224-3).

Continue to name the rest of your pages, at least those whose func-
tion you're sure about.

"To save your pages with useful filenames, double-click the page icon
to see the Page view of the page and then choose File => Save As.
The Save As dialog box appears (see Figure 224-4).
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Figure 224-2: The shortcut menu offers a series of page-specific commands, including
Rename.

Figure 224-4: Save your page with a relevant, Web server-friendly name.

6. ‘Type a name for your file in the File Name field and be sure to add
the extension, especially if you have a preference for .htm versus
html.

7. Click Save to confirm the name, and repeat Steps 5 and 6 for the rest
of your pages that you want to save.
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Task 25 Viewing and Changing Page Properties

At any point in the process of building a Web site it’s good to view the proper-
ties of your pages — the page title, the background image, link colors, and so
on — so you can make changes before you get too far in the design process.

1. In Navigation view, double-click the page whose properties you want
to view and potentially change. This takes you to the Page view.

2. Choose Format = Properties. This opens the Page Properties dialog
box (see Figure 225-1).

Figure 225-1: Six tabs of page property options in the Page Properties dialog box

3. On the General tab type a title for your page, as desired. Keep the
title short, but clear. Remember that it will appear on a visitor’s title
bar, and there may be other text on that bar — their brower name, for
example, which may truncate longer titles.

4. On the Formatting tab designate a background image for the page.
When you click the Background Picture option, you can use the
Browse button to select a graphic to serve as a background.
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5. Still on the Formatting tab, choose a background color for your page.
You can click the color drop list (set to Automatic by default) to view
a palette of Web-safe colors (see Figure 225-2).
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Figure 225-2: A group of 16 basic, Web-safe colors in the color palette

6. You can also set text and hyperlink colors from the same Web-safe
color palette. Why change the defaults for text and hyperlinks? For
text, you may want to use a color that’s more visible or legible on
your chosen background color. For hyperlinks, you may want your
link text to stand out on your background or to not clash with other
colors in your page. It’s generally an aesthetic decision, and/or one

based on legibility.

7. Repeat Steps 1 through 6 for any other pages in your site that you
want to customize. Revert to Navigation view to access another page
using the View menu.
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Task 26 Applying Themes

esides applying individual background images and colors, text colors, and
link colors to individual pages in your site, you can apply a theme so that all
your pages look the same — only the page content will vary.

1. In either Navigation or Page view, choose Format & Theme. This
opens the Theme task pane (see Figure 226-1).

". v x| Figure 226-1: Choosing a theme by viewing its
thumbnail image
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2. Scroll through the themes. If you (or anyone else who uses your
computer) have created a page or site before, the most recently used
themes will appear first, followed by those that were installed with
FrontPage. If you’ve never used the application before, the Theme
task pane will start with the installed themes.

3. When you find a theme you want to apply to your site, point to the
thumbnail for that theme with your mouse and make a selection from
the pop-up menu (see Figure 226-2).

4. Choose Apply As Default Theme from the menu.
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Figure 226-2: Options for applying a theme

5. To see your selected theme on individual pages, work in Page view
and see the background image in place (see Figure 226-3).

Figure 226-3: The Cypress theme applies a subtle green pattern to the page
background.
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Task 27 Creating a New Theme

ontPage offers a seemingly endless series of themes (visible in the task pane).
You might think there are enough to fit most Web sites. Problem is, most
FrontPage designers like working with a small selection of them, which makes
many Web sites shout “Made with FrontPage!” when you visit them because of
their familiar background, navigation bar, page banner, and so on. To break away
from the crowd and make your pages look more unique, create your own theme.

1. Choose Format = Theme to open the Theme task pane. At the bot-
tom of the task pane click Create a New Theme to open the
Customize Theme window (see Figure 227-1).

Figure 227-1: The Customize Theme dialog box lets you build a new theme from
scratch, piece by piece

2. Using the three buttons under the question, “What would you like to
modify?”, choose Colors, Graphics, and Text settings for your cus-
tom theme.

3. When you click the Colors button, the Color Scheme, Color Wheel,
and Custom tabs appear at the top of the dialog box (see Figure 227-2).
Pick a grouping of complementary colors that work well together.

Heading 1 Style
Heading 2 Style

Figure 227-2: Picking from swatches that show sets of five complementary colors, most
including black and/or white
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4. If none of the groups of colors appeals to you, click the Color Wheel

tab and view the color wheel (see Figure 227-3). Drag your mouse
around the color wheel and watch the displayed scheme change to
reflect the complementary and opposite colors for the spot on the

wheel your mouse points to. Drag the Brightness slider as desired to

make these colors lighter or darker.
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Figure 227-3: Using the Color Wheel to develop your own group of complementary

colors

5. To set up your page colors one at a time, go to the Custom tab and
select an item. With that item selected, choose a color. Continue
selecting items until you’ve applied a color to each one that your
page might contain.

6. Click OK to apply your color changes. This returns you to the origi-

nal Customize Theme dialog box where you can use the Graphics

and Text buttons to customize the remaining aspects of your theme.

7. Click the Graphics button to display a series of options for applying

graphics to different page elements. Select an item from the field at

the top of the window and click the Browse button to find an image

to use for the selected Item.

8. After clicking OK to return to the Customize Theme dialog box,
click the Text button to open a version of the window that offers

fonts for each page element (see Item list again) that could be in text

form — body text, headings, and so forth.

9. Click OK to apply your text changes and return once again to the
original Customize Theme dialog box.

10. Click the Save button to give your new theme a name in the Save
Theme dialog box. Click OK to confirm it.
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Task 28 Creating and Using Templates

To add to the pool of web page templates that can be applied to individual new
pages (when you use the File &> New command and resulting New task pane),
you can save an existing Web page as a template. This allows you to reuse a
page’s properties — background colors and images, text colors, fonts, even graph-
ics and text — in subsequent pages you create for the site. Templates help speed
the development process by providing ready-made pages with the basics already
in place, and unlike Themes, include page content — text, images, information,
anything you choose to have on the page when you save it as a template.

1. After you've designed a page containing the elements — text, graph-
ics, and formatting — you want to save for later use, choose File &>
Save As.

2. In the Save As dialog box, click the Save As Type drop-down list and
choose FrontPage Template (*.tem) from the list (see Figure 228-1).

Figure 228-1: Saving a page as a FrontPage template
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3. Pick a template name that describes its purpose or design. Enter it in Task 8
the File Name text box.

4. Click Save to complete the process.

5. The Save As Template dialog box appears (see Figure 228-2). Enter
the requested information — page title, page name, and if desired, a
description.

Figure 228-2: A little more information is required before your template is saved and
ready for use

6. The Save Embedded Files dialog box appears, listing any files used in
the page you just saved. Click OK to confirm.

7. To use a template, choose File &> New and click More Page
Templates in the New task pane. In the Page Templates dialog box,
double-click the icon of the template you just made to create a new
page based on that template.
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Task 29 Inserting and Formatting Text

Text is the backbone of any Web page. It shares information, provides instruc-
tions, and compels the reader to take some action or purchase something.
FrontPage makes it easy to type text onto a page and format it for maximum
effectiveness.

1. In Page view click to position your cursor.
2. Iype your text.

3. Ifyou have existing text from another application — such as
Microsoft Word or a text editor — copy it to the Clipboard and then
choose Edit = Paste in FrontPage to paste it into your page.

4. Before you format any text, select the text you want to format.

5. Use the Formatting toolbar (shown in Figure 229-1) to apply a dif-
ferent font, font size, or to apply bold, italic, or underline styles to
the text.

Figure 229-1: If you're familiar with Microsoft Word, you'll recognize the formatting tools
in FrontPage immediately

6. If your text is a heading, use the Style drop-down list to apply the
appropriate level of heading to the text (see Figure 229-2) so it
stands out.




Working with FrontPage

1 s
Figure 229-2: Applying heading styles to text

If you need to rearrange your text, use the “drag and drop” method:
Select the text with your mouse and then drag it to another location
on the same page. (This mimics the same feature in Microsoft Word.)
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Proofing and Improving Web Page Text

It’s bad enough to find a spelling error or typo in a printed document that every-
one knows you wrote. It’s worse when a mistake appears in something the
entire world can see. Proof your pages before you publish them on the Web!
With FrontPage you can spell-check your pages for text errors and use a the-
saurus to help you select the best word (le mot juste, as they say in literary circles)
when you’re in doubt. Use the thesaurus to find substitutes for overused words
too (such as “nice” or “effective”) or to help define them for you.

1. In Page view choose Tools = Spelling to open the Spelling dialog
box (see Figure 230-1).

Figure 230-1: Viewing the words that FrontPage finds on your page that don’t match
the internal main or custom dictionaries

2. For each word that FrontPage cannot match with either the main or
custom dictionary, check out the list in the Suggestions box. The top-
most one appears in the Change To field.

3. Decide how to handle things. If it’s a name or some terminology you
know is spelled correctly, click the Add button. If you want to pick
one of the suggestions, select it and click the Change button. If you
know the word is correct but you don’t want to add it to the custom
dictionary, click Ignore or Ignore All (for times when the word
appears more than once).
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4. Asyou resolve each spelling error, the next one appears in the Not Task 30
in Dictionary field. Repeat Steps 2 and 3 for each error that
FrontPage finds.

5. To find the best word to substitute for an overused or undesirable
word on your page, or to define a word you’re not sure of, select the
word in question (it must be typed already in the Web page) and
choose Tools &> Thesaurus to open the Thesaurus dialog box (see
Figure 230-2).

Figure 230-2: Looking up a word to make sure you're using it correctly or finding an
alternative to overused words, such as “efficient”

6. If there is more than one meaning for the word — perhaps it’s a noun
or adjective — choose the role the word plays in the context of your
page and view the list of synonyms in the Replace with Synonym list.

7. Select a new word and click Replace. If you’re in the dialog box just
to check a word’s meaning by viewing it’s synonyms, you can click
Cancel now to close the Thesaurus. If you’re in the dialog box to find
an alternative word, select one.
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Task 231 Inserting Clip Art and Pictures

ictures impart meaning and information more efficiently than words — when

they’re used well. FrontPage makes it easy to convey a message or provide
instructions through graphics, saving the designer a lot of typing (and the visitor
a lot of reading) through the use of photographs and clip-art images.

1. In Page view click your cursor where you want the image to appear.

2. Choose Insert = Picture to open the submenu (see Figure 231-1).

Figure 231-1: Inserting stored photos, clip art, or scanned and digitally-captured
images

3. To insert a piece of Microsoft Office clip art, choose Clip Art to open
the Clip Art task pane (see Figure 231-2).

4. Type a keyword (or more than one) in the Search For text box and
click Go.

5. When you find the image you want to use, right-click it and choose
Insert from the shortcut menu.
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Figure 231-2: Searching for clip art by keyword
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6. To insert a stored photo or other image, choose Insert = Picture and
then select From File in the submenu.

7. The Picture dialog box (see Figure 231-3) allows you to navigate to
the folder where your image is stored and select it from that location.
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Figure 231-3: Picking the picture you want to insert into your Web page
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Task 232 Adding Alternative Text to Images

SO—called “alternative text” helps people whose browsers don’t show graphics
or load them slowly. Words appear instead of graphics; they also pop up
when you mouse over an image that does appear. You can make this text instruc-
tive (“Click here to see our list of phone numbers”) or informative (“We had a
great time at our recent retreat in the Adirondacks!”). Whatever motivates you to
use alternative text, it gives you a chance to say more about your images and
other page content than the space on the page may allow.

1. In Page view, click on the graphic to which you’d like to apply alter-
native text. This selects the picture. Handles appear around it so you
know you selected the right image.

2. Right-click the image and choose Picture Properties from the
shortcut menu (see Figure 232-1).

Figure 232-1: Associating alternative text with the selected graphic

3. Click the General tab in the Picture Properties dialog box (see
Figure 232-2).

4. Move to the Text field in the Alternative Representations section
of the dialog box and click the Text check box. This turns on the
alternative text feature.

5. 'Type your alternative text in the Text field. Use proper spelling,
capitalization, and spacing.
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Figure 232-2: The Alternative Representations section allows you to type text to
describe a graphic within your Web page

6. Click OK to apply the text to the selected image.

7. Preview your page and test the alternative text. As you can see in
Figure 232-3, the text appears in a little pop-up box (much like the
tool tip or screen tip you see when pointing to buttons within a soft-
ware interface). It should appear as soon as you mouse over the
graphic that uses alternative text. If you test your pages in various
browsers, you may have different results — some browsers don’t
support Alt text, and others may display it differently than your
default browser.

We've besn helping schook make ends et by providing the most cost-eficent,
G- QUELY PIOOUCES ON th MaLEL. From pAncis 10 Pags 1o COPY machandd, wi
jorovice everytheng for education.

Figure 232-3: Verifying your alternative text by previewing the Web page in a browser
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Task 33 Drawing and Formatting
Shapes and Lines

Your graphical options don’t end with clip art and photos. FrontPage allows
you to draw shapes and lines using the Drawing toolbar found in all Microsoft
Office applications. Apply colored fills and outlines to your shapes and use vari-
ous options for creating dotted and dashed lines, with or without arrowheads.

1. Display the Drawing toolbar by right-clicking the currently displayed
toolbar and choosing Drawing from the submenu.

2. Using the Drawing toolbar, click the AutoShapes button and choose
a shape category (see Figure 233-1).

Figure 233-1: Choosing from five shape categories
3. From the shape category, such as Block Arrows, select a shape to
draw (see Figure 233-2).

4. Move your mouse to the spot where you want to draw and then click
and drag to draw the selected shape.
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Figure 233-2: From within a category,

choose the shape you want to draw Task 33

5. Change the fill color or outline color of your drawn shape using the
Fill Color and Line Color buttons on the Drawing toolbar.

6. To draw a line or arrow, click the Line or Arrow tool and draw a
straight line/arrow in any direction.

7. To change the style of the line or arrow, click the line or arrow you
drew (handles appear at both ends of the line/arrow), and use the
Line Style or Arrow Style buttons to choose a thickness, apply dots
and dashes, or choose from a variety of arrowheads. Figure 233-3
shows the Arrow Style option.

Figure 233-3: Customizing your arrow or line
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Task 23A‘ Adding Flash Content to Web Pages

oving pictures catch the eye and capture the attention of your site’s visitors.

"To add movies in the form of Macromedia Flash files, all you need to do is
insert the object and preview the page in a browser to see the movie play as it
would online. It couldn’t be easier.

1. In Page view click the Design button to make sure you’re in that
view.

2. Click to position your cursor where the Flash content should appear
on the page.

3. Choose Insert = Picture = Flash (see Figure 234-1).

Hayigation...

|| Paye Bapnes
"2 Web Componant..

Databste

Figure 234-1: Selecting the Flash command
4. Using the Select Flash File dialog box (see Figure 234-2), navigate to
the file you wish to insert.

5. When you find the file you want to insert, double-click it or select
the filename and click the Insert button.
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Figure 234-2: Look for the right SWF file to insert into your Web page

6. With the Flash object on your Web page, click the Preview button to
see the page in a browser window. View the Flash movie to make sure
it works properly (see Figure 234-3).

Figure 234-3: Watching the Flash movie run in a browser window through
Preview mode
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Task 35 Creating WordArt Images

Because FrontPage is part of the Microsoft Office suite, you get the benefit of
some of the features in other Office components, such as WordArt. Adding
WordArt on a Web page does add a lot of FrontPage-specific code to your other-
wise HTML, but for sites that are viewed primarily through Microsoft Internet
Explorer, the ability to easily create graphic text can be a creative, convenient
addition to your Web page.

1. In Page view, be sure your Drawing toolbar is displayed by choosing
View = Toolbars = Drawing.

2. Click to position your cursor where the WordArt will go.

3. Click the WordArt button on the Drawing toolbar. The WordArt
Gallery opens (see Figure 235-1).

lﬂmﬂl‘hd)ml‘-mlwarur-hl

Figure 235-1: Pick from 30 different WordArt styles

4. Double-click the style you want to work with, or select it and click
OK. The Edit WordArt Text dialog box opens (see Figure 235-2).
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Your Text Here

Figure 235-2: Replacing the sample text with your own
5. 'Type the text you want to render in the selected WordArt style. After
you type your text, click OK.

6. When your WordArt object appears on the page (see Figure 235-3),
drag it to reposition it or resize it by dragging its handles.

Figure 235-3: Using your mouse to position and resize your WordArt object
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Task 36 Adding Navigation Bars

Based on the theme you apply to your Web page (or the entire site), you can
add navigation bars to help visitors move through your site, navigate from
the home page to the subpages and back again. You can also add buttons and
other types of links for navigating to external pages or sites, but that’s covered in
the next task — for now, we’ll be creating navigation tools for moving around
within our own site.

1. In Page view of the home page, click to position your cursor where
you want the navigation bar to appear.

2. Choose Insert = Navigation to open the Insert Web Component
dialog box (see Figure 236-1).

Figure 236-1: A list of all Web components, from counters to search boxes

3. Ifit’s not already selected, choose Link Bars from the list of compo-
nent types.

4. On the right side of the dialog box click Bar Based on Navigation
Structure.

5. Click Next.

6. In the Choose a Bar Style version of the Insert Web Component
dialog box, click Next to confirm that the link bar you’re creating
should adhere to the current theme.

7. In the next box, click to choose either vertical or horizontal orienta-
tion for your link bar (see Figure 236-2).

8. Click Finish. The Link Bar Properties dialog box opens (see Figure
236-3), allowing you to choose which pages to include in the link bar
you’re creating.

9. Click OK to create the finished navigation bar (see Figure 236-4).
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Figure 236-2: Choosing the direction (up and down or across) that your link bar should
run on the page

Figure 236-3: Establishing your link
bar properties

Figure 236-4: A vertical strip of buttons, one for each page in the site, appears on the
home page.
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Inserting and Aligning Page Banners

Apage banner is really just a page title, and is normally the same text that
appears on a browser’s title bar while the page in question is displayed. The
graphic page banner is more visually dynamic than the title bar, however, and
people are more likely to notice it. While the term “banner” reminds people of
advertising banners — which, of course, you can also create with this feature, for
our purposes, you will simply insert a banner to inform visitors what the name
of the page is.

1. In Page view, click the Design button to make sure you can see the
entire Web page.

2. Click to place your cursor at the top of the page, on the left side.

3. Choose Insert o> Page Banner to open the Page Banner Properties
dialog box (see Figure 237-1).

Figure 237-1: Confirming your page banner properties

4. Choose whether the banner will be a picture or text, and type the text
that should appear in the banner itself.
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5. Click OK. The banner appears on the page (see Figure 237-2).

Figure 237-2: A picture banner across the top of the page

6. To change the alignment of your banner, click on the banner to select
it, and then use the Alignment buttons (Left, Center, or Right) on
the Formatting toolbar.

7. If you change your page theme, the page banner’s design will change,
too. "To see how various themes will affect your banner, choose
Format = Theme, and view the task pane. You can click on individual
themes and see how they’ll look on your page or pages.
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Task 38 Creating Interactive Buttons

he term “interactive” means that when your visitor performs an action, some-

thing happens. FrontPage allows you to insert interactive buttons that per-
form a number of tasks — from linking to another Web site to playing a song.
These buttons come in a variety of preset styles, and you can customize the text
that appears on the button face.

1. Working in Page view, click to position your cursor where you want
the new interactive button to appear.

2. Choose Insert = Interactive Button to open the Interactive Buttons
dialog box (see Figure 238-1).

Figure 238-1: Choose a button style and type your button face text

3. After the dialog box appears, scroll through the Buttons list and
choose the button you’d like to use. As you click on individual items
in the list, a preview appears at the top of the dialog box.

4. Type the text into the Text box that should appear on the button face.
The preview updates to show your text on the selected button.

5. To establish the file, page, or site to which the button links, click in
the Link box and type the path or URL, or click the Browse button
to locate the file, page, or site manually.

6. Click the Text tab in the Interactive Buttons dialog box (see Figure
238-2) to make any required adjustments to the font, size, and color
of the text in your button.

7. Click the Image tab (see Figure 238-3) to increase the button width
and height.

8. When your button’s appearance in the Preview box is as you want it,
click OK to create the button. Figure 238-4 shows a series of interac-
tive buttons.
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Figure 238-2: Changing the text
attributes of your interactive button

2] [ —] [ o—]
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Figure 238-3: Making your button bigger
or smaller

Figure 238-4: A group of similarly-styled interactive buttons to build a central
navigation area for your site
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Task 39 Changing Page Backgrounds and Colors

fter you apply a theme to a site or use a template that determines the colors

and backgrounds in your Web pages, you can still change your mind after the
fact. Either apply a new theme, which updates all your themed pages to the new
one, or reopen the Page Properties dialog box and make your desired changes.
Through the Page Properties dialog box, you can change your background
image, choose a solid color for your page background, and even set the color of
your text links.

1. Ifyou applied a theme and want to change it, choose Format =
Theme to open the Theme task pane (see Figure 239-1).

“. v« Figure 239-1: Viewing the current theme and selecting an
alternative one
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2. When you find the theme you want to use in place of the one that’s
already in use, right-click it and choose Apply As Default Theme
from the shortcut menu.

3. To change your manually-applied background image and text/link
colors on individual pages, where no theme was applied, go to the
first page you want to change and choose File => Properties to open
the Page Properties dialog box (see Figure 239-2).

Figure 239-2: Viewing your page’s background and color settings

4. On the Formatting tab, change your page’s background by choosing
a new or different background image, or by selecting a solid color for
the background.

5. Adjust text and link colors by making selections in the color fields on
the Formatting tab.

rask 939
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Task 2A-0 Creating Bulleted and Numbered Lists

Usm help arrange instructions, features, and ideas on the page. In HTML these
ists are referred to as ordered and unordered lists, but FrontPage refers to
them (as it does throughout Microsoft Office) as numbered and bulleted lists.

1. Switch to Page view of the desired page.
2. Click to position your cursor where the first line of the list begins.

3. Type the first line of your bulleted or numbered list and press Enter
when you’re ready to go down to the next item in the list.

4. Continue typing the items in your list and press Enter between each
line. Before applying a bulleted or numbered style, your list looks like
that in Figure 240-1.

To ot o grassroots erpaazation
Fagater colne or by phons

Suberst 2kt of actwrbes m whsch you con parbopate

Afend ene meving, m perron or v webcam/cooferme e call

Fromde the names of ot least 2 other potersnl partepants

Figure 240-1: A list appearing like a series of short paragraphs before numbers or
bullets are applied

5. Select the items in your list, from beginning to end (or vice-versa).
Be certain to select all of the text in all of the paragraphs.
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6. If there will be a hierarchy within your list — higher and lower-level
bullets, for example, or an outline combining both numbers and let-
ters, use the Tab key when typing your text — the use of the tab key
reduces the eventual rank of the item in your list, and the more tabs,
the lower in rank the text will be. First-level bullets or numbers
should not be tabbed at all, and for each rank beneath that, use one
tab per level down from the top.

7. To create a bulleted list, click the Bullets button on the Formatting
toolbar. Bullets appear in front of each item in your list.

8. To create a numbered list, click the Numbering button on the
Formatting toolbar. Numbers appear in sequence in front of each
item in your list, and by default, you get Arabic numerals (1, 2, 3. . ).

9. To change to different bullets or numbers, select some or all of the
items in the list and choose Format &> Bullets and Numbering. In the
List Properties dialog box (see Figure 240-2), use the Picture Bullets,
Numbers, or Other tabs to choose different characters to precede
your list items.

Figure 240-2: Choosing different bullets or numbers for a list




Applymg Borders to Text

You can apply a top, bottom, left, and/or right border to any text, whether it’s
a single word — such as a heading or section title — or a paragraph. Placing
a border around text helps draw attention to itself. Like many of FrontPage’s for-
matting commands, the Borders and Shading feature should be familiar to you if
you use Word a lot.

1. To apply a border to text — a single word or block of text
(a paragraph) — first select the text.

2. Choose Format = Borders and Shading to open the Borders and
Shading dialog box (see Figure 241-1).

Figure 241-1: Applying formatting in the Borders and Shading dialog box

If it’s not already on top, click the Borders tab to view those tools.
Choose one of the three Setting options: Default, Box, or Custom.

Choose a style for your border.

o o w

In the Preview area, click the border buttons (top, bottom, left, and
right) to turn on the four possible sides of your border. You can click
one, two, three, or all four sides.

7. Choose a color for your border by clicking the Color drop-down list
and making a selection from the palette (see Figure 241-2). Colors
that work best with the current theme appear first in the Color
palette.
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Figure 241-2: Picking colors for borders

8. Set the width (in pixels) for your border. The default is 3.

9. Establish the padding — the distance between the border and the
text it encompasses.

10. Click OK to apply the border (see Figure 241-3).

To join our grassroots organization;

* Eegser onlne or by pheos

* Suberat o ket of actrmiies n wisch you can

= Ancod one meetng. n perron or via webcam/conference call
* Promde the names of at beast 2 cther potentul patcpants

Figure 241-3: A border above and below is more unique than a border on all sides
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Task 2A-2 Applying Shading to Text or
Blank Lines

hading blank areas of your page, or a block of text, helps guide visitors’ eyes
to areas you want to emphasize.

1. To apply shading to text — a single word or a block of text

(a paragraph) — first select the text.

. Choose Format = Borders and Shading to open the Borders and
Shading dialog box (see Figure 242-1).

Figure 242-1: Applying formatting using either tab in the Borders and Shading
dialog box
. Ifit’s not already on top, click the Shading tab to view those tools.

. Click the Background Color drop-down list. A palette appears (see
Figure 242-2), displaying colors that go with the current theme, plus
other Web-safe colors.

. Choose a foreground color from an identical palette.

. If you prefer to use a background image for shading, click the Browse
button across from the Background Picture text box.
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Figure 242-2: Choosing a color for your shaded area

7. Navigate to the image file you want to use as a background pattern
for the shaded area.

8. Click OK to apply your shading (see Figure 242-3).

‘WRegister online o by phone

‘lisubmit 3 list of sctivities in which you can participate
Wattend one meeting, in parson or via webcam/conference call
Werovide the names of ot lesst 2 other potentisl partic|pants

Figure 242-3: Shading can create a subtle, yet effective block of color on the page




Task Inserting Tables

ables may be one of the most powerful design features you can employ in a

Web page — and FrontPage makes creating and customizing tables so easy,
you’ll find yourself using them all the time to control the placement of text and
images.

1. In Page view, click to place your cursor where the new table should
appear.

2. Determine ahead of time the number of rows and columns for your
table. You can do this in any number of ways, as described in Steps 3
and 4.

3. Click the Insert Table button on the toolbar and drag through the
resulting grid (see Figure 243-1) to indicate the dimensions of the
table.

Figure 243-1: Dragging through
the grid in the Insert Table tool

4. You can also choose Table = Insert &> Table to open the Insert Table
dialog box (see Figure 243-2).

5. Click OK to insert the prescribed table (see Figure 243-3).
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Figure 243-2: Setting table dimensions and attributes more precisely

‘WRegister online o by phone

‘lisubmit a list of activities in which you can participate
wWlattand one mesting, in parson or vin webcam/conference call
WProvide the names of at lesit 2 other potential participants

Figure 243-3: A table ready to house text, images, or simply blocks of color based on
cell background colors




Task Adding and Deleting Table Rows,
Columns, and Cells

nce you build a table, you can always make changes later. Insert new rows or
delete existing ones, and add or delete columns.

1. In Page view, select the column (see Figure 244-1) or row you want
to delete, or click next to where a new column or row should appear.
Look for a small black arrow just outside a column or row and then
click to select it.

Figure 244-1: Selecting a table column

2. To delete the selected row or column, choose Table &> Delete =
Rows, or Columns (depending on what you’re doing). The selected
row or column disappears.

3. To insert a new column or row next to the selected table content,
choose Table = Insert &> Rows, or Columns (depending on what

you’re doing). The Insert Rows or Columns dialog box opens (see
Figure 244-2).
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Figure 244-2: Selecting how many new rows or columns to add, and where they should
appear

4. To insert a lone cell within a table, first click in the cell that should be
to the left of the new one.

5. Choose Table = Insert = Cell. A single cell appears to the right of
the selected cell (see Figure 244-3).

Figure 244-3: Adding a single cell to a block of cells
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Task 2A-5 Splitting and Merging Table Cells

t’s easy to change the dimensions of a table after you’ve created it. You can

break existing cells into more cells or merge two or more cells into a single
large cell. Splitting or merging cells makes it possible to build tables that accom-
modate your content as you want to present it, with the layout you had in mind.
By using the Split Cells and Merge Cells commands, you achieve a greater
degree of flexibility than can sometimes be achieved by adding whole rows and
columns.

1. To split a single cell into multiple cells, start by clicking in the cell
you want to split.

2. Choose Table = Split Cells to open the Split Cells dialog box (see
Figure 245-1).

Figure 245-1: Making two or more cells from a single cell
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3. In the Split Cells dialog box, enter the number of columns or rows
you want to create from the cell.

4. Click OK. The cell splits (see Figure 245-2).

Figure 245-2: Splitting a single cell into three cells

5. To merge two or more cells into one, start by selecting the cells —
they must be adjoining cells, either side by side, above or below each
other, or in a block.

6. Choose Table => Merge Cells. The cells merge into one. This can be
useful for creating a single cell to house a table’s title, to create a big
cell for a lot of text, or to make room for a large image without
changing the entire table’s layout.
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Task 2A-6 Resizing and Reformatting Table Cells

FrontPage makes it easy to change any aspect of a cell’s appearance, size, and
position.

1. To resize a table cell in Page view, point to a side border on the cell
in question and look for your mouse to change to a two-headed
arrow (see Figure 246-1).

Figure 246-1: A two-headed resizing arrow appears when you mouse over a cell’s
border
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2. Click and drag to resize the cell. Drag outward to make the cell
larger, or inward to make it smaller. Unlike Dreamweaver, which
allows you to resize table cells vertically as well as horizontally (see
Task 208), FrontPage sticks to the pixel height set when the table was
created; you cannot drag to make a cell taller or shorter.

3. To make fine adjustments over and above (or instead of) the changes
you can make manually with the mouse, click in the cell you want to
resize and choose Table => Table Properties.

4. From the submenu, choose Cell to open the Cell Properties dialog
box (see Figure 246-2).

Figure 246-2: Adjusting the size, fill, border, and alignment of any selected cell with the
Cell Properties dialog box

5. Using the Cell Properties dialog box, enter new numbers in the
Specify Height and Specify Width fields.




Task Populating a Table with
Graphics and Text

Inserting a picture or text in a table is a little more complicated than doing so on
a simple Web page. You have to choose which cell contains the picture or text
and inform FrontPage how to align the content (horizontally and vertically). You
can also format the text to fit within the table if the table’s dimensions are dic-
tated by the page design or some other constraint.

1. To insert a graphic inside a table cell, click within the cell to select it
(see Figure 247-1).

Figure 247-1: Populating your table by clicking in the first cell to receive content
2. Choose Insert = Picture = Clip Art, or From File — whichever is
appropriate for the image you want to insert.

3. Once the image appears in the cell, manipulate its placement by
using the Formatting toolbar (see the relevant tools in Figure 247-2).

Center alignment

Left alignment  Right alignment

Figure 247-2: Applying horizontal alignment from the formatting toolbar by clicking the
Left, Center, or Right alignment buttons

To access more tools for controlling cell content, right-click the cell
and choose Cell Properties (see Figure 247-3).
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Figure 247-3: Specifying horizontal
and vertical alignment for the cell’s
content in the Cell Properties
dialog box

4. 'To add and format text in a table cell, click inside the cell and simply
start typing. You can also use the Paste command (Edit = Paste or
Curl+V) to copy text from elsewhere — a Microsoft Word document
or another Web page — and see it fill the cell (see Figure 247-4).
The cell’s dimensions control word-wrapping within the cell.

Our staff d d

wp largely of former and current teachers, professors,
tand 1chool adminfitration profeszionals, wa know what
it takas to supply & school with avenahing it nesds, Cur
‘Customer Service staff swaits your call, and if you have
lany questions about products or would like an on-tite
vigit, pleass ask to spesk to b0 Education Spacialist,

Figure 247-4: Text and images inserted into table cells

5. Continue typing in cells, using the cell resizing techniques discussed
in Task 246 to make the cells the right width for the overall page and
table design, as well as to accommodate your text. The size of the cell
when you start typing dictates the width of any paragraph you type
(see Figure 247-4).

6. After typing in any particular cell, reopen the Cell Properties dialog
box (by right-clicking the cell, not the text) and make sure No Wrap
is turned off (it’s off by default) so that your table cells don’t widen to
accommodate your text. They’ll lengthen but you may not want
them to widen, which could throw off the overall table layout.
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Task 2A-8 Creating Frames

ames are Web pages within a frameset. Once you add frames to a Web page,
that page goes from being a simple Web page to being a home (frameset) to
one or more frames that are pages unto themselves. Through FrontPage’s frame-
creation and customization tools you can determine where frames appear, how
big they are, how to display their content, and whether or not visitors can resize
them in the browser.

1. Choose File = New to open the New task pane.
2. In the New task pane select More Page Templates.

3. In the Page Templates dialog box, click the Frames Pages tab to see a
series of frame constructs you can apply to the new page.

4. Click once on each of the Frames Pages icons. Each one displays a
different preview, which shows you the arrangement of frames within
that template.

5. Double-click the Frames Page template you want to use and see the
frames created on a new page (see Figure 248-1).

Figure 248-1: Creating frames automatically from a template instead of one at a time
by hand

6. Click the appropriate button (Set Initial Page or New Page) in each
frame.

7. Resize the frames as needed by pointing to their borders and drag-
ging with your mouse.
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8. 'To customize an individual frame, right-click it and select the Frame
Properties button to open the Frame Properties dialog box (shown in
Figure 248-2).

Resize frame

Set inner frame margins
Allow visitors to resize frame

Change Show Scrollbar
option depending on need

Figure 248-2: Naming your frame and choosing how the frame looks and functions for
the user

9. Once the frames are set up as you want them, proceed to add content
to them, inserting text and graphics as desired (see Figure 248-3).

Getting to Know Us...

We can be rasched in any of the following vemys:

Figure 248-3: Each frame contains original content you inserted or displays an existing
page from another site
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Adding Layers

Lizers are like frames that float above the Web page, and by virtue of the fact
at they’re not part of a rigid frameset, you have greater flexibility in their
placement, size, and relationship to other content on the page. You can size and
format them easily, and they can contain anything you want: images, text, tables,
even other layers. Some older versions of browsers don’t display them, however,
so use them judiciously if you know your audience is likely to view your site with
older computers, older operating systems, and older browsers.

1. In Page view, click to position your cursor where the layer should
appear.

2. Choose Insert &> Layer. A layer appears on the page (see
Figure 249-1).

Figure 249-1: A small box with a numbered Layer tab appears on the page

3. Move the layer, as needed, with your mouse. Point to the layer and
when your mouse turns to a four-headed arrow, drag to reposition
the layer.

4. If desired, resize the layer by clicking on it to display its handles (see
Figure 249-2) and drag from any handle to increase or decrease it.

5. To build layer content, click inside the layer and use FrontPage’s tools
to insert and format text, and to insert graphics (see Figure 249-3).

6. Right-click the layer and choose Page Properties to open the Page
Properties dialog box. Here you make adjustments to the layer’s
background, font colors, and font sizes and adjust internal margins.




Working with FrontPage

Figure 249-2: Using the mouse to resize a layer — larger or smaller, taller or shorter,
wider or narrower

Our History

1428, a group of concemead cirizens got together
and formed an organization to help preserve
historic bulldings, untouchad, cpen land, and
bl W our suburban aress.

Figure 249-3: Choosing text and graphical content for your layer that matches the look
and feel of the rest of your page

7. Right-click the layer and choose Layer Properties to display the
Layers task pane (see Figure 249-4).

|i I. v« Figure 249-4: Changing the layer border and shading settings,
and turning layer visibility on and off
et e | [Bemmta
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Task 250 Building Page Bookmarks

f your page has lots of text on it — say, a long article or a series of questions and

answers (as in an FAQ) — you may find it helpful to create bookmarks. These
are areas of the page that you can scroll to quickly by clicking links to them.
Bookmarks are easy to set up and use, and can be a big help to visitors attempting
to navigate a complex or text-heavy document.

1. In Page view (in Design mode), select a word, usually the first word
in a section that you want to bookmark, by double-clicking the word.

2. Choose Insert = Bookmark to open the Bookmark dialog box
(see Figure 250-1).

Figure 250-1: The Bookmark dialog box

3. Type a name for the bookmark or just use the word that appears
automatically in the Bookmark Name text box. Click OK. The dialog
box closes and a dashed line appears under the selected word (see
Figure 250-2).

4. Continue bookmarking other words in your document, repeating
Steps 1 through 3 for each one.

5. 'To create the links that take visitors to the bookmarked text, type or
select existing triggers, such as those shown in Figure 250-3.

6. Select the words/phrases in your table of contents, one at a time, and
click the Insert Hyperlink button for each one.

7. In the Insert Hyperlink dialog box, click the Bookmark button.

8. In the Select Place in Document dialog box, select the bookmark by
name (see Figure 250-4) that you want to use as your link for the
selected text. Click OK here and then again in the Insert Hyperlink
dialog box. Your link is created.
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Our Foundars 1

Robert J. Ctgood and Frances Kirkpatrick ware the first two membars of our
onganization, and we credit them with making The Freservationists » reality. With
1aven of their lhe-minded friends, they smanged for weekly meeting: 1o be held, each
one attended by an invited guest from the wordd of palitics, architechurs, wcisnce, or
aducation,

Our Membership
‘We've grown from a group of 9 originel bers to ower 90,000
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g pis frae, but e pecented. W value activity ovar
money, slthough sctivities have costs involved, 5o we do solicit sponsors from the
community.

Founders  Memberthlp  Accomplishments

_In 1428, a group of concermed citizen got lqedlu'!
‘and formed an organization to help preserve |
historic bulldings, untouched, open land, and
weildife 0 our uburhan aneac.

|

Figure 250-4: Choosing your bookmark to complete the hyperlink setup
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Task 51 Setting Up Keywords and Page
Description Text

he <meta> tags that appear at the top of your document (in Code view) con-

tain, among other things, keywords and descriptive text that search engines
use to help visitors find your site. FrontPage makes it easy to build these tags
outside of Code view.

1. Open or display the page for which you want to set up keywords and
a description.

2. Choose File = Page Properties to open the Page Properties
dialog box.

3. Click the General tab, if it’s not already chosen (see Figure 251-1).

1924, 0 gy of comcrmmnd utimTn gt tigee |

g, stabums, panis,

e EE————
.

Figure 251-1: Entering keywords and description text in the Page Properties dialog box
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Figure 251-2: Generating <meta> tag code the easy way

4. Enter a short description of your page in the Page Description
text box.

5. Enter your keywords in the Keywords text box. Use words that
people might type into a search engine to find your site.

6. Verify that your page title (what appears in the browser’s title bar)
is accurate.

7. Click OK to close the dialog box and build the <meta> tag code
(see Figure 251-2).
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Task 52 Publishing a FrontPage Web Site

G etting your Web publishing achievement “out there” for the Web-surfing
public to see and enjoy requires publishing your site to the Web. Uploading
your FrontPage-created pages to a Web server requires the presence of
FrontPage server extensions on both your computer (where you installed
FrontPage for design purposes) and on the Web host’s server. Check with your
Web host to make sure they support FrontPage server extensions. If they don’t,
either request that they do or find another host. You need them in order for your
FrontPage-designed pages, with all their FrontPage-specific code, to appear and
function properly in the browser.

1. Choose File > Publish Site to open the Remote Web Site Properties
dialog box (see Figure 252-1).

Figure 252-1: Choosing the type of Web server you are publishing to

2. Choose the remote Web server type that matches your Web server
and click OK. A two-sided window appears (see Figure 252-2), show-
ing the pages and folders on your local site as well as the remote site.

3. Click the Publish Web Site button in the lower-right corner.

4. If a prompt asks whether or not to upload modified pages, click Yes
or No depending on your situation.
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Figure 252-2: Seeing the Web pages and folders on both the local site (on your
computer) and the remote site (the Web server)

5. Observe the Status area of the window (see Figure 252-3). When
the uploading finishes, you’ll see what was uploaded and when.

Figure 252-3: All folders and pages that make your site run locally should now be on
the remote server so that the site runs on the Web.







Symbols

/ (forward slash), directories, 89

<!-and -> comment tags
HomeSite, 356-357
introduction, 109

< (less than) symbol in tags, 2

> (greater than) symbol in tags, 2

A

<a> tags
document location, 93
href attribute, 86
links, 86-87
absolute pathnames, 88
absolute positions, 214-215
absolute scale, fonts, 30
accesskey attribute, form
controls, 138-139
Add a Project Folder dialog box
(HomeSite), 349
Add All Subfolders option
(HomesSite), File Types drop-
down list, 346
addresses (e-mail), hiding from
spammers, 230-231
align attribute
heading tags, 24-25
paragraphs, 27
tables, 102-103
alignment
banners in FrontPage, 505
CSS and, 27
headings, 24

horizontal rules (HomeSite), 370

images, 64-65

images in BBEdit, 309

images in Dreamweaver MX,

426-427

inline frames, 158-159

line spacing and, 184-185

table elements, 102-103

tables in BBEdit, 310

text (CSS), 190-191

vertical (CSS), 184185
alphabetical ordered lists, 48
alt attribute

BBEdit, 308

<img> tag, 62

alternative text (FrontPage),
494-495
7am news ticker, 242-243
Amazon.com associates, 246-247
Anchor dialog box (BBEdit), 305
anchor tags, links, 86-87
anchors, named in links, 92-93
<applet> tags, applet embedding,
82-83
applets (Java)
downloading, 82
embedding, 82-83
Arabic numeral lists, 48
arc attribute, <img> tags, 63
arguments (JavaScript),
definition, 226
Assets panel (Dreamweaver MX),
464-465
associates with Amazon.com,
246-247
asterisk, Document Selector
filenames, 274
attributes
accesskey, 138-139
align, 102-103
BBEdit list items, 307
bgcolor, 18-19
border, 98-99
bordercolor, 98-99
cellpadding, 98-99
cellspacing, 98-99
checked (check boxes), 122
checked (radio buttons), 124
class, 168-169
cols, 146-147
colspan, 100-101
displaying in BBEdit, 303
equal sign in values, 3
face, 28
frameborder, 148
height, 104-105
href, 86-87
href, mailto: and, 90
hspace, <img> tags and, 64
inserting with HomeSite,
356-357
leftmargin, 44
marginheight, 150-151
marginwidth, 150-151

Index

maxlength in password fields,
118-119

maxlength in text fields, 116

name, check boxes and, 123

name, pop-up lists and, 126-127

name, property/value pair and, 8

name, radio buttons and, 124

name, value pairs and, 116

order, 229

previewing, HomeSite Browse
tab, 356-357

as properties, 3

property/value pair, 8

quotation marks in values, 3

rel, 167

rows, 146-147

rowspan, 100-101

scrolling, 151

selected, in pop-up lists,
126-127

size, in password fields, 118-119

size, in text fields, 116

start, 50-51

tabindex, 138-139

tags, 3

target, 154-155

topmargin, 44

type, check boxes and, 122-123

type, radio buttons and, 124

type, text fields and, 116

valign, 103

value, check boxes and,
122-123

value, password fields and,
118-119

value, pop-up lists and,
126-127

value, radio buttons and, 124

width, 104-105

wrap, 120

audio files. See also sound

delaying play, 76
downloading, 77
embedding, 76-77
.mid, 76

.mp3 format, 76
.ra format, 76
.wav format, 76
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author information, <meta> tag,
10-11

Auto-Backup (HomeSite), 394-395

automation
tag insertion (HomeSite),
380-381
templates and, 352-353
autoplay attribute, video files,
80-81

AutoShapes (FrontPage), 496-497

autostart attribute, sound, 78

B
<b> tags (bold text), 34
background
color, 18-19
color, CSS, 180-181
controlling, 18-19
editing with FrontPage,
508-509
images, CSS, 192-193

images, tiling, 18-19, 192-193

properties, defining CSS in
BBEdit, 320-321
sound, adding, 78-79
table color in BBEdit, 310
tables, 106-107
background attribute, <body>
tags, 18
background-attachment
property (CSS), 192-193
background-color property
(CSS), 320-321
background-image property
(CSS)
BBEdit, 320
introduction, 192-193

background-position property

(CSS), 192-193
background-repeat property
(CSS)
BBEdit, 321
introduction, 192-193
backups, HomeSite, 394-395
banners (FrontPage), 504-505
<basefont> tag, 30-31
BBEdit
alt attribute, 308
Anchor dialog box, 305
background properties
definitions, 320-321

background-color property

(CSS), 320-321
Block Elements, 305
Body Properties, 305

<body> tag, 300

border area, 326

Border dialog box, 324-325

border properties (CSS),
324-325

box properties (CSS), 326-327

CarbonLib and, 296

color coding HTML syntax,
338-339

color preferences, 340-341

columns in frames, 314

comment deletion, 331

comments, 330

content area, 326

converting text to HTML,
330-331

CSS font properties, 316-317

<dd> tag for lists, 307

<d1> tag for lists, 307

DOCTYPE declarations, 300

<dt> tag for lists, 307

file groups and, 334-335

Find & Replace dialog box,
332-333

Find and Replace, 332-333

<font> tags, 304-305

font-family property
(CSS), 317

font-size property
(CSS), 317

font-style property
(CSS), 317

font-variant property
(CSS), 317

font-weight property
(CSS), 317

forms building, 312-313

forms text areas, 313

Frame dialog box, 314

frames and, 314-315

frames scrolling, 314

handicap accessibility, 308

<head> tag, 300

HTML document creation,
300-301

HTML Syntax Errors panel,
328-329

<html> tag, 300

HTML Tools Palette, 304-305

HTML validation, 328-329

image alignment, 309

Image dialog box, 308

image insertion and, 308-309

<img> tags, 308-309

Input dialog box, 312-313

Insert Tag dialog box, 302-303

<1i> tag for lists, 307

line-height property
(CSS), 317

list creation, 306307

list item attributes, 307

Lists dialog box, 306-307

Mac versions, 296

manual download, 297

margin area, 326

menu keys, setting, 336-337

New HTML Document dialog
box, 300

<ol> tag for lists, 307

padding area, 326

Padding dialog box, 322-323

padding properties (CSS),
322-323

Preferences panel, 298

preformatted text, 40-41

root file, 298

rows in frames, 314

Section 508 compliance, 308

stripping HTML tags, 330-331

table alignment, 310

table borders, 310

table color, 310

table creation, 310-311

table width, 310

tables, cell insertion, 311

tables, row insertion, 311

tag attributes, displaying, 303

TagMaker, 302-303

TagMaker, <style> tags and,
302-303

text as links, 305

text formatting, 304-305

text properties (CSS), 318-319

text-align property
(CSS), 318

text-transform property
(CSS), 319

<ul> tag for lists, 307

URLSs, 298

utilities, 330-331

Web servers, 298

behaviors (Dreamweaver MX)

JavaScript and, 454-455

Open Browser Window,
458-459

Preload Images, 456-457

Set Text for Status Bar, 462-463

Validate Form, 460-461

bgcolor attribute, hexadecimal
color values, 18-19
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<bgsound> tag, 78-79
Bicubic interpolation, Photoshop
Elements, 66
<big> tags, font size, 30-31
_blank target, Dreamweaver MX,
436-437
blank Web pages, rearranging in
FrontPage, 476-477
Block Elements (BBEdit), 305
blocking pop-up windows, 236-237
<blockquote> tags, 42-43
indented paragraphs, 42
printable margins, 43
blocks, code snippets
(Dreamweaver MX), 413
Body Properties (BBEdit), 305
<body> tags, 44
background attribute, 18
BBEdit and, 300
document background and,
18-19
leftmargin attribute, 44
marginheight attribute, 44
margins and, 44-45
marginwidth attribute, 44
starting HomeSite page and,
350-351
text links in color, 87
topmargin attribute, 44
body text, formatting in HomeSite,
364-365
bold text, 34
bookmarks (FrontPage), 530-531
Books (TextPad clip library), 281
border area (BBEdit), 326
Border dialog box (BBEdit),
324-325
borders
CSS border color properties,
200-201
CSS border properties in
BBEdit, 324-325
CSS border property shorthand,
202-203
CSS border width properties,
198-199
CSS properties, 196-197
dashed, 196
dotted, 196
double, 196
frame color, 149
frame properties, 148-149
frames, user resizing, 149
FrontPage, 512-513
groove, 196

image links, 86
inset, 196
outset, 196
ridge, 196
solid, 196
tables, 97, 98-99
tables, border attribute, 98-99
tables, bordercolor attribute,
98-99
tables, cellpadding attribute,
98-99
tables, cellspacing attribute,
98-99
tables in BBEdit, 310
Borders and Shading dialog box
(FrontPage), 512-513
bots, spammers and, 230-231
box properties, CSS in BBEdit,
326-327
brackets in tags, finding with
TextPad, 270-271
British Pound symbol, 38
Browse for Folder dialog box
(TextPad), 268-269
browsers
alternative text (FrontPage),
494-495
BBEdit configuration and, 308
font default size, 31
Open Browser Window
behavior (Dreamweaver MX),
458-459
previewing Web pages,
Dreamweaver MX, 402-403
previewing Web pages,
HomeSite and, 362-363
source code in, 20-21
status bar, writing information
to, 228-229
TextPad configuration, 284-285
bulleted lists
bullet styles, 54-55
bullet styles (CSS), 210-211
Dreamweaver MX, 416-417
FrontPage, 510-511
HomeSite, 367
introduction, 47
Business Solutions link
(Google), 240
buttons
interactive (FrontPage),
506-507
Reset, 132-133
Submit, 132-133
Submit, graphic images and,
134-135

C
caching, <meta> tags’ expiration
date, 1213
CarbonLib, BBEdit and, 296
case sensitivity, in tags, 2
cells
inserting in tables using
BBEdit, 311
inserting in tables using
FrontPage, 518-519
table rows/columns, spanning,
100-101
tables, 96-97
cent symbol, 38
center alignment
BBEdit, 309
Dreamweaver MX, 414
headings, 24-25
paragraphs, 27
CGI (Common Gateway Interface),
forms and, 114
character entities. See special
characters
character spacing (CSS), 182-183
characters
code snippet names
(Dreamweaver MX), 412-413
special, 38-39
starting for ordered lists, 50-51
check boxes (forms), 122-123
formatting, 122-123
Check In/Check Out
(Dreamweaver MX), 470471
Check Spelling dialog box
(Dreamweaver MX), 418-419
checked attribute
check boxes, 122
radio buttons, 124
child lists, 56-57
circular bullets in bulleted lists, 54
circular bullets in bulleted lists
(HomeSite), 367
<cite> tags, 36
class attribute, styles, 168-169
classes, TextPad color coding and,
292-293
clearing status bar of informa-
tion, 229
clip art
inserting with FrontPage,
492-493
as links (FrontPage), 492-493
Clip Art task pane (FrontPage),
492-493
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Index

Clip fields, layers (Dreamweaver
MX), 450-451
clip library (TextPad)
book creation, 281
deleting clips, 281
downloading libraries, 282-283
introduction, 278-279
renaming, 280
Clip Library Entry dialog box
(TextPad), 280-281
Clipboard, TextPad and, 262-263
clipping area, CSS layers, 218-219
code. See source code
code snippets, Dreamweaver MX,
412413
<code> tags, 36
Code View (Dreamweaver MX),
410411
auto indent, 411
Flash buttons and, 432-433

invalid HTML highlighting, 411

line numbers, 411
syntax coloring, 411
word wrap, 411

CodeSweeper (HomeSite), 358-359

color
background (CSS), 180-181
background in tables, 106
border color properties (CSS),
200-201
color coding with BBEdit,
338-339

color coding with Dreamweaver

MX Code View, 411
color coding with TextPad,
292-293
editing with FrontPage,
508-509
fonts, 32-33
foreground (CSS), 180-181
frames, 149
GIF files and, 69
Google results page, 241
hexadecimal, 19
hexadecimal for fonts, 32
predefined names, 33
preferences (BBEdit), 340-341
rollovers (Dreamweaver MX),
428-429
text, default, 33
text links, 87
themes in FrontPage, 484485
color attribute, <font> tag, 32
color picker in dialog boxes, 304
color property, BBEdit, 316

color reduction algorithm, 69
cols attribute, frames, 146-147
colspan attribute, 100-101
columns
deleting with (FrontPage),
518-519
frames as, 145
frames in BBEdit, 314
inserting in tables with
FrontPage, 518-519
table cell spanning, 100-101
comments, 109
comments, BBEdit, 330
connection speed, preloading
images and, 232-233
container tags
document structure and, 4
<1li>, 46
<ol>, 46
content
refreshing using <meta> tags, 14
time-based, changing, 226-227
content area (BBEdit), 326
content attribute
<meta> tag, 7
property/value pair, 8
contextual selectors (CSS), 165
control panel
floating, 76
plug-ins and, 76
controller attribute, video files,
80-81
controls
form focus order, 138-139
form image fields, 134
forms, 114
converting text to HTML,
HomeSite projects and, 354-355
converting text to lists (BBEdit),
306-307
Copy dialog box, TextPad, 264
copyright symbol, 38
Create Image Map dialog box,
378-379
CSE HTML Validator, 286-287
CSS (Cascading Style Sheets)
alignment and, 27
background color, 180-181
background images, 192-193
background properties, defining
in BBEdit, 320-321
background-attachment
property, 192-193
background-color property,
320-321

background-image property,
192-193

background-position
property, 192-193

background-repeat property,
192-193

border color properties, 200-201

border properties in BBEdit,
324-325

border property shorthand,
202-203

border style properties, 196-197

border width properties,
198-199

box properties in BBEdit,
326-327

character spacing, 182-183

contextual selectors, 165

declarations, 162

descendant styles, 163

Dreamweaver MX and, 452-453

editing with Style Editor
(HomeSite), 360-361

element dimensions, 206-207

embedded code in TextPad, 262

embedding style sheets, 164-165

external, 166-167

float property, 208-209

font properties in BBEdit,
316-317

font properties shorthand,
178-179

font property, 178-179

font styling, 176-177

font-family property, 170-171

font-size property keywords,
172-173

font-size property lengths,
174-175

font-weight property, 176

foreground color, 180-181

indentation, 190-191

layer absolute positions, 214-215

layer clipping area, 218-219

layer relative positions, 216-217

letter-spacing property,
182-183, 319

line spacing, 184-185

line-height property, 184-185

list bullet styles, 210-211

list number styles, 212-213

list-style-type property,
210-211

margin properties, 204-205

padding properties, 194-195
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padding properties in BBEdit,
322-323
projects in HomeSite, 360-361
selectors, 162
style classes definition, 168-169
syntax, 163
text alignment, 190-191
text-align property, 318
text-decoration property,
186-187, 319
text-indent property,
190-191, 318
text-transform property,
188-189, 319
vertical-align property,
184-185
white-space property, 182-183
width property, 206-207
word spacing, 182-183
word-spacing property,
182-183
writing style rules, 162
cursor, moving in TextPad, 258-259
Customize dialog box, HomeSite,
392-393
Customize Theme dialog box
(FrontPage), 484-485

D
dashed borders, 196
data tables (Dreamweaver MX),
importing from other
applications, 424-425
Date() object, JavaScript, 226
date, expiration date of <meta>
tag, 12
<dd> tag
BBEdit lists, 307
introduction, 58-59
declarations (CSS), 162
declarations (CSS), multiple
selectors, single declaration
and, 163
definition lists, creating, 58-59
Delete dialog box, TextPad, 265
deployment
files (HomeSite), 398-399
folders (HomeSite), 398-399
HomeSite options, 396-397
Deployment Wizard (HomeSite),
398-399
deprecated, definition, 162
descendant styles, 163
descriptions, <meta> tag, 8-9

Design View (Dreamweaver MX),
410-411
Behaviors tab, 454-455
CSS and, 452453
toggling between Code
View, 411
<dfn> tags, 36
dialog boxes
Add a Project folder
(HomeSite), 349
Anchor (BBEdit), 305
Border (BBEdit), 324-325
Borders and Shading
(FrontPage), 512-513
Browse for Folder (TextPad),
268-269
Check Spelling (Dreamweaver
MX), 418-419
Clip Library Entry (TextPad),
280-281
CodeSweeper (HomeSite), 358
color picker, 304
Copy (TextPad), 264
Create Image Map (HomeSite),
378-379
Customize (HomeSite), 392-393
Customize Theme (FrontPage),
484-485
Delete (TextPad), 265
Edit Sites (Dreamweaver MX),
406-407
Extended Find (HomeSite), 373
External Browsers (HomeSite),
362-363
File Open (TextPad), 257
Find & Replace (BBEdit),
332-333
Find and Replace
(Dreamweaver MX), 420-421
Find (HomeSite), 372-373
Find in Files (TextPad), 268-269
Find (TextPad), 266-267
Frame (BBEdit), 314
Image (BBE), 308
Image Properties
(HomeSite), 389
Import Tabular Data
(Dreamweaver MX), 424-425
Input (BBEdit), 312-313
Insert Navigation Bar
(Dreamweaver MX), 440-441
Insert Rollover Image
(Dreamweaver MX), 438-439
Insert Tag (BBEdit), 302-303

Insert Web Component
(FrontPage), 502-503
List (HomeSite), 366-367
Lists (BBEdit), 306-307
Manage Files (TextPad), 264-265
New Document (HomeSite),
350-351
New HTML Document
(BBEdit), 300
New Project (HomeSite),
346-347
Open File(s) (TextPad), 256
Padding (BBEdit), 322-323
Page Properties (Dreamweaver
MX), 408409
Page Properties (FrontPage),
480-481
Page Templates (FrontPage),
526-527
Preferences (TextPad), 284-285
Rename/Move (TextPad), 265
Replace (HomeSite), 374-375
Replace (TextPad), 266-267
Save As Template
(HomeSite), 353
Save As (TextPad), 276-277
Save Web Page (Internet
Explorer), 20-21
Select Directory (HomeSite),
346-347
Site Definition (Dreamweaver
MX), 404-405
Snippet (Dreamweaver MX),
412-413
Spell Check (HomeSite),
368-369
Split Cells (FrontPage), 520-521
Tag Editor - FONT
(HomeSite), 364-365
Tag Editor - FORM
(HomeSite), 386-387
Tag Editor - HR (HomeSite),
370-371
Tag Editor - IMG (HomeSite),
376-377
dictionaries, TextPad Spelling
Checker, 272-273
directories
/ (forward slash), 89
pathnames, 88-89
disc bullets in bulleted lists, 54
disc bullets in bulleted lists,
HomeSite, 367
<div> tag, 214-215
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<d1> tags
BBEdit lists, 58-59
introduction, 58-59
DOCTYPE declarations
(BBEdit), 300
Document Selector (TextPad),
274-275
Document Selector (TextPad),
asterisks beside names, 274
document weight (HomeSite),
388-389
documents
authors, <meta> tag and, 7
background, 18-19
container tags, 4
frameset. See frameset
documents
indenting tags, 4
script preparation, 222-223
structure, 4-5
title, 5
dotted borders, 196
double borders, 196
downloading
BBEdit, 296-297

clip libraries (TextPad), 282-283

files (Dreamweaver MX),
468-469
HomeSite, 344
Java applets, 82
status bar display, 228-229
TextPad, 254-255
WinZip and, 282
downsampling, images, 66—67
drag-and-drop text
FrontPage, 488-489
TextPad, 254
drawing
lines (FrontPage), 496-497
polygons in HomeSite, 379
shapes (FrontPage), 496-497
Drawing toolbar (FrontPage),
496497
Dreamweaver MX
Assets panel, 464-465
Auto Indent in Code View, 411
behaviors, 454-455
_blank target, 436-437
browsers, previewing Web
pages and, 402-403
bulleted lists, 416-417
CCS and, 452-453
Check In/Check Out, 470-471
Check Spelling dialog box,
418-419

code snippets, 412-413

Code View, 410-411

CodeSweeper and, 359

color coding HTML in Code
View, 411

data tables, 424-425

defining sites, 404—405

definition indents, 416417

Design View, 410-411

Design View, toggling between
Code view, 411

downloading files, 468-469

Edit Sites dialog box, 406-407

Find and Replace, 420-421

Flash buttons, inserting,
430-431

Flash text insertion, 428-429

fonts, 414-415

forms creation, 446-447

frames and, 448-449

HTML, highlighting
invalid, 411

image alignment, 426-427

image formatting, 426-427

image insertion, 426427

image maps, 436-437

images, external editors, 434-435

Import Tabular Data dialog box,
424-425

indents, 415

Insert Navigation Bar dialog
box, 440-441

Insert Rollover Image dialog
box, 438-439

layer clip fields, 450451

layers, 450-451

line numbers in Code View, 411

lists, 416-417

navigation bars, building,
440-441

Open Browser Window
behavior, 458-459

ordered lists, 416-417

page properties, 408-409

Page Properties dialog box,
408-409

Preload Images behavior,
456457

Properties Inspector, 414415

remote host setup, 466-467

rollover color, 428-429

rollover creation, 438-439

Set Text for Status Bar behavior,
462-463

Site Definition dialog box,
404-405

site maps, 406-407

Snippet dialog box, 412-413

Snippets panel, 412-413

spell check, 418-419

style naming, 453

table cell spacing, 442-443

table creation, 442-443

table editing, 444-445

table nesting, 442-443

table population, 446-447

text formatting, 414415

text insertion, 414-415

unordered lists, 416-417

uploading files, 468-469

Validate Form behavior, 460-461

Word HTML, importing,
422-423

word wrap in Code View, 411

<dt> tag
BBE(it lists, 307
introduction, 58-59

E
Edit Sites dialog box
(Dreamweaver MX), 406-407
Editor toolbar (HomeSite),
introduction, 344
elements, dimensions of, 206-207
<em> tags (emphasis), 36
e-mail
addresses, hiding from
spammers, 230-231
<meta> tags, 11
<embed> tag
audio files, 76-77
video, 80-81
embedding
audio files, 76-77
embedded CSS code in
TextPad, 262
Java applets, 82-83
style sheets, 164-165
video, 80-81
emphasis on text, 36
entities, character entities. See
special characters
error reporting, Validate Current
Document option
(HomeSite), 359
Euro symbol, 38
event handlers
onLoad (JavaScript), 228
onMouseOut (JavaScript), 228



Index

543

onMouseOut with rollovers,
234-235
onMouseOver (JavaScript), 228
onMouseOver with rollovers,
234-235
order, 229
window.open( ), 236-237
events, JavaScript, 228
expiration dates, <meta> tags, 12-13
Extended Find dialog box
(HomeSite), 373
External Browsers dialog box
(HomeSite), 362-363
external image editors,
Dreamweaver MX and, 434-435
external style sheets, creating,
166-167

F

face attribute
<font> tag, 28-29
fonts, 28
FAQs (Frequency Asked
Questions), named anchors
and, 93
favorites, Assets panel
(Dreamweaver MX), 464-465
field sets, 140-141
<fieldset> tags, 140-141
file fields, 130-131
File Open dialog box (TextPad), 257
File Open dialog box (TextPad),
workspace creation and, 277
file sharing (Dreamweaver MX),
470-471
files
asterisks in Document
Selector, 274
audio, embedding, 76-77
creating in TextPad, 256-257
deploying, HomeSite and,
398-399
downloading (Dreamweaver
MX), 468-469
groups, BBEdit, 334-335
local, structure, 167
managing with TextPad, 264-265
.mid format, 76
.mp3 format, 76
opening in TextPad, 256-257
pathnames, 88-89
project files (HomeSite),
storage, 347
.ra format, 76

searching multiple, TextPad,
268-269
TextPad workspaces, 276-277
uploading (Dreamweaver MX),
468-469
video, embedding, 80-81
.wav format, 76
Find & Replace dialog box
(BBEdit), 332-333
Find and Replace
BBEdit, 332-333
Dreamweaver MX, 420-421
Find and Replace dialog box
(Dreamweaver MX), 420-421
Find dialog box (HomeSite),
372-373
Find dialog box (TextPad), 266-267
Find in Files dialog box (TextPad),
268-269
Flash buttons (Dreamweaver MX)
formatting, 432-433
inserting, 430-431
testing, 432433
Flash content (FrontPage), 498-499
Flash text, Dreamweaver MX,
428-429
float property (CSS), 208-209
focus, control order, 138-139
folders
Auto-Backup (HomeSite),
394-395
deleting in HomeSite, 349
deploying, HomeSite and,
398-399
HomeSite, 348-349
images (HomeSite), 347
naming in HomeSite, 349
physical folders in
HomeSite, 349
subfolders (HomeSite), 346, 349
font properties (CSS)
BBEdit, 316-317
introduction, 178-179
font property (CSS), 178-179
font styling (CSS), 176-177
<font> tags
BBEdit, 304-305
color attribute, 32
face attribute, 28-29
HomeSite, 355
preformatted text and, 4041
size attribute, 30-31
font-family property (CSS)
BBEdit, 316
introduction, 170-171

fonts
applying, 28-29
Arial, 29
<basefont> tag, 30-31
color, 32-33
Dreamweaver MX, 414-415
face attribute, 28
Helvetica, 29
italic, 176
monospaced, 41
name capitalization, 171
oblique, 176
quotation marks in names, 171
serifs, 29
size, 30-31
Fonts tab (HomeSite),
introduction, 345
Fonts toolbar, HomeSite, 364-365
font-size property (CSS)
BBEdit, 316
keywords and, 172-173
lengths, 174-175
font-style property (CSS),
BBEdit, 317
font-variant property (CSS),
BBEdit, 317
font-weight property (CSS)
BBEdit, 317
introduction, 176
foreground, color (CSS), 180-181
<form> tag, 114-115
<form> tags, HomeSite, 386-387
formats
body text (HomeSite), 364-365
converting text to HTML in
HomeSite, 354-355
file fields, 130-131
Flash buttons (Dreamweaver
MX), 432-433
form check boxes, 122-123
form password fields, 118-119
form radio buttons, 124-125
form text areas, 120-121
form text fields, 116-117
images (Dreamweaver MX),
426-427
paragraphs, 26-27
previewing, HomeSite and,
364-365
Reset button, 132-133
selection lists, 128-129
Submit button, 132-133
text, BBEdit and, 304-305
text, Dreamweaver MX and,
414-415
text, FrontPage and, 488-489
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forms
building with BBEdit, 312-313
CGIl and, 114
check box format, 122-123
control focus order, 138-139
control image fields, 134
controls, 114
creating with Dreamweaver
MX, 446-447
element definitions, 114-115
field sets, 140-141
hidden fields, 136-137
HomeSite, 386-387
<input> tag, 116-117
password field format, 118-119
populating with Dreamweaver
MX, 446-447
pop-up lists, 126-127
radio button format, 124-125
scripts, 114
tables and (Dreamweaver MX),
446-447
text area format, 120-121
text area format in BBEdit, 313
text fields format, 116-117
Validate Form behavior
(Dreamweaver MX), 460-461
Forms toolbar (HomeSite), 386-387
forward slash (/), directories, 89
fractions, 38
Frame dialog box (BBEdit), 314
<frame> tag
BBEdit and, 314
introduction, 144-145
frameborder attribute, framesets
BBEdit, 314
introduction, 148
frames, 144
BBEdit and, 314-315
border color, 149
border properties, 148-149
border resizing by users, 149
columns in BBEdit, 314
creating in FrontPage, 526-527
Dreamweaver MX and, 448-449
HomeSite, 384-385
inline frames, 158-159
margins, 150-151
noframes content, 156157
<noframes> tag, 156-157
rows in BBEdit, 314
scroll bars, 150-151
search engines and, 448-449
size, 146-147
targeting, 154-155

Frames toolbar (HomeSite),
384-385
Frames Wizard (HomeSite),
384-385
frameset documents. See also frames
defining, 144-145
nesting, 152-153
<frameset> tags
BBEdit and, 314
introduction, 144-145
framesets
building in HomeSite, 384-385
Dreamweaver MX and, 448-449
FrontPage, 526-527
templates and in HomeSite, 353
Free WebSearch (Google), 240
Free-Hit-Counters.com, 248-249
freepolls Web poll, 244-245
FrontPage
alternative text, 494495
AutoShapes, 496-497
backgrounds, 508-509
blank Web pages, rearranging,
476-477
bookmarks, 530-531
borders, 512-513
Borders and Shading dialog box,
512-513
bulleted lists, 510-511
clip art as links, 492-493
clip art insertion, 492-493
Clip Art task pane, 492-493
colors, 508-509
Customize Theme dialog box,
484-485
Drawing toolbar, 496-497
Flash content, adding, 498-499
frames creation, 526-527
headings, 489
Insert Web Component dialog
box, 502-503
interactive buttons, 506-507
keywords, 532-533
layers, 528-529
line drawing, 496-497
<meta> tags, 532-533
naming pages, 478-479
Navigation bars, 502-503
New task pane, 474-475
numbered lists, 510-511
page banners, 504-505
page description text, 532-533
page properties, 480-481
Page Properties dialog box,
480-481

Page Templates dialog box,
526-527
picture insertion, 492-493
populating tables, graphics and
text, 524-525
shading, 514-515
shape drawing, 496-497
spelling checker, 490-491
Split Cells dialog box, 520-521
table cell reformatting, 522-523
table cell resizing, 522-523
table column deletion, 518-519
table column insertion, 518-519
table insertion, 516-517
table row deletion, 518-519
table row insertion, 518-519
tables cells, splitting, 520-521
templates, 486-487
text formats, 488-489
text insertion, 488-489
Theme task pane, 482-483
themes, applying, 482-483
themes, creating, 484-485
Web site publishing, 534-535
Web site setup, 474475
WordArt, 500-501
FTP (File Transfer Protocol),
HomeSite deployment and, 399
FTP (File Transfer Protocol),
remote host setup (Dreamweaver

MX), 467
G

getHours method, Date() object
(JavaScript), 226
GIF images
HomeSite, 388-389
Photoshop Elements and, 68-69
GMT (Greenwich Mean Time),
<meta> tags and, 12-13
Google search bar, free, 240-241
grayed out selections, Textpad, 281
groove borders, 196

H
handicap accessibility, BBEdit, 308
hanging indents, definition lists,
58-59

<head> section, display, 4
<head> tags

BBEdit and, 300

HomeSite <meta> tags,

350-351

styles, 164-165

headers, tables, 97



Index

545

headings
align attribute, 24-25
alignment, 24
FrontPage, 489
phrases as, 24-25
tags, 24-25
tags in HomeSite, 350-351
words as, 24-25
height attribute, tables, 104-105
height, pop-up windows, 237
Help
HomeSite, 344
searches in HomeSite, 345
Helvetica font, 29
hexadecimal colors
bgcolor attribute, 19
fonts, 32
hidden fields, 136-137
hiding e-mail addresses from
spammers, 230-231
hit counters, Free-Hit-
Counters.com, 248-249
Home Page
FrontPage, 474-475
Resource panel and
(HomeSite), 345
HomeSite
<!-and -> comment tags,
356-357
Add a Project Folder dialog
box, 349
Add All Subfolders option, 346
attribute insertion, 356-357
attribute previewing, Browse
tag, 356-357
Auto-Backup, 394-395
<body> tags, starting page and,
350-351
body text formatting, 364-365
bulleted lists, 367
CodeSweeper, 358-359
converting text to HTML,
354-355
Create Image Map dialog box,
378-379
Customize dialog box, 392-393
customizing, 392-393
deploying files/folders, 398-399
deployment options, 396-397
Deployment Wizard, 398-399
document weight, 388-389
downloading, 344
editing CSS with Style Editor,
360-361
Editor toolbar, 344

Extended Find dialog box, 373

External Browsers dialog box,
362-363

Find dialog box, 372-373

folder naming rules, 349

folders, 348-349

folders, deleting, 349

folders, physical folders, 349

<font> tags, 355

Fonts tab, 345

Fonts toolbar, 364-365

<form> tags, 386-387

formatting, previewing, 364-365

forms, 386-387

Forms toolbar, 386-387

Frames toolbar, 384-385

Frames Wizard, 384-385

frameset building, 384-385

GIF images, 388-389

<head> tags, <meta> tag and,
350-351

headings tags, 350-351

HTML Comment command
(Tags menu), 356-357

image insertion, 376-377

Image Map Editor, 378-379

Image Properties dialog box, 389

image storage, 377

images folder, 347

JPEG images, 388-389

keywords, 350-351

List dialog box, 366-367

lists, 366-367

<meta> tags, 350-351

New Document dialog box,
350-351

new project creation, 346-347

new project creation with
templates, 352-353

New Project dialog box, 346-347

ordered lists, 366-367

pasting text from word
processing documents, 365

polygon drawing, 379

previewing Web pages, 362-363

project file storage, 347

project names, 346-347

Replace dialog box, 374-375

replacing content, 374-375

Resource panel, 345

Resource window, 344

rules, horizontal, 370-371

Save As Template dialog
box, 353

screen tips, 344
searching HTML documents,
372-373
Select Directory dialog box,
346-347
shortcuts, 345
Site View window, 344
spell check, 368-369
Spell Check dialog box, 368-369
stripping redundant tags, 355
Style Editor and, 360-361
subfolders, 349
table insertion, 382-383
Table Sizer, 382-383
Table Wizard, 382-383
Tables tab, 345
Tables toolbar, 382-383
Tag Chooser, 380-381
Tag Editor - FONT dialog box,
364-365
Tag Editor - FORM dialog box,
386-387
Tag Editor - HR dialog box,
370-371
Tag Editor - IMG dialog box,
376-377
tag insertion, 356-357
tag insertion, automatic, 380-381
templates, 350-351, 352-353
<title> tags text in title bar,
350-351
TopStyle lite (Style Editor),
360-361
unordered lists, 366-367
Validate Current Document
option, 359
Verify Links, 390-391
verifying code, 390-391
horizontal rules, HomeSite, 370-371
hotspots, Dreamweaver MX,
436-437
href attribute, 86-87
mailto: protocol, 90
pop-up windows and, 236-237
hspace attribute, <img> tag, 64
HTML (HyperText Markup
Language)
converting from plain text in
BBEdit, 330-331
converting text to in HomeSite,
354-355
document creation with BBEdit,
300-301
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HTML (HyperText Markup
Language) (continued)
invalid, highlighting in
Dreamweaver MX, 411
searching documents in
HomeSite, 372-373
stripping tags with BBEdit,
330-331
templates in HomeSite, 350-351
validation in BBEdit, 328-329
Word HTML, importing to
Dreamweaver MX, 422-423
HTML Comment command, Tags
menu (HomeSite), 356-357
HTML Syntax Errors panel
(BBEdit), 328-329
<html> tags
BBEdit and, 300
containers and, 4
lang attribute (BBEdit), 300
HTML Tools palette (BBEdit),
304-305
HTML Validator, TextPad and,
286-287
http-equiv attribute
<meta> tag and, 14-15
refreshing content and, 14
hyperlinks. See links

<i> tags (italic text), 34
if statements, JavaScript, 226
if/else statements, JavaScript, 227
<iframe> tags, 158-159
Image dialog box (BBEdit), 308
image fields, Submit buttons
and, 134
Image Map Editor (HomeSite),
378-379
image maps, Dreamweaver MX,
436-437
Image Properties dialog box
(HomeSite), 389
images
alignment, 64-65
alignment in BBEdit, 309
alignment in Dreamweaver MX,
426-427
background, CSS and, 192-193
copying from Web pages, 247
dimensions, 62
document weight and
(HomeSite), 388-389
downsampling, 66-67
Dreamweaver MX, external
editors, 434-435

Flash buttons (Dreamweaver
MX), 430-431
floating, 64-65
folder (HomeSite), 347
formatting with Dreamweaver
MX, 426-427
GIEF, optimizing with
Photoshop Elements, 68-69
<img> tag, 62-63
inserting, 62-63
inserting with BBEdit, 308-309
inserting with Dreamweaver
MX, 426-427
inserting with FrontPage,
492-493
inserting with HomeSite,
376-377
JPEG, optimizing with
Photoshop Elements, 70-71
as links, borders, 86
populating tables (FrontPage),
524-525
Preload Images behavior
(Dreamweaver MX), 456-457
preloading at startup, 232-233
preloading at startup for
rollovers, 234-235
resampling, 66-67
resizing with Photoshop
Elements, 66-67
rollovers, 234-235
rollovers, Dreamweaver MX,
438-439
site maps (Dreamweaver
MX), 407
size, preloading and, 232-233
spacing, 64-65
storage, HomeSite and, 377
table background, 106
tiling in background, 18-19,
192-193
<img> tags, 62-63
arc attribute, 63
BBEdit, 308-309
Import Tabular Data dialog box
(Dreamweaver MX), 424-425
indents
<blockquote> tags and, 42-43
CSS, 190-191
Dreamweaver MX, 415
hanging indents in definition
lists, 58-59
tags, 4
inline frames, 158-159
Input dialog box (BBEdit), 312-313

<input> tag
check boxes, 122-123
file fields, 130-131
forms, 116
hidden fields, 136-137
password fields, 118-119
radio buttons, 124-125
text areas, 120-121
text fields, 116-117
XHTML compatibility, 122
Insert Navigation Bar dialog box
(Dreamweaver MX), 440-441
Insert Rollover Image dialog box
(Dreamweaver MX), 438-439
Insert Table tool (FrontPage),
516-517
Insert Tag dialog box (BBEdit),
302-303
Insert Web Component dialog box
(FrontPage), 502-503
inset borders, 196
installation
BBEdit, 296-297
TextPad, 254-255
interactive buttons (FrontPage),
506-507
Internet Explorer
inline frames support, 158-159
Save Web Page dialog box, 20-21
source code, 20
intranets, inline frames, 158-159
italic text, 34, 176

J
Japanese Yen symbol, 38

Java
downloading applets, 82
embedding applets, 82-83
JavaScript
arguments, 226
behaviors, 454-455
Date() object, 226
events, 228
if statements, 226
if/else statements, 227
onlLoad event handler, 228
onMouseOut event handler, 228
onMouseOver event
handler, 228
parentheses, 226
time-based content, changing,
226-227
variable rules, 225
variables, punctuation in, 225
variables, spaces in, 225
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variables, special characters
in, 225
variables, underscore
character, 225
JPEG images
HomeSite, 388-389
optimizing with Photoshop
Elements, 70-71
JScript, 222
justified alignment
Dreamweaver MX, 414
paragraphs, 27

K
<kbd> tags, 36
keyboard, <kbd> tags, 36
keyboard shortcuts. See also macros
copying, 89
custom in HomeSite, 392-393
macro assignments, 291
pasting, 89
TextPad, 258-259
keystroke macros
tag wrapping in TextPad,
290-291
TextPad, 288-289
keywords
float property (CSS), 208-209
font-size property (CSS),
172-173
FrontPage, 532-533
HomeSite, 350-351
<meta> tag, 6-7
<meta> tag content attribute
and, 7
spam and, 6

L
lang attribute, <html> tags
(BBEdit), 300
layers
clip fields, 450-451
CSS absolute positions,
214-215
CSS clipping area, 218-219
CSS relative positions, 216-217
Dreamweaver MX and, 450-451
FrontPage, 528-529
leading, 184185
left alignment
Dreamweaver MX, 414
headings, 24-25
paragraphs, 27
leftmargin attribute, <body>
tags, 44

<legend> tags, 140-141
letter-spacing property (CSS)
BBEdit and, 319
introduction, 182-183
<li> tags
BBEdit lists, 307
introduction, 46-47
value attribute, 51
libraries
clip library (TextPad), editing,
280-281
clip library (TextPad)
introduction, 278-279
line drawing (FrontPage), 496-497
line numbers, Dreamweaver MX
Code View, 411
line spacing (CSS), 184-185
line-height property (CSS)
BBEdit, 316
introduction, 184-185
links
<a> tags, 86-87
Amazon.com associates and,
246-247
anchor tags, 86-87
BBEdit, 305
clip art as (FrontPage), 492-493
defining, 86-87
images as, borders, 86
mailto, 90-91
named anchors, 92-93
pop-up window creation and,
236-237
text color, 87
text underline, 86
List dialog box (HomeSite), 366-367
lists
BBEdit, converting text to,
306-307
BBEdit attributes, 307
bulleted list bullet style, 54-55
bulleted list bullet style (CSS),
210-211
bulleted lists, 47
definition, 58-59
Dreamweaver MX, 416-417
FrontPage, 510-511
HomeSite, 366-367
nesting, 56-57
number styles, 212-213
ordered list starting character,
50-51
ordered list styles, 48-49
ordered lists, 46-47
pop-up lists, 126-127

selection lists, 128-129

unordered, 52-53
Lists dialog box (BBEdit), 306-307
list-style-type property

(CSS), 210-211
literal characters, <samp> tags, 36
local files, structure, 167
location, pop-up windows, 237
Location Toolbar, Open Browser
Window behavior and, 458-459

logical styles

<cite> tags, 36

<code> tags, 36

<em> tags, 36

<kbd> tags, 36

<pre> tags, 41

<samp> tags, 36

<strong> tags, 36

<var> tags, 36
loop attribute

sound and, 78

video, 81
lowercase

alphabetical ordered lists, 48

filenames in HomeSite,

396-397
in tags, 2

M
Macintosh, versions for
BBEdit, 296
macros
keystroke macros, TextPad,
288-289
tag wrapping (TextPad),
290-291
magazine style headings, 24-25
mailto links, 90-91
mailto: protocol
bots and, 230-231
href attribute, 90
Manage Files dialog box (TextPad),
264-265
margin area (BBEdit), 326
margin properties (CSS), 204-205
marginheight attribute
<body> tags, 44
frames, 150-151
margins
frames, 150-151
printable, 43
setting, 44-45
marginwidth attribute
<body> tags, 44
frames, 150-151
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mark up, definition, 2
maxlength attribute
password fields, 118-119
text fields, 116
memory, preloading images and,
232-233
Menu Bar, Open Browser Window
behavior and, 459
menu keys, setting in BBEdit,
336-337
<meta> tag
content attribute, 7
descriptions, 8-9
document author, 10-11
e-mail addresses, 11
expiration dates, 12-13
Greenwich Mean Time (GMT),
12-13
<head> tags in HomeSite,
350-351
HomeSite, 350-351
http-equiv attribute,
refreshing content and, 14
keywords, 6-7
properties, 4
refreshing content, 14-15
robots and, 16-17
search engines and, 6
sites maintaining, 10
<meta> tags, FrontPage, 532-533
methods, getHours
(JavaScript), 226
.mid files (audio), 76
monospaced fonts, 34, 41
mouse, screen tips (HomeSite), 344
.mp3 files (audio), 76

N
name attribute
check boxes, 123
forms, 116
hidden fields, 136-137
pop-up lists, 126-127
property/value pair, 8
radio buttons, 124
name attribute, <meta> tag, 4
named anchors, links, 92-93
names
code snippets (Dreamweaver
MX), 412-413
color, predefined, 33
folders (HomeSite), 349
pages (FrontPage), 478-479
projects in HomeSite, 346-347
styles (Dreamweaver MX), 453
templates (FrontPage), 487

navigation bars, building in
Dreamweaver MX, 440-441
Navigation bars (FrontPage),
502-503
Navigation Toolbar, Open Browser
Window behavior and, 458-459
nesting
frameset documents, 152-153
lists, 56-57
physical styles, 35
tables, 108-109
tables in Dreamweaver MX,
442443
Netscape Navigator
Page Source, viewing, 20-21
plug-ins, 76
QuickTime, 76
Source window, 20
New Document dialog box
(HomeSite), 350-351
New HTML Document dialog box
(BBEdit), 300
New Project dialog box
(HomeSite), 346-347
New task pane (FrontPage),
474-475
news ticker from 7am.com, 242-243
newspaper-style headings, 24-25
noframes content, 156-157
<noframes> tags
BBEdit, 315
introduction, 156-157
noresize attribute, borders, 149
Notepad, source code and, 20-21
numbered lists
Arabic numeral lists, 48
FrontPage, 510-511
number styles, 212-213
Roman numeral lists, 48

0
<object> tag, applet embedding,
82-83
object-based languages, 224-225
oblique fonts, 176
<ol> tag
BBEdit lists, 307
introduction, 46-47
onLoad event handler
(JavaScript), 228
onMouseOut event handler
JavaScript, 228
rollovers and, 234-235
onMouseOver event handler
JavaScript, 228
rollovers and, 234-235

Open Browser Window behavior
(Dreamweaver MX), 458-459
Open File(s) dialog box,
TextPad, 256
opening/closing tags, description, 2
<option> tags, 126-127
ordered lists
alphabetical, 48
creating, 46-47
Dreamweaver MX, 416-417
HomeSite, 366-367
start attribute, 50-51
starting character, 50-51
styles, 48-49
outset borders, 196

P
<p> tags (paragraph)
introduction, 2
paragraph formatting, 26-27
padding area (BBEdit), 326
Padding dialog box (BBEdit),
322-323
padding properties (CSS)
BBEdit and, 322-323
introduction, 194-195
page banners (FrontPage), 504-505
page description text (FrontPage),
532-533
page properties (Dreamweaver
MX), 408-409
Page Properties dialog box
(Dreamweaver MX), 408-409
Page Properties dialog box,
FrontPage, 480481
Page Source, viewing in Netscape
Navigator, 20-21
Page Templates dialog box
(FrontPage), 526-527
pages (FrontPage)
naming, 478-479
properties, 480-481
rearranging, 476477
saving as templates, 486-487
paragraph (<p>) tags, 2
paragraphs
formatting, 26-27
separating, 371
tags, 26-27
parent lists, 56-57
parentheses, in JavaScript, 226
passwords, form fields, 118-119
pathnames
absolute, 88
defining, 88-89
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Document Selector
(TextPad), 275
preloading images and, 232-233
relative, 88
Perl, forms and, 114
Photoshop Elements
GIF image optimization, 68-69
image resize, 66-67
JPEG image optimization, 70-71
PNG image optimization, 72-73
phrases, formatting as headings,
24-25
physical folders (HomeSite), 349
physical styles
applying, 34-35
nested, 35
<pre> tags, 41
plug-ins
control panel and, 76
QuickTime, 76
PNG (Portable Network
Graphics), optimizing with
Photoshop Elements, 72-73
points, font size, 30-31
polls, freepolls.com Web poll,
244-245
polygons, drawing in HomeSite, 379
populating tables, FrontPage,
524-525
populating tables with
Dreamweaver MX, 446-447
pop-up lists, 126-127
pop-up windows
creating, 236-237
height, 237
href attribute and, 236-237
links and, 236-237
location, 237
scroll bars, 237
toolbars, 237
width, 237
<pre> tag (preformatted text)
BBEdit, 305
introduction, 40-41
predefined color names, 33
Preferences dialog box (TextPad),
284-285
Preferences panel (BBEdit), 298
preformatted text
BBEdit and, 305
introduction, 40-41
Preload Images behavior
(Dreamweaver MX), 456-457
preloading images, 232-233
preloading images, rollovers and,
234-235

previewing Web pages
browsers, Dreamweaver MX
and, 402-403
browsers, HomeSite and,
362-363
printing, margins, 43
Project tab (HomeSite), project file
storage, 347
projects (HomeSite)
creating, 346-347
creating with templates,
352-353
CSS documents, 360-361
files, Project tab, 347
images folder at setup, 347
naming, 346-347
properties
attributes, 3
background properties
(BBEdiv), 320-321
background-attachment
(CSS), 192-193
background-image (CSS),
192-193
background-position (CSS),
192-193
background-repeat (CSS),
192-193
border color (CSS), 200-201
border frames, 148-149
border properties, CSS in
BBEdit, 324-325
border property shorthand
(CSS), 202-203
border width (CSS), 198-199
borders (CSS), 196-197
box properties, CSS in BBEdit,
326-327
£loat (CSS), 208-209
font (CSS), 178-179
font properties, CSS in BBEdit,
316-317
font-family (CSS), 170-171
font-size (CSS), 172-173
font-weight (CSS), 176
letter-spacing (CSS),
182-183
line-height (CSS), 184-185
margin properties (CSS),
204-205
padding properties (CSS),
194-195
page properties (Dreamweaver
MX), 408-409
pages (FrontPage), 480-481
table background, 106-107

text, CSS in BBEdit, 318-319
text-decoration (CSS),
186-187
text-indent (CSS), 190-191
text-transform (CSS),
188-189
vertical-align (CSS),
184-185
white-space (CSS), 182-183
width (CSS), 206-207
word-spacing (CSS), 182-183
Properties Inspector (Dreamweaver
MX), 414-415
property/value pairs
content attribute, 8
name attribute, 8
publishing Web sites (FrontPage),
534-535
punctuation, variables,
JavaScript, 225

QuickBar (HomeSite),
introduction, 344
QuickTime, 76
quotation marks
attribute values, 171
font names, 171
quoted text, <blockquote>
tags, 42

R

.ra files (RealAudio), 76

radio buttons (forms), 124-125

readability of code, 4

RealAudio, .ra format, 76

recording macros (TextPad), 288

rect values, layer clipping area and,
218-219

refreshing content, <meta> tag
and, 14

registered symbol, 38

rel attribute, style sheets, 167

relative pathnames, 88

relative scale, fonts, 30

remote host setup, Dreamweaver
MX, 466-467

Rename/Move dialog box
(TextPad), 265

Replace dialog box, HomeSite,
374-375

Replace dialog box (TextPad),
266-267

replacing content, HomeSite,
374-375

resampling, images, 66-67
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Reset button, 132-133
Resize Handles, Open Browser
Window behavior and, 459
Resource panel (HomeSite)
display, 345
introduction, 344
Resource window (HomeSite),
introduction, 344
ridge borders, 196
right alignment
Dreamweaver MX, 414
headings, 24-25
paragraphs, 27
robots, <meta> tags, 16-17
rollovers
alternative text (FrontPage),
494-495
color (Dreamweaver MX),
428-429
creating, 234-235
Dreamweaver MX, 438-439
onMouseOut event handler,
234-235
onMouseOver event handler,
234-235
preloading images and, 234-235
status bar text, 462-463
Roman numeral lists, 48
root file, BBEdit and, 298
rows
cell spanning in tables, 100-101
deleting with (FrontPage),
518-519
frames as, 145
frames in BBEdit, 314
inserting in tables with
BBEdit, 311
inserting in tables with
FrontPage, 518-519
tables, 96-97
rows attribute, frames, 146-147
rowspan attribute, 100-101
rules, horizontal in HomeSite,
370-371

)
<s> tags (strikethrough text), 34

<samp> tags, 36

Save As dialog box (TextPad),
276-277

Save As Template dialog box
(HomeSite), 353

Save Web Page dialog box (Internet
Explorer), saving source code,
20-21

screen tips, HomeSite, 344

<script> tags, 222-233
scripting
content based on time,
changing, 226-227
document preparation, 222-223
JScript, 222
time stamps, 224-225
scripts
containers in for hiding e-mail
addresses, 230-231
custom in HomeSite, 392-393
forms and, 114
scroll bars
frames, 150-151
pop-up windows, 237
Scrollbars as Needed, Open
Browser Window behavior
and, 459
scrolling attribute, frames
BBEdit, 314
introduction, 151
Search button (HomeSite), help
files and, 345
search engines
frames and, 448-449
Google, adding free search bar,
240-241
keywords and, 6-7
<meta> tag, 6, 8-9
robots, 16
searches
Dreamweaver MX, 420-421
HTML documents (HomeSite),
372-373
matching brackets (TextPad),
266-267,270-271
strings in multiple files
(TextPad), 268-269
Section 508 compliance, BBEdit
and, 308
Select Directory dialog box
(HomeSite), 346-347
<select> tag
pop-up lists, 126-127
selection lists, 128-129
selected attribute, pop-up lists,
126-127
selection lists, 128-129
selectors (CSS), 162
contextual, 165
declarations, single for series of
selectors, 163
series, identical styles for, 165
_self target, 154-155
serifs, fonts, 29

Set Text for Status Bar behavior
(Dreamweaver MX), 462-463
shading (FrontPage), 514-515
shading, horizontal rules
(HomeSite), 370
shape drawing (FrontPage), 496-497
shortcuts, HomeSite, 345
Site Definition dialog box
(Dreamweaver MX), 404-405
site maps, Dreamweaver MX,
406-407
Site View window (HomeSite),
introduction, 344
size
clip art (FrontPage), 492-493
fonts, 30-31
frames, 146-147
lines (FrontPage), 496-497
shapes (FrontPage), 496-497
table elements, 104-105
size attribute
<font> tags, 30-31
password fields, 118-119
text fields, 116
<small> tags, font size, 30-31
Snippet dialog box (Dreamweaver
MX), 412-413
Snippet Shortcuts (HomeSite),
392-393
Snippets panel (Dreamweaver MX),
412-413
solid borders, 196
sound. See also audio files
background, 78-79
loop attribute, 78
source code
browsers and, 20-21
code snippets (Dreamweaver
MX), 412-413
color coding in BBEdit,
338-339
color coding in Dreamweaver
MX Code View, 411
color coding in TextPad, 292-293
NotePad and, 20-21
readability, 4
saving, 20-21
selecting in TextPad, 260-261
verification (HomeSite), 390-391
viewing, 20-21
Source window (Netscape), 20
spaces in variables (JavaScript), 225
spacing
character spacing (CSS), 182-183
images, 64-65
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line spacing (CSS), 184185
word spacing (CSS), 182-183
spam, keywords and, 6
spammers
bots and, 230-231
hiding e-mail addresses from,
230-231
spanning cells in tables, 100-101
special characters
British Pound symbol, 38
cent symbol, 38
copyright symbol, 38
European Union’s Euro
symbol, 38
fractions, 38
Japanese Yen symbol, 38
registered symbol, 38
trademark symbol, 38
spell check
Dreamweaver MX, 418-419
FrontPage, 490-491
HomeSite, 368-369
Spell Check dialog box
(HomeSite), 368-369
spell check, TextPad, 254
Spelling Checker (TextPad),
272-273
Split Cells dialog box (FrontPage),
520-521
splitting table cells (FrontPage),
520-521
square bullets in bulleted lists, 54
square bullets in bulleted lists
(HomeSite), 367
start attribute, ordered lists,
50-51
starting character of ordered lists,
50-51
startup, preloading images, 232-233
statements
if statements, 226
if/else, 227
status bar
browser, writing information to,
228-229
clearing of information, 229
download display, 228-229
rollovers and, 462-463
Status Bar, Open Browser Window
behavior and, 458-459
strikethrough text, 34
strings
concatenation, 230
definition, 230
<strong> tags (strong
emphasis), 36

structure of documents, 4-35
structure of documents, container
tags, 4
style classes, defining, 168-169
Style Editor (HomeSite)
CSS editing, 360-361
TopStyle lite, 360-361
<style> tags
BBEdit TagMaker, 302-303
introduction, 164-165
styles. See also CSS (Cascading
Style Sheets)
bullet styles, 54-55
descendant, 163
embedding style sheets, 164-165
logical, 36-37
naming (Dreamweaver MX), 453
ordered lists, 48-49
physical, 34-35
rules, writing, 162-163
<sub> tags, 34
subfolders (HomeSite), 349
Submit button
formatting, 132-133
graphic images, 134-135
subscript text, <sub> tags, 34
<sup> tags, 34
superscript text, <sup> tags, 34
symbols, 38
syntax, tags, 2
syntax, tags, color coding HTML
in TextPad, 292-293

T
tabindex attribute, form controls,
138-139

Table Sizer (HomeSite), 382-383

<table> tags
BBEdit and, 310-311
introduction, 96-97

Table Wizard (HomeSite), 382-383

tables
alignment in, 102-103
alignment in BBEdit, 310
background color in BBEdit, 310
background properties, 106-107
BBEdit creation, 310-311
border attribute, 98-99
bordercolor attribute, 98-99
borders, 97, 98-99
borders in BBEdit, 310
cell insertion in BBEdit, 311
cell insertion in FrontPage,

518-519
cell reformatting (FrontPage),
522-523

cell resizing (FrontPage),
522-523
cell spacing (Dreamweaver
MX), 442-443
cellpadding attribute, 98-99
cells, 96-97
cellspacing attribute, 98-99
column deletion (FrontPage),
518-519
column insertion in FrontPage,
518-519
creating with Dreamweaver
MX, 442-443
data organization, 110-111
data tables (Dreamweaver MX),
424-425
defining, 96-97
dimensions of elements, 104-105
editing in Dreamweaver MX,
444-445
headers, 97
height, 104-105
indenting code, 109
inserting with FrontPage,
516-517
inserting with HomeSite,
382-383
nesting, 108-109
nesting (Dreamweaver MX),
442-443
populating with graphics and
text (FrontPage), 524-525
row deletion (FrontPage),
518-519
row insertion in BBEdit, 311
row insertion in FrontPage,
518-519
rows, 96-97
spanning row/column with cells,
100-101
splitting cells (FrontPage),
520-521
width, 104-105
width in BBEdit, 310
Tables tab (HomeSite),
introduction, 345
Tables toolbar (HomeSite), 382-383
Tag Chooser (HomeSite), 380-381
Tag Editor - FORM dialog box
(HomeSite), 386-387
Tag Editor - HR dialog box
(HomeSite), 370-371
Tag Editor - IMG dialog box
(HomeSite), 376-377
Tag Editor -FONT dialog box
(HomeSite), 364-365
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tag wrapping macro (TextPad),
290-291
TagMaker (BBEdit)
edit tools, 302-303
<style> tags and, 302-303
tags
< (less than) symbol, 2
> (greater than) symbol, 2
<a>, 86-87
<applet>, 82-83
attribute order, 229
attributes, 3
attributes, displaying in
BBEdit, 303
<b>, 34
<bgsound>, 78-79
<big>, 30-31
<blockquote>, 42-43
<body>, 18-19
<body>, margins and, 44-45
case sensitivity, 2
<cite>, 36
<code>, 36
comments, 109
container tags, 4
<dd>, 58-59
<dfn>, 36
<divs, 214-215
<dl>, 58-59
<dt>, 58-59
<em>, 36
<embed>, 76-77
event handler order, 229
<fieldset>, 140-141
<form>, 114-115
<frame>, 144-145
<frameset>, 144-145
<head>, 164-165
headings, 24-25
headings (HomeSite), 350-351
<html>, 4
<i>, 34
<iframe>, 158-159
<img>, 62-63
indenting, 4
<input>, 116, 118-119
inserting automatically with
HomeSite, 380-381
inserting with HomeSite,
356-357
<kbd>, 36
<legend>, 140-141
<li>, 46-47
list creation in BBEdit, 306-307

<meta>, 6-7, 10, 12-13, 14-15,
16-17
<noframes>, 156-157
<object>, 82-83
<ol>, 46-47
opening/closing, 2
<option>, 126-127
paragraphs, 26-27
<pre>, 40-41
<s>, 34
<samp>, 36
<scripts, 222-223
<select>, 126-127, 128-129
<small>, 30-31
stripping redundant in
HomeSite, 355
stripping with BBEdit, 330-331
<strong>, 36
<style>, 164-165
syntax, 2
<table>, 96-97
<tbody>, 110-111
<tcaption>, 110-111
<td>, 96-97
<textarea>, 120-121
<tfoot>, 110-111
<thead>, 110-111
<title>, 5
<tr>, 96-97
<tsummary>, 110-111
<tt>, 34
<u>, 34
<ul>, 52-53
<var>, 36
writing, 2-3
Tags menu (HomeSite)
attributes display, 356-357
HTML Comment command,
356-357
tags display, 356-357
target attribute, frames, 154-155
targets, frames, 154-155
<tbody> tag, 110-111
<tcaption> tag, 110-111
<td> tags
BBEdit and, 310-311
introduction, 96-97
templates
frames, FrontPage and, 526-527
framesets, HomeSite and, 353
FrontPage, 486-487
HomeSite, 350-351, 352-353
text
alignment (CSS), 190-191
alternative (FrontPage),
494-495

body text formatting in
HomeSite, 364-365
bold, 34
borders (FrontPage), 512-513
color, default, 33
converting plain to HTML in
BBEdit, 330-331
converting to HTML in
HomeSite, 354-355
converting to list, BBEdit,
306-307
converting to lists
(HomeSite), 367
emphasis, 36
Flash text (Dreamweaver MX),
428-429
formatting (Dreamweaver MX),
414-415
formatting (FrontPage), 488-489
formatting in BBEdit, 304-305
as hyperlink (BBEdit), 305
inserting (Dreamweaver MX),
414-415
inserting (FrontPage), 488-489
italic, 34
link color, 87
link underlining, 86
monospaced fonts, 34
navigating in TextPad, 258-259
pasting to HomeSite from word
processing document, 365
populating tables (FrontPage),
524-525
preformatted, 4041
preformatted, in BBEdit, 40-41
properties, CSS in BBEdit,
318-319
selecting in Textpad, 260-261
shading (FrontPage), 514-515
status bar display in
browsers, 228
status bar display in browsers,
Dreamweaver MX and,
462-463
strikethrough, 34
underlined, 34
text areas (forms)
BBEdit and, 313
formatting, 120-121
wrapping text, 120
text attribute, <body> tag, color
and, 33
text boxes (forms), 116
text fields (forms), formatting,
116-117
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text-align property (CSS),
BBEdit, 318

<textarea> tags, 120-121

text-decoration property (CSS)

BBEdit, 319

introduction, 186-187

text-indent property (CSS)

BBEdit, 318

introduction, 190-191

TextPad

Books (clip library), 281

brackets, finding matching,
270-271

brackets, opening/closing,
270-271

Browse for Folder dialog box,
268-269

browser configuration, 284-285

clip library downloads, 282-283

clip library edits, 280-281

Clip Library Entry dialog box,
280-281

clip library introduction,
278-279

Clipboard, 262-263

color coding and, 292-293

Copy dialog box, 264

creating files, 256-257

Delete dialog box, 265

deleting clips, 281

dictionaries, 272-273

Document Selector, 274-275

downloading, 254-255

drag-and-drop, 254

embedded CSS code, 262

file management, 264-265

File Open dialog box, 257

File Open dialog box in creating
workspaces, 277

files, searching multiple, 268-269

Find and Replace functions,
266-267

Find dialog box, 266-267

Find in Files dialog box,
268-269

grayed-out selections, 281

HTML Validator, 286-287

installing, 254-255

keyboard shortcuts, 258-259

keystroke macro creation,
288-289

keystroke macros, tag wrapping,
290-291

Manage Files dialog box,
264-265

navigating text, 258-259
new clips, 281
Open File(s) dialog box, 256
opening files, 256-257
Preferences dialog box, 284-285
recording macros, 288
Rename/Move dialog box, 265
renaming clips, 280
Replace dialog box, 266-267
Save As dialog box, 276-277
searching for strings, multiple
files, 268-269
source code selection and,
260-261
Spelling Checker, 272-273
workspace creation, 276-277
text-transform property (CSS)
BBEdit, 319
introduction, 188-189
<tfoot> tag, 110-111
<th> tag, BBEdit, 310-311
<thead> tag, 110-111
Theme task pane (FrontPage),
applying themes, 482-483
themes (FrontPage)
applying, 482-483
creating, 484-485
tiling images, background, 18
time stamps, scripts, 224-225
time zone, <meta> tags and, 12
time-based content, changing with
JavaScript code, 226-227
Time'Temperature.com, 250-251
title bar, <title> tags (HomeSite),
350-351
<title> tags, 5
<title> tags, title bar (HomeSite),
350-351
titles, 5
toolbars
customizing in HomeSite,
392-393
Fonts (HomeSite), 364-365
pop-up windows, 237
topmargin attribute, <body>
tags, 44
TopStyle lite (Style Editor)
editing CSS, 360-361
workspace, 360
<tr> tags
BBEdit and, 310-311
introduction, 96-97
tracing images, Dreamweaver MX
page properties, 408-409
trademark symbol, 38

<tsummary> tag, 110-111
<tt> tags (teletype text), 34
type attribute
check boxes, 122-123
file fields, 130-131
hidden fields, 136-137
radio buttons, 124
text fields, 116

u

<u> tags (underlined text), 34
<ul> tag
BBEdit lists, 307
introduction, 52-53
underlined text, 34
underscore character, JavaScript
variables and, 225
unordered lists
creating, 52-53
Dreamweaver MX, 416-417
HomeSite, 366-367
uploading, files (Dreamweaver
MX), 468-469
uppercase
alphabetical ordered lists, 48
Roman numeral lists, 48
in tags, 2
URLs (Uniform Resource
Locators)
absolute pathnames, 88
BBEdit and, 298
typos, 391

vV
Validate Current Document option
(HomeSite), 359
Validate Form behavior
(Dreamweaver MX), 460-461
validating HTML in BBEdit,
328-329
valign attribute, 103
value attribute
check boxes, 122-123
<li>tags, 51
password fields, 118-119
pop-up lists, 126-127
radio buttons, 124
value pairs, name attribute, 116
<var> tags, 36
variables
definition, 224
JavaScript, punctuation, 225
JavaScript, spaces in, 225
JavaScript, special
characters, 225
JavaScript rules, 225
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Verify Links (HomeSite), 390-391
verifying code, HomeSite, 390-391
vertical-align property (CSS)
BBEdit, 318
introduction, 184-185
video
controller attribute, 81
embedding, 80-81
loop attribute, 81

w
.wav files (audio), 76
W3C (World Wide Web
Consortium), 27
weather information, adding to site,
250-251
Web pages
blank, rearranging in
FrontPage, 476-477
previewing in browsers,
HomeSite and, 362-363
Web servers
BBEdit and, 298
Dreamweaver MX setup, 467
Web sites
defining, Dreamweaver MX,
404-405
publishing with FrontPage,
534-535
setup (FrontPage), 474-475

white-space property (CSS),
182-183
width
horizontal rule (HomeSite), 370
pop-up windows, 237
width attribute, tables, 104-105
width property (CSS), 206-207
Window Name, Open Browser
Window behavior and, 459
window.open( ) event handler,
236-237
windows
pop-up, creating, 236-237
Source (Netscape Navigator),
20-21
Windows Explorer, project setup
(HomeSite), 347
WinZip, downloading and, 282
Word HTML, importing to
Dreamweaver MX, 422-423
word processing documents,
pasting text to HomeSite, 365
word spacing (CSS)
BBEdit and, 319
introduction, 182-183
word wrap, Dreamweaver MX
Code View, 411
WordArt (FrontPage), 500-501
words, formatting as headings,
24-25

word-spacing property (CSS),
182-183
workspaces
TextPad, 276-277
TopStyle, 360
wrap attribute, 120
wrap selection, Dreamweaver MX
code snippets, 413
WYSIWYG (what you see is what
you get), 344

X
XHTML (Extensible Hypertext
Markup language), 2
/ (forward slash) for
compatibility, 7
<frame> tag compatibility, 145
<input> tag compatibility,
117,122
<meta> tag compatibility, 7
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